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Skaitmeninis fotoaparatas su keičiamaisiais objektyvais ILME-FR7 / ILME-
FR7K

Apžvalga

Įprastas naudojimas

Sistemos konfigūracija [1]

Vieno įrenginio valdymas naudojant pridedamą infraraudonųjų spindulių
nuotolinio valdymo pultą [2]

Vieno įrenginio valdymas naudojant planšetinį kompiuterį arba kompiuterį
[3]

Vieno įrenginio valdymas naudojant išorinį nuotolinį valdiklį [4]

Kelių įrenginių valdymas naudojant išorinį nuotolinį valdiklį [5]

Dalių vieta ir funkcijos

Vaizdas iš priekio [6]

Vaizdas iš galo [7]

Jungčių blokas [8]

Vaizdas iš šono [9]

Vaizdas iš viršaus [10]

Vaizdas iš apačios [11]

Objektyvo atrama [12]

Infraraudonųjų spindulių nuotolinio valdymo pulto (pridedama)
dalių vieta ir funkcija [13]

Žiniatinklio programos ekranas
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Žiniatinklio programos ekrano apžvalga [14]

Bendrosios ekranų srities struktūra [15]

Tiesioginio valdymo ekrano struktūra [16]

Atkūrimo valdymo ekrano struktūra [17]

Nustatymų ekrano struktūra [18]

Fotoaparato meniu [19]

Fotoaparato ekrano rodinys [20]

Parengiamieji veiksmai

Įrenginio montavimas

Montavimas stačiai fiksuotoje vietoje [21]

Montavimas stačiai aukštoje, fiksuotoje vietoje [22]

Montavimas prie lubų [23]

Objektyvo uždėjimas / nuėmimas

Atsargumo priemonės uždedant / nuimant objektyvą [24]

Objektyvo jungiklių tikrinimas [25]

Atsargumo priemonės naudojant keičiamo židinio nuotolio objektyvą [26]

Objektyvo uždėjimas [27]

Objektyvo nuėmimas [28]

Kabelių prijungimas [29]

Įrenginio prijungimas prie tinklo įrenginio laidiniu ryšiu [30]

Maitinimo prijungimas

Kintamosios srovės naudojimas [31]
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PoE++ maitinimo naudojimas [32]

Pasukimo / pakreipimo nustatymas iš naujo [33]

Konfigūravimas prieš fiksuojant vaizdus

Įrenginio pradinių nustatymų atkūrimas naudojant žiniatinklio programą

Prisijungimas prie žiniatinklio programos iš žiniatinklio naršyklės [34]

Įrenginio pradinių nustatymų atkūrimas [35]

Pagrindinių funkcijų konfigūravimas [36]

Atminties kortelių paruošimas

Palaikomos atminties kortelės [37]

Atminties kortelės įdėjimas [38]

Atminties kortelės išėmimas [39]

Atminties kortelių formatavimas (inicijavimas) [40]

Likusio įrašymo laiko tikrinimas [41]

Atminties kortelių taisymas [42]

Vaizdų fiksavimas

Pagrindinės funkcijos

Įrašymo pradėjimas / sustabdymas [43]

Perjungimas tarp atminties kortelių [44]

Garso tikrinimas [45]

Laiko duomenų nustatymas [46]

Įrašo peržiūra („Rec Review“) [47]
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Kadravimo reguliavimas

Kadravimo koregavimo ekranas [48]

Vaizdų fiksavimo krypties reguliavimas

Vaizdų fiksavimo krypties reguliavimas naudojant žiniatinklio programą [49]

Pasukimo / pakreipimo greičio nustatymas [50]

Pasukimo / pakreipimo spartinimo nustatymas [51]

Vaizdų fiksavimo krypties reguliavimas naudojant pridedamą infraraudonųjų
spindulių nuotolinio valdymo pultą [52]

Priartinimo reguliavimas

Priartinimo tipo nustatymas [53]

Priartinimo reguliavimas naudojant žiniatinklio programą [54]

Priartinimo greičio nustatymas [55]

Priartinimo reguliavimas naudojant pridedamą infraraudonųjų spindulių nuotolinio
valdymo pultą [56]

Fotoaparato pasukimo / pakreipimo / priartinimo padėties išsaugojimas /
atkūrimas

Objektyvo su E tipo tvirtinimu kalibravimas [57]

Pasukimo / pakreipimo, priartinimo padėties ir fokusavimo nustatymo išsaugojimas
/ atkūrimas naudojant žiniatinklio programą [58]

Padėties išankstinių nustatymų pervardijimas naudojant žiniatinklio programą [59]

Išsaugotos padėties keitimas nauja padėtimi naudojant žiniatinklio programą [60]

Išsaugotos padėties trynimas naudojant žiniatinklio programą [61]

Padėties išankstinių nustatymų perėjimo greičio keitimas [62]

Pasukimo / pakreipimo ir priartinimo padėties išsaugojimas / atkūrimas naudojant
pridedamą infraraudonųjų spindulių nuotolinio valdymo pultą [63]

Fokusavimo reguliavimas

Fokusavimo koregavimo ekranas [64]

Fokusavimo reguliavimas rankiniu būdu (rankinis fokusavimas)

Rankinis reguliavimas naudojant žiniatinklio programą [65]
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Rankinis reguliavimas naudojant pridedamą infraraudonųjų spindulių nuotolinio
valdymo pultą [66]

Fokusavimas nurodant fokusavimo padėtį (taškinis fokusavimas) [67]

Laikino automatinio fokusavimo naudojimas (automatinis fokusavimas (AF)
spaudžiant) [68]

Vieno kadro automatinio fokusavimo naudojimas („Push Auto Focus (AF-S)“) [69]

Fokusavimo reguliavimas automatiškai (automatinis fokusavimas)

Automatinis reguliavimas naudojant žiniatinklio programą [70]

Automatinis reguliavimas naudojant pridedamą infraraudonųjų spindulių nuotolinio
valdymo pultą [71]

Automatinio fokusavimo srities / padėties nustatymas (fokusavimo sritis) [72]

Greitas fokusavimo srities keitimas (fokusavimo nustatymas) [73]

Fokusavimo srities rėmelio perkėlimas naudojant jutiklinį valdymą (jutiklinis
fokusavimo srities valdymas) [74]

Automatinio fokusavimo reguliavimas (AF perėjimo greitis, AF objekto poslinkio
jautrumas) [75]

Rankinis automatinio fokusavimo taikinio nustatymas (AF pagalba) naudojant
žiniatinklio programą [76]

Rankinis fokusavimas veikiant automatiniam fokusavimui naudojant pridedamą
infraraudonųjų spindulių nuotolinio valdymo pultą [77]

Laikinas rankinio fokusavimas naudojimas veikiant automatiniam fokusavimui
(rankinis fokusavimas spaudžiant) [78]

Sekimas naudojant veido ir akių aptikimą (veido / akių aptikimo AF) [79]

Nustatyto objekto sekimas (sekimo realiuoju laiku AF) [80]

Šviesumo reguliavimas

Šviesumo reguliavimo ekranas [81]

Bazinio jautrumo nustatymas [82]

Numatyto automatinio šviesumo reguliavimo lygio nustatymas [83]

Diafragmos reguliavimas

Automatinis diafragmos reguliavimas [84]

Rankinis diafragmos reguliavimas [85]
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Stiprinimo reguliavimas

Automatinis stiprinimo reguliavimas [86]

Rankinis stiprinimo reguliavimas [87]

Užrakto reguliavimas

Automatinis užrakto reguliavimas [88]

Rankinis užrakto reguliavimas [89]

Šviesos lygio reguliavimas (ND filtras)

Apie ND filtrą [90]

Reguliavimas išankstinio nustatymo režimu [91]

Automatinis reguliavimas kintamuoju režimu [92]

Rankinis reguliavimas kintamuoju režimu [93]

Natūralių spalvų reguliavimas (baltos spalvos balansas)

Baltos spalvos balanso reguliavimo ekranas [94]

Automatinis baltos spalvos balanso reguliavimas [95]

Baltos spalvos balanso reguliavimas rankiniu būdu [96]

Automatinio baltos spalvos balanso naudojimas [97]

Įrašomo garso konfigūravimas

Garso konfigūravimo ekranas [98]

Garso įvesties įrenginio pasirinkimas [99]

Automatinis garso įrašymo lygio reguliavimas [100]

Garso įrašymo lygio reguliavimas rankiniu būdu [101]

Naudingos funkcijos

Tiesioginių meniu naudojimas [102]
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Priskiriami mygtukai [103]

Sulėtintas ir pagreitintas filmavimas [104]

Vaizdo įrašymas su pertrūkiais (filmavimas intervalais) [105]

Talpykloje esančių nuotraukų įrašymas („Picture Cache Rec“) [106]

Įrašymas į atminties korteles A ir B vienu metu (2 lizdų
sinchroniškas įrašymas) [107]

„Video Signal Monitor“ (vaizdo signalo stebėjimas) [108]

Klipo žymės [109]

Pulsuojantis kompensavimas [110]

Proxy Recording

Tarpinio įrašymo apžvalga [111]

Tarpinis įrašymas [112]

Vaizdų fiksavimas su norimu vaizdu

Vaizdo apžvalga [113]

Vaizdo pasirinkimas [114]

Norimo bazinio vaizdo importavimas [115]

Vaizdo pritaikymas [116]

Vaizdo išsaugojimas [117]

Bazinio vaizdo trynimas [118]

Vaizdų fiksavimas koreguojant vaizdą vėlesnio redagavimo metu
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Vaizdų fiksavimas koreguojant vaizdą vėlesnio redagavimo metu [119]

LUT taikymas HDMI išvesčiai ir transliacijai [120]

LUT keitimas [121]

Tamsių ir šviesių sričių pasiskirstymo keitimas įrašytame vaizde [122]

RAW įrašymas

RAW vaizdo įrašymas [123]

RAW vaizdo įrašų fiksavimas naudojant sulėtinto ir pagreitinto filmavimo
režimą [124]

„Bokeh“ reguliavimas („Bokeh“ valdymo funkcija)

„Bokeh“ valdymo funkcijos įjungimas / išjungimas [125]

„Bokeh“ laipsnio reguliavimas [126]

Konfigūravimo duomenų išsaugojimas ir įkėlimas

Konfigūracijos duomenų išsaugojimo ir įkėlimo apžvalga [127]

ALL failo išsaugojimas [128]

ALL failo įkėlimas [129]

Tinklo funkcijos

Failų perdavimas

Apie failų perdavimą [130]

Failų perdavimo paskirties vietos registravimas [131]

Įkeliamo failo pasirinkimas

Atminties kortelėje esančio tarpinio failo įkėlimas iš miniatiūrų ekrano [132]

Atminties kortelėje esančio pradinio failo įkėlimas iš miniatiūrų ekrano [133]

Failų perdavimo būsenos tikrinimas [134]
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Įkėlimas naudojant saugų FTP [135]

Transliacijos konfigūravimas

Apie transliavimą [136]

Transliavimo formato nustatymas [137]

Transliavimo vaizdo kodeko nustatymas [138]

Transliavimo garso kodeko nustatymas [139]

Transliavimo pradėjimas / sustabdymas [140]

Miniatiūrų ekranas

Miniatiūrų ekranas [141]

Klipų leidimas ir kiti veiksmai su klipais

Įrašytų klipų atkūrimas [142]

Veiksmai su įrašytais klipais [143]

Fotoaparato meniu ir išsamūs nustatymai

Fotoaparato meniu konfigūravimas [144]

Fotoaparato meniu naudojimas

Fotoaparato meniu naudojimas [145]

Simbolių eilutės įvedimas [146]

Naudotojo meniu

„User“ (naudotojas) [147]
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Naudotojo redagavimo meniu

„Edit User“ (naudotojo redagavimas) [148]

Vaizdų fiksavimo meniu

ISO/„Gain“/EI (ISO / stiprinimas / EI) [149]

„ND Filter“ (ND filtras) [150]

„Shutter“ (užraktas) [151]

„Iris“ (diafragma) [152]

„Auto Exposure“ (automatinė ekspozicija) [153]

„White“ (balta spalva) [154]

„White Setting“ (baltos spalvos nustatymas) [155]

„Offset White“ (baltos spalvos balanso poslinkis) [156]

„Focus“ (fokusavimas) [157]

„S&Q Motion“ (sulėtinto ir pagreitinto vaizdo fiksavimas) [158]

„LUT On/Off“ (LUT įjungimas / išjungimas) [159]

„Noise Suppression“ (triukšmo slopinimas) [160]

„Flicker Reduce“ (mirgėjimo sumažinimas) [161]

„SteadyShot“ [162]

Projekto meniu

„Base Setting“ (bazinis nustatymas) [163]

„Rec Format“ (įrašymo formatas) [164]

„Cine EI Setting“ („Cine EI“ nustatymas) [165]

„Simul Rec“ (sinchroniškas įrašymas) [166]

„Proxy Rec“ (tarpinis įrašymas) [167]

„Interval Rec“ (įrašymas intervalais) [168]

„Picture Cache Rec“ (nuotraukų talpyklos įrašymas) [169]

„SDI/HDMI Rec Control“ (SDI / HDMI įrašymo valdymas) [170]

„Assignable Button“ (priskiriamas mygtukas) [171]
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„Paint/Look“ (piešimo / vaizdo meniu)

„Scene File“ (siužeto failas) [172]

„Base Look“ (bazinis vaizdas) [173]

„Reset Paint Settings“ (piešimo nustatymų nustatymas iš naujo) [174]

„Black“ (juoda spalva) [175]

„Knee“ (lenkimo taškas) [176]

„Detail“ (detalės) [177]

„Matrix“ (matrica) [178]

„Multi Matrix“ (daugybinė matrica) [179]

„Pan-Tilt Menu“ (pasukimo / pakreipimo meniu)

„P/T Acceleration“ (P/T spartinimas) [180]

Laiko kodo / laikmenos meniu

„Timecode“ (laiko kodas) [181]

„TC Display“ (laiko kodo rodymas) [182]

„Users Bit“ (informacijos bitas) [183]

„HDMI TC Out“ (HDMI TC išvestis) [184]

„Clip Name Format“ (klipų pavadinimų formatas) [185]

„Update Media“ (laikmenos naujinimas) [186]

„Format Media“ (laikmenos formatavimas) [187]

„Media Life“ (laikmenos naudojimo laikas) [188]

Stebėjimo meniu

„Output Format“ (išvesties formatas) [189]

„Display On/Off“ (ekrano įjungimas / išjungimas) [190]

„Video Signal Monitor“ (vaizdo signalo stebėjimas) [191]

„Marker“ (žymeklis) [192]
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Garso meniu

„Audio Input“ (garso įvestis) [193]

„Audio Output“ (garso išvestis) [194]

Miniatiūrų meniu

„Display Clip Properties“ (rodyti klipo savybes) [195]

„Set Clip Flag“ (nustatyti klipo žymę) [196]

„Lock/Unlock Clip“ (užrakinti / atrakinti klipą) [197]

„Delete Clip“ (ištrinti klipą) [198]

„Transfer Clip“ (perduoti klipą) [199]

„Transfer Clip (Proxy)“ (perduoti klipą (tarpinis) [200]

„Filter Clips“ (filtruoti klipus) [201]

„Customize View“ (pritaikyti rodinį) [202]

Techninis meniu

„Color Bars“ (spalvų juostos) [203]

„Genlock“ [204]

„Tally“ (įspėjamoji lemputė) [205]

„Rec Review“ (įrašo peržiūra) [206]

„Zoom“ (priartinimas) [207]

„Lens“ (objektyvas) [208]

APR [209]

Tinklo meniu

„Wired LAN“ (laidinis LAN) [210]

„File Transfer“ (failų perdavimas) [211]

Priežiūros meniu

„Language“ (kalba) [212]

„Clock Set“ (laikrodžio nustatymas) [213]
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„Hours Meter“ (valandų skaitiklis) [214]

Vaizdų fiksavimo meniu nustatymai ir numatytosios reikšmės

ISO / stiprinimo nustatymai ir numatytosios reikšmės [215]

AGC ribų nustatymai ir numatytosios reikšmės [216]

Vaizdo kokybės nustatymai, išsaugoti kiekvienam filmavimo
režimui [217]

Žiniatinklio meniu ir išsamūs nustatymai

Žiniatinklio meniu konfigūravimas [218]

Žiniatinklio meniu naudojimas [219]

Vaizdų fiksavimo meniu

„Focus“ (fokusavimas) [220]

Projekto meniu

„Base Setting“ (bazinis nustatymas) [221]

„Rec Format“ (įrašymo formatas) [222]

„Simul Rec“ (sinchroniškas įrašymas) [223]

„Proxy Rec“ (tarpinis įrašymas) [224]

„Interval Rec“ (įrašymas intervalais) [225]

„Picture Cache Rec“ (nuotraukų talpyklos įrašymas) [226]

„All File“ (ALL failas) [227]

„Paint/Look“ (piešimo / vaizdo meniu)

„Base Look“ (bazinis vaizdas) [228]
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„Pan-Tilt Menu“ (pasukimo / pakreipimo meniu)

„P/T Speed“ (P/T greitis) [229]

„P/T Acceleration“ (P/T spartinimas) [230]

„P/T Range Limit“ (P/T diapazono apribojimas) [231]

„P/T Direction“ (P/T kryptis) [232]

„P/T Preset“ (P/T išankstinis nustatymas) [233]

Stebėjimo meniu

„Output Format“ (išvesties formatas) [234]

„Output Display“ (išvesties rodymas) [235]

Garso meniu

„Audio Input“ (garso įvestis) [236]

„Audio Output“ (garso išvestis) [237]

Techninis meniu

„Tally“ (įspėjamoji lemputė) [238]

„IR Remote“ (IR nuotolinio valdymo pultas) [239]

Tinklo meniu

„Camera Name“ (fotoaparato pavadinimas) [240]

„User“ (naudotojas) [241]

„Wired LAN“ (laidinis LAN) [242]

„File Transfer“ (failų perdavimas) [243]

„FTP Server 1 to 3“ (1–3 FTP serveris) [244]

SSL [245]

„Referer Check“ (nuorodos tikrinimas) [246]

„Brute Force Attack Protection“ (apsauga nuo grubios jėgos atakos) [247]
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Transliavimo meniu

„Stream“ (transliavimas) [248]

„Video Stream“ (vaizdo įrašo transliavimas) [249]

„Audio Stream“ (garso transliavimas) [250]

Priežiūros meniu

„Language“ (kalba) [251]

„Accessibility“ (pritaikymas neįgaliesiems) [252]

„Clock Set“ (laikrodžio nustatymas) [253]

„Reset“ (nustatymas iš naujo) [254]

„Information“ (informacija) [255]

„System Log“ (sistemos žurnalas) [256]

„HTTP Access Log“ (HTTP prieigos žurnalas) [257]

„Service“ (paslauga) [258]

EULA (GNLS) [259]

„Software“ (programinė įranga) [260]

Išorinio įrenginio prijungimas

Išorinių monitorių ir įrašymo įrenginių prijungimas [261]

Valdymas naudojant RM-IP500 nuotolinį valdiklį (pasirenkama)

Apie valdymą naudojant RM-IP500 nuotolinį valdiklį (pasirenkama) [262]

RM-IP500 nuotolinio valdiklio prijungimas [263]

Sinchronizavimas su išoriniu įrenginiu

Apie sinchronizavimą su išoriniu įrenginiu [264]

Vaizdo signalo fazės („Genlock“) sinchronizavimas [265]
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Laiko kodo susiejimas su kitais įrenginiais [266]

Išorinio mikrofono arba išorinio garso įrenginio prijungimas [267]

Klipų tvarkymas / redagavimas naudojant kompiuterį [268]

Optinio signalo išvestis [269]

Įspėjamojo signalo prijungimas [270]

Priedas

Perspėjimai dėl naudojimo [271]

Išvesties formatai ir ribojimai [272]

Trikčių šalinimas [273]

Klaidų / įspėjamieji pranešimai [274]

Meniu elementų sąrašas [275]

Išsaugoti išankstinių nustatymų padėčių elementai [276]

Struktūrinės schemos [277]

Objektyvo su E tipo tvirtinimu programinės įrangos naujinimas
[278]

Objektyvo atlaisvinimo mygtuko dangtelio uždėjimas [279]
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Licencijos [280]

Specifikacijos [281]

Prekių ženklai [282]

[1] Apžvalga Įprastas naudojimas

Sistemos konfigūracija

Šis įrenginys gali būti jungiamas prie išorinių įrenginių sudarant įvairias sistemos konfigūracijas.

„E-mount“ objektyvas1.

LA-EA3 / LA-EA4 A tipo tvirtinimo adapteris2.

Infraraudonųjų spindulių nuotolinio valdymo pultas (pridedamas)3.

„CFexpress“ A tipo atminties kortelės / SDXC atminties kortelės4.

„CFexpress“ A tipo kortelių skaitytuvas / SD kortelių skaitytuvas5.

ECM-680S, ECM-678*, ECM-674* mikrofonas6.
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[2] Apžvalga Įprastas naudojimas

Vieno įrenginio valdymas naudojant pridedamą
infraraudonųjų spindulių nuotolinio valdymo pultą

Vieną įrenginį galite valdyti nuotoliniu būdu naudodami pridedamą infraraudonųjų spindulių
nuotolinio valdymo pultą.

 Vaizdo signalas
 Signalo srautas

[3] Apžvalga Įprastas naudojimas

Vieno įrenginio valdymas naudojant planšetinį
kompiuterį arba kompiuterį

Prie įrenginio galite prijungti planšetinį kompiuterį arba kompiuterį ir valdyti įrenginį naudodami
žiniatinklio naršyklę.

Reikalingas EC-0.5X3F5M 3 kontaktų ? 5 kontaktų XLR adapterio kabelis.*

Kintamosios srovės adapteris (pridedamas)7.

Vaizdo monitorius8.

RM-IP500 nuotolinis valdiklis9.

Infraraudonųjų spindulių nuotolinio valdymo pultas (pridedamas)1.

Vaizdo monitorius2.
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 Vaizdo signalas
 Nuotolinio valdymo signalas

 Signalo srautas

[4] Apžvalga Įprastas naudojimas

Vieno įrenginio valdymas naudojant išorinį nuotolinį
valdiklį

Įrenginį galite valdyti nuotoliniu būdu naudodami nuotolinį valdiklį.

Vaizdo monitorius1.

Planšetinis kompiuteris2.

Kompiuteris3.

Prieigos taškas4.
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 Vaizdo signalas
 Nuotolinio valdymo signalas

 Signalo srautas

[5] Apžvalga Įprastas naudojimas

Kelių įrenginių valdymas naudojant išorinį nuotolinį
valdiklį

Nuotoliniu būdu naudodami vieną nuotolinį valdiklį (RM-IP500) galite nuotoliniu būdu valdyti iki
100 įrenginių.

Vaizdo monitorius1.

RM-IP500 nuotolinis valdiklis2.
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 Vaizdo signalas
 Nuotolinio valdymo signalas
 Įspėjamasis / kontakto signalas

 Signalo srautas

[6] Apžvalga Dalių vieta ir funkcijos

Vaizdas iš priekio

Šioje temoje aprašoma įrenginio priekyje esančių dalių vieta ir funkcija.

Patarimas

Šiame aprašyme vadovaujamasi įrenginio iliustracija be uždėto objektyvo.

Vaizdo monitorius1.

Vaizdo signalo perjungiklis2.

Eterneto šakotuvas3.

RM-IP500 nuotolinis valdiklis4.
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Fotoaparato galvutė

Pastaba

Fotoaparato galvutę saugokite nuo stiprių smūgių.

1.

Įrašymo / įspėjimo lemputė
Jei sukonfigūruojama kaip įrašymo lemputė, ši lemputė šviečia raudonai, kai įrašoma į
atminties kortelę. Lemputė mirksi, kai lieka mažai vietos įrašymo laikmenoje arba kai įvyksta
klaida.

Išsamesnė informacija pateikiama dalyje „Klaidų / įspėjamieji pranešimai“.

Jei sukonfigūruota kaip įspėjimo lemputė, ši lemputė šviečia raudonai arba žaliai pagal
išorinį įspėjimo signalą.

Išsamesnė informacija pateikiama dalyje „Įspėjamojo signalo prijungimas“.

2.

Vaizdo jutiklis

Pastaba

Nelieskite tiesiogiai rankomis.

3.



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

Objektyvo išleidimo mygtukas
Paspauskite ir nuimkite objektyvą.

Išsamesnė informacija pateikiama dalyje „Objektyvo nuėmimas“.

4.

Objektyvo signalų kontaktai

Pastaba

Nelieskite tiesiogiai rankomis.

5.

Maitinimo lemputė POWER6.

Tinklo lemputė NETWORK
Įrenginio būseną nurodo POWER ir NETWORK lempučių spalva ir švietimo būsenos
(šviečia, mirksi, nešviečia) derinys.

7.

Maitinimo
lemputė
POWER

Tinklo
lemputė
NETWORK

Įrenginio būsena

Šviečia
žalia
spalva*1

Šveičia
žalia
spalva

Įjungtas (prisijungta prie tinklo)

Nešviečia Įjungtas (neprisijungta prie tinklo)

Mirksi
žalia
spalva

Nešviečia Vyksta įjungimo procesas

Šviečia
oranžine
spalva

Nešviečia Maitinimas budėjimo būsenoje

Mirksi
geltona
spalva

Nešviečia Vyksta programinės įrangos naujinimas

Iš lėto
mirksi
oranžine
spalva*2

Iš lėto
mirksi žalia
spalva*2

Įrenginys negali veikti įprastai. Išsami informacija pateikiama
sistemos žurnale. Jei problema išlieka įjungus įrenginio
budėjimo režimą arba išjungus ir vėl įjungus, kreipkitės į
„Sony“ techninės priežiūros atstovą.

Greitai
mirksi
oranžine
spalva*3

Greitai
mirksi žalia
spalva*3

Įvyko įrenginio gedimas. Kreipkitės į „Sony“ techninės
priežiūros atstovą.
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[7] Apžvalga Dalių vieta ir funkcijos

Vaizdas iš galo

Šioje temoje aprašoma įrenginio gale esančių dalių vieta ir funkcija.

Mirksi žalia spalva, kai iš pridedamo infraraudonųjų spindulių nuotolinio valdymo pulto gaunamas komandos
signalas.

*1

Iš lėto mirksi: sumirksi vieną kartą per sekundę*2
Greitai mirksi: sumirksi keturis kartus per sekundę*3

Infraraudonųjų spindulių nuotolinio valdymo pulto jutiklis
Gaunamas valdymo signalas iš pridedamo infraraudonųjų spindulių nuotolinio valdymo
pulto.

8.

Oro įleidimo anga

Pastaba

Neužblokuokite oro srauto. Kitaip galite sukelti gedimų.

9.

Fotoaparato galvutės užrakto svirtelė
Užfiksuoja fotoaparato galvutės judėjimą pirmyn / atgal.

Pastaba

Išjunkite įrenginio maitinimą ir užfiksuokite fotoaparato galvutę horizontaliai naudodami pasukimo
/ pakreipimo užrakto svirtelę, tik tada pasinaudokite užrakto svirtele, kad nesusižalotumėte
prispausdami pirštus. Išsamesnė informacija apie pasukimo / pakreipimo užrakto svirtelę
pateikiama dalyje „Pasukimo / pakreipimo užrakto svirtelė“ skyriuje „Vaizdas iš šono“.

1.

Slankusis pagrindas2.
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[8] Apžvalga Dalių vieta ir funkcijos

Jungčių blokas

Šioje temoje aprašoma įrenginio jungčių bloko dalių vieta ir funkcija.

(įžeminimo) jungtis
Įžeminimo kontaktą prijunkite prijungdami prie maitinimo lizdo įžeminimo kontakto arba
įžeminimo juostos.

1.

Maitinimo jungtis DC IN (standartinis DC lizdas)
Prijunkite kintamosios srovės adapterį.

Pastaba

Naudokite tik pridedamą kintamosios srovės adapterį. Prijungus kitą adapterį gali kilti gaisras
arba įvykti gedimas.

2.

LAN (tinklo) jungtis (RJ-45)
Prijunkite tinklo kabelį (5e ar aukštesnės kategorijos) tinklo ryšio funkcijai ir PoE++*

maitinimo tiekimui užtikrinti.

Spartos LED būsena ekrane
Rodo tinklo ryšio spartą.

3.

PoE++: maitinimas per „Ethernet Plus Plus“. Atitinka IEEE802.3bt (4 tipas, 8 klasė). Išsamesnė informacija
apie prijungimą pateikiama maitinimo šaltinio įrenginio naudojimo instrukcijose.

*
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„Link“/ACT LED būsena ekrane
Rodo tinklo ryšio būseną.

Pastaba

Kai jungiate šį gaminį prie interneto, junkite per sistemą, kuri užtikrintų apsaugos funkciją,
pavyzdžiui, per maršruto parinktuvą arba užkardą. Jei jungiatės be tokios apsaugos, gali kilti
saugos problemų.

Rodoma  Ryšio sparta

Nešviečia
10 Mb/s

100 Mb/s

Šviečia oranžine spalva 1000 Mb/s

Rodoma  Ryšio būsena

 Nešviečia Nėra sąsajos

Mirksi žalia spalva Sąsaja yra, duomenų perdavimas aktyvus

Šveičia žalia spalva Aktyvi sąsaja

TC IN jungtis
Naudojama išorinio nuorodos laiko kodo signalo įvesčiai.

Išsamesnė informacija pateikiama dalyje „Laiko kodo susiejimas su kitais įrenginiais“.

4.

Jungtis HDMI
Naudojama vaizdo signalo iš įrenginio išvesčiai naudojant HDMI signalą.

Išsamesnė informacija pateikiama dalyje „Jungtis HDMI (A tipo jungtis)“ skyriuje „Išorinių
monitorių ir įrašymo įrenginių prijungimas“.

5.

HDMI kabelio tvirtinimo plokštelės montavimo varžtas
Kad HDMI kabelis nebūtų atjungtas, uždėkite pridedamą HDMI kabelio tvirtinimo plokštelę
naudodami pridedamą montavimo varžtą (M2,6×6) ir pritvirtinkite HDMI kabelį rinkoje
parduodamais veržtukais ar juostelėmis.

Išsamesnė informacija apie HDMI kabelio tvirtinimo plokštelės montavimą pateikiama
dalyje „Kabelių prijungimas“.

6.

Jungtis OPTION
Naudojama įspėjamajam signalui iš išorinio įrenginio prijungti.

Išsamesnė informacija pateikiama dalyje „Įspėjamojo signalo prijungimas“.

7.
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Laido spaustukas
Naudojamas kintamosios srovės adapterio laidui tvirtinti.

8.

Jungiklis RESET
Rašiklio galiuku ar panašia priemone paspauskite ir palaikykite bent 5 sek., kad įrenginio
nustatymus nustatytumėte iš naujo atkurdami gamyklines numatytąsias reikšmes.
1 jungikliu SETUP galite pasirinkti, ar norite iš naujo nustatyti tik tinklo ryšio nustatymus ar
visus nustatymus.

9.

Išvesties jungtis OPTICAL
Naudojama į optinį formatą konvertuoto SDI signalo išvesčiai, kai prijungiamas SFP+
modulis (pasirenkama).

Išsamesnė informacija pateikiama dalyje „Optinio signalo išvestis“.

10.

Jungikliai SETUP

Naudojama toliau nurodytiems nustatymams konfigūruoti.
1 jungiklis: nustato, kurie nustatymai bus nustatyti iš naujo paspaudus jungiklį RESET.

2 jungiklis: nustatoma, ar prijungus garso įvesties įrenginį +48 V maitinimo šaltinis
(fantominis maitinimas) bus įjungtas / išjungtas. Nustatymas pritaikomas iškart.
Ši funkcija įjungiama, jei fotoaparato meniu [Audio] > [Audio Input] > [AUDIO IN Select]
(garsas > garso įvestis > AUDIO IN pasirinkimas) nustatoma kaip [MIC].

11.

Nustatymas Aprašas

OFF
(išjungta;
numatytasis)

Iš naujo nustatomi tik tinklo ryšio nustatymai. Iš naujo bus nustatyti
įrenginio tinklo nustatymai, saugumo nustatymai ir naudotojo informacija
(naudotojo vardas ir slaptažodis).

ON (įjungta)
Iš naujo nustatomi visi nustatymai atkuriant gamyklines numatytąsias
reikšmes.

Nustatymas Aprašas

OFF
(išjungta;
numatytasis)

Netiekti +48 V maitinimo (fantominis maitinimo šaltinis). Sukonfigūruokite
šį nustatymą, kai naudojamas išorinis garso įrenginys (pvz., daugiafunkcis
pultas), dinaminis mikrofonas arba mikrofonas su integruotu maitinimo
elementu.

ON
Tiekti +48 V maitinimą (fantominis maitinimo šaltinis) fantominį maitinimą
palaikančiam mikrofonui, kuris prijungtas prie jungties AUDIO IN (CH-1
arba CH-2).
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Pastaba

2 jungiklį nustačius į įjungimo padėtį ON ir prijungus mikrofoną, kuris nepalaiko +48 V šaltinio,
prijungtą įrenginį galima sugadinti. Prieš jungdami įrenginį patikrinkite nustatymą.

3 jungiklis: įjungiamas / išjungiamas VISCA per IP ryšys. Nustatymai pritaikomi įjungus
fotoaparatą.
Nustatykite į įjungimo padėtį ON, jei įrenginį norite naudoti, kai jis prijungtas prie nuotolinio
valdiklio (RM-IP500).

Pastaba

Jei nesukonfigūruotas administratoriaus slaptažodis, VISCA per IP ryšys liks išjungtas nepaisant
jungiklio nustatymo. Išsamesnė informacija apie administratoriaus slaptažodžio konfigūravimą
pateikiama dalyje „Įrenginio pradinių nustatymų atkūrimas“.

4 jungiklis: pakeičia iš infraraudonųjų spindulių nuotolinio valdymo pulto siunčiamų
pasukimo / pakreipimo signalų greitį. Nustatymas pritaikomas iškart.

Nustatymas Aprašas

OFF (išjungta; numatytasis) Neatsakys į VISCA per IP komandas.

ON (įjungta) Priima VISCA per IP komandas.

Nustatymas Aprašas

OFF (išjungta; numatytasis) Veikia įprastu greičiu.

ON (įjungta) Veikia didžiausiu greičiu.

Jungtis SDI OUT
Naudojama vaizdo išvesčiai iš įrenginio naudojant 12G/6G/3G/HD-SDI signalą.
Įrenginį taip pat galima sukonfigūruoti RAW signalo išvesčiai.

Išsamesnė informacija pateikiama dalyje „Jungtis SDI OUT (BNC tipas)“ skyriuje
„Išorinių monitorių ir įrašymo įrenginių prijungimas“.

12.

Infraraudonųjų spindulių nuotolinio valdymo pulto jutiklis (gale)
Infraraudonųjų spindulių jutiklis, skirtas pridedamam infraraudonųjų spindulių nuotolinio
valdymo pultui.

13.

Ventiliatoriaus / oro išleidimo anga
Išleidžiama šiluma iš įrenginio vidaus.

Pastaba

14.
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[9] Apžvalga Dalių vieta ir funkcijos

Vaizdas iš šono

Šioje temoje aprašoma įrenginio šone esančių dalių vieta ir funkcija.

Patarimas

Šiame aprašyme vadovaujamasi įrenginio iliustracija be uždėto objektyvo.

Neuždenkite oro išleidimo angos. Kitaip galite sukelti gedimų.

Atminkite, kad sritis prie oro išleidimo angos gali būti karšta.

Jungtis GENLOCK
Naudojama išorinio sinchronizavimo signalo įvesčiai.

Išsamesnė informacija pateikiama dalyje „Vaizdo signalo fazės sinchronizavimas
(„Genlock“)“.

15.

Jungtis AUDIO IN (XLR tipo 5 kontaktų jungtis)
Naudojama signalo iš išorinio mikrofono ar garso įrenginio įvesčiai.
Ji veikia kaip jungtis AUDIO IN CH-1 arba jungtis AUDIO IN CH-2.

Išsamesnė informacija pateikiama dalyje „Išorinio mikrofono ar išorinio garso įrenginio
prijungimas“.

16.
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Pasukimo / pakreipimo užrakto svirtelė
Užfiksuoja įrenginio pasukimo / pakreipimo mechanizmą. Naudojama toliau nurodytais
atvejais.

Transportuojant įrenginį arba jį supakavus.
Tvirtinant ar nuimant objektyvą. Išsamesnė informacija pateikiama dalyje „Objektyvo
uždėjimas“ arba „Objektyvo nuėmimas“.
Naudojant objektyvą, kuris nepalaiko pasukimo / pakreipimo funkcijos (pvz., „Sony“
SEL100400GM / SEL200600G / SEL400F28GM / SEL600F40GM objektyvą).

Patarimas

Pasukimo / pakreipimo judėjimą galima užfiksuoti toliau nurodytais kampais.

1.
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[10] Apžvalga Dalių vieta ir funkcijos

Vaizdas iš viršaus

Šioje temoje aprašoma įrenginio viršuje esančių dalių vieta ir funkcija.

Patarimas

Šiame aprašyme vadovaujamasi įrenginio iliustracija be uždėto objektyvo.

Slankusis pagrindas2.

Išorinių įrenginių varžtų skylės (4 vietose)
M3 varžtams iki 6 mm (1/4 in) ilgio.

Pastaba

Nenaudokite ilgesnių nei 6 mm (1/4 in) varžtų. Kitaip galite sukelti gedimų.

3.

A prieigos indikatorius4.

B prieigos indikatorius
Indikatorius šviečia arba mirksi, kai įdedama įrašymo laikmena.

Išsamesnė informacija pateikiama dalyje „Atminties kortelių įdėjimas“.

5.

„CFexpress“ A tipo / SD kortelės lizdas (A)6.

„CFexpress“ A tipo / SD kortelės lizdas (B)
Naudojama įrašymo laikmenai įstatyti.

Išsamesnė informacija pateikiama dalyje „Atminties kortelių įdėjimas“.

7.

Prisijungimo prie tinklo QR kodas
Naudojama konfigūruojant pradinius nustatymus.

Išsamesnė informacija pateikiama dalyje „Prisijungimas prie žiniatinklio programos iš
žiniatinklio naršyklės“.

8.
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[11] Apžvalga Dalių vieta ir funkcijos

Vaizdas iš apačios

Šioje temoje aprašoma įrenginio apačioje esančių dalių vieta ir funkcija.

Patarimas

Šiame aprašyme vadovaujamasi įrenginio iliustracija be uždėto objektyvo.

Išorinių įrenginių varžtų skylės (2 vietose)
Tinka 1/4-20 UNC trikojo varžtams.
Maks. ilgis – 6 mm (1/4 in).

1.

? (vaizdo jutiklio žyma)
Vaizdo jutiklio žyma yra toje pačioje plokštumoje kaip vaizdo jutiklis.
Jei norite tiksliai išmatuoti atstumą tarp įrenginio ir objekto, kaip atskaitos tašką naudokite
vaizdo jutiklio žymą.

2.
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[12] Apžvalga Dalių vieta ir funkcijos

Objektyvo atrama

Šioje temoje aprašoma įrenginio objektyvo atramos dalių vieta ir funkcija.

Lubų laikiklio tvirtinimo varžtų skylės (6 vietose)
Jei įrenginys montuojamas prie lubų ar aukštai esančios lentynos, ant įrenginio pagrindo
pritvirtinkite korpuso laikiklį (papildoma) į šias varžtų skyles įsukite šešis korpuso laikiklio
tvirtinimo varžtus.

Išsamesnė informacija apie tvirtinimą pateikiama dalyje „Montavimas stačiai aukštoje,
fiksuotoje vietoje“ ir „Montavimas prie lubų“.

1.

Trikojo tvirtinimo varžtai (2 vietose)
Naudojama, kai įrenginys tvirtinamas prie fotoaparato trikojo (papildoma, 1/4-20 UNC varžtai
iki 5,5 mm (1/4 in) ilgio).

Pastaba

Nenaudokite ilgesnių nei 5,5 mm (1/4 in) varžtų. Kitaip galite sukelti gedimų.

2.
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Patarimas

Šiame aprašyme vadovaujamasi įrenginio iliustracija be uždėto objektyvo.

Objektyvo atramos strypas (2)
Laiko objektyvą.
Taip pat gali būti naudojamas bendriesiems Ø15 strypo priedams tvirtinti.

1.

Objektyvo atramos blokas
Objektyvo atramą galima paslinkti pirmyn / atgal atsižvelgiant į naudojamą objektyvą ir
užfiksuoti.

2.

Objektyvo atramos pagrindo tvirtinimo varžtas
Tvirtinama prie objektyvo atramos pagrindo. Varžtą galite pastumti aukštyn / žemyn ir
pritaikyti pagal objektyvo atramos pagrindo aukštį.

3.

Objektyvo atramos strypo spaudžiamoji svirtelė (2 vietos)4.



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

[13] Apžvalga

Infraraudonųjų spindulių nuotolinio valdymo pulto
(pridedamas) dalių vieta ir funkcijos

Šioje temoje aprašomos infraraudonųjų spindulių nuotolinio valdymo pulto (pridedamas) dalių

Objektyvo atramos blokas užfiksuojamas priekinėje / galinėje padėtyje.

Objektyvo atramos pagrindo tvirtinimo varžto spaudžiamoji svirtelė
Užfiksuojama vertikali objektyvo atramos pagrindo tvirtinimo varžto padėtis.

Patarimas

Jei spaudžiamoji svirtelė yra padėtyje, dėl kurios ją sunku pasukti, atleiskite spaudžiamąją
svirtelę ir pasukite tokiu kampu, kad pasukti būtų lengviau. Nustačius reikiamą padėtį,
spaudžiamąją svirtelę užspauskite.

A: objektyvo atramos pagrindo tvirtinimo varžto spaudžiamoji svirtelė
B: objektyvo atramos strypo spaudžiamoji svirtelė

Pastaba

Kad objektyvo atramos blokas netrukdytų pasukimo / pakreipimo funkcijai, kai objektyvo atramos
blokas nenaudojamas, pastumkite jį aukštyn iki fotoaparato galvutės, o objektyvo atramos
pagrindo tvirtinimo varžtą pastumkite į aukščiausią padėtį (kuo arčiau objektyvo).

5.
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vieta ir funkcijos.

Mygtukas REC? (PRADĖTI / STABDYTI įrašymą)
Paspausdami pradėkite arba sustabdykite įrašymą.

1.

Mygtukas MENU
Paspausdami įjunkite arba išjunkite fotoaparato meniu.

2.

GUI valdymo mygtukai
Paspausdami atlikite veiksmus fotoaparato meniu, pranešimų dialogo languose, kuriuose
naudojami mygtukai, ir atlikite kitas funkcijas ekrane.

3.

Mygtukas CANC./BACK
Paspausdami atšaukite nustatymą arba sugrįžkite į ankstesnį fotoaparato meniu ekraną.

4.

Pasukite ir pakreipimo valdymo mygtukai
Spausdami rodyklių mygtukus galite valdyti fotoaparato pasukimą / pakreipimą.
Paspausdami mygtuką HOME grąžinsite fotoaparato padėtį, kai jis nukreiptas į priekį.

5.

Iš anksto nustatytų padėčių valdymo mygtukai
Laikydami nuspaudę mygtuką PRESET paspauskite vieną iš 1–3 mygtukų, kad
išsaugotumėte fotoaparato kryptį, priartinimą ir fokusavimo būseną priskirdami nustatymus

6.
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paspaustam skaitiniam mygtukui.
Paspausdami skaitinį mygtuką su išsaugotais nustatymais įjunkite išsaugotą būseną.

Fokusavimo valdymo mygtukai
Naudojama fokusavimui reguliuoti.
Jei fokusavimą norite reguliuoti automatiškai, paspauskite mygtuką AF.
Jei fokusavimą norite valdyti rankiniu būdu, paspauskite mygtuką MF, tada paspauskite
mygtuką F (toli), kai reikia sufokusuoti toli esančius objektus, arba mygtuką N (arti), kai
reikia sufokusuoti arti esančius objektus.

7.

Priskiriami mygtukai nuo 1 iki 3
Atliekamos priskiriamiems mygtukams priskirtos funkcijos iš fotoaparato meniu.
Jei priskiriamam mygtukui priskirsite funkciją [Direct Menu] (tiesioginis meniu), GUI valdymo
mygtukais galėsite reguliuoti ekspoziciją, baltos spalvos balansą ir kitus nustatymus.

Išsamesnė informacija apie fotoaparato meniu naudojimą pateikiama dalyje „Priskiriami
mygtukai“.

Išsamesnė informacija apie tiesioginį meniu pateikiama dalyje „Tiesioginio meniu
naudojimas“.

8.

(maitinimo) mygtukas
Paspausdami įrenginį įjunkite arba perjunkite maitinimo tiekimą į budėjimo būseną.

9.

Mygtukas THUMBNAIL
Parodomas miniatiūrų ekranas su klipais, įrašytais įrenginio atminties kortelėje.

Išsamesnė informacija apie miniatiūrų ekraną pateikiama dalyje „Miniatiūrų ekranas“.

Galite pasirinkti klipus ir valdyti atkūrimą miniatiūrų ekrane GUI valdymo mygtukais.

Išsamesnė informacija apie klipų pasirinkimą ir atkūrimo valdymą pateikiama dalyje
„Įrašytų klipų atkūrimas“ ir „Veiksmai su įrašytais klipais“.

10.

Mygtukas SLOT SEL (A) / (B) atminties kortelės lizdui pasirinkti)
Jei įdėtos dvi atminties kortelės, paspausdami šį mygtuką galite perjungti įrašymui skirtas
atminties korteles.
Paspauskite šį mygtuką, kai rodomas miniatiūrų ekranas, kad įjungtumėte atminties kortelę,
kurios turinį norite peržiūrėti.

11.

Mygtukas P/T RESET (pasukimo / pakreipimo nustatymas iš naujo)
Iš naujo nustato pasukimo / pakreipimo funkcijas. Paspauskite mygtuką, kai vienu metu
mirksi lemputės POWER ir NETWORK arba kai žiniatinklio programos kadro valdymo
skydelyje rodoma [Execute Pan-Tilt Reset] (atlikite pasukimo / pakreipimo nustatymą iš
naujo).

12.

Priartinimo valdymo mygtukai
Jei norite priartinti, paspauskite T (teleobjektyvo) mygtuką.
Jei norite atitolinti, paspauskite W (plataus kampo) mygtuką.

13.
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Infraraudonųjų spindulių nuotolinio valdymo pulto maitinimo elementas

Infraraudonųjų spindulių nuotolinio valdymo pultui reikalingi du AA (LR6) maitinimo elementai.
Įdėkite maitinimo elementus į infraraudonųjų spindulių nuotolinio valdymo pultą, kaip parodyta
toliau esančiame paveikslėlyje.

Pastaba

Naudokite tik mangano arba šarminius maitinimo elementus, nes kiti gali pratrūkti.

Panaudotus maitinimo elementus išmeskite laikydamiesi jūsų šalyje ar regione galiojančių įstatymų ir
taisyklių.

[14] Apžvalga Žiniatinklio programos ekranas

Žiniatinklio programos ekrano apžvalga

Prijungę planšetinį kompiuterį arba kompiuterį galite reguliuoti pasukimą / pakreipimą,
priartinimą, įrašyti, paleisti įrašytą vaizdo įrašą ir konfigūruoti įrenginį iš žiniatinklio naršyklės
(toliau ši funkcija vadinama „žiniatinklio programa“).

Išsamesnė informacija apie žiniatinklio programos paleidimą pateikiama dalyje
„Prisijungimas prie žiniatinklio programos iš žiniatinklio naršyklės“.

Pastaba

Žiniatinklio programa nepalaiko fotoaparato garso išvesties.

Kai paleidžiama žiniatinklio programa, pasirodo toliau pateikiamas tiesioginio valdymo ekranas.

Tiesioginio valdymo ekranas
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Išsamesnė informacija apie tiesioginio valdymo ekraną pateikiama dalyje „Tiesioginio
valdymo ekrano struktūra“.
Ekrano viršuje rodomi dažniausi tiesioginio valdymo ekrano ir atkūrimo valdymo ekrano
mygtukai ir piktogramos.

Išsamesnė informacija apie bendrąją ekranų sritį pateikiama dalyje „Bendrosios ekranų
srities struktūra“.
Ekranus galite perjungti spausdami ekrano perjungimo skirtukus bendrojoje srityje.

Atkūrimo valdymo ekranas

Paspauskite skirtuką [Playback] (atkūrimas), kad būtų parodytas atkūrimo valdymo ekranas.
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Išsamesnė informacija apie atkūrimo valdymo ekraną „Atkūrimo valdymo ekrano struktūra“.

Nustatymų ekranas

Paspauskite skirtuką [Settings] (nustatymai), kad būtų parodytas nustatymų ekranas (toliau
vadinama „žiniatinklio meniu“).
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Pastaba

Žiniatinklio meniu nustatymai pritaikomi tik paspaudus mygtuką [OK]. Jei nustatymus pakeisite
puslapyje, kuriame yra [OK], būtinai paspauskite mygtuką [OK].

Išsamesnė informacija apie nustatymų ekraną pateikiama dalyje „Nustatymų ekrano
struktūra“.
Šiame žinyne žiniatinklio programos nustatymų ekranas vadinamas „žiniatinklio meniu“.

[15] Apžvalga Žiniatinklio programos ekranas

Bendrosios ekranų srities struktūra

Šioje temoje aprašoma bendrosios ekranų srities struktūra.

Fotoaparato pavadinimas
Rodomas fotoaparato pavadinimas.
Pavadinimą galite pakeisti naudodami [Network] > [Camera Name] (tinklas > fotoaparato
pavadinimas) žiniatinklio meniu.
Fono spalva keičiama pagal išorinį įspėjamąjį signalą.

1.

Maitinimo jungiklis
Kai įrenginys įjungiamas, parodoma [Power ON] (įjungti). Paspaudę jungiklį ir pasirinkę
[Power Standby] (maitinimo budėjimo režimas) galite įrenginio maitinimą nustatyti į budėjimo
būseną.
Kai rodoma [Power Standby] (maitinimo budėjimo režimas), paspaudę jungiklį ir pasirinkę
[Power ON] (įjungti) galite įjungti įrenginio maitinimą.

2.

Valdymo ekrano perjungimo skirtukai
Paspauskite skirtuką, kad būtų parodytas atitinkamas valdymo ekranas.
Skirtukas [Live] (tiesioginis): parodomas tiesioginio valdymo ekranas.
Skirtukas [Playback] (atkūrimas): parodomas atkūrimo valdymo ekranas.
Skirtukas [Settings] (nustatymai): parodomas nustatymų ekranas (žiniatinklio meniu).

3.

Pranešimų žyma
Gavus pranešimą žymos indikatorius pasikeičia, kaip nurodoma toliau.

 (pranešimai įjungti)
Vadovaudamiesi fotoaparato vaizdo skydelyje rodomu pranešimu imkitės reikiamų veiksmų.

Pastaba

Pranešimai nerodomi, kai žiniatinklio meniu [Monitoring] > [Output Display] > [HDMI] (stebėjimas
> išvesties rodymas > HDMI) nustatyta kaip [Off] (išjungta). Nustatykite kaip [On] (įjungta), kad
galėtumėte peržiūrėti pranešimų turinį.

4.
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[16] Apžvalga Žiniatinklio programos ekranas

Tiesioginio valdymo ekrano struktūra

Šioje temoje aprašoma tiesioginio valdymo ekrano struktūra.

(fotoaparato būsenos) mygtukas
Paspauskite šį mygtuką, kad atskirame ekrane būtų parodyta fotoaparatu įrašyto vaizdo /
išvesties vaizdo signalo informacija ir objektyvo informacija.

5.

Ekrano valdymo užrakto jungiklis
 (valdymo atrakinimas): jungiklį nustatykite į kairiąją padėtį, kad galėtumėte atlikti

valdymo veiksmus tiesioginio valdymo ir atkūrimo valdymo ekranuose.
 (valdymo užrakinimas): jungiklį nustatykite į dešiniąją padėtį, kad valdymo veiksmai

tiesioginio valdymo ir atkūrimo valdymo ekranuose būtų draudžiami ir jų neatliktumėte
netyčia.

6.
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Iš anksto nustatytų padėčių valdymo skydelis
Parodoma užregistruota išankstinio nustatymo padėtis naudojant miniatiūrą. Dukart
bakstelėkite miniatiūrą, kad sugrįžtumėte į išankstiniame nustatyme išsaugotą padėtį.

Išsamesnė informacija apie iš anksto nustatytą padėtį pateikiama dalyje „Pasukimo /
pakreipimo, priartinimo padėties ir fokusavimo nustatymo išsaugojimas / atkūrimas
naudojant žiniatinklio programą“.

1.

Fotoaparato vaizdo skydelis
Parodomas dabartinis fotoaparato vaizdas ir įrenginio būsena.
Jame rodomas vaizdas sutampa su HDMI išvestimi.
Virš vaizdo rodoma toliau nurodyta būsena. Aplink vaizdą rodomas ir raudonas arba žalia
rėmelis, kuris priklauso nuo gaunamo išorinio įspėjamojo signalo.

2.
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Mygtukas [Display] (rodyti)
Paspauskite šį mygtuką, kad ant vaizdo būtų rodoma fotoaparato informacija.
Paspauskite dar kartą, kai fotoaparato informacija rodoma, kad šią informaciją
paslėptumėte.

Ne. Rodoma Aprašas

2-1
Fokusavimo režimo
indikatorius

Žr. „Fokusavimo režimo indikatorius“ dalyje
„Fotoaparato ekrano rodinys“.

2-2
Įrašymo režimo, A/B lizdų,
„Interval Rec“ įrašymo
intervalo indikatorius

Žr. „Įrašymo režimo, A/B lizdų, „Interval Rec“
įrašymo intervalo indikatorius“ dalyje „Fotoaparato
ekrano rodinys“.

2-3
Transliacijos būsenos
indikatorius

Rodoma transliacijos metu (tik kai [Stream Setting]
(transliacijos nustatymas) nustatyta kaip [SRT-
Caller] (SRT siuntėjas)

2-4
RAW išvesties būsenos
indikatorius

Rodo RAW signalo išvesties būseną. Išsamesnė
informacija apie RAW pateikiama dalyje „RAW
vaizdo įrašymas“.

2-5
Laikmenos likusios talpos
indikatorius

Žr. „Laikmenos likusios talpos indikatorius“ dalyje
„Fotoaparato ekrano rodinys“.

2-6
Priartinimo padėties
indikatorius

Žr. „Priartinimo padėties indikatorius“ dalyje
„Fotoaparato ekrano rodinys“.

2-7
AE režimo / AE lygio
indikatorius

Rodomas AE režimo / AE lygio indikatorius.
Išsamesnė informacija apie AE pateikiama dalyje
„Šviesumo reguliavimas“.
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Be žymeklių, atsižvelgiant į būseną, rodomi automatinio fokusavimo indikatoriai ir
pranešimai.

Išsamesnė informacija apie rodomą fotoaparato informaciją pateikiama dalyje
„Fotoaparato ekrano rodinys“.

Sekimo realiuoju laiku AF sustabdymo mygtukas
Paspauskite šį mygtuką, kad sustabdytumėte objekto sekimą.

Išsamesnė informacija apie sekimą pateikiama dalyje „Nustatyto objekto sekimas
(sekimo realiuoju laiku AF)“.

Įrašymo PRADĖJIMO / SUSTABDYMO mygtukas
Norėdami pradėti įrašymą, paspauskite šį mygtuką. Įrašymo metu įrašymo PRADĖJIMO /
SUSTABDYMO mygtukas šviečia raudonai.
Paspauskite įrašymo metu, kad įrašymą sustabdytumėte.
Išlaikymo jungiklį galite nustatyti į išlaikymo būseną, kad įrašymo PRADĖJIMO /
SUSTABDYMO mygtuko nepaspaustumėte netyčia.

3.

Pagrindinių fotoaparato funkcijų konfigūravimo skydelis
Parodo vaizdų fiksavimui reikalingų pagrindinių funkcijų nustatymus ant mygtukų.
Paspauskite mygtuką, kad būtų parodytas atitinkamas sąrankos ekranas, skirtas kiekvienai
funkcijai iš toliau pateikto fotoaparato bazinės konfigūracijos koregavimo skydelio (5).

4-1 [FPS] (kadrų sparta)
4-2 [ISO/Gain / Exposure Index] (ISO / stiprinimas / ekspozicijos indeksas)
4-3 [Shutter] (užraktas)
4-4 [Iris] (diafragma)
4-5 [ND Filter] (ND filtras)
4-6 [Scene File / Base Look/LUT] (scenos failas / bazinis vaizdas / LUT)
4-7 [White Balance] (baltos spalvos balansas)

Išsamesnė informacija pateikiama kiekvienos funkcijos aprašyme.

4.

Function Nuoroda

FPS „Sulėtintas ir pagreitintas filmavimas“
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„ISO/Gain“ (ISO /
stiprinimas)

„Bazinio jautrumo nustatymas“, „Automatinis stiprinimo
reguliavimas“ ir „Rankinis stiprinimo reguliavimas“ dalyje
„Stiprinimo reguliavimas“

„Exposure Index“
(ekspozicijos
indeksas)

„Bazinio jautrumo nustatymas“, „Tamsių ir šviesų sričių
pasiskirstymo keitimas įrašytame vaizde“

„Shutter“ (užraktas)
„Automatinis išlaikymo reguliavimas“ ir „Rankinis užrakto
reguliavimas“ dalyje „Užrakto reguliavimas“

„Iris“ (diafragma)
„Automatinis diafragmos reguliavimas“ ir „Rankinis diafragmos
reguliavimas“ dalyje „Diafragmos reguliavimas“

„ND Filter“ (ND
filtras)

„Apie ND filtrą“ dalyje „Šviesos lygio reguliavimas (ND filtras)“

„Scene File“
(siužeto failai)

„Vaizdo apžvalga“ ir kitos temos dalyje „Vaizdų fiksavimas su
norimu vaizdu“

„Base Look/LUT“
(bazinis vaizdas /
LUT)

„Vaizdų fiksavimas koreguojant vaizdą vėlesnio redagavimo metu“

„White Balance“
(baltos spalvos
balansas)

„Baltos spalvos balanso reguliavimo ekranas“

Priskiriami mygtukai / bazinės fotoaparato konfigūracijos reguliavimo skydelis
Įprasto naudojimo metu parodomi priskiriami mygtukai. Paspauskite fotoaparato sąrankos
skydelio mygtuką, kad būtų parodyti atitinkami sąrankos elementai. Paspauskite mygtuką
[X] arba dar kartą paspauskite fotoaparato sąrankos skydelio mygtuką, kad sugrįžtumėte į
priskiriamų mygtukų rodinį.

Išsamesnė informacija apie priskiriamus mygtukus pateikiama dalyje „Priskiriami
mygtukai“.
Išsamesnė informacija apie bazinės fotoaparato konfigūracijos reguliavimo skydelį
pateikiama kiekvienos funkcijos aprašyme.

5.

Kadravimo valdymo skydelis / GUI valdymo skydelis
Naudodami skirtukus viršuje įjunkite kadravimo valdymo skydelį / GUI valdymo skydelį.
Kadravimo valdymo skydelyje galite reguliuoti kadravimą. Paspauskite skirtuką [Pan-Tilt-
Zoom] (pasukimas / pakreipimas / priartinimas), kad būtų parodytas kadravimo valdymo
skydelis.

6.
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Išsamesnė informacija apie naudojimą pateikiama dalyje „Kadravimo reguliavimas“.

Patarimas

Kadravimo valdymo skydelio manipuliatorius (parodyta toliau) parodomas, kai išjungiama
pasukimo / pakreipimo funkcija ir kai būtinas pasukimo / pakreipimo funkcijos inicijavimas.

Kai pasukimo / pakreipimo funkcija užrakinama naudojant pasukimo / pakreipimo užrakto
svirtelę

Kai pasukimo / pakreipimo funkcija nėra inicijuota

Kai pasukimo / pakreipimo funkciją reikia nustatyti iš naujo

Kai pasukimo / pakreipimo funkcija išjungta
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Kai pasukimo / pakreipimo funkcija nėra inicijuota arba ją reikia nustatyti iš naujo, paspausdami
po manipuliatoriumi rodomą pranešimą galite greitai pasiekti mygtuką [Pan-Tilt Reset] (pasukimo
/ pakreipimo nustatymas iš naujo) fotoaparato valdymo skydelyje.

Naudodami GUI valdymo skydelį galite pereiti prie fotoaparato meniu, valdyti klipų atkūrimą
ir kitas funkcijas. Paspausdami skirtuką [Cam GUI] (fotoaparato GUI) galite įjungti GUI
valdymo skydelį.

Išsamesnė informacija apie naudojimą pateikiama dalyje „Fotoaparato meniu
naudojimas“ ir „Klipų leidimas ir kiti veiksmai su klipais“.

Fotoaparato valdymo skydelis
Naudojama fotoaparatui valdyti reikalingoms funkcijoms konfigūruoti.
Perjunkite rodomus ekranus naudodami viršuje esančius skirtukus.

Išsamesnė informacija pateikiama kiekvienos funkcijos aprašyme.

(pagrindinis) skirtukas
Rodomi dažnai naudojamų funkcijų sąrankos elementai.
Viršutinio ir apatinio slankiklio funkcijas galima keisti spaudžiant mygtuką [?] ir pasirenkant iš
rodomo sąrašo. Galima pasirinkti toliau nurodytas funkcijas.

„ND Filter“ (ND filtras)
„Iris“ (diafragma)
ISO*

„Gain“* (stiprinimas)
„Exposure Index“* (ekspozicijos indeksas)
„AE Level“ (AE lygis)

7.
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„Zoom Speed“ (priartinimo greitis)
„Pan-Tilt Speed“ (pasukimo ir pakreipimo greitis)

 (fokusavimo) skirtukas
Rodomi su fokusavimu susiję sąrankos elementai.

 (garso) skirtukas

Rodomi su garsu susiję sąrankos elementai.

(transliavimo) skirtukas
Rodomi su transliavimu susiję sąrankos elementai.
Rodomi elementai priklauso nuo transliavimo formato nustatymo.

Rodoma pagal meniu nustatymus.*
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[17] Apžvalga Žiniatinklio programos ekranas

Atkūrimo valdymo ekrano struktūra

Šioje temoje aprašoma atkūrimo valdymo ekrano struktūra.

Kai nustatyta kaip [SRT-Caller] (SRT siuntėjas), šiame ekrane galima pradėti / sustabdyti
transliaciją.

Išsamesnė informacija pateikiama dalyje „Apie transliavimą“ ir kitose temose iš dalies
„Transliacijos konfigūravimas“.

(kita) skirtukas
Rodomi su kitomis funkcijomis susiję sąrankos elementai.
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Fotoaparato vaizdo skydelis
Parodomas atkūrimo vaizdas ir susijusi informacija. Kai atkūrimas sustabdomas, pasirodo
fotoaparato vaizdo ekranas.

1-1 Fiksavimo data ir laikas
1-2 Atkūrimo būsenos indikatorius
1-3 Atkūrimo formato (vaizdo dydžio) indikatorius
1-4 Atkūrimo formato (kodeko) indikatorius
1-5 Klipo pavadinimo rodinys
1-6 Klipo numeris / bendras klipų skaičius
1-7 Transliacijos būsenos indikatorius

1.
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1-8 Atkūrimo formatas (kadrų spartos ir skenavimo metodo) indikatorius
1-9 Bazinio vaizdo indikatorius

Atkūrimo valdymo skydelis

Parodomi atkūrimo valdymo mygtukai.

Mygtukas [Display] (rodyti)
Paspausdami perjunkite rodomus vaizdo ekranus.

Mygtukas [Thumbnail] (miniatiūros)
Atminties kortelėje įrašyti klipai fotoaparato vaizdo skydelyje parodomi kaip miniatiūros.

Paspaudus mygtuką [Thumbnail] (miniatiūros) esant miniatiūrų ekrano rodinyje miniatiūrų
ekranas uždaromas ir grįžtama į fotoaparato vaizdą.

Išsamesnė informacija apie miniatiūrų ekraną pateikiama dalyje „Miniatiūrų ekranas“.

Mygtukas [Slot Select] (lizdo pasirinkimas)
Perjungiama numatyta atkūrimo laikmena.

2.

Mygtukas Function

Mygtukas  (leisti /
pristabdyti)

Paleidžiamas klipas. Atkūrimo metu klipas
pristabdomas.

 (sukimo pirmyn) mygtukas,
 (sukimo atgal) mygtukas

Klipas paleidžiamas didžiausiu greičiu. Spaudžiant
mygtuką atkūrimo greitis keičiamas trimis žingsniais.

 (kitas) mygtukas, 
(ankstesnis) mygtukas

Pereinama į klipo pradžią arba prie ankstesnio / kito
klipo.

 (stabdymo) mygtukas Atkūrimas sustabdomas.
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[18] Apžvalga Žiniatinklio programos ekranas

Nustatymų ekrano struktūra

Nustatymų ekrane naudodami žiniatinklio meniu galite konfigūruoti įvairius įrenginio sąrankos
elementus, įskaitant pradinius nustatymus, tinklo nustatymus , fiksavimo / atkūrimo nustatymus.

Priskiriami mygtukai
Parodomi priskiriami mygtukai, kuriems priskirtos įrenginio funkcijos.

Išsamesnė informacija apie priskiriamus mygtukus pateikiama dalyje „Priskiriami
mygtukai“.

3.

GUI valdymo skydelis
Naudodami GUI valdymo skydelį galite pereiti prie fotoaparato meniu, valdyti klipų atkūrimą
ir kitas funkcijas.

Išsamesnė informacija apie naudojimą pateikiama dalyje „Fotoaparato meniu
naudojimas“ ir „Įrašytų klipų atkūrimas“.

4.
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Pastaba

Įprastai žiniatinklio meniu nustatymai pritaikomi tik paspaudus mygtuką [OK]. Jei nustatymus
pakeisite puslapyje, kuriame yra [OK], būtinai paspauskite mygtuką [OK].

Išsamesnė informacija apie nustatymų ekraną pateikiama dalyje „Žiniatinklio meniu ir
išsamūs nustatymai“.

[19] Apžvalga Žiniatinklio programos ekranas

Fotoaparato meniu

Tiesioginio valdymo ekrane esančiame GUI valdymo skydelyje paspaudus mygtuką [Menu]
(meniu) fotoaparato vaizdo skydelyje parodomas fotoaparato meniu.
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Fotoaparato meniu galite sukonfigūruoti fiksavimui ir atkūrimui reikalingus nustatymus.
Rodant fotoaparato meniu paspauskite mygtuką [Menu] (meniu), kad fotoaparato meniu
paslėptumėte.
Fotoaparato meniu yra valdomas naudojant GUI valdymo skydelį.

Išsamesnė informacija apie fotoaparato meniu pateikiama dalyje „Fotoaparato meniu ir
išsamūs nustatymai“.

Pastaba

Jei žiniatinklio meniu [Monitoring] > [Output Display] > [HDMI/Stream] (stebėjimas > išvesties
rodymas > HDMI / transliacija) nustatyta kaip „Off“ (išjungta) (išjungiama informacijos perdanga
ekrano rodinyje), fotoaparato meniu fotoaparato vaizdo skydelyje neberodomas. Vis dėlto atminkite,
kad meniu toliau galite naudotis GUI valdymo skydelyje. Kad įrenginys veiktų, kaip numatyta,
nesinaudokite meniu GUI valdymo skydelyje, kai [HDMI/Stream] (HDMI / transliacija) nustatyta kaip
„Off“ (išjungta).

[20] Apžvalga

Fotoaparato ekrano rodinys

Įrenginio būsena ir nustatymai gali būti rodomi ant vaizdo išvesties iš fotoaparato. Žiniatinklio
meniu naudodami [Monitoring] > [Output Display] (stebėjimas > išvesties rodymas) galite
nustatyti išvestis, kurioms bus įjungtas ekrano rodinys.
Informaciją parodyti / paslėpti galite mygtuku [Display] (rodyti). Net jei informacija paslėpta, ji
bus rodoma atliekant veiksmus tiesioginiame meniu.
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Atskirus elementus parodyti / paslėpti galite fotoaparato meniu naudodami [Monitoring] >
[Display On/Off] (stebėjimas > įjungti / išjungti rodymą).

Informacija, rodoma ekrane fiksuojant vaizdus

Įkėlimo indikatorius / likusių failų indikatorius

Išsamesnė informacija apie failų perdavimą pateikiama dalyje „Apie failų perdavimą“ ir
kitose dalies „Failų perdavimas“ temose.

1.

Fokusavimo srities indikatorius
Rodo automatinio fokusavimo sritį.

Išsamesnė informacija apie automatinį fokusavimą pateikiama dalyje „Automatinis
reguliavimas naudojant žiniatinklio programą“ ir kitose dalies „Automatinis fokusavimo
reguliavimas (automatinis fokusavimas)“ temose.

2.

Įrašymo režimo, A/B lizdų, „Interval Rec“ įrašymo intervalo indikatorius

Išsamesnė informacija apie filmavimo intervalais funkciją pateikiama dalyje „Vaizdo
įrašymas su pertrūkiais (filmavimas intervalais)“.

3.

Rodoma Reikšmė

?Rec Įrašymas

Stby Filmavimo parengtis

Lauko gylio indikatorius4.

Vaizdo jutiklio skenavimo režimo indikatorius
 (nesutapimo) žyma rodoma, jei nesutampa objektyvo vaizdo apskritimo dydis ir

efektyviojo vaizdo dydžio vaizdo jutiklio skenavimo režimo nustatymas.
Kai vaizdo jutiklio skenavimo („Imager Scan“) režimas nustatytas FF, siauresnio apžvalgos

5.
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kampo režimuose rodoma žymė „C“ (apkarpytas).
Apkarpymas vyksta naudojant toliau nurodytus režimus.

Kai įrašymo formatas yra 3840 × 2160, o „S&Q Motion“ kadrų dažnis yra 100 kadr./sek.
arba 120 kadr./sek.
Kai [Codec] (kodekas) nustatytas kaip RAW arba RAW & XAVC-I, o RAW išvesties
formatas yra 3840 × 2160
Išsamesnė informacija apie vaizdo jutiklio skenavimo režimą pateikiama dalyje „Vaizdo
jutiklio skenavimo režimo nustatymas“ skyriuje „Pagrindinių funkcijų konfigūravimas“.

RAW išvesties būsenos indikatorius
Rodo RAW signalo išvesties būseną.

Išsamesnė informacija apie RAW pateikiama dalyje „RAW vaizdo įrašymas“.

6.

Sulėtinto ir pagreitinto filmavimo spartos indikatorius

Išsamesnė informacija apie sulėtinto ir pagreitinto filmavimo funkciją pateikiama dalyje
„Sulėtintas ir pagreitintas filmavimas“.

7.

Fokusavimo padėties indikatorius

Parodo fokusavimo padėtį.

8.

Fokusavimo režimo indikatorius

Veido / akių aptikimo AF

9.

Rodoma Reikšmė

Focus Hold Fokusavimo užlaikymo režimas

MF MF režimas

AF AF režimas

 (sekimo realiuoju laiku AF režimas) Sekimo realiuoju laiku AF režimas

Rodoma Reikšmė

 (veido / akių aptikimo AF) Rodo, kad aktyvus veido / akių aptikimo
AF

 (tik veido / akių AF) Rodo, kad aktyvus tik veido / akių AF

 (sekamas veidas išsaugotas) Rodo, kad sekamas veidas yra išsaugotas

 (AF pristabdymo piktograma, kai įjungtas
veido / akių aptikimo AF)

Rodo, kad veikiant veido / akių aptikimo
AF buvo pristabdytas AF*
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Išsamesnė informacija apie veido / akių sekimo AF pateikiama dalyje „Sekimas
naudojant veido ir akių aptikimą (veido / akių aptikimo AF)“.

Rodoma, kai nėra išsaugoto sekamo veido ir veidas nėra aptiktas arba kai sekamas veidas yra išsaugotas,
bet numatytas sekamas veidas neaptiktas.

*

Priartinimo padėties indikatorius
Rodo priartinimo padėtį nuo 0 (plačiakampis) iki 99 (teleobjektyvas) (jei prijungtas
objektyvas, kuris palaiko priartinimo padėties rodymą).
Be to, indikatorių galite pakeisti juostos arba židinio nuotolio rodiniu – naudokite fotoaparato
meniu nustatymą [Technical] > [Lens] > [Zoom Position Display] (techniniai > objektyvas >
priartinimo padėties rodymas).
Toliau nurodyti elementai yra pridėti ekrane, kai įjungta funkcija „Clear Image Zoom“.

Išsamesnė informacija apie priartinimą pateikiama dalyje „Priartinimo tipo nustatymas“ ir
kitose dalies „Priartinimo reguliavimas“ temose.

10.

Rodoma Reikšmė

 („Clear Image Zoom“ įjungtas) Įjungtas „Clear Image Zoom“

Išdidinimo reikšmė Kai naudojamas „Clear Image Zoom“

Vaizdo stabilizavimo režimo indikatorius11.

SDI išvesties / HDMI išvesties įrašymo valdymo būsenos indikatorius
Rodo įrašymo valdymo signalo išvesties būseną.

Išsamesnė informacija pateikiama dalyje „Išorinių monitorių ir įrašymo įrenginių
prijungimas“.

12.

Fokusavimo indikatorius

Išsamesnė informacija pateikiama dalyje „Vieno kadro automatinio fokusavimo
naudojimas („Push Auto Focus (AF-S)“)“ skyriuje „Fokusavimo reguliavimas“.

13.

Laikmenos likusios talpos indikatorius
Piktograma  (apsauga) rodoma, jei atminties kortelė yra apsaugota nuo įrašymo.

14.

Baltos spalvos balanso režimo indikatorius15.

Rodoma Reikšmė

 (ATW) Automatinis režimas

 (ATW užlaikymas) Automatinio režimo pauzė

W:P iš anksto nustatytas režimas
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W:A atminties A režimas

Laiko kodo išorinio užrakinimo indikatorius / laiko duomenų rodymas
Rodo „EXT-LK“, kai susietas su išorinio įrenginio laiko kodu.

Išsamesnė informacija apie laiko kodą pateikiama dalyje „Laiko duomenų nustatymas“.

16.

ND filtro indikatorius

Išsamesnė informacija apie ND filtrus pateikiama dalyje „Šviesos lygio reguliavimas (ND
filtras)“.
Išsamesnė informacija apie „bokeh“ valdymą pateikiama dalyje „Bokeh“ reguliavimas
(„Bokeh“ valdymo funkcija)“.

17.

Rodoma Reikšmė

 (A) Automatinis režimas

 (B) „Bokeh“ valdymo režimas

Scenos failų indikatorius

Išsamesnė informacija apie scenos failus pateikiama dalyje „Vaizdo apžvalga“ ir kitose
dalies „Vaizdų fiksavimas su norimu vaizdu“.

18.

Diafragmos indikatorius
Rodo diafragmos padėtį (F reikšmę) (jei prijungtas objektyvas, kuris palaiko diafragmos
nustatymo rodymą).

Išsamesnė informacija apie diafragmą pateikiama dalyje „Automatinis diafragmos
reguliavimas“ ir „Rankinis diafragmos reguliavimas“.

19.

Vaizdo įrašo lygio įspėjimo indikatorius20.

Stiprinimo indikatorius
Rodo EI reikšmę, kai veikia „Cine EI“ režimas.

Išsamesnė informacija apie stiprinimą pateikiama dalyje „Automatinis stiprinimo

21.

Rodoma Reikšmė

 (A) Automatinis režimas

L Iš anksto nustatytas L režimas

 (laikinas reguliavimo režimas) Laikinas reguliavimo režimas

 (B) „Bokeh“ valdymo režimas
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reguliavimas“ ir „Rankinis stiprinimo reguliavimas“.
Išsamesnė informacija apie „Cine EI“ režimą pateikiama dalyje „Fiksavimo režimo
nustatymas“ skyriuje „Pagrindinių funkcijų konfigūravimas“.

Klipo pavadinimo rodymas
Parodo šiuo metu įrašomo arba ketinamo įrašyti pavadinimą.

22.

Užrakto indikatorius

Išsamesnė informacija apie užraktą pateikiama dalyje „Automatinis užrakto
reguliavimas“ ir „Rankinis užrakto reguliavimas“.

23.

AE režimo / AE lygio indikatorius

Išsamesnė informacija apie automatinę ekspoziciją (AE) pateikiama dalyje „Numatyto
automatinio šviesumo reguliavimo lygio nustatymas“.

24.

Gulsčiuko indikatorius
Rodo horizontalų lygį ±1° žingsniu iki ±15°.

25.

Garso lygio matuoklis
Parodo kiekvieno kanalo garso lygį.

26.

Vaizdo signalo stebėjimas
Rodo kreivę, vektorskopą ir histogramą.
Oranžinė linija rodo nustatytą šviesumo lygio žymeklio reikšmę.
Veikiant „Cine EI“ režimui rodomas stebimo signalo LUT tipas.

Išsamesnė informacija pateikiama dalyje „Vaizdo signalo stebėjimas“.
Išsamesnė informacija apie „Cine EI“ režimą pateikiama dalyje „Fiksavimo režimo
nustatymas“ skyriuje „Pagrindinių funkcijų konfigūravimas“.

27.

Bazinio jautrumo indikatorius / bazinio ISO indikatorius
Veikiant pasirinktiniam režimui rodomas bazinis jautrumas, nustatytas mygtuku [ISO/Gain /
Exposure Index] (ISO / stiprinimas / ekspozicijos indeksas) pagrindinių fotoaparato funkcijų
konfigūravimo skydelyje arba [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] (vaizdų
fiksavimas > ISO / stiprinimas / EI > bazinis jautrumas) fotoaparato meniu.
Veikiant „Cine EI“ režimui rodomas bazinis ISO jautrumas, nustatytas mygtuku [ISO/Gain /
Exposure Index] (ISO / stiprinimas / ekspozicijos indeksas) pagrindinių fotoaparato funkcijų
konfigūravimo skydelyje arba [Shooting] > [ISO/Gain/EI] > [Base ISO] (vaizdų fiksavimas >
ISO / stiprinimas / EI > bazinis ISO) fotoaparato meniu.

Išsamesnė informacija apie bazinį jautrumą pateikiama dalyje „Bazinio jautrumo
pasirinkimas“.
Išsamesnė informacija apie „Cine EI“ režimą pateikiama dalyje „Fiksavimo režimo
nustatymas“ skyriuje „Pagrindinių funkcijų konfigūravimas“.

28.

Stebėjimo vaizdo indikatorius
Veikiant „Cine EI“ režimui rodomas stebėjimo LUT nustatymas.

29.
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Atkūrimo metu ekrane rodoma informacija

Ant atkuriamo vaizdo uždedama ši informacija.

Išsamesnė informacija apie LUT nustatymą pateikiama dalyje „Vaizdų fiksavimas
koreguojant vaizdą vėlesnio redagavimo metu“ ir susijusiose temose.
Išsamesnė informacija apie „Cine EI“ režimą pateikiama dalyje „Fiksavimo režimo
nustatymas“ skyriuje „Pagrindinių funkcijų konfigūravimas“.

Bazinio vaizdo / įrašymo vaizdo indikatorius
Rodo bazinio vaizdo nustatymą.
Veikiant „Cine EI“ režimui rodomas vaizdo signalas, naudojamas įrašymui į atminties
korteles.

Išsamesnė informacija apie bazinį vaizdą pateikiama dalyje „Vaizdo apžvalga“ skyriuje
„Vaizdų fiksavimas su norimu vaizdu“.
Išsamesnė informacija apie „Cine EI“ režimą pateikiama dalyje „Fiksavimo režimo
nustatymas“ skyriuje „Pagrindinių funkcijų konfigūravimas“.

30.

Įrašymo mažesne raiška būsenos indikatorius31.

Įrašymo formato (kodeko) indikatorius
Rodo įrašymo atminties kortelėse formato pavadinimą.
Įrašymo formatą (kodeką) galite nustatyti naudodami [Project] > [Rec Format] > [Codec]
(projektas > įrašymo formatas > kodekas) žiniatinklio meniu arba fotoaparato meniu.

32.

Įrašymo formato (kadrų dažnio ir skenavimo metodo) indikatorius33.

Įrašymo formato (vaizdo dydžio) indikatorius
Rodo atminties kortelėje įrašomo vaizdo dydį.
Įrašymo formatą (vaizdo dydį) galite nustatyti naudodami [Project] > [Rec Format] > [Codec]
(projektas > įrašymo formatas > kodekas) žiniatinklio meniu arba fotoaparato meniu.

34.

Įspėjamasis indikatorius
Aplink vaizdą rodomas raudonas arba žalias rėmelis, kuris priklauso nuo gaunamo išorinio
įspėjamojo signalo.

35.
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[21] Parengiamieji veiksmai Įrenginio montavimas

Montavimas stačiai fiksuotoje vietoje

Įkėlimo indikatorius / likusių failų indikatorius1.

Klipo numeris / bendras klipų skaičius2.

Atkūrimo būsenos indikatorius3.

Atkūrimo formato (kadrų dažnio ir skenavimo metodo) indikatorius4.

Atkūrimo formato (vaizdo dydžio) indikatorius5.

Atkūrimo formato (kodeko) indikatorius6.

Laikmenos indikatorius
Piktograma  (apsauga) rodoma, jei atminties kortelė yra apsaugota nuo įrašymo.

7.

Laiko duomenų rodymas8.

Klipo pavadinimo rodymas9.

Gamos rodymo pagalbos indikatorius10.

Garso lygio matuoklis
Rodo atkuriamo garso lygį.

11.

Bazinio vaizdo / įrašymo vaizdo indikatorius12.

Įspėjamasis indikatorius13.
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Šioje temoje aprašomas įrenginio montavimas ant stalo arba trikojo.

Montavimo pastaba
Kad apsaugotumėte objektyvą ir įrenginio objektyvo jungties bloką, objektyvą ir dangtelį
arba įrenginio dangtelį laikykite uždėję iki pat objektyvo tvirtinimo.
Kad išvengtumėte objektyvo gedimo, dirbdami nelaikykite suėmę už objektyvo dalių.
Kad išvengtumėte įrenginio gedimo, dirbdami nelaikykite suėmę už fotoaparato galvutės.

Patikrinkite montavimo vietą.

Jei montuojama ant stalo
Šį įrenginį montuokite ant lygaus paviršiaus įvertinę, ar pakaks vietos objektyvui pasisukti ir
įrenginio gale esantiems laidams ištiesti.

Pastaba

Jį montuokite stabilioje vietoje, kurios neveikia vibracija. Dėl vibracijos veikiamos vietos gali
vibruoti vaizdas.

Jei įrenginį reikia montuoti ant paviršiaus su nuolydžiu, išlaikykite ne didesnį kaip ±15° nuolydį
nuo horizontalios plokštumos ir pasirūpinkite, kad įrenginys nenukristų.

Jei montuojama ant trikojo
Trikojį pritvirtinkite prie trikojo tvirtinimo varžto skylės apatinėje dalyje.
Įsukite trikojo tvirtinimo varžtą, kuris virš montavimo paviršiaus išsikiša tiek, kiek nurodyti
toliau, ir priveržkite jį rankiniu atsuktuvu.

A: trikojo montavimo varžtai 1/4-20 UNC, ISO 1222 (6,35 mm)
B: išsikišimas (4,5–5,5 mm)

Trikojo montavimo varžtų nenaudokite įrenginį montuodami aukštai.

1
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Tada uždėkite objektyvą. Žr. „Objektyvo uždėjimas“ ir vadovaukitės informacija dalyje
„Atsargumo priemonės uždedant / nuimant objektyvą“, „Objektyvo jungiklių tikrinimas“ ir
„Atsargumo priemonės naudojant keičiamo“.

[22] Parengiamieji veiksmai Įrenginio montavimas

Montavimas stačiai aukštoje, fiksuotoje vietoje

Šioje temoje aprašoma stačio įrenginio montavimo aukštoje vietoje procedūra, kai naudojamas
lubų laikiklis (CIB-PCM1 (priedas).

Jei įrenginį reikia sumontuoti aukštai, kreipkitės į specialistą.
Montuodami aukštai įsitikinkite, kad montavimo paviršius ir montavimo medžiaga (išskyrus
priedus) gali atlaikyti 200 kg (440 lb 14,8 oz) ar didesnį svorį, ir sumontuokite įrenginį
vadovaudamiesi šiame žinyne pateikiamomis instrukcijomis. Jei tvirtinimas nebus
pakankamai tvirtas, įrenginys gali nukristi ir sunkiai sužaloti.
Prie CIB-PCM1 lubų laikiklio (priedas) prikabinkite pridedamą apsaugos nuo kritimo lynelį,
kad įrenginys nenukristų.
Jei įrenginys sumontuojamas aukštai, kartą per metus patikrinkite, ar tvirtinimas
neatsilaisvino. Patikrinimo intervalus trumpinkite atsižvelgdami į naudojimo sąlygas.

Montavimo pastaba
Kad apsaugotumėte objektyvą ir įrenginio objektyvo jungties bloką, objektyvo dangtelį ir

Pastaba

Pasirinkite trikojį, kuris neapvirstų objektyvui sukantis.
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dangtelį laikykite uždėję iki pat objektyvo tvirtinimo.
Kad išvengtumėte objektyvo gedimo, dirbdami nelaikykite suėmę už objektyvo dalių.
Kad išvengtumėte įrenginio gedimo, dirbdami nelaikykite suėmę už fotoaparato galvutės.

Patikrinkite montavimui aukštai skirtus priedus ir montavimo vietą.

CIB-PCM1 lubų laikiklio rinkinys (priedas)
Prieš pradėdami patikrinkite, ar turite toliau nurodytas dalis.

Korpuso laikiklis (1)
Lubų laikiklis (1)
Objektyvo atlaisvinimo mygtuko dangtelis (1)
Apsaugos nuo kritimo lynelis (1)
+PSW M3×8 varžtai (9)
+PSW M4x8 nerūdijančiojo plieno varžtas apsaugos nuo kritimo lyneliui tvirtinti (1)

Pastaba

Apsaugos nuo kritimo lynelis yra pritaikytas išlaikyti kabantį įrenginį. Ant lynelio negali būti
prikabintas joks kitas svoris, išskyrus įrenginį.

Montavimo vieta
Rinkdami montavimo vietą ir kryptį vadovaukitės toliau pateikiamu brėžiniu ir įvertinkite
vietą, kurios reikės objektyvui pasisukti ir laidui įrenginio gale ištiesti.

A: fotoaparato galvutės judėjimo spindulys (pvz., SEL70200GM2 (uždėjus SEL20TC):
Ø340)
B: lubų laikiklis (skylė montavimo paviršiaus šone (Ø60)
C: montavimo lygiavimo skylė

Pastaba

Jį montuokite stabilioje vietoje, kurios neveikia vibracija. Dėl vibracijos veikiamos vietos gali
vibruoti vaizdas.

1
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Jei įrenginį reikia montuoti ant paviršiaus su nuolydžiu, išlaikykite ne didesnį kaip ±15° nuolydį
nuo horizontalios plokštumos ir pasirūpinkite, kad įrenginys nenukristų.

Paslinkite pasukimo / pakreipimo užrakto svirtelę į padėtį LOCK, kad užrakintumėte
fotoaparato galvutės pasukimo / pakreipimo funkciją.

Pastaba

Jei fotoaparato galvutės pasukimo / pakreipimo funkcija neužrakinama svirtelę nustačius į
padėtį LOCK, pasukite fotoaparato galvutę ranka ir užfiksuokite ją.

2

Korpuso laikiklį pritvirtinkite įrenginio apatinėje dalyje naudodami šešis pridedamus
varžtus (M3×8).

3
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Naudokite pridedamus varžtus. Jei naudosite kitus varžtus nei pridedami, galite sugadinti
įrenginio vidų.

Apsaugos nuo kritimo lynelį pritvirtinkite prie korpuso laikiklio.4



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

A: pridedamas lynelis?
B: pridedamas varžtas kryžmine galvute (M4×8)
C: metalinė lynelio kilpa

Naudokite pridedamą varžtą. Jei naudosite kitą varžtą nei pridedamas, gali sumažėti
lynelio funkcijos efektyvumas.

Lubų laikiklį pritvirtinkite prie paviršiaus, pvz., lentynos, prie kurio ketinate tvirtinti
įrenginį.

5
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A: siena?
B: ? žyma (fotoaparato priekinės dalies kryptis)
C: skylė jungiamiesiems kabeliams
D: lentyna ar kitas montavimo paviršius

Apsaugos nuo kritimo lynelį pritvirtinkite šalia montavimo paviršiaus.

Naudodami M5 (3/16 in) varžtą šešiakampe galvute (priedas) pritvirtinkite jį prie daikto
šalia lentynos ar paviršiaus, prie kurio pritvirtintas lubų laikiklis.

6
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A: lynelis?
B: varžtas šešiakampe galvute (M5, 3/16 in)

? varžto skylę korpuso laikiklio priekyje sulygiuokite su ? skyle lubų laikiklyje,
įstatykite įrenginį ir laikinai pritvirtinkite korpuso laikiklį prie lubų laikiklio
pasukdami įrenginį pagal laikrodžio rodyklę.

7
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A: ? skylė
B: ? skylė

Korpuso laikiklį ir lubų laikiklį pritvirtinkite naudodami tris pridedamus fiksuojamus
varžtus (M3×8).

8
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Tada uždėkite objektyvą. Žr. „Objektyvo uždėjimas“ ir vadovaukitės informacija dalyje
„Atsargumo priemonės uždedant / nuimant objektyvą“, „Objektyvo jungiklių tikrinimas“ ir
„Atsargumo priemonės naudojant keičiamo“.

Pastaba

Pritvirtinę objektyvą patikrinkite, ar jis tvirtai laikosi.
Objektyve nėra jokios apsaugos nuo kritimo. „Sony“ neprisiima jokios atsakomybės už nuo įrenginio
nukritusį objektyvą.

[23] Parengiamieji veiksmai Įrenginio montavimas

Montavimas prie lubų

Patikrinkite montavimo būseną.

Ypač patikrinkite toliau nurodytus dalykus. 

Ar tinkamai įsukti montavimo varžtai.
Ar tinkamai pritvirtintas apsaugos nuo kritimo lynelis ir ar jis nesusisukęs.
Ar įrenginys sumontuotas tiesiai (nepakreiptas arba nejuda).
Ar įrenginys pasukus nesisuka laisvai.

9
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Šioje temoje aprašoma įrenginio montavimo prie lubų procedūra, kai naudojamas lubų laikiklis
(CIB-PCM1 (priedas).

Jei įrenginį reikia sumontuoti prie lubų, kreipkitės į specialistą.
Montuodami prie lubų įsitikinkite, kad montavimo paviršius ir montavimo medžiaga (išskyrus
priedus) gali atlaikyti 200 kg (440 lb 14,8 oz) ar didesnį svorį, ir sumontuokite įrenginį
vadovaudamiesi šiame žinyne pateikiamomis instrukcijomis. Jei tvirtinimas nebus
pakankamai tvirtas, įrenginys gali nukristi ir sunkiai sužaloti.
Prie CIB-PCM1 lubų laikiklio (priedas) prikabinkite pridedamą apsaugos nuo kritimo lynelį,
kad įrenginys nenukristų.
Jei įrenginys sumontuojamas prie lubų, kartą per metus patikrinkite, ar tvirtinimas
neatsilaisvino. Patikrinimo intervalus trumpinkite atsižvelgdami į naudojimo sąlygas.

Montavimo pastaba
Kad apsaugotumėte objektyvą ir įrenginio objektyvo jungties bloką, objektyvo dangtelį ir
dangtelį laikykite uždėję iki pat objektyvo tvirtinimo.
Kad išvengtumėte objektyvo gedimo, dirbdami nelaikykite suėmę už objektyvo dalių.
Kad išvengtumėte įrenginio gedimo, dirbdami nelaikykite suėmę už fotoaparato galvutės.

Patikrinkite montavimui prie lubų skirtus priedus ir montavimo vietą.

CIB-PCM1 lubų laikiklio rinkinys (priedas)
Prieš pradėdami patikrinkite, ar turite toliau nurodytas dalis.

Korpuso laikiklis (1)
Lubų laikiklis (1)
Objektyvo atlaisvinimo mygtuko dangtelis (1)
Apsaugos nuo kritimo lynelis (1)
+PSW M3×8 varžtai (9)
+PSW M4×8 nerūdijančiojo plieno varžtas apsaugos nuo kritimo lyneliui tvirtinti (1)

Pastaba

1
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Apsaugos nuo kritimo lynelis yra pritaikytas išlaikyti kabantį įrenginį. Ant lynelio negali būti
prikabintas joks kitas svoris, išskyrus įrenginį.

Montavimo vieta
Rinkdami montavimo vietą ir kryptį vadovaukitės toliau pateikiamu brėžiniu ir įvertinkite
vietą, kurios reikės objektyvui pasisukti ir laidui įrenginio gale ištiesti.

A: fotoaparato galvutės judėjimo spindulys (pvz., SEL70200GM2 (uždėjus SEL20TC):
Ø340)
B: lubų laikiklis (skylė lubų pusėje (Ø60)
C: montavimo lygiavimo skylė

Pastaba

Montuokite prie lubų (pvz., betono), kurios yra pakankamai tvirtos.

Jei įrenginį reikia montuoti prie nepakankamai tvirtų lubų, būtinas tinkamas sutvirtinimas.

Jį montuokite stabilioje vietoje, kurios neveikia vibracija. Dėl vibracijos veikiamos vietos gali
vibruoti vaizdas.

Jei įrenginį reikia montuoti ant paviršiaus su nuolydžiu, išlaikykite ne didesnį kaip ±15° nuolydį
nuo horizontalios plokštumos ir pasirūpinkite, kad įrenginys nenukristų.

Priešingoje pusėje ? skylė lubų laikiklyje yra vaizdų fiksavimo krypties žyma (fotoaparato
priekis).

Paslinkite pasukimo / pakreipimo užrakto svirtelę į padėtį UNLOCK, kad
atrakintumėte pasukimo / pakreipimo funkciją ir pasuktumėte fotoaparato galvutę
180° kampu pakreipimo kryptimi.

2

Paslinkite pasukimo / pakreipimo užrakto svirtelę į padėtį LOCK, kad užrakintumėte
fotoaparato galvutės pasukimo / pakreipimo funkciją.

3
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Fotoaparato galvute pasukta 180° kampu

Pastaba

Jei fotoaparato galvutės pasukimo / pakreipimo funkcija neužrakinama svirtelę nustačius į
padėtį LOCK, pasukite fotoaparato galvutę ranka ir užfiksuokite ją.

Korpuso laikiklį pritvirtinkite įrenginio apatinėje dalyje naudodami šešis pridedamus
varžtus (M3×8).

4
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Naudokite pridedamus varžtus. Jei naudosite kitus varžtus nei pridedami, galite sugadinti
įrenginio vidų.

Pritvirtinkite lubų laikiklį prie montavimo plokštelės (priedas), tada plokštelę
pritvirtinkite prie lubų.

5
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A: lubų laikiklis
B: lubos
C: montavimo plokštelė
D: ? skylė
Laikiklį pritvirtinkite pagal lubų laikiklio kryptį
Atminkite, kad tvirtinant prie lubų fotoaparato priekis yra priešingoje lubų laikiklio pusėje
(priešingai nei montuojant įprastai stačiai). Sumontuokite tinkamai vadovaudamiesi
schema, kurioje nurodyta montavimo kryptis.

A: priekis montuojant stačiai (? skylės kryptis)
B: priekis montuojant prie lubų

Pastaba

Montavimo paviršiaus medžiagą turi parinkti klientas.

Apsaugos nuo kritimo lynelį pritvirtinkite prie lubų.6
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A: lubų laikiklis
B: varžtas šešiakampe galvute (M5, 3/16 in)
C: lynelis (pridedamas)
D: montavimo plokštelė
E: lubos

Perkiškite apsaugos nuo kritimo lynelį pro skylę lubų laikiklio viduryje ir
pritvirtinkite jį prie korpuso laikiklio.

Ištieskite apsaugos nuo kritimo lynelį pro metalinę lynelio kilpą korpuso laikiklyje ir
pritvirtinkite jį prie laikiklio pridedamu nerūdijančiojo plieno varžtu (M4×8).

A: pridedamas lynelis
B: pridedamas varžtas kryžmine galvute (M4×8)

7
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C: metalinė lynelio kilpa

Naudokite pridedamą varžtą. Jei naudosite kitą varžtą nei pridedamas, gali sumažėti
lynelio funkcijos efektyvumas.

Pastaba

Rekomenduojame vienam žmogui laikyti įrenginį, kaip parodyta toliau esančioje schemoje, kol
kitas žmogus pritvirtina įrenginį.

Montuodami įrenginį nelaikykite už fotoaparato galvutės ar objektyvo atramos. Įrenginiui
išslydus ar nukritus kyla pavojus jį sugadinti arba susižaloti.

Būkite atsargūs jungdami laidus ir saugokite, kad elektros jungtys ir kabeliai nebūtų sutrumpinti
apsaugos nuo kritimo lyneliu.

Laikiklis gali atlaikyti iki 8,8 kg (19 lb 6,4 oz) svorį (su objektyvu). Kad įrenginys nenukristų,
neviršykite didžiausio leistino svorio.

Varžto skylę (A) korpuso laikiklyje sulygiuokite su ? skyle (B) lubų laikiklyje,
įstatykite įrenginį ir pasukite jį maždaug 60 laipsnių pagal laikrodžio rodyklę, kol
varžto skylės (A) ir (C) bus sulygiuotos.

8
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A: varžto skylė korpuso laikiklyje
B: varžto skylė lubų laikiklyje (? skylė)
C: varžto skylė
D: lubos
E: montavimo plokštelė

Korpuso laikiklį ir lubų laikiklį pritvirtinkite naudodami tris pridedamus fiksuojamus
varžtus (M3×8).

9
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Tada uždėkite objektyvą. Žr. „Objektyvo uždėjimas“ ir vadovaukitės informacija dalyje
„Atsargumo priemonės uždedant / nuimant objektyvą“, „Objektyvo jungiklių tikrinimas“ ir
„Atsargumo priemonės naudojant keičiamo“.

Pastaba

Kad pasukimo / pakreipimo funkcija veiktų tinkamai įrenginį sumontavus prie lubų, žiniatinklio meniu
[Pan-Tilt] > [Direction] > [Ceiling] (pasukimas / pakreipimas > kryptis > lubos) nustatykite kaip [On]
(įjungta).

Pritvirtinę objektyvą patikrinkite, ar jis tvirtai laikosi.
Objektyve nėra jokios apsaugos nuo kritimo. „Sony“ neprisiima jokios atsakomybės už nuo įrenginio
nukritusį objektyvą.

Patikrinkite montavimo būseną.

Ypač patikrinkite toliau nurodytus dalykus.

Ar tinkamai įsukti montavimo varžtai.
Ar tinkamai pritvirtintas apsaugos nuo kritimo lynelis ir ar jis nesusisukęs.
Ar įrenginys sumontuotas tiesiai (nepakreiptas arba nejuda).
Ar įrenginys pasukus nesisuka laisvai.

10
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[24] Parengiamieji veiksmai Objektyvo uždėjimas / nuėmimas

Atsargumo priemonės uždedant / nuimant objektyvą

Nepalikite objektyvo nukreipto į saulę. Tiesioginiai saulės spinduliai praėję per objektyvą gali
būti sufokusuoti įrenginio viduje ir sukelti gaisą.

Pastaba

Objektyvą uždėkite / nuimkite, kai fotoaparatas išjungtas.

Objektyvas yra precizinis komponentas. Nedėkite objektyvo ant paviršiaus žemyn nukreiptu
objektyvo tvirtinimo lizdu. Uždėkite pridedamą objektyvo tvirtinimo lizdo dangtelį.

Patarimas

Dėl informacijos apie įrenginiui tinkančius objektyvus kreipkitės į „Sony“ techninės priežiūros atstovą.

[25] Parengiamieji veiksmai Objektyvo uždėjimas / nuėmimas

Objektyvo jungiklių tikrinimas

Atsižvelgiant į objektyvo tipą, būtini toliau nurodyti patikrinimai ir nustatymai.

Objektyvui su priartinimo jungikliu

Jungiklį nustatykite į padėtį SERVO.
Jei jungiklis nustatytas į padėtį MANUAL, priartinimą galima reguliuoti tik naudojant priartinimo
žiedą. Priartinimo valdymas įrenginyje neveikia.

Objektyvui su fokusavimo režimo jungikliu

Jungiklį nustatykite į padėtį AF/MF arba AF.
Jei jungiklis nustatytas į padėtį MF, fokusavimą galima reguliuoti tik objektyvo žiedu arba
rankiniu būdu nuotolinio valdymo įrenginyje. Jei jungiklis nustatytas į padėtį „Full MF“,
fokusavimą galima reguliuoti tik objektyvo žiedu.

Pastaba

Kai naudojate objektyvą su A tipo tvirtinimu, rankinis reguliavimas iš nuotolinio valdymo įrenginio gali
būti negalimas.

Objektyvas su automatinės diafragmos jungikliu
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Jungiklį nustatykite į padėtį AUTO.
Jei nenustatyta į padėtį AUTO, diafragmą galima reguliuoti tik objektyvo žiedu. Diafragmos
valdymas įrenginyje neveikia.

Objektyvas su vaizdo stabilizavimo jungikliu

Jungiklį nustatykite į padėtį OFF.
Jei jungiklis nustatytas į padėtį ON, naudojant pasukimo / pakreipimo funkciją įrenginyje gali
veikti netinkamai.

SELP28135G

A: jungiklį ZOOM nustatykite į padėtį SERVO.
B: fokusavimo žiedą pasukite į priekinę padėtį (AF/MF režimą).
C: vaizdo stabilizavimo jungiklį nustatykite į padėtį OFF.

[26] Parengiamieji veiksmai Objektyvo uždėjimas / nuėmimas

Atsargumo priemonės naudojant keičiamo židinio
nuotolio objektyvą

Jei naudojamas kitoks kintamo židinio nuotolio objektyvas nei automatizuotas, priartinimo
padėtis gali keistis atsižvelgiant į montavimo aplinką. Atsižvelgdami į naudojimo tikslą
priartinimo žiedą užfiksuokite naudodami lipnią juostą.
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Plastikinė lipni juosta: 471 BLA 50 ar analogiška

[27] Parengiamieji veiksmai Objektyvo uždėjimas / nuėmimas

Objektyvo uždėjimas

Šioje temoje aprašoma, kaip uždėti objektyvą su E tipo arba A tipo jungtimi.

Pastaba

Kai naudojate objektyvą su A tipo tvirtinimu, diafragma nustatoma rankiniu būdu, o fokusavimas
nustatomas į MF.

Paslinkite pasukimo / pakreipimo užrakto svirtelę į padėtį LOCK, kad užrakintumėte
fotoaparato galvutės pasukimo / pakreipimo funkciją.

Pastaba

Jei fotoaparato galvutės pasukimo / pakreipimo funkcija neužrakinama svirtelę nustačius į
padėtį LOCK, pasukite fotoaparato galvutę ranka ir užfiksuokite ją.

1

Objektyvo atramos pagrindo tvirtinimo varžto spaudžiamąją svirtelę pasukite prieš
laikrodžio rodyklę, kad užfiksuotumėte, tada pastumkite objektyvo atramos
pagrindo tvirtinimo varžtą į tokią padėtį, kurioje jis netrukdytų objektyvui.

2
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A: tinkama
B: netinkama

Pasukite fotoaparato galvutės užrakto svirtelę rodyklės kryptimi, kad fotoaparato
galvutę atrakintumėte.

Pastaba

Kol fotoaparato galvutė vėl bus užrakinta, išlieka pavojus, kad fotoaparato galvutė pasisuks dėl
savo pačios svorio. Fiksuodami vaizdus fotoaparato galvutę prilaikykite ranka.

3

Pastumkite fotoaparato galvutę į tolimiausią priekinę padėtį.4
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Pasukite fotoaparato galvutės užrakto svirtelę rodyklės kryptimi, kad fotoaparato
galvutę užrakintumėte.

5

Nuimkite dangtelius nuo įrenginio ir objektyvo.6

Sulygiuokite objektyvo tvirtinimo žymą (baltą) su įrenginiu, atsargiai įstatykite
objektyvą į fotoaparato galvutę, tada sukite objektyvą pagal laikrodžio rodyklę, kol
jis spragtelėdamas užsifiksuos.

A: tvirtinimo žymos (baltos)

Pastaba

Jei norite naudoti objektyvą su A tipo tvirtinimu, uždėkite objektyvo tvirtinimo adapterį
(įsigyjamas atskirai) ant įrenginio, tada prijunkite objektyvą su A tipo tvirtinimu.

7

Pasukite fotoaparato galvutės užrakto svirtelę rodyklės kryptimi, kad fotoaparato
galvutę atrakintumėte.

8
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Pastaba

Kol fotoaparato galvutė vėl bus užrakinta, išlieka pavojus, kad fotoaparato galvutė pasisuks dėl
savo pačios svorio. Fiksuodami vaizdus fotoaparato galvutę prilaikykite ranka.

Išlaikykite fotoaparato galvutės balansą priekyje / gale, kad slankusis pagrindas
būtų horizontalus.

Jei naudojate vieną iš toliau nurodytų objektyvų, įrenginį ir objektyvą galite apytiksliai
subalansuoti pagal skalę ant slankiojo pagrindo.

9

Skalės padėtis Objektyvo pavadinimas

0,5 SEL70200GM (su uždėtu SEL20TC)

1,7 SEL70200GM

2,0 SEL70200GM2 (su uždėtu SEL20TC)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G
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Pastaba

Vadovaudamiesi slankiojo pagrindo skale subalansuokite apytiksliai.

Uždėdami objektyvą prireikus sureguliuokite balansą, kad įrenginys nepalinktų atgal ir pirmyn.

Sureguliuokite balansą ant horizontalaus paviršiaus.

4,3 SEL70200G

5,0 arba
didesnė

SEL1224GM, SEL1635GM, SELP1635G, SELP18105G,
SELP1020G

Pasukite fotoaparato galvutės užrakto svirtelę rodyklės kryptimi, kad fotoaparato
galvutę užrakintumėte.

10

Sukite objektyvo atramos spaudžiamąsias svirteles prieš laikrodžio rodyklę ir
atlaisvinkite objektyvo atramos bloką.

A: objektyvo atramos strypo spaudžiamoji svirtelė (2 vietos)

11
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B: objektyvo atramos blokas

Objektyvo atramos bloką pastumkite taip, kad objektyvo atramos pagrindas būtų
sulygiuotas su objektyvo atramos pagrindo tvirtinimo varžtu, tada pasukite varžtą
pagal laikrodžio rodyklę ir užfiksuokite objektyvo atramos pagrindą.

Pastaba

Įsitikinkite, kad objektyvo atramos pagrindas yra statmenas objektyvo atramos pagrindo
tvirtinimo varžtui, tada priveržkite.

12

Objektyvo atramos pagrindo tvirtinimo varžto spaudžiamąją svirtelę pasukite pagal
laikrodžio rodyklę, kad užfiksuotumėte objektyvo atramos pagrindo tvirtinimo
varžtą.

A: objektyvo atramos pagrindo tvirtinimo varžtas
B: tvirtinimo varžto skylė
C: objektyvo atramos pagrindo tvirtinimo varžto spaudžiamoji svirtelė

Patarimas

Jei spaudžiamoji svirtelė yra padėtyje, dėl kurios ją sunku pasukti, atleiskite spaudžiamąją
svirtelę ir pasukite tokiu kampu, kad pasukti būtų lengviau. Nustačius reikiamą padėtį,
spaudžiamąją svirtelę užspauskite.

13
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[28] Parengiamieji veiksmai Objektyvo uždėjimas / nuėmimas

Objektyvo nuėmimas

Atlikdami veiksmus priešinga tvarka nei uždedant objektyvą nuimkite.

A: objektyvo atramos pagrindo tvirtinimo varžto spaudžiamoji svirtelė
B: objektyvo atramos strypo spaudžiamoji svirtelė

Sukite dvi objektyvo atramos strypo spaudžiamąsias svirteles pagal laikrodžio
rodyklę ir užfiksuokite objektyvo atramos bloką.

14

Patikrinkite, ar abi svirtelės yra priveržtos ir neatsilaisvinusios, objektyvas uždėtas
tinkamai, o objektyvo jungikliai nustatyti tinkamai.

Jei svirtelė atsilaisvinusi arba objektyvas uždėtas netinkamai, objektyvas gali nukristi ir
būti sugadintas.
Jei naudojate kintamo židinio nuotolinio objektyvą su E tipo tvirtinimu, objektyvą reikia
sukalibruoti atskirai, kad būtų tiksliai atkurtos fotoaparate išsaugotos priartinimo
padėtys. Išsamesnė informacija pateikiama dalyje „Objektyvo su E tipo tvirtinimu
kalibravimas“.

15

Patikrinkite, ar pasukimo / pakreipimo funkcija užrakinta.1

Objektyvo atramos pagrindo tvirtinimo varžto spaudžiamąją svirtelę pasukite prieš
laikrodžio rodyklę, kad atlaisvintumėte užraktą.

2

Išimkite objektyvo atramos pagrindo tvirtinimo varžtą iš objektyvo atramos bloko ir
nustatykite į tokią padėtį, kad jis netrukdytų objektyvui.

3

Atfiksuokite fotoaparato galvutę ir pastumkite ją į tolimiausią priekinę padėtį.

Išsamesnė informacija pateikiama 3–5 veiksmuose dalyje „Objektyvo uždėjimas“.

4

Paspauskite ir laikykite objektyvo atlaisvinimo mygtuką ir sukite objektyvą prieš
laikrodžio rodyklę prilaikydami objektyvą.

5

Sulygiavę tvirtinimo žymas (baltas) ant fotoaparato ir objektyvo, pastumkite
objektyvą link priekio.

6
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Pastaba

Tvirtai laikykite objektyvą rankoje, kad objektyvas neiškristų.

Jei nesiruošiate iškart prijungti kito objektyvo, visada uždėkite korpuso dangtelį.

[29] Parengiamieji veiksmai

Kabelių prijungimas

Šioje temoje aprašomas kabelių jungčių prijungimas.

[30] Parengiamieji veiksmai

Prijunkite reikiamus kabelius prie galiniame skydelyje esančių jungčių.

Kad HDMI kabelis neatsijungtų, išsukite HDMI kabelio tvirtinimo plokštelės montavimo
varžtą (M2,6×6, juodas) iš jungčių bloko ir pritvirtinkite pridedamą HDMI kabelio tvirtinimo
plokštelę naudodami montavimo varžtą. HDMI kabelį pritvirtinkite prie HDMI kabelio
tvirtinimo plokštelės naudodami rinkoje parduodamą kabelio veržtuką ar juostelę.

A: HDMI kabelio tvirtinimo plokštelės montavimo varžtas (M2,6×6, juodas)
B: rinkoje parduodamas kabelio veržtukas ar juostelė
C: HDMI kabelio tvirtinimo plokštelė (pridedama)

1
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Įrenginio prijungimas prie tinklo įrenginio laidiniu
ryšiu

Šioje temoje aprašomas įrenginio prijungimas prie tinklo įrenginio laidiniu ryšiu.

[31] Parengiamieji veiksmai Maitinimo prijungimas

Kintamosios srovės naudojimas

Šioje temoje aprašoma įrenginio prijungimas prie maitinimo naudojant kintamosios srovės
adapterį.

Įrenginį prie tinklo įrenginio (pvz., „Wi-Fi“ prieigos taško arba perjungimo šakotuvo)
prijunkite 5e ar aukštesnės kategorijos LAN laidu.

1

Paslinkite pasukimo / pakreipimo užrakto svirtelę į padėtį LOCK, kad užrakintumėte
fotoaparato galvutės pasukimo / pakreipimo funkciją.

1

Prijunkite kintamosios srovės adapterį (pridedamas) prie įrenginio maitinimo lizdo
DC IN ir prijunkite maitinimo laidą (pridedamas) prie kintamosios srovės maitinimo
šaltinio.

2
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A: jungtis DC IN
B: maitinimo laidas
C: kintamosios srovės adapteris

Kad laidas nebūtų atjungtas, pritvirtinkite kintamosios srovės adapterį naudodami
laido spaustuką.

Atlaisvinkite laido spaustuką, ištieskite laidą pro spaustuką, kaip parodyta toliau, tada
spaustuką užveržkite.

A: laido spaustukas
B: laido spaustuko fiksatorius
C: kintamosios srovės adapterio laidas

3
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Pastaba

Naudokite tik su įrenginiu pateikiamą kintamosios srovės adapterį ir maitinimo laidą. Prijungus kitą
adapterį ar maitinimo laidą gali kilti gaisras arba įvykti gedimas.

Nejunkite ir nenaudokite kintamosios srovės adapterio uždaroje vietoje, pavyzdžiui, tarp sienos ir
baldų.

Trumpai nesujunkite metalinių kintamosios srovės adapterio kištuko dalių. Kitaip galite sukelti
gedimų.

Prijunkite kintamosios srovės adapterį prie artimiausio kintamosios srovės maitinimo šaltinio. Jei
problema iškyla vaizdo kamerai veikiant, iškart atjunkite maitinimo laidą nuo kintamosios srovės
maitinimo šaltinio.

Atjungdami kintamosios srovės adapterį nuo įrenginio suimkite kištuką ir traukite jį tiesiai. Traukdami
už laido galite sugadinti įrangą.

[32] Parengiamieji veiksmai Maitinimo prijungimas

PoE++ maitinimo naudojimas

Kai įrenginys prijungiamas prie PoE++ palaikančio maitinimo tiekimo įrenginio, maitinimas į
įrenginį tiekiamas naudojant rinkoje parduodamą tinklo kabelį.
Toks būdas leidžia maitinimą į įrenginį tiekti neprijungiant maitinimo laido, kai šalia įrengimo
vietos nėra maitinimo lizdo.

Pastaba

Kai maitinimas tiekiamas naudojant PoE++, įrašymo ir atkūrimo funkcijų negalima naudoti su

Patikrinkite, ar įrenginio priekyje esanti lemputė POWER nebemirksi žaliai, o liko
šviesti žaliai ir ar buvo baigtas paleidimo procesas.

Įrenginį paleidus įprastai ir prijungus prie tinklo lemputė NETWORK pradės šviesti žaliai.

Jei naudojamas pasukimo / pakreipimo funkcijos nepalaikantis objektyvas, užfiksuokite
pasukimo / pakreipimo užrakinimo svirtelę ir toliau pateikiamus veiksmus praleiskite.
Išsamesnės informacijos apie pasukimo / pakreipimo nepalaikančius objektyvus
teiraukitės pardavėjo arba „Sony“ techninės priežiūros atstovo.

4

Paslinkite pasukimo / pakreipimo užrakto svirtelę į padėtį UNLOCK, kad
atrakintumėte fotoaparato galvutės pasukimo / pakreipimo funkciją.

5

Nustatykite pasukimo / pakreipimo funkciją iš naujo.

Išsamesnė informacija pateikiama dalyje „Pasukimo / pakreipimo nustatymas iš naujo“.

6
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įrenginyje įdėta laikmena.

Paslinkite pasukimo / pakreipimo užrakto svirtelę į padėtį LOCK, kad užrakintumėte
fotoaparato galvutės pasukimo / pakreipimo funkciją.

1

Įrenginį prie PoE++ palaikančio maitinimo tiekimo įrenginio prijunkite naudodami
rinkoje parduodamą tinklo kabelį.

A: tinklo kabelis
B: PoE++ palaikantis maitinimo tiekimo įrenginys

2

Patikrinkite, ar įrenginio priekyje esanti lemputė POWER nebemirksi žaliai, o liko
šviesti žaliai ir ar buvo baigtas paleidimo procesas.

Įrenginį paleidus įprastai ir prijungus prie tinklo lemputė NETWORK pradės šviesti žaliai.

Pastaba

Kai maitinimas tiekiamas naudojant PoE++, pradinis autentiškumo nustatymas atliekamas iki
pasibaigiant paleidimo procesui.

Jei naudojamas pasukimo / pakreipimo funkcijos nepalaikantis objektyvas, užfiksuokite
pasukimo / pakreipimo užrakinimo svirtelę ir toliau pateikiamus veiksmus praleiskite.
Išsamesnės informacijos apie pasukimo / pakreipimo nepalaikančius objektyvus teiraukitės
pardavėjo arba „Sony“ techninės priežiūros atstovo.

3
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Pastaba

Įrenginys atitinka IEEE802.3bt 4 tipo, 8 klasės reikalavimus. Išsamesnę informaciją apie patvirtintus
suderinamus PoE++ maitinimo tiekimo įrenginius suteiks pardavėjas arba „Sony“ techninės
priežiūros atstovas.

Įrenginys atitinka programinio autentiškumo nustatymo (LLDP) reikalavimus, tačiau gali tekti
sukonfigūruoti tinklo įrenginius (atitinkančius IEEE802.3bt).

Kai naudojamas PoE++ maitinimo tiekimas įjungus programinį autentiškumo nustatymą (LLDP),
nejunkite kintamosios srovės adapterio.

Jei vienu metu prijungsite kintamosios srovės adapterį ir PoE++ maitinimo tiekimo įrenginį,
maitinimas bus tiekiamas iš kintamosios srovės adapterio.

Kai maitinimas tiekiamas naudojant PoE++, naudokite 5e ar aukštesnės kategorijos tinklo kabelį.

Kai maitinimas tiekiamas naudojant PoE++, vėl įjungę įrenginį palaukite apie 10 sek.

Kai naudojamas PoE++ maitinimo tiekimas, prijunkite įžeminimo kontaktą prie įžeminimo.

Jungdami PoE++ maitinimo tiekimo įrenginį netieskite laidų lauke.

[33] Parengiamieji veiksmai

Pasukimo / pakreipimo nustatymas iš naujo

Pasukimo / pakreipimo funkciją galite nustatyti iš naujo, pvz., kai pakeičiate objektyvą,
vadovaudamiesi toliau pateikiama procedūra.

Paslinkite pasukimo / pakreipimo užrakto svirtelę į padėtį UNLOCK, kad
atrakintumėte fotoaparato galvutės pasukimo / pakreipimo funkciją.

4

Nustatykite pasukimo / pakreipimo funkciją iš naujo.

Išsamesnė informacija pateikiama dalyje „Pasukimo / pakreipimo nustatymas iš naujo“.

5

Paslinkite pasukimo / pakreipimo užrakto svirtelę į padėtį UNLOCK ir patikrinkite, ar
fotoaparato galvutės pasukimo / pakreipimo funkcija atrakinta.

1

Paleiskite pasukimo / pakreipimo nustatymo iš naujo funkciją.

Pasukimo / pakreipimo funkcijos nustatymą iš naujo galima atlikti naudojant infraraudonųjų
spindulių nuotolinio valdymo pultą, žiniatinklio programą arba RM-IP500 n nuotolinį valdiklį
(papildoma).
Veiksmai naudojant infraraudonųjų spindulių nuotolinio valdymo pultą: paspauskite
mygtuką P/T RESET.

2
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[34] Parengiamieji veiksmai Konfigūravimas prieš fiksuojant vaizdus Įrenginio pradinių
nustatymų atkūrimas naudojant žiniatinklio programą

Prisijungimas prie žiniatinklio programos iš
žiniatinklio naršyklės

Prijungę įrenginį prie planšetinio kompiuterio ar kompiuterio galite jį valdyti ir konfigūruoti
naudodami žiniatinklio naršyklę.

Veiksmai naudojant infraraudonųjų spindulių nuotolinio valdymo pultą: paspauskite
mygtuką P/T RESET.
Veiksmai naudojant žiniatinklio programą: paspauskite mygtuką [Pan-Tilt Reset]
(pasukimo / pakreipimo nustatymas iš naujo) tiesioginio valdymo ekrane esančiame
skirtuke  (kita).
Veiksmai naudojant RM-IP500: žr. RM-IP500 naudojimo instrukcijas.

Pastaba

Atliekant pasukimo / pakreipimo nustatymą iš naujo fotoaparato galvutė ir objektyvas sukasi.
Prieš naudodami šią funkciją patikrinkite, ar objektyvui niekas netrukdo.

Įrenginyje yra funkcija, kuria apribojamas pasukimo / pakreipimo diapazonas, tačiau ši funkcija
išjungiama, kai įrenginys įjungiamas arba paleidžiamas pasukimo / pakreipimo funkcijos
nustatymas iš naujo.

Patarimas

Užbaigus pasukimo / pakreipimo nustatymą iš naujo įrenginys sugrįžta į ankstesnę padėtį.

Patikrinkite, ar jūsų planšetinis kompiuteris arba kompiuteris palaiko žiniatinklio
programoje atliekamus veiksmus.

1

Elementas Reikalavimas

Rodoma

Rekomenduojama 1080×810 ar
daugiau piks. 
Planšetinio kompiuterio ekrano dydis:
rekomenduojama 10 in ar didesnis

Windows

OS „Windows 10“ arba naujesnė

Žiniatinklio
naršyklė

Google Chrome

Mac

OS „macOS“ 10.15 ar naujesnė

Žiniatinklio Google Chrome 
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Pastaba

Jei nebus išpildyti aplinkos reikalavimai arba tai priklauso nuo planšetinio kompiuterio /
kompiuterio, gali būti neigiamai paveiktas žiniatinklio naršyklėje rodomas vaizdas.

Šio įrenginio žiniatinklio programoje naudojamas „JavaScript“. Jei planšetiniame kompiuteryje /
kompiuteryje naudojama apsaugos nuo virusų programinė įranga, tinklalapis gali būti rodomas
netinkamai.

Palaikoma OS ir
žiniatinklio naršyklė

naršyklė Safari

iPad

OS „iPadOS“ 15 ar naujesnė

Žiniatinklio
naršyklė

Google Chrome 
Safari

Android

OS „Android“ 12 ar naujesnė

Žiniatinklio
naršyklė

Google Chrome

Patikrinkite, ar įjungtas įrenginys, planšetinis kompiuteris arba kompiuteris ir
prijungti įrenginiai.

2

Patikrinkite, ar įrenginys ir planšetinis kompiuteris arba kompiuteris yra prijungti
sujungti naudojant „Wi-Fi“ ar laidinį LAN vietinį tinklą.

3

Prisijunkite prie įrenginio naudodami žiniatinklio naršyklę planšetiniame
kompiuteryje ar kompiuteryje.

Prisijungimas naudojant QR kodą
Planšetinio kompiuterio fotoaparatu nuskaitykite QR kodą, kuris atspausdintas ant
laikmenos dangtelio įrenginio šone.

Atidarykite planšetiniame kompiuteryje rodomą nuorodą.
Planšetiniame kompiuteryje paleidžiama žiniatinklio naršyklė ir parodomas įrenginio
žiniatinklio programos ekranas.

4
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Pastaba

Jei HTTP prievado numeris buvo pakeistas nurodant kitą nei 80, adresų juostoje įveskite
„http://įrenginio IP adresas:prievado numeris“.

Jei jungiatės naudodami QR kodu ar įvesdami URL žiniatinklio naršyklės adresų juostoje, naudokite
mDNS* palaikantį įrenginį.

Patarimas

Vėliau prie įrenginio galėsite greitai prisijungti naudodami adresyno įrašų funkciją žiniatinklio
naršyklėje.

[35] Parengiamieji veiksmai Konfigūravimas prieš fiksuojant vaizdus Pradinių nustatymų
atkūrimas naudojant žiniatinklio programą

Įrenginio pradinių nustatymų atkūrimas

Jei įrenginį naudojate pirmą kartą, jį būtinai sukonfigūruokite vadovaudamiesi toliau pateikiama
procedūra.

Patarimas

Jei visiškai išsikraus atsarginis maitinimo elementas, pradinę sąranką turėsite atlikti iš naujo.

Prisijungimas įvedant URL žiniatinklio naršyklės adresų juostoje
Planšetiniame kompiuteryje ar kompiuteryje paleiskite žiniatinklio naršyklę ir įveskite URL,
kuris atspausdintas ant laikmenos dangtelio įrenginio šone.
Žiniatinklio naršyklėje turėtų būti rodomas įrenginio žiniatinklio programos ekranas.

Prisijungimas įvedant įrenginio IP adresą žiniatinklio naršyklės adresų juostoje
Planšetiniame kompiuteryje arba kompiuteryje paleiskite žiniatinklio naršyklę ir adresų
juostoje įveskite „http://įrenginio IP adresas“.
Žiniatinklio naršyklėje turėtų būti rodomas įrenginio žiniatinklio programos ekranas.

mDNS: ryšio protokolas, naudojamas IP adresui nustatyti pagal pagrindinio kompiuterio pavadinimą vietiniame tinkle.*

Prijunkite įrenginį prie planšetinio kompiuterio arba kompiuterio ir paleiskite
žiniatinklio programą.

Jei įrenginys naudojamas pirmą kartą, žiniatinklio naršyklėje būsite paraginti įvesti
naudotojo vardą ir slaptažodį. Įveskite toliau nurodytus nustatymus.

Naudotojo vardas: admin

1
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Slaptažodis: (palikite tuščią)

Vykdydami ekrane pateikiamas instrukcijas atlikite pradinę sąranką.

Įveskite administratoriaus („Administrator“) naudotojo vardą ir slaptažodį, tada
paspauskite mygtuką [OK].

1: Įveskite administratoriaus naudotojo vardą.
2: Nustatykite administratoriaus slaptažodį.
3: Patvirtindami dar kartą įveskite tą patį slaptažodį.

Pastaba

Naudotojo vardą ir slaptažodį gali sudaryti toliau nurodyti simboliai. Slaptažodį turi sudaryti
bent viena didžioji raidė, viena mažoji raidė, vienas skaičius, o jo ilgis turi būti nuo 8 iki 64
simbolių.

Raidiniai ir skaitiniai simboliai
Simboliai (!$%`*+-./<=>?@[]^_{|}~)

Jūsų žiniatinklio naršyklė bus įkelta iš naujo, o jūsų bus prašoma įvesti naudotojo vardą ir
slaptažodį.

2

Įveskite 2 veiksme sukonfigūruotą naudotojo vardą ir slaptažodį.

Parodomas kalbos ir laikrodžio sąrankos ekranas.

3
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Pasirodo tiesioginio vaizdo ekranas, kuriame galite pasirinkti fiksavimo parinktis. Tęskite
pagrindinių įrenginio funkcijų konfigūravimą pagal naudojamą veikimo režimą.

[36] Parengiamieji veiksmai Konfigūravimas prieš fiksuojant vaizdus

Pagrindinių funkcijų konfigūravimas

Nurodykite reikiamus elementus ir paspauskite mygtuką [OK].

[Language] (kalba)
Pasirinkite kalbą, kuri bus naudojama žiniatinklio programos ir kameros ekranuose.
Pakeitus kalbą bus pakeista ir žiniatinklio programos kalba.
[Date & Time Format] (datos ir laiko formatas)
Iš toliau pateiktų parinkčių pasirinkite datos ir laiko rodymo formatą.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
[y] rodo metus, [m] rodo mėnesį, [d] rodo dieną, [h] rodo valandą, [m] rodo minutes, o [s]
rodo sekundes.
[12 h/24 h]
Pasirinkite [12 h] (12 val. laikrodis) arba [24 h] (24 val. laikrodis) laiko rodinį.
[Time Setting] (laiko nustatymas)
Pasirinkite datos / laiko nustatymo metodą.
[Synchronize with PC]: sinchronizuokite su kompiuterio ar planšetinio kompiuterio data /
laiku.
[Manual setting]: nustatykite rankiniu būdu. Kai pasirenkamas šis būdas, pasirodo datos ir
laiko įvedimo laukai.
[Time Zone] (laiko juosta)
Pasirinkite laiko juostą.

4
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Šioje temoje aprašoma, kaip sukonfigūruoti pagrindines įrenginio funkcijas.

Fiksavimo režimo nustatymas

Įjungę pasirinktinį fiksavimo režimą „Custom mode“ galite lanksčiai fiksuoti vaizdus, o pasirinkę
kino režimą „Cine EI mode“ įrenginį galite naudoti panašiai kaip kino kamera, kai filmuota
medžiagą ketinama redaguoti studijoje.
Fiksavimo režimus galite perjungti žiniatinklio meniu arba fotoaparato meniu eidami į [Project] >
[Base Setting] > [Shooting Mode] (projektas > bazinis nustatymas > fiksavimo režimas).

Pasirinktinis režimas
Fiksuodami vaizdus pasirinktiniu („Custom“) režimu galite pasirinkti vaizdo įrašo standartą.
Perjunkite žiniatinklio meniu arba fotoaparato meniu eidami į [Project] > [Base Setting] > [Target
Display] (projektas > bazinis nustatymas > numatytasis rodinys).
[SDR(BT.709)]: vaizdų fiksavimas pagal HD transliacijos standartą
[HDR(HLG)]: vaizdų fiksavimas pagal naujos kartos 4K transliacijos standartą

Išsamesnė informacija pateikiama dalyje „Vaizdo apžvalga“ ir kitose dalies „Vaizdų
fiksavimas su norimu vaizdu“ temose.

„Cine EI“ režimas
Kai nustatytas „Cine EI“ fiksavimo režimas, pasirinkite įrašymo signalo ir išvesties signalo
pagrindinių spalvų erdvę. Čia pasirinkta spalvų erdvė yra vaizdo išvesties spalvų erdvė, kai
[MLUT] nustatyta kaip [Off] (išjungta).
Perjunkite fotoaparato meniu naudodami [Project] > [Cine EI Setting] > [Color Gamut] (projektas
> „Cine EI“ nustatymai > spalvų gama).
[S-Gamut3.Cine/SLog3]: lengvai sureguliuosite skaitmeninio kino spalvų gamą (DCI-P3).
[S-Gamut3/SLog3]: plati „Sony“ spalvų gama, kuri apima ITU-R BT.2020 spalvų erdvę.

Išsamesnė informacija pateikiama dalyje „Vaizdų fiksavimas koreguojant vaizdą vėlesnio
redagavimo metu“.

Pastaba

Veikiant „Cine EI“ režimui toliau nurodytų funkcijų negalima reguliuoti automatiškai (sekant).
baltos spalvos balansas
Stiprinimas
Shutter

Veikiant „Cine EI“ režimui toliau nurodytų funkcijų nustatymų keisti negalima.
ISO jautrumas / stiprinimas (nustatytas bazinis ISO jautrumas, fiksuotas)
Meniu [Paint/Look] (piešinys / vaizdas) nustatymais (išskyrus „Base Look“ (bazinis vaizdas)
„Scene File“ (siužeto failai) (išjungta)

Toliau pateiktos funkcijos veikia tik įjungus „Cine EI“ režimą.
Monitoriaus LUT
„Exposure Index“ (ekspozicijos indeksas)

Patarimas

Veikiant „Cine EI“ režimui fiksavimas vykdomas naudojant bazinį ISO jautrumą be stiprinimo, kad
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būtų maksimaliai išnaudotos vaizdo jutiklio techninės galimybės. Šviesumas reguliuojamas
naudojant apšvietimą ir ND filtrą, kuriais sureguliuojamas vaizdo jutiklį pasiekiančios šviesos kiekis.

Sistemos dažnio nustatymas

Perjunkite žiniatinklio meniu arba fotoaparato meniu naudodami [Project] > [Rec Format] >
[Frequency] (projektas > įrašymo formatas > dažnis). Įjungus įrenginys gali būtų automatiškai
paleistas iš naujo, tai priklauso nuo pasirinktos reikšmės.

Pastaba

Negalima perjungti sistemos dažnio filmavimo arba atkūrimo metu.

Jutiklio skenavimo režimo nustatymas

Galite nustatyti veiksmingą vaizdo jutiklio vaizdo dydį ir raišką.
Perjunkite žiniatinklio meniu arba fotoaparato meniu naudodami [Project] > [Rec Format] >
[Imager Scan Mode] (projektas > įrašymo formatas > jutiklio skenavimo režimas).
[FF]: viso kadro dydis.
[S35]: „Super 35mm“ dydis.

Pastaba

Negalima perjungti „Imager Scan“ režimo filmavimo arba atkūrimo metu.

Nustačius S35, vaizdo įrašo formatas ribojamas iki 1920×1080.

Kodeko nustatymas

Galite nustatyti įrašymui naudojamą kodeką.
Perjunkite žiniatinklio meniu arba fotoaparato meniu naudodami [Project] > [Rec Format] >
[Codec] (projektas > įrašymo formatas > kodekas).

Pastaba

Negalima perjungti kodeko filmavimo arba atkūrimo metu.

Vaizdo formato nustatymas

Galite nustatyti įrašymui naudojamą vaizdo įrašų formatą ir fotoaparato išvesčiai naudojamą
išvesties formatą.

Įrašymui naudojamą vaizdo įrašų formatą perjunkite žiniatinklio meniu arba fotoaparato
meniu naudodami [Project] > [Rec Format] > [Video Format] (projektas > įrašymo formatas >
vaizdo įrašų formatas).
Jungčių SDI OUT ir HDMI OUT išvesties formatą perjunkite žiniatinklio meniu arba
fotoaparato meniu naudodami [Monitoring] > [Output Format] (stebėjimas > išvesties
formatas).
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Pastaba

Negalima perjungti vaizdo įrašo formato filmavimo arba atkūrimo metu.

Signalui iš SDI OUT ir HDMI OUT jungčių gali būti taikomi ribojimai, atsižvelgiant į vaizdo įrašo
formato nustatymą.

[37] Parengiamieji veiksmai Konfigūravimas prieš fiksuojant vaizdus Atminties kortelių
paruošimas

Palaikomos atminties kortelės

Įrenginys įrašo garsą ir vaizdą į „CFexpress“ A tipo atminties korteles (galima įsigyti atskirai)
arba SDXC atminties korteles (galima įsigyti atskirai) įstatytas į kortelių lizdus. Atminties kortelės
naudojamos ir tarpiniam įrašymui.

„CFexpress“ A tipo atminties kortelės

Naudokite „Sony CFexpress“ A tipo atminties korteles*, kurios nurodytos įrenginio parinktyje
„Recommended media“ (rekomenduojamos laikmenos).
Informacijos apie kitų gamintojų laikmenų naudojimą rasite laikmenos naudojimo instrukcijose
arba žiūrėkite gamintojo informaciją.

SDXC atminties kortelės

Naudokite SDXC atminties korteles*, kurios nurodytos įrenginio parinktyje „Recommended
media“ (rekomenduojamos laikmenos).

Rekomenduojamos laikmenos

Užtikrinto veikimo sąlygos priklauso nuo įrašymo formato ir įrašymo nustatymų.

CFexpress Type A
Suderinama su VPG400
Palaikoma visiems įrenginio įrašymo formatams.

SDXC
Palaikoma esant toliau esančioje lentelėje nurodytoms sąlygoms. „Taip“ rodo, kad veikimas yra
patvirtintas, o „Ne“ rodo, kad veikimas negarantuojamas.

„RAW Out & XAVC-I“, 4096×2160 300 klasė, įprastas režimas

Šiame žinyne vadinamos „Cfexpress“ kortelėmis.*

Žinyne vadinamos SD kortelėmis.*

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Taip
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„RAW Out & XAVC-I“, 3840×2160 300 klasė, įprastas režimas

„RAW Out & XAVC-I“, 3840×2160 300 klasė, S&Q (60 kadr./sek. ar mažesnė sparta)

„RAW Out & XAVC-I“, 3840×2160 300 klasė, S&Q (100 kadr./sek., 120 kadr./sek.)
Patvirtintų laikmenų nėra.

XAVC-I, 4096×2160 300 klasė, įprastas režimas

50P Ne Ne Ne Ne Ne Ne Taip

29,97P Ne Ne Ne Ne Ne Taip Taip

25P Ne Ne Ne Ne Ne Taip Taip

24P Ne Ne Ne Ne Ne Taip Taip

23,98P Ne Ne Ne Ne Ne Taip Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Taip

50P Ne Ne Ne Ne Ne Ne Taip

29,97P Ne Ne Ne Ne Ne Taip Taip

25P Ne Ne Ne Ne Ne Taip Taip

23,98P Ne Ne Ne Ne Ne Taip Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Taip

50P Ne Ne Ne Ne Ne Ne Taip

29,97P Ne Ne Ne Ne Ne Ne Taip

25P Ne Ne Ne Ne Ne Ne Taip

23,98P Ne Ne Ne Ne Ne Ne Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Taip

50P Ne Ne Ne Ne Ne Ne Taip
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XAVC-I, 4096×2160 300 klasė, S&Q (60 kadr./sek. arba mažesnė sparta)

XAVC-I, 3840×2160 300 klasė, įprastas režimas

XAVC-I, 3840×2160 300 klasė, S&Q (60 kadr./sek. arba mažesnė sparta)

29,97P Ne Ne Ne Ne Ne Taip Taip

25P Ne Ne Ne Ne Ne Taip Taip

24P Ne Ne Ne Ne Ne Taip Taip

23,98P Ne Ne Ne Ne Ne Taip Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Taip

50P Ne Ne Ne Ne Ne Ne Taip

29,97P Ne Ne Ne Ne Ne Ne Taip

25P Ne Ne Ne Ne Ne Ne Taip

24P Ne Ne Ne Ne Ne Ne Taip

23,98P Ne Ne Ne Ne Ne Ne Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Taip

50P Ne Ne Ne Ne Ne Ne Taip

29,97P Ne Ne Ne Ne Ne Taip Taip

25P Ne Ne Ne Ne Ne Taip Taip

23,98P Ne Ne Ne Ne Ne Taip Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Taip

50P Ne Ne Ne Ne Ne Ne Taip

29,97P Ne Ne Ne Ne Ne Ne Taip

25P Ne Ne Ne Ne Ne Ne Taip
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XAVC-I, 3840×2160 300 klasė, S&Q (100 kadr./sek., 120 kadr./sek.)
Patvirtintų laikmenų nėra.

XAVC-I, 1920×1080 100 klasė, įprastas režimas

XAVC-I, 1920×1080 100 klasė, S&Q (60 kadr./sek. arba mažesnė sparta)

XAVC-I, 1920×1080 100 klasė, S&Q (100 kadr./sek., 120 kadr./sek.)

XAVC-I, 1920×1080 100 klasė, S&Q (150 kadr./sek., 180 kadr./sek.)

23,98P Ne Ne Ne Ne Ne Ne Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Taip Taip

50P Ne Ne Ne Ne Ne Taip Taip

29,97P Ne Ne Taip Ne Taip Taip Taip

25P Ne Ne Taip Ne Taip Taip Taip

23,98P Ne Ne Taip Ne Taip Taip Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Taip Taip

50P Ne Ne Ne Ne Ne Taip Taip

29,97P Ne Ne Ne Ne Ne Taip Taip

25P Ne Ne Ne Ne Ne Taip Taip

23,98P Ne Ne Ne Ne Ne Taip Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Taip

50P Ne Ne Ne Ne Ne Ne Taip

29,97P Ne Ne Ne Ne Ne Ne Taip

25P Ne Ne Ne Ne Ne Ne Taip

23,98P Ne Ne Ne Ne Ne Ne Taip
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Patvirtintų laikmenų nėra.

XAVC-I, 1920×1080 100 klasė, S&Q (200 kadr./sek., 240 kadr./sek.)
Patvirtintų laikmenų nėra.

XAVC-L, 3840×2160 420, įprastas režimas

XAVC-L, 3840×2160 420, S&Q (60 kadr./sek. arba mažesnė sparta)

XAVC-L, 3840×2160 420, S&Q (100 kadr./sek., 120 kadr./sek.)

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Taip Ne Taip Taip Taip

50P Ne Ne Taip Ne Taip Taip Taip

29,97P Ne Ne Taip Ne Taip Taip Taip

25P Ne Ne Taip Ne Taip Taip Taip

23,98P Ne Ne Taip Ne Taip Taip Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Taip Ne Taip Taip Taip

50P Ne Ne Taip Ne Taip Taip Taip

29,97P Ne Ne Ne Ne Ne Taip Taip

25P Ne Ne Ne Ne Ne Taip Taip

23,98P Ne Ne Ne Ne Ne Ne Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Taip Taip

50P Ne Ne Ne Ne Ne Taip Taip

29,97P Ne Ne Ne Ne Ne Ne Taip

25P Ne Ne Ne Ne Ne Ne Taip

23,98P Ne Ne Ne Ne Ne Ne Ne
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XAVC-L, 1920×1080 HD50, įprastas režimas

XAVC-L, 1920×1080 HD50, S&Q (60 kadr./sek. arba mažesnė sparta)

XAVC-L, 1920×1080 HD50, S&Q (100 kadr./sek., 120 kadr./sek.)

XAVC-L, 1920×1080 HD50, S&Q (150 kadr./sek., 180 kadr./sek.)

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Taip Ne Taip Taip Taip

50P Ne Ne Taip Ne Taip Taip Taip

29,97P Ne Ne Taip Ne Taip Taip Taip

25P Ne Ne Taip Ne Taip Taip Taip

23,98P Ne Ne Taip Ne Taip Taip Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Taip Taip Taip Taip Taip Taip Taip

50P Taip Taip Taip Taip Taip Taip Taip

29,97P Ne Ne Taip Ne Taip Taip Taip

25P Ne Ne Taip Ne Taip Taip Taip

23,98P Ne Ne Taip Ne Taip Taip Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Taip Ne Taip Taip Taip

50P Ne Ne Taip Ne Taip Taip Taip

29,97P Ne Ne Ne Ne Ne Taip Taip

25P Ne Ne Ne Ne Ne Taip Taip

23,98P Ne Ne Ne Ne Ne Taip Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Taip Taip

50P Ne Ne Ne Ne Ne Taip Taip
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XAVC-L, 1920×1080 HD50, S&Q (200 kadr./sek., 240 kadr./sek.)

XAVC-L, 1920×1080 HD35, įprastas režimas

XAVC-L, 1920×1080 HD35, S&Q (60 kadr./sek. arba mažesnė sparta)

XAVC-L, 1920×1080 HD35, S&Q (100 kadr./sek., 120 kadr./sek.)

29,97P Ne Ne Ne Ne Ne Ne Taip

25P Ne Ne Ne Ne Ne Ne Taip

23,98P Ne Ne Ne Ne Ne Ne Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Taip Taip

50P Ne Ne Ne Ne Ne Taip Taip

29,97P Ne Ne Ne Ne Ne Ne Taip

25P Ne Ne Ne Ne Ne Ne Taip

23,98P Ne Ne Ne Ne Ne Ne Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Taip Taip Taip Taip Taip Taip Taip

50P Taip Taip Taip Taip Taip Taip Taip

29,97P Taip Taip Taip Taip Taip Taip Taip

25P Taip Taip Taip Taip Taip Taip Taip

23,98P Taip Taip Taip Taip Taip Taip Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Taip Taip Taip Taip Taip Taip Taip

50P Taip Taip Taip Taip Taip Taip Taip

29,97P Ne Ne Taip Ne Taip Taip Taip

25P Ne Ne Taip Ne Taip Taip Taip

23,98P Ne Ne Taip Ne Taip Taip Taip
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XAVC-L, 1920×1080 HD35, S&Q (150 kadr./sek., 180 kadr./sek.)

XAVC-L, 1920×1080 HD35, S&Q (200 kadr./sek., 240 kadr./sek.)

[38] Parengiamieji veiksmai Konfigūravimas prieš fiksuojant vaizdus Atminties kortelių
paruošimas

Atminties kortelių įdėjimas

Šioje temoje aprašomos atsargumo priemonės, kurių būtina imtis įdedant atminties korteles.

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Taip Ne Taip Taip Taip

50P Ne Ne Taip Ne Taip Taip Taip

29,97P Ne Ne Taip Ne Taip Taip Taip

25P Ne Ne Taip Ne Taip Taip Taip

23,98P Ne Ne Ne Ne Ne Taip Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Taip Ne Taip Taip Taip

50P Ne Ne Taip Ne Taip Taip Taip

29,97P Ne Ne Ne Ne Ne Taip Taip

25P Ne Ne Ne Ne Ne Taip Taip

23,98P Ne Ne Ne Ne Ne Taip Taip

Sistemos dažnis Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Taip Ne Taip Taip Taip

50P Ne Ne Taip Ne Taip Taip Taip

29,97P Ne Ne Ne Ne Ne Taip Taip

25P Ne Ne Ne Ne Ne Taip Taip

23,98P Ne Ne Ne Ne Ne Ne Taip

Atidarykite laikmenų dangtelį kortelių lizdų skyriuje.1
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Įdėkite atminties kortelę.

Naudojant „CFexpress“ korteles etiketė turi būti nukreipta aukštyn.

Pastaba

Jei įrenginys sumontuotas prie lubų, etiketė turi būti nukreipta žemyn.

Naudojant SD korteles etiketė turi būti nukreipta žemyn.

Pastaba

Jei įrenginys sumontuotas prie lubų, etiketė turi būti nukreipta aukštyn.

Prieigos indikatorius šviečia raudonai, paskui, jei kortelė tinkama, ima šviesti žaliai.

Pastaba

Jei prieigos indikatorius nuolat mirksi raudonai ir nepasikeičia į žalią, laikinai išjunkite įrenginį,
tada išimkite ir vėl įdėkite atminties kortelę.

2

Uždarykite laikmenos skyriaus dangtelį.3
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Pastaba

Bandant per jėgą įkišti neteisingai nukreiptą kortelę į lizdą, galima sugadinti atminties kortelę,
atminties kortelės lizdą ir atminties kortelėje esančius vaizdo duomenis.

Kai įrašote į laikmenas, įstatytas į abu „CFexpress Type A“ / SD kortelių lizdus A ir B, į abu lizdus
įstatykite laikmenas, kurios rekomenduojamos pasirinktam įrašymo formatui.

[39] Parengiamieji veiksmai Konfigūravimas prieš fiksuojant vaizdus Atminties kortelių
paruošimas

Atminties kortelės išėmimas

Atidarykite laikmenų dangtelį kortelių lizdų skyriuje ir lengvai paspauskite atminties kortelę į
vidų, kad ji atsipalaiduotų ir išlįstų.

Pastaba

Jei įrenginys išjungiamas arba atminties kortelė išimama tuo metu, kai vyksta duomenų įrašymas ar
nuskaitymas, duomenų saugumas negali būti užtikrintas. Visi kortelėje įrašyti duomenys gali būti
sugadinti. Prieš išjungdami įrenginį arba išimdami atminties kortelę visada įsitikinkite, kad prieigos
indikatorius yra žalias arba nešviečia.

Kai išimate atminties kortelę iškart baigę filmuoti, atminties kortelė gali būti karšta, bet tai nėra
problemos požymis.

[40] Parengiamieji veiksmai Konfigūravimas prieš fiksuojant vaizdus Atminties kortelių
paruošimas

Atminties kortelių formatavimas (inicijavimas)

Jei įdedama nesuformatuota atminties kortelė arba atminties kortelė, kuri buvo suformatuota,
netinkamu formatu, fotoaparato vaizdo skydelyje rodomas pranešimas „Media Needs to be
Formatted“ (laikmeną reikia suformatuoti).
Suformatuokite kortelę atlikdami toliau aprašytą procedūrą.

Fotoaparato meniu pasirinkite [TC/Media] > [Format Media] (laiko kodas / laikmena >
formatuoti laikmeną).

1

Pasirinkite „Media(A)“ (lizdas A) arba „Media(B)“ (lizdas B), tada pasirinkite
formatavimo būdą:„Full Format“ (išsamus formatavimas) arba „Quick Format“
(greitas formatavimas).

Pasirodys patvirtinantis pranešimas.
[Full Format] (visiškai suformatuoti): laikmena visiškai inicijuojama, įskaitant duomenų
sritį ir duomenų valdymo informaciją.

2
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Pastaba

Formatuojant atminties kortelę ištrinami visi duomenys, įskaitant įrašytus vaizdo duomenis ir
nustatymų failus.

Atsižvelgiant į formatavimo proceso trukmę, pranešimai gali būti rodomi ir proceso eigoje.

Jei formatavimas nesėkmingas
Atminties kortelių, kurių įrenginys nepalaiko, suformatuoti negalima.
Bus rodomas įspėjamasis pranešimas. Vykdykite instrukcijas ir pakeiskite kortelę palaikoma
atminties kortele.

Jei įrenginyje suformatuotą kortelę norite naudoti kito įrenginio lizde
Pirmiausia pasidarykite kortelės atsarginę kopiją, tada iš naujo suformatuokite kortelę įrenginiu,
kuriame ruošiatės ją naudoti.

[41] Parengiamieji veiksmai Konfigūravimas prieš fiksuojant vaizdus Atminties kortelių
paruošimas

Likusio įrašymo laiko tikrinimas

Fiksuodami vaizdus (įrašant / budėjimo režimu) galite stebėti likusią atminties kortelės talpą
kiekviename lizde naudodami lizdų A/B likusio laikmenos laiko indikatorius fotoaparato vaizdo
skydelyje.
Likęs įrašymo laikas apskaičiuojamas pagal likusią laikmenos talpą kiekviename lizde ir tuo
metu naudojamą įrašymo formatą (įrašymo greitį bitais) ir rodomas minutėmis.

Atminties kortelės pakeitimo laikas
Kai iš viso įrašymo laiko abejose atminties kortelėse lieka mažiau nei 5 minutės, parodomas
pranešimas „Media Near Full“ (laikmena beveik užpildyta), o įrašymo / įspėjimo lemputė ima
mirksėti ir jus apie tai įspėja.
Pakeiskite laikmena, kurioje yra laisvos vietos.
Jei įrašymą tęsite, kol visas likęs laikas pasieks nulį, pranešimas pasikeis į „Media Full“
(laikmena pilna) ir įrašymas bus sustabdytas.

Pastaba

[Quick Format] (spartusis formatavimas): inicijuojama tik laikmenos duomenų valdymo
informacija.

Pasirinkite [Execute] (vykdyti).

Kol vyksta formatavimas, rodomas pranešimas, o prieigos indikatorius šviečia raudonai.
Formatavimui pasibaigus parodomas užbaigimo pranešimas.

3
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Į vieną atminties kortelę galima įrašyti maždaug iki 600 klipų

[42] Parengiamieji veiksmai Konfigūravimas prieš fiksuojant vaizdus Atminties kortelių
paruošimas

Atminties kortelių taisymas

Jei dėl kokios nors priežasties atminties kortelėje įvyko klaida, kortelę prieš naudojant reikia
sutaisyti.
Kai įdedate atminties kortelę, kurią reikia taisyti, fotoaparato vaizdo skydelyje parodomas
pranešimas, klausiantis, ar norite ją taisyti.

Kortelės taisymas
Rodyklių mygtukais GUI valdymo skydelyje pasirinkite [Execute] (vykdyti) ir paspauskite
mygtuką [Set] (nustatyti).
Kol vykdomas taisymas, rodomas pranešimas ir eigos būsena (%), o prieigos indikatorius
šviečia raudonai.
Kai taisymas baigiasi, rodomas pabaigos pranešimas.

Jei sutaisyti nepavyko
Atminties kortelių, kuriose įvyko atminties klaidos, sutaisyti negalima. Bus rodomas
įspėjamasis pranešimas. Vykdykite nurodymus ir pakeiskite atminties kortelę.
Atminties kortelės, kuriose įvyko atminties klaidos, gali būti vėl naudojamos jas
suformatavus.
Kai kuriais atvejais kai kurie klipai gali būti sutaisyti, o kiti ne. Sutaisyti klipai gali būti
atkuriami įprastai.

Pastaba

Šiuo įrenginiu įrašytoms laikmenoms taisyti būtinai naudokite šį įrenginį.

Laikmena, įrašyta ne šiuo įrenginiu arba kitos versijos įrenginiu (net to paties modelio), negali būti
sutaisyta naudojant šį įrenginį.

Trumpesnių nei 2 sekundės klipų sutaisyti negalima.

[43] Vaizdų fiksavimas Pagrindinės funkcijos

Įrašymo pradėjimas / sustabdymas

Šioje temoje aprašoma, kaip pradėti / sustabdyti įrašymą.

Pastaba

Įrašymas ir atkūrimas negalimi, kai įrenginiui maitinimas tiekiamas naudojant PoE++.
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Prijunkite reikalingus įrenginius ir patikrinkite, ar tiekiamas maitinimas į įrenginį ir
prijungtus įrenginius.

1

Įdėkite atminties kortelę (-es).2

Patikrinkite įrenginio maitinimo būseną, kuri rodoma viršutiniame kairiajame
žiniatinklio programos ekrano kampe.

Kai maitinimas įjungtas
Kai įrenginys įjungtas, ant maitinimo jungiklio žiniatinklio programos ekrano viršuje rodoma
[Power ON] (įjungta).

Įrenginio priekyje užsidega lemputė POWER, o žiniatinklio programos tiesioginio valdymo
ekrane pasirodo fotoaparato vaizdas.

Pastaba

Jei administratoriaus slaptažodis nesukonfigūruotas, pasirodo ekranas, kuriame raginama
slaptažodį sukonfigūruoti. Žr. „Įrenginio pradinių nustatymų atkūrimas“.

Kai maitinimo tiekimas yra budėjimo būsenos
Kai įrenginio maitinimas yra budėjimo būsenos, ant maitinimo jungiklio žiniatinklio
programoje rodoma [Power Standby] (maitinimo budėjimo režimas).

Esant šiai būsenai paspauskite maitinimo jungiklį ir pasirinkite [Power ON] (įjungti).
Įrenginys įjungiamas, įrenginio priekyje užsidega lemputė POWER, o žiniatinklio
programos tiesioginio valdymo ekrane pasirodo fotoaparato vaizdas.

Patarimas

Įrenginį galite įjungti ir naudodami maitinimo mygtuku pridedamame infraraudonųjų spindulių
nuotolinio valdymo pulte.

3
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Jei įrenginio maitinimą norite perjungti į budėjimo būseną
Žiniatinklio programoje paspauskite maitinimo mygtuką ir pasirinkite [Power Standby] (maitinimo
budėjimo režimas), kad įrenginio maitinimo šaltinį nustatytumėte į budėjimo būseną.

Patarimas

Maitinimo budėjimo būseną taip pat galite įjungti maitinimo mygtuku pridedamame infraraudonųjų
spindulių nuotolinio valdymo pulte.

Paspauskite įrašymo PRADĖJIMO / SUSTABDYMO mygtuką.

Įrašymas pradedamas, o įrenginyje užsidega įrašymo / įspėjimo lemputė (2 vietos).
Įrašymo metu įrašymo PRADĖJIMO / SUSTABDYMO mygtukas šviečia. Be to, rodoma
numatytos įrašymo laikmenos piktograma ir [?Rec].

4

Norėdami sustabdyti filmavimą, vėl paspauskite mygtuką START/STOP.

Įrašymas sustabdomas, o įrenginyje užgęsta įrašymo / įspėjimo lemputė (2 vietos).
Veikiant įrašymo budėjimo režimui įrašymo PRADĖJIMO / SUSTABDYMO mygtukas
nešviečia. Be to, rodoma numatytos įrašymo laikmenos piktograma ir [Stby].

Patarimas

Įrašymą galite pradėti / sustabdyti ir naudodami PRADĖJIMO / SUSTABDYMO mygtuką
pridedamame infraraudonųjų spindulių nuotolinio valdymo pulte.

5
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[44] Vaizdų fiksavimas Pagrindinės funkcijos

Atminties kortelių perjungimas

Jei įdėtos dvi atminties kortelės, žiniatinklio programos atkūrimo valdymo skydelyje
paspausdami mygtuką [Slot Select] (lizdo pasirinkimas) atminties korteles galite perjungti.

Patarimas

Be to, atminties korteles galite perjungti spausdami mygtuką SLOT SEL (atminties kortelės lizdo
(A)/(B) pasirinkimas) pridedamame infraraudonųjų spindulių nuotolinio valdymo pulte.

Apie nepertraukiamą įrašymą

Įrašymo metu įrenginys automatiškai persijungia į kitą atminties kortelę prieš pat pasibaigiant
laisvai vietai pirmojoje kortelėje (nepertraukiamas įrašymas). Perjungdami korteles galite
nepertraukiamai filmuoti pakeisdami užpildytą kortelę nauja atminties kortele.

Pastaba

Atkūrimo režimu kortelių perjungti negalima. Be to, klipo, padalyto laikmenose lizde A ir lizde B,
nepertraukiamas atkūrimas nepalaikomas.

Apie įrašytus duomenis

Kai sustabdote filmavimą, vaizdo įrašas, garsas ir susiję duomenys nuo filmavimo pradžios iki
pabaigos atminties kortelėje išsaugomi kaip vienas „klipas“.

Įrašytų duomenų klipo pavadinimas

Kiekvienam įrenginiu įrašytam klipui pavadinimas suteikiamas automatiškai fotoaparato meniu
naudojant [TC/Media] > [Clip Name Format] (laiko kodas / laikmena > klipo pavadinimo
formatas).

Maksimali klipo trukmė

Kiekvienas klipas gali trukti iki 6 valandų.
Maksimali nepertraukiamo filmavimo trukmė yra tokia pati, kaip maksimali klipo trukmė. Jei
įrašymo laikas viršija maksimalią klipo trukmę, automatiškai sukuriamas naujas klipas ir
filmavimas tęsiasi. Naujas klipas miniatiūrų ekrane rodomas kaip atskiras klipas.
Nepertraukiamo įrašymo metu paeiliui sukuriami vis nauji klipai, bet įrašymas sustabdomas
praėjus maždaug 24 valandoms.

Pastaba

Neišimkite atminties kortelės, kol į ją vyksta įrašymas. Kai vyksta filmavimas, atminties kortelę
keiskite tik tame lizde, kurio prieigos indikatorius nešviečia.

Kai atminties kortelėje, į kurią vyksta įrašymas, vietos lieka mažiau nei vienai minutei, o į kitą lizdą
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yra įdėta įrašoma atminties kortelė, bus rodomas pranešimas „Will Switch Slots Soon“ (lizdai greit
bus perjungti). Pranešimas dings perjungus atminties kortelių lizdus.

Įrašymas perjungiant kortelę gali neveikti, jei filmuoti pradedama, kai kortelėje likę laisvos vietos
mažiau nei vienai įrašo minutei. Kad tinkamai vyktų įrašymas perjungiant kortelę, prieš filmuodami
įsitikinkite, jog atminties kortelėje yra likę vietos daugiau nei vienai įrašo minutei.

Įrenginio nepertraukiamo įrašymo funkcija sukurto vaizdo įrašo negalima sklandžiai paleisti
įrenginyje.

Jei norite sujungti įrenginio nepertraukiamo įrašymo funkcija sukurtą vaizdo įrašą, naudokite
programinę įrangą „Catalyst Browse“.

[45] Vaizdų fiksavimas Pagrindinės funkcijos

Garso tikrinimas

Garsas yra išvestis iš įrenginio SDI ir HDMI jungčių. Garso kanalus, iš kurių išvesčiai
naudojama HDMI jungtis, galite pasirinkti fotoaparato meniu naudodami [Audio] > [Audio
Output] > [HDMI/Stream Output CH] (garsas > garso išvestis > HDMI / transliacijos išvesties
kanalas).
CH1/CH2: CH1 ir CH2 junginys
CH3/CH4: CH3 ir CH4 junginys
Jei garsą kontroliuojate žiniatinklio programoje, naudokite fotoaparato vaizdo apatiniame
dešiniajame kampe esantį garso lygio matuoklį.

[46] Vaizdų fiksavimas

Laiko duomenų nustatymas

Šioje temoje aprašoma, kaip nustatyti laiko duomenis.

Laiko kodo nustatymas

Įrašomą laiko kodą galite nustatyti fotoaparato meniu naudodami [TC/Media] > [Timecode]
(laiko kodas / laikmena > laiko kodas).

Naudotojo informacijos bitų nustatymas

Prie įrašyto vaizdo galite pridėti 8 skaitmenų šešioliktainį skaičių kaip naudotojo bitus. Be to,
galite nustatyti naudotojo bitus esamam laikui. Nustatykite fotoaparato meniu naudodami
[TC/Media] > [Users Bit] (laiko kodas / laikmena > naudotojų bitas).

Laiko duomenų rodymas

Nustatykite, kad būtų rodomas laiko kodas, fotoaparato meniu naudodami [TC/Media] > [TC
Display] > [Display Select] (laiko kodas / laikmena > laiko kodo rodymas > rodymo
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pasirinkimas).
Paspaudus priskiriamą mygtuką, kuriam priskirta [DURATION/TC/U-BIT] (trukmė / laiko kodas /
naudotojų bitas), rodomi duomenys bus paeiliui perjungiami tarp laiko kodo, naudotojo bitų ir
trukmės.

[47] Vaizdų fiksavimas

Įrašo peržiūra („Rec Review“)

Galite peržiūrėti paskutinį įrašytą klipą ekrane (įrašo peržiūra).

Pastaba

Funkcija „Rec Review“ (įrašo peržiūra) negalima, jei po klipo įrašymo buvo pakeistas vaizdo įrašo
formatas.

Funkcijos „Rec Review“ (įrašo peržiūra) pradinės padėties nustatymas

Atkūrimo pradinę padėtį galite nustatyti pasirinkdami vieną iš pateikiamų parinkčių fotoaparato
meniu eidami į [Technical] > [Rec Review] (techniniai > įrašo peržiūra).

Paskutinės 3 klipo sekundės
Paskutinė 10 klipo sekundžių
Nuo klipo pradžios

Patarimas

Jei įrašę kelis klipus norite peržiūrėti tam tikrą klipą, paspauskite miniatiūrų mygtuką [Thumbnail]
(miniatiūros), kad būtų parodytas miniatiūrų ekranas, ir pasirinkite klipą, kurį norite peržiūrėti.

Be to, miniatiūrų ekraną galite įjungti pridedamame infraraudonųjų spindulių nuotolinio valdymo pulte
paspausdami mygtuką THUMBNAIL.

Įrašo peržiūros būdas

Funkciją „Rec Review“ priskirkite vienam iš priskiriamų mygtukų pagrindinių funkcijų
konfigūracijos reguliavimo skydelyje.

Išsamesnė informacija apie priskyrimą pateikiama „Priskiriami mygtukai“ dalyje „Naudingos
funkcijos“.

Sustabdykite įrašymą, tada paspauskite priskiriamą mygtuką, kuriam priskirta funkcija „Rec
Review“, kad paleistumėte anksčiau įrašymo klipo atkūrimą.
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Klipas bus parodytas iki galo, „Rec Review“ (įrašo peržiūra) baigsis, o įrenginys grįš į „Stby“
(budėjimo) režimą.

Funkcijos „Rec Review“ (įrašo peržiūra) sustabdymas
Paspauskite priskiriamą mygtuką, kuriam priskirta funkcija „Rec Review“ (įrašo peržiūra), arba
paspauskite mygtuką [Cancel/Back] (atšaukti / atgal).
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Patarimas

Be to, funkciją „Rec Review“ (įrašo peržiūra) galite sustabdyti pridedamame infraraudonųjų spindulių
nuotolinio valdymo pulte paspausdami mygtuką [Cancel/Back] (atšaukti / atgal).

[48] Vaizdų fiksavimas Kadravimo reguliavimas

Kadravimo reguliavimo ekranas

Kadravimas reguliuojamas naudojant toliau nurodytas tiesioginio valdymo ekrano dalis.

Pastaba

Atsižvelgiant į fotoaparato kryptį, objektyvo židinio nuotolį ir priartinimo padėtį, gali būti matomos
įrenginio dalys arba prie jungčių bloko prijungti kabeliai. Prieš fiksuodami vaizdus patikrinkite
objektyvo matymo lauką ir naudojamą židinio nuotolį. Pasukimo / pakreipimo funkcijos diapazoną
taip pat galite valdyti žiniatinklio meniu naudodami [Pan-Tilt] > [P/T Range Limit] (pasukimas /
pakreipimas > pasukimo / pakreipimo diapazono apribojimas). Kai įrenginys įjungiamas arba
atliekamas pasukimo / pakreipimo funkcijos nustatymas iš naujo, šio diapazono apribojimo
nustatymo nepaisoma. Išsamesnė informacija pateikiama žiniatinklio meniu [Pan-Tilt] > [P/T Range
Limit] (pasukimas pakreipimas > pasukimo / pakreipimo diapazono apribojimas).

Patarimas

Iš anksto nustatytų padėčių valdymo skydelis1.

(pagrindinis) skirtukas / (kita) skirtukas2.

Kadravimo valdymo skydelis3.



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

Kadravimą galite valdyti ir naudodami pridedamą infraraudonųjų spindulių nuotolinio valdymo pultą.

[49] Vaizdų fiksavimas Kadravimo reguliavimas Vaizdų fiksavimo krypties reguliavimas

Vaizdų fiksavimo krypties reguliavimas naudojant
žiniatinklio programą

Fotoaparato sukimas horizontaliai vadinamas pasukimu, o vertikaliai – pakreipimu.
Vaizdų fiksavimo kryptį galite koreguoti naudodami pasukimo / pakreipimo funkciją.

Patarimas

Jei po manipuliatoriumi rodoma [Execute Pan-Tilt Reset] (vykdyti pasukimo / pakreipimo nustatymą
iš naujo), vadinasi, yra įrenginio pasukimo / pakreipimo valdymo pradžios informacijos neatitikimų.
Kad būtų atnaujinta pradžios informacija, atlikite pasukimo / pakreipimo funkcijos nustatymą iš naujo.
Išsamesnė informacija pateikiama dalyje „Pasukimo / pakreipimo nustatymas iš naujo“.

Kad fotoaparatas vėl būtų nukreiptas į priekį
Spauskite mygtuką [Pan-Tilt Home] (pradinė pasukimo / pakreipimo padėtis) fotoaparato
valdymo skydelio skirtuke  (kita).

Pastaba

Atsižvelgiant į fotoaparato kryptį, objektyvo židinio nuotolį ir priartinimo padėtį, gali būti matomos
įrenginio dalys arba prie jungčių bloko prijungti kabeliai. Prieš fiksuodami vaizdus patikrinkite

Kadravimo valdymo skydelyje paspauskite skirtuką [Pan-Tilt-Zoom] (pasukimas /
pakreipimas / priartinimas), kad būtų parodytas manipuliatorius.

1

Manipuliatoriaus centrą vilkite norima matyti kryptimi ir stebėkite fotoaparato vaizdo
skydelį.

Fotoaparato kryptis ir greitis keičiasi pagal vilkimo kryptį ir lygį.
Pasukimą / pakreipimą tiksliau galite sureguliuoti spausdami aplinkines manipuliatoriaus
sritis.

2
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objektyvo matymo lauką ir naudojamą židinio nuotolį. Pasukimo / pakreipimo funkcijos diapazoną
taip pat galite valdyti žiniatinklio meniu naudodami [Pan-Tilt] > [P/T Range Limit] (pasukimas /
pakreipimas > pasukimo / pakreipimo diapazono apribojimas). Kai įrenginys įjungiamas arba
atliekamas pasukimo / pakreipimo funkcijos nustatymas iš naujo, šio diapazono apribojimo
nustatymo nepaisoma. Išsamesnė informacija pateikiama žiniatinklio meniu [Pan-Tilt] > [P/T Range
Limit] (pasukimas pakreipimas > pasukimo / pakreipimo diapazono apribojimas).

[50] Vaizdų fiksavimas Kadravimo reguliavimas Vaizdų fiksavimo krypties reguliavimas

Pasukimo / pakreipimo greičio nustatymas

Pasukimo / pakreipimo funkcijos veikimo greitį galite pakeisti naudodami slankiklį [Pan-Tilt
Speed] (pasukimo / pakreipimo greitis) fotoaparato valdymo skydelyje – tam naudokite
manipuliatorių kadravimo valdymo skydelyje.

Pastaba

Jei fotoaparato judėjimo srityje yra siena ar kita kliūtis, saugokite, kad fotoaparatas ar objektyvas į ją
neatsitrenktų naudojant pasukimo / pakreipimo funkciją.

Pasukimo / pakreipimo funkcijos spartinimas priklauso nuo fizinių savybių, pvz., objektyvo svorio
balanso. Spartinimo nustatymą galite keisti žiniatinklio meniu arba fotoaparato meniu naudodami
[Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] (pasukimas / pakreipimas > pasukimo / pakreipimo

Fotoaparato valdymo skydelyje paspauskite skirtuką  (pagrindinis).1

Sąraše pasirinkite slankiklį [Pan-Tilt Speed] (pasukimo / pakreipimo greitis).

Jei slankiklis [Pan-Tilt Speed] (pasukimo / pakreipimo greitis) nerodomas, pasirinkite vieną
iš dviejų slankiklio funkcijos pasirinkimo mygtukų, kad slankiklis būtų parodytas.

2

Slankiklio rankenėlę perkelkite į kairę ar dešinę.

Perkėlus rankenėlę į kairę veikimo greitis sumažinamas, o į dešinę – padidinamas.

3
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spartinimas > kylanti kreivė).

[51] Vaizdų fiksavimas Kadravimo reguliavimas Vaizdų fiksavimo krypties reguliavimas

Pasukimo / pakreipimo spartinimo nustatymas

Spartinimą galite nustatyti devyniais žingsniais žiniatinklio meniu arba fotoaparato meniu
naudodami [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] (pasukimas / pakreipimas >
pasukimo / pakreipimo spartinimas > kylanti kreivė). Reikšmę padidinkite, jei norite spartesnio
greičio pasikeitimo, ir ją sumažinkite, jei norite, kad greitis keistųsi palaipsniui.
Kad pasukimo / pakreipimo funkcija būtų jautresnė, pasirinkite reikšmę nuo 7 iki 9.
Kad judėjimo į iš anksto nustatytą padėtį pradžioje / pabaigoje būtų išlaikytas didesnis vietos
tikslumas, rekomenduojama reikšmę nustatyti nuo 1 iki 6.

Išsamesnė informacija apie iš anksto nustatytą padėtį pateikiama dalyje „Pasukimo /
pakreipimo ir priartinimo padėties išsaugojimas / atkūrimas“.

Pastaba

Jei pasirenkama didelė reikšmė, funkcija gali veikti netinkamai uždėjus sunkų objektyvą. Patikrinkite,
kaip funkcija veikia prieš pradėdami ją naudoti iš tikrųjų.

Nustatymo [Ramp Curve] (kylanti kreivė) ir pasukimo / pakreipimo
funkcijos veikimo ryšys

Kai naudojama pasukimo / pakreipimo funkcija

Kai naudojama iš anksto išsaugota padėtis
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[52] Vaizdų fiksavimas Kadravimo reguliavimas Vaizdų fiksavimo krypties reguliavimas

Vaizdų fiksavimo krypties reguliavimas naudojant
pridedamą infraraudonųjų spindulių nuotolinio
valdymo pultą

Vaizdų fiksavimo kryptį galite koreguoti naudodami pasukimo / pakreipimo funkcijos mygtukus
pridedamame infraraudonųjų spindulių nuotolinio valdymo pulte.

Pasukimo / pakreipimo funkciją valdykite spausdami rodyklių mygtukus.

Stebėdami fotoaparato vaizdą spauskite norimos matyti krypties rodyklės mygtuką.
Jei norite pasukti tik šiek tiek, rodyklės mygtuką spustelėkite trumpai.
Jei norite pasukti daugiau, rodyklės mygtuką paspauskite ir palaikykite.
Jei norite pasukti įstrižai, laikykite nuspaudę mygtuką  (rodyklė aukštyn) arba 
(rodyklė žemyn) ir paspauskite mygtuką  (rodyklė į kairę) arba  (rodyklė į dešinę).

1
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Kad fotoaparatas vėl būtų nukreiptas į priekį
Paspauskite mygtuką HOME.

Pastaba

Atsižvelgiant į fotoaparato kryptį, objektyvo židinio nuotolį ir priartinimo padėtį, gali būti matomos
įrenginio dalys arba prie jungčių bloko prijungti kabeliai. Prieš fiksuodami vaizdus patikrinkite
objektyvo matymo lauką ir naudojamą židinio nuotolį. Pasukimo / pakreipimo funkcijos diapazoną
taip pat galite valdyti žiniatinklio meniu naudodami [Pan-Tilt] > [P/T Range Limit] (pasukimas /
pakreipimas > pasukimo / pakreipimo diapazono apribojimas). Kai įrenginys įjungiamas arba
atliekamas pasukimo / pakreipimo funkcijos nustatymas iš naujo, šio diapazono apribojimo
nustatymo nepaisoma. Išsamesnė informacija pateikiama žiniatinklio meniu [Pan-Tilt] > [P/T Range
Limit] (pasukimas pakreipimas > pasukimo / pakreipimo diapazono apribojimas).

[53] Vaizdų fiksavimas Kadravimo reguliavimas Priartinimo reguliavimas

Priartinimo tipo nustatymas

Priartinimo tipą nustatykite fotoaparato meniu naudodami [Technical] > [Zoom] > [Zoom Type]
(techniniai > priartinimas > priartinimo tipas).
Transfokavimo tipas priklausys nuo naudojamo objektyvo tipo.

Uždėto objektyvo tipas

[Zoom Type] (priartinimo tipo) nustatymas

Optical zoom only
(tik optinis

priartinimas):

[On(Clear Image Zoom)]
(įjungta („Clear Image

Zoom“)

Fiksuoto židinio nuotolio objektyvas
/ objektyvas su rankiniu priartinimu

Priartinimo
reguliavimas
negalimas.

Funkcija „Clear Image Zoom“
palaikoma.
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Pastaba

Funkcija „Clear Image Zoom“ negalima šiais atvejais.
Kai [Shooting] > [S&Q Motion] > [Setting] (vaizdų fiksavimas > sulėtintas ir pagreitintas filmavimas
> nustatymas) nustatytas kaip On (įjungta), o nustatymas [Frame Rate] (kadrų sparta) fotoaparato
meniu yra didesnis nei 60 kadr./sek.
Kai fotoaparato meniu [Project] > [Rec Format] > [Codec] (projektas > įrašymo formatas >
kodekas) nustatyta kaip [RAW] ar parinktis su RAW

Jei naudojate pasirinkimo mygtuką SERVO/MANUAL ant objektyvo, funkcijos „Clear Image Zoom“
išdidinimo reikšmė grąžinama į 1x.

Naudojant „Clear Image Zoom“ fokusavimo sritis nustatoma kaip Wide (plati). Be to, išjungiamas
veido / akių aptikimo AF.

Kai nustatoma kaip [On(Clear Image Zoom)] (įjungta („Clear Image Zoom“), pasukimo / pakreipimo
išankstinio nustatymo funkcija išjungiama.

Clear Image Zoom

Įrenginyje įdiegta priartinimo funkcija, kuri naudoja vaizdo signalo apdorojimą, vadinamą „Clear
Image Zoom“. Kai funkcija „Clear Image Zoom“ įjungta, priartinimas galimas net naudojant
fiksuoto židinio nuotolio objektyvus. Be to, ši funkcija gali būti naudojama optinio transfokavimo
diapazonui išplėsti kintamojo židinio nuotolio objektyvuose su automatizuota pavara.
Maksimalus priartinimo santykis naudojant „Clear Image Zoom“ priklauso nuo filmavimo raiškos.

Naudojant QFHD/4K įrašymo raišką: 1,5×
Naudojant HD įrašymo raišką: 2×

[54] Vaizdų fiksavimas Kadravimo reguliavimas Priartinimo reguliavimas

Priartinimo reguliavimas naudojant žiniatinklio
programą

Įrenginio priartinimą galima reguliuoti naudojant optinį priartinimą arba „Clear Image Zoom“.
Šioje temoje aprašoma, kaip atlikti pakeitimus naudojant žiniatinklio programą. Išsamesnė
informacija apie „Clear Image Zoom“ pateikiama dalyje „Priartinimo tipo nustatymas“.

Automatizuotas kintamo židinio
objektyvas

Galimas tik optinis
priartinimas.

Palaikomas optinis
transfokavimas ir „Clear
Image Zoom“.

Kadravimo valdymo skydelyje paspauskite skirtuką [Pan-Tilt-Zoom] (pasukimas /
pakreipimas / priartinimas), kad būtų parodytas pasukimo / pakreipimo valdymo
skydelis.

1

Paslinkite slankiklio rankenėlę [Zoom] (priartinimas) link [T] (teleobjektyvas) arba
[W] (plačiakampis) ir sureguliuokite priartinimą.

2



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

Pastaba

Atsižvelgiant į fotoaparato kryptį, objektyvo židinio nuotolį ir priartinimo padėtį, gali būti matomos
įrenginio dalys arba prie jungčių bloko prijungti kabeliai. Prieš fiksuodami vaizdus patikrinkite
objektyvo matymo lauką ir naudojamą židinio nuotolį. Pasukimo / pakreipimo funkcijos diapazoną
taip pat galite valdyti žiniatinklio meniu naudodami [Pan-Tilt] > [P/T Range Limit] (pasukimas /
pakreipimas > pasukimo / pakreipimo diapazono apribojimas). Kai įrenginys įjungiamas arba
atliekamas pasukimo / pakreipimo funkcijos nustatymas iš naujo, šio diapazono apribojimo
nustatymo nepaisoma. Išsamesnė informacija pateikiama žiniatinklio meniu [Pan-Tilt] > [P/T Range
Limit] (pasukimas pakreipimas > pasukimo / pakreipimo diapazono apribojimas).

[55] Vaizdų fiksavimas Kadravimo reguliavimas Priartinimo reguliavimas

Priartinimo greičio nustatymas

Priartinimo veikimo greitį pagal slankiklį [Zoom] (priartinimas) kadravimo valdymo skydelyje
galite keisti naudodami slankiklį [Zoom Speed] (priartinimo greitis) fotoaparato valdymo
skydelyje.

Fotoaparato valdymo skydelyje paspauskite skirtuką  (pagrindinis).1

Sąraše pasirinkite slankiklį [Zoom Speed] (priartinimo greitis).

Jei slankiklis [Zoom Speed] (priartinimo greitis) nerodomas, pasirinkite vieną iš dviejų
slankiklio funkcijos pasirinkimo mygtukų, kad slankiklis būtų parodytas.

 

2
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[56] Vaizdų fiksavimas Kadravimo reguliavimas Priartinimo reguliavimas

Priartinimo reguliavimas naudojant pridedamą
infraraudonųjų spindulių nuotolinio valdymo pultą

Įrenginio priartinimą galima reguliuoti naudojant optinį priartinimą arba „Clear Image Zoom“.
Šioje temoje aprašoma, kaip atlikti pakeitimus naudojant pridedamą infraraudonųjų spindulių
nuotolinio valdymo pultą. Išsamesnė informacija apie „Clear Image Zoom“ pateikiama dalyje
„Priartinimo tipo nustatymas“.

Slankiklio rankenėlę [Zoom Speed] (priartinimo greitis) perkelkite į kairę ar dešinę.

Perkėlus rankenėlę į kairę veikimo greitis sumažinamas, o į dešinę – padidinamas.

3

Priartinimą sureguliuokite spausdami priartinimo mygtuką.

Stebėdami ekrane spauskite mygtuką T (teleobjektyvas) arba W (plačiakampis) ir
sureguliuokite priartinimą.
Jei vaizdą norite priartinti, spauskite mygtuką T.
Jei vaizdą norite atitolinti, spauskite mygtuką W.

1



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

Pastaba

Atsižvelgiant į fotoaparato kryptį, objektyvo židinio nuotolį ir priartinimo padėtį, gali būti matomos
įrenginio dalys arba prie jungčių bloko prijungti kabeliai. Prieš fiksuodami vaizdus patikrinkite
objektyvo matymo lauką ir naudojamą židinio nuotolį. Pasukimo / pakreipimo funkcijos diapazoną
taip pat galite valdyti žiniatinklio meniu naudodami [Pan-Tilt] > [P/T Range Limit] (pasukimas /
pakreipimas > pasukimo / pakreipimo diapazono apribojimas). Kai įrenginys įjungiamas arba
atliekamas pasukimo / pakreipimo funkcijos nustatymas iš naujo, šio diapazono apribojimo
nustatymo nepaisoma. Išsamesnė informacija pateikiama žiniatinklio meniu [Pan-Tilt] > [P/T Range
Limit] (pasukimas pakreipimas > pasukimo / pakreipimo diapazono apribojimas).

[57] Vaizdų fiksavimas Kadravimo reguliavimas Fotoaparato pasukimo / pakreipimo /
priartinimo padėties išsaugojimas / atkūrimas

Objektyvo su E tipo tvirtinimu kalibravimas

Kalibruojant pataisomi priartinimo padėties skirtumai dėl kiekvieno objektyvo skirtingų savybių,
kai naudojamas E tipo tvirtinimo automatizuotas kintamo židinio nuotolio objektyvas.
Jei norite tiksliai apskaičiuoti priartinimo padėtį, vadovaudamiesi toliau pateikiama procedūra
sukalibruokite objektyvą, kad būtų pataisyti objektyvo skirtumai.

Kalibravimo duomenys
Įrenginyje galima išsaugoti iki penkių objektyvų kalibravimo duomenis. Seniausi duomenys
perrašomi, kai sukalibruojamas 6-asis ar vėlesnis objektyvas.
Jei norite patikrinti, ar uždėtam objektyvui yra išsaugoti kalibravimo duomenys, bendrojoje
žiniatinklio programos ekrano srityje paspauskite mygtuką  (fotoaparato būsena) ir
pasirinkite [Lens] > [Calibration Data] (objektyvas > kalibravimo duomenys).

[58] Vaizdų fiksavimas Kadravimo reguliavimas Fotoaparato pasukimo / pakreipimo /
priartinimo padėties išsaugojimas / atkūrimas

Pasukimo / pakreipimo, priartinimo padėties ir

Jei ant objektyvo yra jungiklis SERVO/MANUAL, nustatykite jį į padėtį SERVO.

Pastaba

Objektyvas negalės gauti priartinimo signalų iš įrenginio, jei jungiklis bus nustatytas į padėtį
MANUAL.

1

Paleiskite kalibravimą naudodami [Technical] > [Lens] > [Lens Calibration]
(techniniai > objektyvas > objektyvo kalibravimas) fotoaparato meniu.

Kalibravimo metu kintamo židinio nuotolio objektyvas juda automatiškai ir yra
išmatuojamas.

2
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fokusavimo nustatymo išsaugojimas / atkūrimas
naudojant žiniatinklio programą

Pasukimo / pakreipimo, priartinimo padėtį ir fokusavimo nustatymą galite išsaugoti ir vėliau juos
panaudoti žiniatinklio programoje.

Išsamesnė informacija apie elementus, kuriuos galima išsaugoti / atkurti, pateikiama dalyje
Išsaugoti išankstinių nustatymų pozicijų elementai“.

Pastaba

Ši funkcija yra išjungiama, kai fotoaparato meniu [Technical] > [Zoom] > [Zoom Type] (techniniai >
priartinimas > priartinimo tipas) nustatoma kaip [On(Clear Image Zoom)] (įjungta („Clear Image
Zoom“)

Jei nustatymas [Pan-Tilt] > [P/T Direction] [Ceiling] (pasukimas / pakreipimas > pasukimo /
pakreipimo kryptis > lubos) žiniatinklio menu pakeičiamas, visi išsaugoti išankstiniai nustatymai
ištrinami.

Nustatykite norimą išsaugoti pasukimo / pakreipimo ir priartinimo padėtį.1

Iš anksto nustatytų padėčių valdymo skydelyje paspauskite mygtuką [+].

Iš anksto nustatytų padėčių valdymo skydelyje parodomas vaizdas su išsaugota padėtimi.

Patarimas

Jei iš anksto nustatytų padėčių valdymo skydelis nerodomas, paspauskite mygtuką 
(atidaryti), kad jį įjungtumėte.

Padėtys išsaugomos iš eilės pradedant [Preset1] (1 išankstinis nustatymas).

Jei išankstinių nustatymų sekoje yra nepanaudotų išankstinių nustatymų, padėtys pirmiausia
bus išsaugotos laisvuose išankstiniuose nustatymuose. Pavyzdžiui, jei padėčių išankstiniai
nustatymai yra išsaugoti [Preset1] ir [Preset3], o [Preset2] yra nepanaudotas, kitas padėties

2
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[59] Vaizdų fiksavimas Kadravimo reguliavimas Fotoaparato pasukimo / pakreipimo /
priartinimo padėties išsaugojimas / atkūrimas

Padėties išankstinių nustatymų pervardijimas
naudojant žiniatinklio programą

Padėties išankstinius nustatymus galite pervardyti.

išankstinis nustatymas bus išsaugotas [Preset2], o tada – [Preset4].

Galima išsaugoti iki 100 padėčių išankstinių nustatymų.

Kiekvieną padėties išankstinį nustatymą galite pervardyti. Išsamesnė informacija pateikiama
dalyje „Padėties išankstinių nustatymų pervardijimas naudojant žiniatinklio programą“.

Atkurkite išsaugotą padėtį.

Dukart paspauskite norimą atkurti padėties miniatiūrą iš anksto nustatytų padėčių valdymo
skydelyje, kad atitinkamą padėtį atkurtumėte.

Patarimas

Padėtį galite atkurti ir paspausdami vaizdą, spausdami pasirodžiusį mygtuką  (išankstinių
nustatymų padėčių meniu) ir pasirinkdami [Recall] (atkurti).

Perėjimo greitis į išsaugotą padėtį nustatomas naudojant nustatymą [Pan-Tilt] > [P/T Preset] >
[Common Speed] (pasukimas / pakreipimas > pasukimo / pakreipimo išankstinis nustatymas >
bendrasis greitis) žiniatinklio meniu, jei pozicija yra išsaugota. Be to, perėjimo greitį galite keisti
išsaugoję. Išsamesnė informacija pateikiama dalyje „Padėties išankstinių nustatymų perėjimo
greičio keitimas“.

Pasukimo / pakreipimo padėties pasikeitimo laipsnis nustačius iš anksto nustatytą padėtį gali
būti reguliuojamas naudojant perėjimo greičio ir [Ramp Curve] (kylanti kreivė) nustatymus.
Išsamesnė informacija pateikiama dalyje „Padėties išankstinių nustatymų perėjimo greičio
keitimas“ ir „Pasukimo / pakreipimo spartinimo nustatymas“.

3

Paspauskite norimą pervardyti padėties išankstinį nustatymą.

Vaizdo viršutiniame dešiniajame kampe pasirodys mygtukas  (išankstinių nustatymų
padėčių meniu).

1

Paspauskite mygtuką  (išankstinių nustatymų padėčių meniu) ir pasirodžiusiame
meniu pasirinkite [Rename] (pervardyti).

2

Įveskite naują išankstinio nustatymo pavadinimą.3
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[60] Vaizdų fiksavimas Kadravimo reguliavimas Fotoaparato pasukimo / pakreipimo /
priartinimo padėties išsaugojimas / atkūrimas

Išsaugotos padėties keitimas nauja padėtimi
naudojant žiniatinklio programą

Išsaugotą padėtį galite pakeisti nauja padėtimi.

[61] Vaizdų fiksavimas Kadravimo reguliavimas Fotoaparato pasukimo / pakreipimo /
priartinimo padėties išsaugojimas / atkūrimas

Išsaugotos padėties trynimas naudojant žiniatinklio
programą

Padėties išankstinius nustatymus galite ištrinti.

[62] Vaizdų fiksavimas Kadravimo reguliavimas Fotoaparato pasukimo / pakreipimo /

Nustatykite norimą išsaugoti pasukimo / pakreipimo ir priartinimo padėtį.1

Paspauskite norimos keisti padėties vaizdą išankstinių nustatymų padėčių valdymo
skydelyje.

Viršutiniame dešiniajame kampe pasirodo mygtukas  (išankstinių nustatymų padėčių
meniu).

2

Paspauskite mygtuką  (išankstinių nustatymų padėčių meniu) ir pasirodžiusiame
meniu pasirinkite [Replace] (pakeisti).

Nauja padėtis pakeičia esamą nustatymą.

3

Paspauskite norimos ištrinti padėties vaizdą išankstinių nustatymų padėčių
valdymo skydelyje.

Vaizdo viršutiniame dešiniajame kampe pasirodys mygtukas  (išankstinių nustatymų
padėčių meniu).

1

Paspauskite mygtuką  (išankstinių nustatymų padėčių meniu) ir pasirodžiusiame
meniu pasirinkite [Delete] (trinti).

Išsaugota padėtis ištrinama.

2
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priartinimo padėties išsaugojimas / atkūrimas

Padėties išankstinių nustatymų perėjimo greičio
keitimas

Galite pakeisti perėjimo greitį, kai atkuriama išsaugota padėtis.

Patarimas

Kai [Pan-Tilt] > [P/T Preset] > [Speed Select] (pasukimas / pakreipimas > pasukimo / pakreipimo
išankstinis nustatymas > greičio pasirinkimas) nustatyta kaip [Common] (bendras), visos padėtys bus
atkurtos nustatytu greičiu naudojant [Pan-Tilt] > [P/T Preset] > [Common Speed] (pasukimas /
pakreipimas > pasukimo / pakreipimo išankstinis nustatymas > bendras greitis).

[63] Vaizdų fiksavimas Kadravimo reguliavimas Fotoaparato pasukimo / pakreipimo /
priartinimo padėties išsaugojimas / atkūrimas

Pasukimo / pakreipimo ir priartinimo padėties
išsaugojimas / atkūrimas naudojant pridedamą
infraraudonųjų spindulių nuotolinio valdymo pultą

Pasukimo / pakreipimo ir priartinimo padėtis galite išsaugoti ir jas prireikus atkurti naudodami
pridedamą infraraudonųjų spindulių nuotolinio valdymo pultą.

Žiniatinklio meniu [Pan-Tilt] > [P/T Preset] > [Speed Select] (pasukimas /
pakreipimas > pasukimo / pakreipimo greitis > greičio pasirinkimas) nustatykite kaip
[Separate] (atskirti).

1

Paspauskite padėties, kurios perėjimo greitį norite keisti, vaizdą išankstinių
nustatymų padėčių valdymo skydelyje.

Vaizdo viršutiniame dešiniajame kampe pasirodys mygtukas  (išankstinių nustatymų
padėčių meniu).

2

Paspauskite mygtuką  (išankstinių nustatymų padėčių meniu) ir pasirodžiusiame
meniu pasirinkite [Speed] )(greitis).

3

Pasirinkite norimą perėjimo greitį.

Kitą kartą atkūrus išsaugotą padėtį, fotoaparatas judės sukonfigūruotu greičiu.

4

Sureguliuokite fotoaparato pasukimą / pakreipimą ir priartinimą.1
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[64] Vaizdų fiksavimas Fokusavimo reguliavimas

Fokusavimo reguliavimo ekranas

Fokusavimas reguliuojamas naudojant toliau aprašytas tiesioginio valdymo ekrano dalis.

Paspauskite ir palaikykite mygtuką PRESET, tada paspauskite vieną iš 1–3 mygtukų.

Padėtis išsaugoma.

2

Atkurkite išsaugotą padėtį.

Paspauskite vieną iš 1–3 mygtukų, kuriems yra išsaugotos padėtys, kad atkurtumėte
reikiamą padėtį.

Patarimas

Jei naudojate infraraudonųjų spindulių nuotolinio valdymo pultą, vaizdas bus perkeltas į
išsaugotą padėtį didžiausiu greičiu.
Be to, perėjimo greitį galite keisti išsaugoję. Išsamesnė informacija pateikiama dalyje „Padėties
išankstinių nustatymų perėjimo greičio keitimas“.

3
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[65] Vaizdų fiksavimas Fokusavimo reguliavimas Fokusavimo reguliavimas rankiniu būdu
(rankinis fokusavimas)

Rankinis koregavimas naudojant žiniatinklio programą

Fokusavimą galite reguliuoti rankiniu būdu, pvz., toliau nurodytais atvejais.

Objektai iš dalies neryškūs dėl vandens lašelių
Objektus, kurie yra mažai kontrastingi fono atžvilgiu
Objektus, esančius toliau nei arti esantys objektai

Fotoaparato vaizdo skydelis
Fokusavimą galite reguliuoti liesdami fotoaparato vaizdą. Jutiklinį valdymą galite išjungti
išjungę jungiklį [Touch Focus] (jutiklinis fokusavimas) fotoaparato valdymo skydelio skirtuke 

 (fokusavimas).

1.

Fotoaparato valdymo skydelis  (fokusavimo) skirtukas2.

GUI valdymo skydelis3.

Jei objektyve yra fokusavimo pasirinkimo jungiklis, nustatykite šį jungiklį į padėtį
„AF/MF“ arba „AF“.

Pastaba

Jei jungiklis nustatytas į padėtį „Full MF“ arba „MF“, objektyvo fokusavimo nebus galima valdyti
iš įrenginio. Žr. „Objektyvo su fokusavimo režimo jungikliu fokusavimo reguliavimas“ dalyje

1
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Patarimas

Be to, automatinį fokusavimą galite naudoti, kai rankinis reguliavimas yra pagrindinis valdymo būdas.
Išsamesnė informacija pateikiama dalyje „Rankinis automatinio fokusavimo taikinio nustatymas (AF
pagalba) naudojant žiniatinklio programą“.

[66] Vaizdų fiksavimas Fokusavimo reguliavimas Fokusavimo reguliavimas rankiniu būdu
(rankinis fokusavimas)

Rankinis reguliavimas naudojant pridedamą
infraraudonųjų spindulių nuotolinio valdymo pultą

Fokusavimą galite reguliuoti rankiniu būdu naudodami pridedamą infraraudonųjų spindulių
nuotolinio valdymo pultą.

„Objektyvo jungiklių tikrinimas“.

Fotoaparato valdymo skydelyje paslinkite jungiklį [Auto Focus] (automatinis
fokusavimas) į kairiąją padėtį, kad automatinį fokusavimą išjungtumėte.

Suaktyvinamas rankinio fokusavimo režimas.

 (MF)

2

Sureguliuokite naudodami slankiklį  (fokusavimo) skirtuko apačioje.3

Paspauskite infraraudonųjų spindulių nuotolinio valdymo pulto MF mygtuką.1

Fokusavimą sureguliuokite rankiniu būdu mygtuku F (toli) ir N (arti).

Jei norite sufokusuoti toli esantį objektą, spauskite mygtuką F.
Jei norite sufokusuoti arti esantį objektą, spauskite mygtuką N.

2
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Patarimas

Be to, automatinį fokusavimą galite naudoti, kai rankinis reguliavimas yra pagrindinis valdymo būdas.
Išsamesnė informacija pateikiama dalyje „Rankinis fokusavimas veikiant automatiniam fokusavimui
naudojant pridedamą infraraudonųjų spindulių nuotolinio valdymo pultą“.

[67] Vaizdų fiksavimas Fokusavimo reguliavimas Fokusavimo reguliavimas rankiniu būdu
(rankinis fokusavimas)

Fokusavimas nurodant fokusavimo padėtį (taškinis
fokusavimas)

Veikiant rankinio fokusavimo režimui fotoaparato vaizdo skydelyje galite nurodyti vietą, kurioje
norite reguliuoti fokusavimą.

Žiniatinklio meniu arba fotoaparato meniu [Shooting] > [Focus] > [Touch Function in
MF] (vaizdų fiksavimas > fokusavimas > lietimo funkcija naudojant MF) nustatykite
kaip [Spot Focus] (taškinis fokusavimas).

1

Kad įjungtumėte, paslinkite jungiklį [Touch Focus] (jutiklinis fokusavimas) skirtuke 
 (fokusavimas) į dešiniąją padėtį.

2

Kad išjungtumėte, paslinkite jungiklį [Auto Focus] (automatinis fokusavimas)
skirtuke  (fokusavimas) į kairiąją padėtį.

3

Nurodykite fokusavimo vietą.

Pasirodo taškinio fokusavimo žymeklis, o vaizdas sureguliuojamas sufokusuojant šią vietą.

4
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Pastaba

Taškinio fokusavimo funkcija neveiks, jei objektyvas nustatytas veikti rankinio fokusavimo režimu.

Patarimas

Veikiant taškinio fokusavimo režimui paspausdami priskiriamą mygtuką, kuriam priskirta funkcija
[Push AF/MF] (AF/MF spaudžiant), galite laikinai sustabdyti taškinį fokusavimą ir įjungti automatinį
fokusavimą, kol mygtukas laikomas nuspaustas. Atleidus mygtuką bus grąžintas rankinio fokusavimo
režimas.

[68] Vaizdų fiksavimas Fokusavimo reguliavimas Fokusavimo reguliavimas rankiniu būdu
(rankinis fokusavimas)

Laikino automatinio fokusavimo naudojimas
(automatinis fokusavimas AF) spaudžiant)

Veikiant rankiniam fokusavimo režimui fokusavimą galite laikinai reguliuoti naudodami
automatinį fokusavimą – spauskite mygtuką [Push AF/MF] (AF/MF spaudžiant), kad būtų
fokusuojama automatiškai, kol paspaustas mygtukas.
Tai naudinga, kai norite lėtai perkelti fokusavimą nuo vieno objekto į kitą rankinio fokusavimo
metu.

Vietos nurodymo liečiant pavyzdys

Fotoaparato meniu [Shooting] > [Focus] > [Push AF Mode] (vaizdų fiksavimas >
fokusavimas > AF režimas spaudžiant) nustatykite kaip [AF].

1

Kad išjungtumėte, paslinkite jungiklį [Auto Focus] (automatinis fokusavimas)
skirtuke  (fokusavimas) į kairiąją padėtį.

2

Paspauskite mygtuką [Push AF/MF] (AF/MF spaudžiant).

Automatinio fokusavimo funkcija veikia, kol laikote mygtuką nuspaustą.

3
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Pastaba

Automatinio fokusavimo spaudžiant funkcija neveiks, jei objektyvas nustatytas veikti rankinio
fokusavimo režimu.

Patarimas

Tą patį galima atlikti naudojant priskiriamą mygtuką, kuriam priskirta funkcija [Push AF/MF] (AF/MF
spaudžiant).

[69] Vaizdų fiksavimas Fokusavimo reguliavimas Fokusavimo reguliavimas rankiniu būdu
(rankinis fokusavimas)

Vieno kadro automatinio fokusavimo naudojimas
(„Push Auto Focus (AF-S)“)

Veikiant rankinio fokusavimo režimui paspaudę mygtuką [Push AF/MF] (AF/MF spaudžiant)
fokusavimą galite atlikti automatiškai dideliu greičiu.
Šią funkciją patogu naudoti, kai objektą sufokusuojate prieš pradėdami fiksuoti vaizdus.

Automatins fokusavimas išjungiamas, o fokusavimas vėl grąžinamas į rankinį režimą, kai
mygtuką atleidžiate.

Žiniatinklio meniu arba fotoaparato meniu [Shooting] > [Focus] > [Push AF Mode]
(vaizdų fiksavimas > fokusavimas > AF režimas spaudžiant) nustatykite kaip [Single-
shot AF(AF-S)] (vieno kadro AF (AF-S).

1

Nurodykite vietą, kurioje norite koreguoti fokusavimą, fotoaparato meniu eidami į
[Shooting] > [Focus] > [Focus Area (AF-S)] (vaizdų fiksavimas > fokusavimas >
fokusavimo sritis (AF-S).

Patarimas

2
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Pastaba

Automatinio fokusavimo spaudžiant funkcija neveiks, jei objektyvas nustatytas veikti rankinio
fokusavimo režimu.

Fokusavimo srities rėmelis nepaslepiamas, kai naudojamas mygtukas [Display] (rodyti).

Veikiant „Clear Image Zoom“ [Focus Area (AF-S)] (fokusavimo sritis (AF-S) rėmelio padėties
nustatyti negalima. Veikiant automatiniam fokusavimui spaudžiant pasinaudojus AF pirmenybė taip
pat suteikiama centrinei daliai.

Patarimas

Tą patį galima atlikti naudojant priskiriamą mygtuką, kuriam priskirta funkcija [Push AF/MF] (AF/MF
spaudžiant).

Be to, priskiriamam mygtukui galite priskirti funkciją [Push AF Mode] (AF režimas spaudžiant).

Be to, priskiriamam mygtukui galite priskirti funkciją [Focus Area (AF-S)] (fokusavimo sritis (AF-S).

Vietą galite pakeisti spausdami priskiriamą mygtuką, kuriam priskirta funkcija [Focus Setting]
(fokusavimo nustatymas), kad aplink fokusavimo sritį būtų parodytas oranžinis rėmelis ir
galėtumėte pasirinkti vietą jutikliniu valdymu.

Kad išjungtumėte, paslinkite jungiklį [Auto Focus] (automatinis fokusavimas)
skirtuke  (fokusavimas) į kairiąją padėtį.

3

Paspauskite mygtuką [Push AF/MF] (AF/MF spaudžiant).

Jei mygtuką atleisite prieš sufokusuojant, automatinis fokusavimas spaudžiant bus
sustabdytas.

Veikiant automatinio fokusavimo spaudžiant režimui fokusavimo būseną nurodo
fokusavimo indikatorius.
Šviečia: fokusavimas užfiksuojamas sufokusavimo padėtyje.
Mirsi: nesufokusuota. Kadangi įrenginys nefokusuos automatiškai, fokusavimui pasiekti
pakeiskite kompozicijos ir fokusavimo nustatymus.
Atleidus mygtuką bus grąžintas rankinio fokusavimo režimas.

4
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Fokusavimo srities rėmelį galite parodyti / paslėpti fotoaparato meniu naudodami [Monitoring] >
[Display On/Off] > [Focus Area Ind.(AF-S)] (stebėjimas > rodymo įjungimas / išjungimas >
fokusavimo srities indikatorius AF-S).

[70] Vaizdų fiksavimas Vienas kadras Automatinis fokusavimo reguliavimas (automatinis
fokusavimas)

Automatinis reguliavimas naudojant žiniatinklio
programą

Įrenginyje naudojamas fazės aptikimo AF, užtikrinantis didelės spartos fokusavimą, ir kontrasto
AF, užtikrinantis didelio tikslumo fokusavimą.
Šių dviejų AF metodų derinys leidžia atlikti automatinį fokusavimą ir greitai bei dideliu tikslumu.

Pastaba

Reikalingas objektyvas, kuris palaiko automatinį fokusavimą.

Tikslumas gali būti nepakankamas, tai priklauso nuo filmavimo sąlygų.

Fokusavimas negali būti reguliuojamas automatiškai naudojant objektyvą su A tipo tvirtinimu.

Patarimas

Veikiant automatinio fokusavimo režimui fokusavimą galite reguliuoti naudodami fotoaparato
valdymo skydelio fokusavimo slankiklį. Išsamesnė informacija pateikiama dalyje „Rankinis
automatinio fokusavimo taikinio nustatymas (AF pagalba) naudojant žiniatinklio programą“.

Jei objektyve yra fokusavimo pasirinkimo jungiklis, nustatykite šį jungiklį į padėtį
„AF/MF“ arba „AF“.

Pastaba

Jei jungiklis nustatytas į padėtį „Full MF“ arba „MF“, objektyvo fokusavimo nebus galima valdyti
iš įrenginio. Žr. „Objektyvo su fokusavimo režimo jungikliu fokusavimo reguliavimas“ dalyje
„Objektyvo jungiklių tikrinimas“.

1

Kad įjungtumėte, fotoaparato valdymo skydelyje paslinkite jungiklį [Auto Focus]
(automatinis fokusavimas) į dešiniąją padėtį.

Suaktyvinamas automatinio fokusavimo režimas.

 (AF)

2



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

[71] Vaizdų fiksavimas Fokusavimo reguliavimas Automatinis fokusavimo reguliavimas
(automatinis fokusavimas)

Automatinis koregavimas naudojant pridedamą
infraraudonųjų spindulių nuotolinio valdymo pultą

Fokusavimą galite reguliuoti automatiškai naudodami pridedamą infraraudonųjų spindulių
nuotolinio valdymo pultą.

Pastaba

Be to, automatinį fokusavimą galite naudoti, kai rankinis reguliavimas yra pagrindinis valdymo būdas.
Išsamesnė informacija pateikiama dalyje „Rankinis fokusavimas veikiant automatiniam fokusavimui
naudojant pridedamą infraraudonųjų spindulių nuotolinio valdymo pultą“.

[72] Vaizdų fiksavimas Fokusavimo reguliavimas Automatinis fokusavimo reguliavimas
(automatinis fokusavimas)

Automatinio fokusavimo srities / padėties nustatymas
(fokusavimo sritis)

Galite nustatyti automatinio fokusavimo numatytą sritį ir sureguliuoti šios srities fokusavimą.

Paspauskite infraraudonųjų spindulių nuotolinio valdymo pulto AF mygtuką.

Objekto fokusavimas reguliuojamas automatiškai.

1

Paspauskite GUI valdymo skydelio mygtuką [Menu] (meniu), kad atidarytumėte
fotoaparato meniu.

1
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Norimą automatinio fokusavimo sritį nustatykite fotoaparato meniu naudodami
[Shooting] > [Focus] > [Focus Area] (vaizdų fiksavimas > fokusavimas > fokusavimo
sritis).

[Wide] (plačiakampis):
fokusuojant ieško objekto plataus matymo kampo vaizdo srityje. Rėmelis nerodomas.

[Zone] (zona):
automatiškai ieško fokusavimo padėties nurodytoje zonoje.
Pasirinkę GUI valdymo skydelio rodyklių mygtukais nurodykite padėtį.

Į centrinę padėtį galite sugrįžti paspausdami ir palaikydami mygtuką [Set] (nustatyti).
[Flexible Spot] (lankstus taškas):
fokusuoja nurodytoje vaizdo vietoje.
Pasirinkę GUI valdymo skydelio rodyklių mygtukais nurodykite padėtį.

2
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Pastaba

Fokusavimo srities rėmelis nepaslepiamas, kai naudojamas fotoaparato valdymo skydelio mygtukas
[Display] (rodyti).

Veikiant „Clear Image Zoom“ režimui fokusavimo sritis nustatoma kaip [Wide] (plačiakampis)
(fiksuota).

Patarimas

Fokusavimo srities rėmelį galite parodyti / paslėpti fotoaparato meniu naudodami [Monitoring] >
[Display On/Off] > [Focus Area Indicator] (stebėjimas > rodymo įjungimas / išjungimas > fokusavimo
srities indikatorius).

[73] Vaizdų fiksavimas Fokusavimo reguliavimas Automatinis fokusavimo reguliavimas
(automatinis fokusavimas)

Greitas fokusavimo srities keitimas (fokusavimo
nustatymas)

Fiksuodami vaizdus galite greitai pakeisti automatinio fokusavimo srities padėtį ir dydį, jei
priskiriamam mygtukui priskirsite funkciją [Focus Setting] (fokusavimo nustatymas).

Išsamesnė informacija apie priskiriamus mygtukus pateikiama dalyje „Priskiriami mygtukai“.

Valdymas priklauso nuo fokusavimo zonos nustatymo.

Kai fotoaparato meniu [Shooting] > [Focus] > [Focus Area] (vaizdų
fiksavimas > fokusavimas > fokusavimo sritis) nustatyta kaip [Flexible
Spot] (taškas) arba [Zone] (zona)

Fokusavimo srities padėtį galite pakeisti spausdami priskiriamą mygtuką, kuriam priskirta
funkcija [Focus Setting] (fokusavimo nustatymas), ir reguliuodami GUI valdymo skydelio
rodyklių mygtukais. Kai reguliuojate fokusavimo srities padėtį, ją galite grąžinti į centrą
paspausdami mygtuką [Set] (nustatyti).

Į centrinę padėtį galite sugrįžti paspausdami ir palaikydami mygtuką [Set] (nustatyti).
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Fokusavimo srities dydį galite keisti paspaudę ir palaikę priskiriamą mygtuką, kuriam
priskirta funkcija [Focus Setting] (fokusavimo nustatymas). Pakeitę dydį fokusavimo srities
padėtį galite pakeisti spausdami mygtuką [Set] (nustatyti). Baigę paspauskite priskiriamą
mygtuką, kuriam priskirta funkcija [Focus Setting] (fokusavimo nustatymas), kad grįžtumėte į
ankstesnį ekraną.

Kai fotoaparato meniu [Shooting] > [Focus] > [Focus Area] (vaizdų
fiksavimas > fokusavimas > fokusavimo sritis) nustatyta kaip [Wide]
(plati)

Fokusavimo srities dydį galite keisti tik paspaudę ir palaikę priskiriamą mygtuką, kuriam priskirta
funkcija [Focus Setting] (fokusavimo nustatymas). Padėtį taip pat galima pakeisti pirmiausia
pakeitus tipą į [Flexible Spot] (lankstus taškas) arba [Zone] (zona).

Patarimas

Kai fotoaparato meniu [Shooting] > [Focus] > [Push AF Mode] (vaizdų fiksavimas > fokusavimas >
AF režimas spaudžiant) nustatyta kaip [Single-shot AF(AF-S)] (vieno kadro AF (AF-S), o jungiklis
[Auto Focus] (automatinis fokusavimas) nustatytas į išjungimo padėtį (rankinio fokusavimo režimas),
galite pakeisti [Focus Area (AF-S)] (fokusavimo sritis (AF-S) fokusavimo srities padėtį.

Kai fokusavimo zonos padėtį galima keisti, fokusavimo zonos rėmelis yra oranžinis.

[74] Vaizdų fiksavimas Fokusavimo reguliavimas Automatinis fokusavimo reguliavimas
(automatinis fokusavimas)

Fokusavimo srities rėmelio perkėlimas naudojant
jutiklinį valdymą (jutiklinis fokusavimo srities
valdymas)

Fokusavimo srities padėtį galite pakeisti spausdami priskiriamą mygtuką, kuriam priskirta
funkcija [Focus Setting] (fokusavimo nustatymas), kad fokusavimo srities rodinys pasikeistų į
oranžinį, tada fokusavimo srities rėmelį galėsite perkelti naudodami jutiklinį valdymą fotoaparato
vaizdo skydelyje.
Bakstelėkite ekraną ir fokusavimo zona pasislinks, kad toje vietoje būtų fokusavimo zonos
centras. Braukdami pirštu per ekraną perkelkite fokusavimo sritį į norimą padėtį.

Patarimas

Jutiklinį fokusavimo srities valdymą galite įjungti / išjungti vaizdų fiksavimo ekrane naudodami
priskiriamą mygtuką, kuriam priskirta funkcija [Focus Setting] (fokusavimo nustatymas).

Bakstelėkite bet kurioje padėtyje.1
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Pastaba

Jei bakstelėsite padėtį arba nuvilksite fokusavimo zoną į padėtį, kuri išeina už nustatymo ribų,
fokusavimo zona bus nustatyta viršutiniame / apatiniame / kairiajame / dešiniajame nustatymo zonos
krašte.

Ši funkcija neveikia toliau nurodytomis aplinkybėmis.
Kai fotoaparato valdymo skydelyje jungiklis [Auto Focus] (automatinis fokusavimas) išjungtas
Kai fotoaparato valdymo skydelyje jungiklis [Touch Focus] (jutiklinis fokusavimas) išjungtas
Kai fokusavimo srities rėmelis rodomas pilka spalva arba išvis nerodomas

Bakstelėta padėtis tampa fokusavimo srities centru.

Braukdami galite perkelti fokusavimo sritį pagal piršto padėtį.2
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[75] Vaizdų fiksavimas Fokusavimo reguliavimas Automatinis fokusavimo reguliavimas
(automatinis fokusavimas)

Automatinio fokusavimo reguliavimas (AF perėjimo
greitis, AF objekto poslinkio jautrumas)

Automatinio fokusavimo veikimą galite keisti keisdami perėjimo greitį ir objekto poslinkio
jautrumą.

AF perėjimo greičio nustatymas

Galite keisti fokusavimo įrenginio greitį, kai keičiasi objektas – tam naudokite fotoaparato
valdymo skydelio mygtuką [AF Transition Speed] (AF perėjimo greitis).

Greitį pasirinkite diapazone nuo [Speed 1] (lėtas) iki [Speed 7] (greitas) 1 intervalais.
Spausdami mygtuką < reikšmę sumažinkite (lėčiau), o spausdami mygtuką > reikšmę
padidinkite (greičiau).
Kai nustatytas mažas greitis, keičiantis fokusuojamam objektui fokusavimas keičiasi lėtai, todėl
galima fiksuoti įspūdingai ryškius vaizdus.
Kai nustatytas didelis greitis, fokusavimas tarp objektų pasikeičia greitai. Toliau pateikiamame
pavyzdyje fokusavimas greitai pakeičiamas perkeliant jį nuo pastato fone ant priekiniame fone
einančio žmogaus. Kadre atsiradęs objektas iškart sufokusuojamas, todėl šis nustatymas
idealiai tinka filmuojant dokumentinius siužetus, kai reikalingas greitas fokusavimas.

AF objekto poslinkio jautrumas

Kitimo tarp objektų jautrumą galite nustatyti naudodami mygtuką [AF Subj. Shift Sens.] (AF
objekto poslinkio jautrumas) fotoaparato valdymo skydelyje.
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Jautrumą pasirinkite diapazone nuo [Sens 1] (fiksuotas) iki [Sens 5] (jautrus) 1 intervalais.
Spausdami mygtuką < reikšmę sumažinkite (keisti lėtai), o spausdami mygtuką > reikšmę
padidinkite (keisti greitai).
Kai nustatytas mažas jautrumas, fokusavimas greitai nepasikeičia net jei kitas objektas
atsiranda priešais sufokusuotą objektą.

Kai nustatytas didelis jautrumas, fokusavimas pasikeičia ir suteikia pirmenybę priekyje
atsiradusiam objektui.

Patarimas

Jei funkcija „[AF Speed/Sens.“ (AF greitis / jautrumas) priskirta priskiriamam mygtukui, kaskart
paspaudus mygtuką fotoaparato vaizdo skydelyje parodomos reikšmių reguliavimo lygio padalos,
kad galėtumėte keisti perėjimo greičio ir AF objekto poslinkio jautrumo nustatymus toliau nurodyta
tvarka.
AF perėjimo greitis ? AF objekto poslinkio jautrumas ? Nerodoma …

[76] Vaizdų fiksavimas Fokusavimo reguliavimas Automatinis fokusavimo reguliavimas
(automatinis fokusavimas)

Rankinis automatinio fokusavimo taikinio nustatymas
(AF pagalba) naudojant žiniatinklio programą
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Pakeitę ir sureguliavę fokusavimą rankiniu būdu fokusavimo valdymą galite perjungti į
automatinį, kad jis būtų sureguliuotas tiksliai.

Pastaba

Veikiant AF pagalbai fokusavimą perjungti tampa sudėtinga nepaisant fotoaparato meniu nustatymo
[Shooting] > [Focus] > [AF Subj. Shift Sens.] (vaizdų fiksavimas > fokusavimas > AF objekto
poslinkio jautrumas).

AF pagalbos būsena atšaukiama tokiais atvejais:
Kai objektas, sufokusuotas naudojant slankiklį [Focus] (fokusavimas), nebematomas
Kai perjungiama į rankinį fokusavimą
Kai užregistruojamas veidas

Patarimas

AF pagalbos būseną galima greitai atšaukti naudojant priskiriamą mygtuką, kuriam priskirta funkcija

Fotoaparato meniu [Shooting] > [Focus] > [AF Assist] (vaizdų fiksavimas >
fokusavimas > AF pagalba) nustatykite kaip [On] (įjungta).

1

Žiniatinklio meniu [Shooting] > [Focus] > [AF Assist Control] (vaizdų fiksavimas >
fokusavimas > AF pagalbos valdymas) nustatykite kaip [On] (įjungta).

2

Kad įjungtumėte, fotoaparato valdymo skydelyje paslinkite jungiklį [Auto Focus]
(automatinis fokusavimas) į dešiniąją padėtį.

Suaktyvinamas automatinio fokusavimo režimas.

3

Fokusavimo taikinį nustatykite naudodami fotoaparato valdymo skydelyje esantį
slankiklį [Focus] (fokusavimas).

[Near] (arti): fokusuoti arti esantį objektą.
[Far] (toli): fokusuoti toli esantį objektą.

Jei įjungta AF pagalba, automatiškai bus sufokusuotas objektas, kuris nutolęs atstumu,
nustatytu slankikliu [Focus] (fokusavimas).

4
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[Push AF/MF] (AF/MF spaudžiant).

Pasinaudojus slankikliu [Focus] (fokusavimas) panaikinamas registruoto veido pasirinkimas.

Veikiant tik veido / akių AF režimui automatinis fokusavimas sufokusuoja veidą, kuris yra arčiausiai
slankiklio [Focus] (fokusavimas) fokusavimo padėties.

[77] Vaizdų fiksavimas Fokusavimo reguliavimas Automatinis fokusavimo reguliavimas
(automatinis fokusavimas)

Rankinis fokusavimas veikiant automatiniam
fokusavimui naudojant pridedamą infraraudonųjų
spindulių nuotolinio valdymo pultą

Kai fotoaparato meniu [Shooting] > [Focus] > [AF Assist] (vaizdų fiksavimas > fokusavimas > AF
pagalba) nustatyta kaip [On] (įjungta), pridedamo infraraudonųjų spindulių nuotolinio valdymo
pulto mygtuką F (toli) ir N (arti) galite naudoti net veikiant automatiniam fokusavimui ir reguliuoti
objekto fokusavimą.

[78] Vaizdų fiksavimas Fokusavimo reguliavimas Automatinis fokusavimo reguliavimas
(automatinis fokusavimas)

Laikinas rankinio fokusavimo naudojimas veikiant
automatiniam fokusavimui (rankinis fokusavimas
spaudžiant)

Veikiant automatinio fokusavimo režimui paspauskite mygtuką [Push AF/MF] (AF/MF
spaudžiant) ir, kol mygtukas paspaustas, galėsite fokusuoti rankiniu būdu. Automatinis
fokusavimas vėl pradės veikti, kai atleiskite mygtuką.
Taip galite laikinai sustabdyti automatinį fokusavimą ir fokusuoti rankiniu būdu, kai kas nors
praeina priešais fiksuojamą objektą.
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Patarimas

Tą patį galima atlikti naudojant priskiriamą mygtuką, kuriam priskirta funkcija [Push AF/MF] (AF/MF
spaudžiant).

[79] Vaizdų fiksavimas Fokusavimo reguliavimas

Sekimas naudojant veido ir akių aptikimą (veido / akių
aptikimo AF)

Įrenginys gali aptikti žmonių veidus ir akis kaip sekimo taikinį bei sureguliuoti fokusavimą pagal
veidus ir akis fokusavimo srityje.
Kai veidai aptinkami, rodomi pilki veido / akių aptikimo rėmeliai. Jei galima naudoti automatinį
fokusavimą, rėmeliai pasikeičiami į baltus ir pradedamas sekimas. Kai aptinkamos akys,
fokusavimas sureguliuojamas, veido / akių aptikimo rėmelis rodomas ant akių. Kai aptinkami
keli asmenys, automatiškai nustatomas pagrindinis objektas.
Šią funkciją galima naudoti tik kai fokusavimo režimas vykdomas AF režimu arba automatinio
fokusavimo spaudžiant metu.

Patarimas

Kai fokusavimo sritis nustatyta į [Zone] (zona) arba [Flexible Spot] (lankstus taškas), o veidai arba
akys atsiduria nurodytoje fokusavimo srityje, veido / akių aptikimo rėmeliai pasikeičia į baltus,
įrenginys automatiškai sufokusuoja šiuos veidus / akis.

Kai naudojamas laikinas automatinis fokusavimas (AF-S), sufokusuotų veidų / akių aptikimo rėmeliai
pasikeičia į žalius.

Nustatymas fotoaparato valdymo skydelyje naudojant mygtuką [Face/Eye
Detection AF] (veido / akių aptikimo AF)

Paspauskite mygtuką [Face/Eye Detection AF] (veido / akių aptikimo AF) ir nustatykite veido /
akių aptikimo AF veikimą.

[Face/Eye Only AF] (tik veido / akių AF): fotoaparatas aptinka objektų (žmonių) veidus / akis
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bei sufokusuoja ir seka tik jų veidus / akis. Jei veidas arba akys neaptinkami, AF laikinai
sustabdomas ir parodoma piktograma  (tik veido / akių AF režimo automatinio fokusavimo
pristabdymas). Šis režimas veiksmingas, kai norite automatiškai fokusuoti ir sekti tik veidus /
akis.
[Face/Eye Priority AF] (veido / akių pirmumo AF): fotoaparatas aptinka objektų (žmonių)
veidus / akis bei pirmenybę teikia veidų / akių fokusavimui / sekimui. Kai veidas arba akys
neaptinkami, fokusavimas vyksta AF režimu (numatytasis nustatymas).
[AF]: veido / akių aptikimo AF funkcija išjungta.

Pastaba

Kai veikia automatinis fokusavimas spaudžiant, funkcija [Face/Eye Priority AF] (veido / akių pirmumo
AF) suaktyvinama, net jei šiuo metu pasirinkta [Face/Eye Only AF] (tik veido / akių AF).

Kai jungiklis [Auto Focus] (automatinis fokusavimas) nustatomas į išjungimo padėtį, veido / akių
aptikimo AF išjungiamas (išskyrus atvejus, kai veikia automatinis fokusavimas spaudžiant).

Jei išjungiate vaizdo kamerą, kai pasirinkta [Face/Eye Only AF] (tik veido / akių AF), kitą kartą
įjungus kamerą režimas automatiškai perjungiamas į [Face/Eye Priority AF] (veido / akių pirmumo
AF).

Patarimas

Veido / akių aptikimo AF veikimą galite nustatytu fotoaparato meniu naudodami [Shooting] > [Focus]
> [Face/Eye Detection AF] (vaizdų fiksavimas > fokusavimas > veido / akių aptikimo AF).

Veido / akių aptikimo rėmelių slėpimas
Veido / akių aptikimo rėmelius galite paslėpti / parodyti fotoaparato meniu naudodami
[Monitoring] > [Display On/Off] > [Face/Eye Detection Frame] (stebėjimas > rodymo įjungimas /
išjungimas > veido / akių aptikimo rėmelis).

Pastaba

Žali veido / akių aptikimo rėmeliai rodomi sufokusuotiems veidams ir akims, kai naudojamas
automatinis fokusavimas spaudžiant (AF-S), ir nepaslepiami paspaudus mygtuką [Display] (rodyti)
arba parinktį [Face/Eye Detection Frame] (veido / akių aptikimo rėmelio) nustačius kaip [Off]
(išjungta).

Veido / akių aptikimo AF perjungimas naudojant priskiriamą mygtuką
[Face/Eye Detection AF] (veido / akių aptikimo AF) priskirkite priskiriamam mygtukui. Tada
kaskart paspausdami mygtuką veido / akių aptikimo AF galite perjungti tokia eilės tvarka:
[Face/Eye Priority AF] (veido / akių pirmumo AF), [Face/Eye Only AF] (tik veido / akių AF) ir
[AF].

Nustatymas naudojant tiesioginį meniu

Be to, veido / akių aptikimo AF galite nustatyti naudodami tiesioginį meniu.

Išsamesnė informacija apie tiesioginį meniu pateikiama dalyje „Tiesioginio meniu
naudojimas“.
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[80] Vaizdų fiksavimas Fokusavimo reguliavimas

Nustatyto objekto sekimas (sekimo realiuoju laiku AF)

Objekto fokusavimą galite išlaikyti objektą nurodydami jutikliniu valdymu arba pasirinkdami
veido aptikimo rėmelį fotoaparato valdymo skydelyje.
Kai objektas pasirenkamas, parodomas baltas sekimo rėmelis ir pradedamas sekimas.

Patarimas

Sekimas vykdomas visoje vaizdo srityje nepaisant fokusavimo srities nustatymo.

Kai žiniatinklio meniu arba fotoaparato meniu [Shooting] > [Focus] > [Touch Function in MF] (vaizdų
fiksavimas > fokusavimas > Lietimo funkcija veikiant rankiniam fokusavimui) nustatyta kaip [Tracking
AF] (sekimo AF), sekimo realiuoju laiku AF gali būti naudojamas, net jei įjungtas MF fokusavimo
režimas.

Atsižvelgiant į veido / akių aptikimo AF veikimo režimo nustatymą galimi toliau nurodyti taikinio
sekimo veiksmai.

[Face/Eye Only AF] (tik veido / akių AF) arba [Face/Eye Priority AF] (veido / akių pirmumo
AF): fokusuojamas ir sekamas nustatytas objektas.
Jei sekimo taikinys yra žmogus, aptikus jo veidą / akis fotoaparatas sufokusuoja veidą / akis.
Jei aptinkamas sekimo taikinio veidas / akis, sekimo taikinio veidas išsaugomas. Kai
išsaugoma, parodoma  (išsaugoto sekamo veido piktograma).

Pastaba

Jei sekimo AF suaktyvinamas veikiant rankiniam fokusavimui, sekimo taikinio veidas nebus
išsaugotas.

[AF]: sufokusuojamas ir sekamas nustatytas objektas. Veido / akių sekimas nevykdomas, net
jei sekimo taikinys yra žmogus.

Pastaba

Sekimo realiuoju laiku AF funkcija neveikia, jei objektyve nustatytas rankinis fokusavimas.
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Sekimo realiuoju laiku AF aktyvinimas

Jei kaip sekimo taikinys nustatomas konkretus objektas, pradedamas šio taikinio sekimas.

Nustatymas naudojant jutiklinį valdymą
Kad įjungtumėte, paslinkite jungiklį [Touch Focus] (jutiklinis fokusavimas) fotoaparato valdymo
skydelio skirtuke  (fokusavimas) į dešiniąją padėtį, tada esant kuriai nors iš toliau nurodytų
būsenų bakstelėkite norimą sekti numatytą objektą.

Veikiant rankinio fokusavimo arba rankinio fokusavimo spaudžiant režimui ir žiniatinklio
meniu ar fotoaparato meniu [Shooting] > [Focus] > [Touch Function in MF] (vaizdo
fiksavimas > fokusavimas > lietimo funkcija veikiant rankiniam fokusavimui) nustačius kaip
[Tracking AF] (sekimo AF)
Veikiant automatiniam fokusavimui arba automatiniam fokusavimui spaudžiant (AF)

Nustatymas naudojant veido aptikimo rėmelio pasirinkimą
Veido pasirinkimo žymeklį (oranžinė linija) GUI valdymo skydelio rodyklių mygtukais perkelkite
ant norimo sekti numatyto objekto, tada paspauskite mygtuką [Set] (nustatyti).

A: veido aptikimo rėmeliai (pilki)
B: sekimo rėmelis
C: veido pasirinkimo žymeklis (oranžinis)

Pastaba

Veikiant rankiniam fokusavimui sekimo negalima pasirinkus veido aptikimo rėmelį.

Patarimas

Sekamą taikinį galima keisti ir veikiant sekimo realiuoju laiku AF.

Sekimo realiuoju laiku AF stabdymas

Paspauskite mygtuką  (sekimo realiuoju laiku AF stabdymas).



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

Patarimas

Sekimo realiuoju laiku AF bus sustabdytas toliau nurodytais atvejais:
Perjungus jungiklį [Auto Focus] (automatinis fokusavimas) arba valdiklį AUTO/MANUAL ant
objektyvo
Pakeitus fokusavimo režimą
Kai įjungiama AF pagalba
Pakeitus fokusavimo srities nustatymą arba veido / akių aptikimo AF veiksmą
Paspaudus priskiriamą mygtuką, kuriam priskirta funkcija [Push AF/MF] (AF/MF spaudžiant)
Jei sekamas objektas nepatenka į fiksavimo ekraną arba kai objektas kelias sekundes nėra
sufokusuotas

Kai sekamas veidas išsaugomas (kai rodoma  (išsaugoto sekamo veido piktograma), sekimo
realiuoju laiku AF bus tęsiamas, jei išsaugotas sekamas veidas pateks į vaizdo sritį. Jei norite
pašalinti sekamą veidą, sekimo realiuoju laiku AF sustabdykite anksčiau aprašytu būdu.

[81] Vaizdų fiksavimas Šviesumo reguliavimas

Šviesumo reguliavimo ekranas

Šviesumą galite reguliuoti keisdami diafragmą, stiprinimą, užrakto greitį ir koreguodami šviesos
lygį ND filtrais toliau nurodytuose žiniatinklio programos tiesioginio valdymo ekrano valdymo
skydeliuose. Be to, šviesumas gali būti reguliuojamas ir automatiškai.
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Pastaba

Stiprinimo negalima reguliuoti, kai [Shooting Mode] (fiksavimo režimas) nustatyta kaip [Cine EI]. Be
to, šviesumo negalima automatiškai reguliuoti naudojant išlaikymą. Automatinis šviesumo
reguliavimas galimas naudojant diafragmą ir ND filtrą.

Patarimas

Veikiant „Cine EI“ režimui vaizdai fiksuojami naudojant bazinį jautrumą be stiprinimo, kad būtų
maksimaliai išnaudotos vaizdo jutiklio techninės galimybės. Šviesumas reguliuojamas naudojant
apšvietimą ir ND filtrą, kuriais sureguliuojamas vaizdo jutiklį pasiekiančios šviesos kiekis. Išsamesnė
informacija apie ekspozicijos indeksą (EI) pateikiama dalyje „Tamsių ir šviesių sričių pasiskirstymo
keitimas įrašytame vaizde“.

[82] Vaizdų fiksavimas Šviesumo reguliavimas

Fotoaparato valdymo skydelis –  (pagrindinis) skirtukas1.

Pagrindinių fotoaparato funkcijų konfigūravimo skydelis
Ant mygtukų parodoma pagrindinių funkcijų, reikalingų vaizdų fiksavimui, būsena.
Paspauskite mygtuką, kad būtų parodytas atitinkamas sąrankos ekranas, skirtas kiekvienai
funkcijai iš toliau pateikto pagrindinių fotoaparato funkcijų konfigūracijos reguliavimo
skydelio.

2.

Pagrindinių fotoaparato funkcijų konfigūracijos reguliavimo skydelis
Parodomas reguliavimo skydelis, skirtas sąrankos elementams, pasirinkties pagrindinių
fotoaparato funkcijų konfigūravimo skydelyje.

3.
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Bazinio jautrumo nustatymas

Bazinį jautrumą galite nustatyti prieš pradėdami reguliuoti šviesumą.

Kai [Shooting Mode] (fiksavimo režimas) nustatyta kaip [Custom]
(pasirinktinis)

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką [ISO/Gain] (ISO /
stiprinimas) ir nustatykite [Base Sensitivity] (bazinis jautrumas) ISO / stiprinimo reguliavimo
skydelyje kaip [High] (didelis) arba [Low] (mažas).
Esant normalioms apšvietimo sąlygoms pasirinkite [Low] (mažas), o esant prastam apšvietimui
– [High] (didelis).
Ekranas, kai [AGC] išjungta

Ekranas, kai [AGC] įjungta

Kai [Shooting Mode] (fiksavimo režimas) nustatyta kaip [Cine EI]

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką [Base
ISO/Exposure Index] (bazinis ISO / ekspozicijos indeksas) ir nustatykite [Base ISO] (bazinis ISO
) bazinio ISO / ekspozicijos indekso reguliavimo skydelyje kaip [ISO 12800] arba [ISO 800].
Esant normalioms apšvietimo sąlygoms pasirinkite ISO 800], o esant prastam apšvietimui –
[ISO 12800].
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Patarimas

Šį nustatymą galite nustatyti ir fotoaparato valdymo skydelio  (pagrindiniame) skirtuke.

Galima nustatyti ir fotoaparato meniu naudojant [Shooting] > [ISO/Gain/EI] > [Base Sensitivity]
(vaizdų fiksavimas > ISO / stiprinimas / EI > bazinis jautrumas) arba [Base ISO] (bazinis ISO).

Be to, funkciją [Base ISO/Sensitivity] (bazinis ISO / jautrumas) galite priskirti priskiriamam mygtukui.

[83] Vaizdų fiksavimas Šviesumo reguliavimas

Numatyto automatinio šviesumo reguliavimo lygio
nustatymas

Numatytas automatinio šviesumo reguliavimo lygis nustatomas fotoaparato valdymo skydelio
slankikliu [AE Level] (AE lygis).

Fotoaparato valdymo skydelyje paspauskite skirtuką  (pagrindinis).

Jei slankiklis [AE Level] (AE lygis) nerodomas, pasirinkite vieną iš dviejų slankiklio funkcijų
pasirinkimo mygtukų ir pasirinkite slankiklį [AE Level] (AE lygis) iš sąrašo.

Slankiklis [AE Level] (AE lygis) pasirodo.

1

Slankikliu nustatykite norimą lygį.2
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[84] Vaizdų fiksavimas Šviesumo reguliavimas Diafragmos reguliavimas

Automatinis diafragmos reguliavimas

Šviesumas gali būti reguliuojamas automatiškai pagal objektą. Reikalingas suderinamas
objektyvas.

Pastaba

Diafragmos negalima reguliuoti automatiškai naudojant objektyvą su A tipo tvirtinimu.

Patarimas

Paslinkite slankiklio rankenėlę į kairę, kad vaizdas būtų tamsesnis. Paslinkite slankiklio
rankenėlę į dešinę, kad vaizdas būtų šviesesnis.

Patarimas

Galima nustatyti ir fotoaparato meniu naudojant [Shooting] > [Auto Exposure] > [Level] (vaizdų
fiksavimas > automatinė ekspozicija > lygis).

Jei prijungtas objektyvas su automatinės diafragmos jungikliu, nustatykite jungiklį į
padėtį AUTO.

1

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką
[Iris] (diafragma).

Mygtuko [Iris] (diafragma) rėmelis pasikeičia į oranžinį.

Pasirodo diafragmos reguliavimo skydelis.

2

Jei norite įjungti, paslinkite jungiklį [Auto] (automatins) į dešiniąją padėtį.

Įjungiamas automatinio diafragmos reguliavimo režimas. Automatiškai sureguliuota
diafragmos reikšmė rodoma dešinėje jungiklio pusėje.

3
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Be to, funkciją [Auto Iris] (automatinė diafragma) galite priskirti priskiriamam mygtukui.

[85] Vaizdų fiksavimas Šviesumo reguliavimas Diafragmos reguliavimas

Rankinis diafragmos reguliavimas

Šviesumą galite reguliuoti rankiniu būdu.

Jei prijungtas objektyvas su automatinės diafragmos jungikliu, nustatykite jungiklį į
padėtį AUTO.

Pastaba

Kai objektyvo automatinės diafragmos jungiklis nustatomas į padėtį MANUAL (rankinis),
įrenginio funkcijos [Auto Iris] (automatinė diafragma) ir [Push Auto Iris] (automatinė diafragma
spaudžiant) neveikia. Rankinis įrenginio diafragmos reguliavimas taip pat neveikia.

1

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką
[Iris] (diafragma).

Mygtuko [Iris] (diafragma) rėmelis pasikeičia į oranžinį.

Pasirodo diafragmos reguliavimo skydelis.

2

Jei norite išjungti, paslinkite jungiklį [Auto] (automatinis) į kairiąją padėtį.

Įjungiamas rankinis diafragmos reguliavimo režimas.

3

Diafragmą sureguliuokite slankikliu [Iris] (diafragma) arba reguliavimo mygtukais
[Iris] (diafragma).

Patarimas

4
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Laikinas diafragmos reguliavimas automatiškai
Be to, galite spausti diafragmos reguliavimo skydelyje esantį mygtuką [Push Auto] (automatinis
reguliavimas spaudžiant), kad diafragma būtų reguliuojama automatiškai, kol mygtukas
nuspaustas.

Patarimas

Kad diafragma būtų reguliuojama automatiškai, kol nuspaustas mygtukas, paspauskite priskiriamą
mygtuką, kuriam priskirta funkcija [Push Auto Iris] (automatinė diafragma spaudžiant).
Rankinis diafragmos reguliavimo režimas vėl įjungiamas atleidus mygtuką.

[86] Vaizdų fiksavimas Šviesumo reguliavimas Stiprinimo reguliavimas

Automatinis stiprinimo reguliavimas

Šviesumą galite reguliuoti automatiškai naudodami stiprinimo nustatymą, kai [Shooting Mode]
(fiksavimo režimas) nustatyta kaip [Custom] (pasirinktinis).

Slankiklio ir reguliavimo mygtukų nustatymai yra susieti.

Be to, diafragmos funkciją galite priskirti slankikliui fotoaparato valdymo skydelio 
(pagrindiniame) skirtuke.

Žiniatinklio meniu arba fotoaparato meniu [Project] > [Shooting Mode] (projektas >
fiksavimo režimas) nustatykite kaip [Custom] (pasirinktinis).

1

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką
[ISO/Gain] (ISO / stiprinimas).

Mygtuko [ISO/Gain] (ISO / stiprinimas) rėmelis pasikeičia į oranžinį.

Pasirodo ISO / stiprinimo reguliavimo skydelis.

2

Jei norite įjungti, paslinkite jungiklį [AGC] į dešiniąją padėtį.3
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[87] Vaizdų fiksavimas Šviesumo reguliavimas Stiprinimo reguliavimas

Rankinis stiprinimo reguliavimas

Šviesumą galite reguliuoti rankiniu būdu naudodami stiprinimo nustatymą, kai [Shooting Mode]
(fiksavimo režimas) nustatyta kaip [Custom] (pasirinktinis).
Galite valdyti stiprinimą, kai norite reguliuoti ekspoziciją esant fiksuotai diafragmai arba kai
norite išvengti stiprinimo padidėjimo dėl AGC.

Įjungiamas automatinis stiprinimo reguliavimo režimas. Automatiškai sureguliuota
stiprinimo reikšmė rodoma dešinėje jungiklio pusėje.

Patarimas

Tą patį veiksmą galite atlikti ir fotoaparato meniu [Shooting] > [Auto Exposure] > [AGC] (vaizdų
fiksavimas > automatinė ekspozicija > AGC) nustatę kaip [On] (įjungta).

Be to, funkciją [AGC] galite priskirti priskiriamam mygtukui.

Žiniatinklio meniu arba fotoaparato meniu [Project] > [Shooting Mode] (projektas >
fiksavimo režimas) nustatykite kaip [Custom] (pasirinktinis).

1

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką
[ISO/Gain] (ISO / stiprinimas).

Mygtuko [ISO/Gain] (ISO / stiprinimas) rėmelis pasikeičia į oranžinį.

Pasirodo ISO / stiprinimo reguliavimo skydelis.

2

Jei norite išjungti, paslinkite jungiklį [AGC] į kairiąją padėtį.

Įjungiamas rankinis stiprinimo reguliavimo režimas.

3
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Laikinas rankinis stiprinimo reguliavimas
Stiprinimą laikinai galite reguliuoti rankiniu būdu funkciją [ISO/Gain] (ISO / stiprinimas)
priskirdami slankiklio funkcijos pasirinkimo mygtukui fotoaparato valdymo skydelio skirtuke 
(pagrindinis) ir naudodami slankiklį.
Tai naudinga, kai norite pakoreguoti ekspoziciją vienu laipsniu ir nekeisti lauko gylio.
Atlikus kurį nors iš toliau nurodytų veiksmų reguliavimo rezultatas grąžinamas į iš anksto
nustatytą reikšmę, sukonfigūruotą naudojant [ISO/Gain<L>] (ISO / stiprinimas <L>).

ISO / stiprinimo reguliavimo elementų keitimas
Bazinio jautrumo perjungimas
AGC jungiklio nustatymas į įjungimo padėtį
Įrenginio maitinimo perjungimas į budėjimo režimą

Laikinas automatinis stiprinimo reguliavimas naudojant priskiriamą mygtuką
Kad stiprinimas būtų reguliuojamas automatiškai, kol nuspaustas mygtukas, paspauskite
priskiriamą mygtuką, kuriam priskirta funkcija [Push AGC] (AGC spaudžiant).
Rankinis stiprinimo reguliavimo režimas vėl įjungiamas atleidus mygtuką.
Atlikus kurį nors iš toliau nurodytų veiksmų reguliavimo rezultatas grąžinamas į iš anksto
nustatytą reikšmę, sukonfigūruotą naudojant [ISO/Gain<L>] (ISO / stiprinimas <L>).

ISO / stiprinimo reguliavimo elementų keitimas
Bazinio jautrumo perjungimas
AGC jungiklio nustatymas į įjungimo padėtį
Įrenginio maitinimo perjungimas į budėjimo režimą

Pastaba

Šios funkcijos negalima naudoti, kai fotoaparato meniu [Shooting] > [Iris] > [Bokeh Control] (vaizdų
fiksavimas > diafragma > „bokeh“ valdymas) nustatyta kaip [On] (įjungta).

[88] Vaizdų fiksavimas Šviesumo reguliavimas Užrakto reguliavimas

Automatinis užrakto reguliavimas

Stiprinimą sureguliuokite naudodami slankiklį [ISO/Gain] (ISO / stiprinimas) arba
reguliavimo mygtukus [ISO/Gain] (ISO / stiprinimas).

Patarimas

Slankiklio ir reguliavimo mygtukų nustatymai yra susieti.

4
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Užraktą galite reguliuoti automatiškai pagal vaizdo šviesumą.

[89] Vaizdų fiksavimas Šviesumo reguliavimas Užrakto reguliavimas

Rankinis užrakto reguliavimas

Užraktą galite reguliuoti rankiniu būdu.

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką
[Shutter] (užraktas).

Mygtuko [Shutter] (užraktas) rėmelis pasikeičia į oranžinį.

Pasirodo užrakto reguliavimo skydelis.

1

Paspauskite mygtuką [Shutter Type] (užrakto tipas) ir iš sąrašo pasirinkite [Auto]
(automatinis).

Patarimas

Tą patį veiksmą galite atlikti ir fotoaparato meniu [Shooting] > [Auto Exposure] > [Auto Shutter]
(vaizdų fiksavimas > automatinė ekspozicija > automatinis užraktas) nustatę kaip [On]
(įjungta).

Be to, funkciją [Auto Shutter] (automatinis užraktas) galite priskirti priskiriamam mygtukui.

2

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką
[Shutter] (užraktas).

Mygtuko [Shutter] (užraktas) rėmelis pasikeičia į oranžinį.

Pasirodo užrakto reguliavimo skydelis.

1
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[90] Vaizdų fiksavimas Šviesumo reguliavimas Šviesos lygio reguliavimas (ND filtras)

Apie ND filtrą

Esant per silpnam apšvietimui galite nustatyti atitinkamą šviesumą keisdami ND filtrą.
Kai filmuojate ryškiai apšviestą objektą, per daug uždarius diafragmą gali atsirasti difrakcinis
susiliejimas ir gali pradėti dingti vaizdo fokusavimas (tipinis vaizdo kamerų fenomenas). Šio
efekto galite išvengti ir gauti geresnius filmavimo rezultatus naudodami ND filtrą.
Įrenginyje yra toliau nurodyti ND filtro režimai.
iš anksto nustatytas režimas

Žr. „Reguliavimas išankstinio nustatymo režimu“.

Paspauskite mygtuką [Shutter Type] (užrakto tipas) ir iš sąrašo pasirinkite [Speed]
(greitis).

2

Užraktą sureguliuokite [Speed] (greitis) arba reguliavimo mygtukais [Speed]
(greitis).

Jei norite reguliuoti ekspozicijos laiką ir pritaikyti jį pagal kadro intervalą, 2 veiksme
pasirinkite [Off] (išjungti). Be to, naudodami [ECS] (dažnis) galite nustatyti fiksuotą reikšmę
arba reguliuoti automatiškai naudodami [Auto] (automatinis).
Pavyzdys: nustatykite naudodami [ECS] (dažnis)

Patarimas

Slankiklio ir reguliavimo mygtukų nustatymai yra susieti.

Jei [Angle] (kampas) norite naudoti vietoje [Speed] (greitis) arba [Off] (išjungta), fotoaparato
meniu [Shooting] > [Shutter] > [Mode] (vaizdų fiksavimas > užraktas > režimas) nustatykite
kaip [Angle] (kampas).

3
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Kintamasis režimas (automatinis reguliavimas)

Žr. „Automatinis reguliavimas kintamuoju režimu“.

Kintamasis režimas (rankinis reguliavimas)

Žr. „Rankinis reguliavimas kintamuoju režimu“.

[91] Vaizdų fiksavimas Šviesumo reguliavimas Šviesos lygio reguliavimas (ND filtras)

Reguliavimas išankstinio nustatymo režimu

Iš anksto galite pasirinkti tris ND filtro skaidrumo reikšmes ir greitai jas perjungti fiksuodami
vaizdus.

Fotoaparato meniu [Shooting] > [ND Filter] > [Mode] (vaizdų fiksavimas > ND filtras
> režimas) nustatykite kaip [Preset] (išankstinis nustatymas).

1

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką [ND
Filter] (ND filtras).

Mygtuko [ND Filter] (ND filtras) rėmelis pasikeičia į oranžinį.

Pasirodo ND filtro reguliavimo skydelis.

2

Paspauskite mygtuką [ND Filter] (ND filtras) ir pasirinkite vieną iš toliau nurodytų
sąrašo elementų.

[Clear] (skaidrus): be ND filtro.
[Preset1]: skaidrumas nustatomas fotoaparato meniu naudojant [Shooting] > [ND Filter] >
[Preset1] (vaizdų fiksavimas > ND filtras > 1 išankstinis nustatymas).
[Preset2]: skaidrumas nustatomas fotoaparato meniu naudojant [Shooting] > [ND Filter] >
[Preset2] (vaizdų fiksavimas > ND filtras > 2 išankstinis nustatymas).
[Preset3]: skaidrumas nustatomas fotoaparato meniu naudojant [Shooting] > [ND Filter] >
[Preset3] (vaizdų fiksavimas > ND filtras > 3 išankstinis nustatymas).

Jei ND filtrui pasirenkamas vienas iš [Preset1]–[Preset3], skaidrumo reikšmė parodoma
šalia ND filtro pavadinimo.

3
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Patarimas

Jei paspaudžiamas priskiriamas mygtukas, kuriam priskirta funkcija [ND Filter Position] (ND filtro
padėtis), ND filtras perjungiamas tokia tvarka: [Clear] ? [Preset1] ? [Preset2] ? [Preset3] ? [Clear]
(skaidrus > 1 išankstinis nustatymas > 2 išankstinis nustatymas > 3 išankstinis nustatymas >
skaidrus).

[92] Vaizdų fiksavimas Šviesumo reguliavimas Šviesos lygio reguliavimas (ND filtras)

Automatinis reguliavimas kintamuoju režimu

Naudodami ND filtrą galite įjungti automatinį ekspozicijos reguliavimą.

Pastaba

Kai fiksavimo metu ND filtras perjungiamas pasirenkant [Clear] (skaidrus) arba šis nustatymas
išjungiamas, ant vaizdo parodomas ND filtro rėmelis ir pasigirsta signalas.

Fotoaparato meniu [Shooting] > [ND Filter] > [Mode] (vaizdų fiksavimas > ND filtras
> režimas) nustatykite kaip [Variable] (kintamas).

1

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką [ND
Filter] (ND filtras).

Mygtuko [ND Filter] (ND filtras) rėmelis pasikeičia į oranžinį.

Pasirodo ND filtro reguliavimo skydelis.

2

Paspauskite mygtuką [ND Filter] (ND filtras) ir iš sąrašo pasirinkite [Auto]
(automatinis).

Automatiškai sureguliuota ND filtro skaidrumo reikšmė parodoma šalia mygtuko [ND Filter]
(ND filtras).

3
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Patarimas

Be to, priskiriamam mygtukui galite priskirti funkciją [Auto ND Filter] (automatinis ND filtras) ir
spausdami šį mygtuką įjungti režimą [Auto] (automatinis) arba [Manual] (rankinis).

[93] Vaizdų fiksavimas Šviesumo reguliavimas Šviesos lygio reguliavimas (ND filtras)

Rankinis reguliavimas kintamuoju režimu

Naudodami ND filtrą galite įjungti rankinį ekspozicijos reguliavimą.

Fotoaparato meniu [Shooting] > [ND Filter] > [Mode] (vaizdų fiksavimas > ND filtras
> režimas) nustatykite kaip [Variable] (kintamas).

1

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką [ND
Filter] (ND filtras).

Mygtuko [ND Filter] (ND filtras) rėmelis pasikeičia į oranžinį.

Pasirodo ND filtro reguliavimo skydelis.

2

Paspauskite mygtuką [ND Filter] (ND filtras) ir iš sąrašo pasirinkite [Manual]
(rankinis).

3

ND filtro skaidrumą sureguliuokite naudodami slankiklį [ND Filter] (ND filtras) arba
reguliavimo mygtukais [ND Filter] (ND filtras).

Patarimas

Slankiklio ir reguliavimo mygtukų nustatymai yra susieti.

Be to, ND filtrą galite reguliuoti fotoaparato valdymo skydelio skirtuke  (pagrindinis).

4
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Laikinas reguliavimas automatiškai
Funkciją [Push Auto ND] (automatinis ND spaudžiant) galite priskirti priskiriamam mygtukui ir
laikinai įjungti automatinį ND filtrą, kol laikomas nuspaustas mygtukas. Atleidus mygtuką
automatinis ND filtras bus vėl išjungtas.
Nustatykite ND filtrą kaip [Manual] (rankinis).

Pastaba

Kai fiksavimo metu ND filtras perjungiamas pasirenkant [Clear] (skaidrus) arba šis nustatymas
išjungiamas, ant vaizdo parodomas ND filtro rėmelis ir pasigirsta signalas.

Patarimas

Be to, priskiriamam mygtukui galite priskirti funkciją [ND Filter Position] (ND filtro padėtis) ir
spausdami šį mygtuką įjungti režimą [Manual] (rankinis) arba [Clear] (skaidrus).

Be to, galite spausti ND filtro reguliavimo skydelyje esantį mygtuką [Push Auto] (automatinis
spaudžiant), kad automatinis ND filtras būtų įjungtas, kol laikomas nuspaustas mygtukas.

[94] Vaizdų fiksavimas Natūralių spalvų (baltos spalvos balanso) reguliavimas

Baltos spalvos balanso reguliavimo ekranas

Baltos spalvos balansą galite reguliuoti naudodami tiesioginio valdymo ekraną žiniatinklio
programoje, kad sureguliavus baltos spalvos balansą vaizdas atrodytų natūralesnis.
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[95] Vaizdų fiksavimas Natūralių spalvų (baltos spalvos balanso) reguliavimas

Automatinis baltos spalvos balanso reguliavimas

Tinkamai sureguliuoti baltos spalvos balansą visada galite naudodami ATW (automatinį sekimo
baltos spalvos balansą).
Kai įjungtas ATW, baltos spalvos balansas reguliuojamas automatiškai keičiantis šviesos
šaltinio spalvos temperatūrai.

Pastaba

ATW negalima naudoti, kai [Shooting Mode] (fiksavimo režimas) nustatyta kaip [Cine EI].

Gali būti neįmanoma sureguliuoti norimą spalvą naudojant ATW, tai priklauso nuo apšvietimo ir
objekto sąlygų.
Pavyzdžiai:

Kai objekte dominuoja viena spalva, pavyzdžiui, dangus, žemė ar gėlės.
Kai spalvos temperatūra yra itin aukšta arba itin žema.

Jei ATW automatinio sekimo greitis per mažas arba nepavyksta pasiekti reikiamo efekto,

Pagrindinių fotoaparato funkcijų konfigūravimo skydelis1.

Pagrindinių fotoaparato funkcijų konfigūracijos reguliavimo skydelis
Parodomas reguliavimo skydelis, skirtas sąrankos elementams, pasirinkties pagrindinių
fotoaparato funkcijų konfigūravimo skydelyje.

2.

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką
[White Balance] (baltos spalvos balansas).

Mygtuko [White Balance] (baltos spalvos balansas) rėmelis pasikeičia į oranžinį.

Pasirodo baltos spalvos balanso reguliavimo skydelis.

1

Paspauskite mygtuką [White Mode] (baltos spalvos balanso režimas) ir iš sąrašo
pasirinkite [ATW].

2
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paspauskite mygtuką [WB SET] (baltos spalvos balanso nustatymas), kad būtų įjungtas automatinis
baltos spalvos balanso režimas.

Patarimas

Veikiant ATW režimui atsako greitį galite rinktis iš žingsnių (1, 2, 3, 4, 5) – fotoaparato meniu eikite
[Shooting] > [White Setting] > [ATW Speed] (vaizdų fiksavimas > baltos spalvos balanso nustatymas
> ATW greitis). Kuo mažesnis skaičius, tuo didesnis greitis.

Esamą baltos spalvos balanso nustatymą galite užfiksuoti funkciją [ATW Hold] (ATW užlaikymas)
priskyrę priskiriamam mygtukui, kad paspaudus priskiriamą mygtuką ATW būtų laikinai sustabdytas
veikiant ATW režimui.

[96] Vaizdų fiksavimas Natūralių spalvų (baltos spalvos balanso) reguliavimas

Rankinis baltos spalvos balanso reguliavimas

Baltos spalvos balansą galite reguliuoti rankiniu būdu.

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką
[White Balance] (baltos spalvos balansas).

Mygtuko [White Balance] (baltos spalvos balansas) rėmelis pasikeičia į oranžinį.

Pasirodo baltos spalvos balanso reguliavimo skydelis.

1

Paspauskite mygtuką [White Mode] (baltos spalvos balanso režimas) ir pasirinkite
vieną iš toliau nurodytų sąrašo elementų.

[Memory A(T/T)] (A atmintis (T/T)

[Memory A(R/B)] (A atmintis (R/B)

[Preset] (išankstinis nustatymas)

2
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[97] Vaizdų fiksavimas Natūralių spalvų (baltos spalvos balanso) reguliavimas

Automatinio baltos spalvos balanso naudojimas

Veikiant A atminties režimui baltos spalvos balansas prieš jį išsaugant sureguliuojamas
automatiškai.

Baltos spalvos balansą sureguliuokite naudodami slankiklius ir reguliavimo
mygtukus.

Patarimas

Slankiklio ir reguliavimo mygtukų nustatymai yra susieti.

Skirtumas tarp [Memory A(T/T)] (A atmintis (T/T) ir [Memory A(R/B)] (A atmintis (R/B) yra
skirtinga reguliavimo ašis, tačiau reguliavimo rezultatai yra susieti.

[Memory A(T/T)] (A atmintis (T/T)
Veikiant šiam režimui reguliuojamas A atmintyje išsaugotas baltos spalvos balansas –
reguliuojama spalvų temperatūra („Temp“) ir atspalvis.
Spalvų temperatūrą galite nustatyti 20 K intervalais diapazone nuo 2000 K iki 5600 K.
Didesnes nei 5600K reikšmes galima nustatyti intervalais, lygiais spalvos pokyčio dydžiui
(miredais), nuo 5580K iki 5600K.
Paspaudus mygtuką [Reset] (nustatyti iš naujo) atkuriamos numatytosios nustatymų
[Temp] (spalvų temperatūra) arba [Tint] (atspalvis) reikšmės.
[Memory A(R/B)] (A atmintis (R/B)
Veikiant šiam režimui reguliuojamas A atmintyje išsaugotas baltos spalvos balansas –
reguliuojama R stiprinimas ir B stiprinimas.
Paspaudus mygtuką [Reset] atkuriama numatytoji atitinkamo stiprinimo nustatymu
reikšmė.
[Preset] (išankstinis nustatymas)
Veikiant šiam režimui spalvų temperatūra sureguliuojama pagal iš anksto nustatytą
reikšmę.
Reikšmę galite nustatyti 100 K intervalais.
Veikiant išankstiniam nustatymo režimui funkciją [Preset White Select] (iš anksto nustatyto
baltos spalvos balanso pasirinkimas) galite priskirti priskiriamam mygtukui, kad jį
paspaudus būtų naudojamas iš anksto sukonfigūruota reikšmė.
[Custom] (pasirinktinis) režimas: 3200 K ? 4300 K ? 5600 K ? 6300 K ? 3200 K…
[Cine EI] režimas: 3200 K ? 4300 K ? 5500 K ? 3200 K…

3

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką
[White Balance] (baltos spalvos balansas).

Mygtuko [White Balance] (baltos spalvos balansas) rėmelis pasikeičia į oranžinį.

1
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Pasirodo baltos spalvos balanso reguliavimo skydelis.

Paspauskite mygtuką [White Mode] (baltos spalvos balanso režimas) ir iš sąrašo
pasirinkite [Memory A(T/T)] (A atmintis (T/T) arba [Memory A(R/B)] (A atmintis (R/B).

[Memory A(T/T)] (A atmintis (T/T)

[Memory A(R/B)] (A atmintis (R/B)

2

Padėkite baltą popierių (ar kitą objektą) tokioje vietoje, kurioje apšvietimo šaltinis ir
sąlygos yra tokios pat, kaip filmuojamo objekto, tada išdidinkite popierių, kad
ekrane būtų tik balta spalva.

3

Sureguliuokite šviesumą.

Diafragmą sureguliuokite vadovaudamiesi procedūra, aprašyta dalyje „Rankinis
diafragmos reguliavimas“.

4

Baltos spalvos balanso reguliavimo skydelyje spauskite mygtuką [WB SET] (baltos
spalvos balanso nustatymas).

[Memory A(T/T)] (A atmintis (T/T)

[Memory A(R/B)] (A atmintis (R/B)

5
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Pastaba

Jei reguliavimas nesėkmingas, ekrane maždaug tris sekundes bus rodomas klaidos pranešimas. Jei
klaidos pranešimas kartojasi po pakartotinių bandymų nustatyti baltos spalvos balansą, kreipkitės į
savo „Sony“ techninės priežiūros atstovą.

Patarimas

Be to, jį galite naudoti ir veikiant ATW režimui. Šią funkciją galite naudoti, kai norite greitai
sureguliuoti baltos spalvos balansą veikiant ATW. Baigus reguliuoti režimas vėl bus perjungtas į
įprastą ATW.

[98] Vaizdų fiksavimas Įrašomo garso konfigūravimas

Garso konfigūravimo ekranas

Įrenginio įrašomą garso lygį galite reguliuoti žiniatinklio programos tiesioginio valdymo ekrane.
Sukonfigūruokite jungčių bloke esančius jungiklius ir sukonfigūruokite garsą naudodami
žiniatinklio meniu.

Jei automatinis baltos spalvos balansas naudojamas veikiant atminties režimui,
automatinio reguliavimo rezultatas išsaugomas A atmintyje.
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[99] Vaizdų fiksavimas Įrašomo garso konfigūravimas

Garso įvesties įrenginio pasirinkimas

Toliau nurodytus jungiklius nustatykite pagal prie AUDIO IN jungties prijungtą įrenginį.

Fotoaparato valdymo skydelis –  (garso) skirtukas1.

Kai prijungtas mikrofonas, nustatykite 2 jungiklį SETUP įrenginio nugarėlėje
esančiame jungčių bloke.

CH-1 ir CH-2 naudojami tokie patys nustatymai.

1

Nustatymas Aprašas

OFF
(išjungta;
numatytasis)

Pasirinkite, kai naudojamas dinaminis mikrofonas arba mikrofonas su
maitinimo elementu. Ši funkcija išjungia +48 V fantominį maitinimo
tiekimą ir nustato LINE arba MIC įvestį kaip CH-1 ir CH-2 garso šaltinį.

ON

Pasirinkite, kai naudojamas +48 V fantominį maitinimo tiekimą
palaikantis mikrofonas. Ši funkcija įjungia +48V fantominį maitinimo
tiekimą ir nustato fantominį maitinimo tiekimą palaikantį mikrofoną kaip
CH-1 ir CH-2 garso šaltinį.

Prijungto įrenginio tipą nustatykite fotoaparato meniu naudodami [Audio] > [Audio2
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Pastaba

Garsas neįrašomas filmavimo intervalais režimu arba sulėtinto ir pagreitinto filmavimo režimu.

[100] Vaizdų fiksavimas Įrašomo garso konfigūravimas

Automatinio garso įrašymo lygio reguliavimas

Kanalą, kurio garso įrašymo lygį norite reguliuoti automatiškai, nustatykite kaip [Auto]
(automatinis) žiniatinklio meniu puslapyje [Audio] (garsas) arba fotoaparato meniu [Audio] >
[Audio Input] > [CH1 Level Control] (garsas > garso įvestis > CH1 lygio valdymas) nustatydami
kaip [CH4 Level Control] (CH4 lygio valdymas).
Automatiniam reguliavimui nustatyti kanalai yra pažymėti piktograma  (automatins) šalia
atitinkamo kanalo tiesioginio valdymo ekrano skirtuke  (garsas).

[101] Vaizdų fiksavimas Įrašomo garso konfigūravimas

Rankinis garso įrašymo lygio reguliavimas

Garso įrašymo lygį galite reguliuoti rankiniu būdu.

Input] > [AUDIO IN Select] (garsas > garso įvestis > AUDIO IN pasirinkimas).

Garso įvestį pasirinkite žiniatinklio meniu arba fotoaparato meniu [Audio] > [Audio
Input] > [CH1 Input Select] (garsas > garso įvestis > CH1 įvesties pasirinkimas)
nustatydami kaip [CH4 Input Select] (CH4 įvesties pasirinkimas).

3

Kanalą, kurio garso įrašymo lygį norite reguliuoti rankiniu būdu, nustatykite kaip
[Manual] (rankinis) žiniatinklio meniu puslapyje [Audio] (garsas) arba fotoaparato
meniu [Audio] > [Audio Input] > [CH1 Level Control] (garsas > garso įvestis > CH1
lygio valdymas) nustatydami kaip [CH4 Level Control] (CH4 lygio valdymas).

1

Fotoaparato valdymo skydelyje paspauskite skirtuką  (garsas).2

Fotoaparato valdymo skydelio ekrane [Audio] (garsas) garso įrašymo lygį
nustatykite naudodami slankiklį arba reguliavimo mygtukus, skirtus kanalui, kurio
garso įrašymo lygį norite nustatyti rankiniu būdu.

3
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[102] Naudingos funkcijos

Tiesioginio meniu naudojimas

Įrenginio būseną ir nustatymus galite patikrinti fotoaparato vaizde, be to, nustatymus galite
pasirinkti ir keisti naudodami GUI valdymo mygtukus infraraudonųjų spindulių nuotolinio
valdymo pulte.
Galima konfigūruoti toliau išvardytus elementus.
[Face/Eye Detection AF] (veido / akių aptikimo AF)
[SteadyShot]
[White Mode] (baltos spalvos balanso režimas)
[Color Temp] (spalvų temperatūra)
[Scene File] (scenos failas)
[ND Filter Position] (ND filtro padėtis)
[Auto ND Filter] (automatinis ND filtras):
[ND Filter] (ND filtro) reikšmė
[Auto Iris] (automatinė diafragma)
[Iris] (diafragmos) reikšmė
[AGC]
[Gain] (stiprinimo) reikšmė
[ISO] reikšmė
[Exposure Index] (ekspozicijos indeksas)

Pastaba

Kanalai, prie kurių rodoma piktograma  (automatinis), yra reguliuojami automatiškai.
Reikšmių pakeitimai naudojant slankiklį ar mygtukus įrašomam garsui netaikomi.

Patarimas

Slankiklio ir reguliavimo mygtukų nustatymai kiekvienoje eilėje yra susieti.

Garso įvesties lygį galite patikrinti realiuoju laiku naudodami garso lygio matuoklį vaizdų
fiksavimo ekrane.
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[Shutter Type] (užrakto tipas)
[Auto Shutter] (automatinis užraktas)
[Shutter] (užraktas)
[Auto Exposure Mode] (automatinės ekspozicijos režimas)
[Auto Exposure Level] (automatinės ekspozicijos lygis)
[S&Q Motion] (sulėtintas ir pagreitintas filmavimas) ir [Frame Rate] (kadrų sparta)

Patarimas

Be to, ta pačia funkcija galite pasinaudoti spausdami priskiriamą mygtuką ir naudodami žiniatinklio
programos GUI valdymo skydelį.

[103] Naudingos funkcijos

Priskiriami mygtukai

Įrenginio žiniatinklio programoje yra dešimt priskiriamų mygtukų, kuriems galite priskirti
funkcijas.
Priskiriami mygtukai rodomi tiesioginio valdymo ekrane ir atkūrimo valdymo ekrane.

Pastaba

Priskiriamų mygtukų sąrašas nerodomas, kai konfigūruojami nustatymai pagrindinių fotoaparato
funkcijų skydelyje, esančiame tiesioginio valdymo ekrane. Jei norite užbaigti atliekamą veiksmą,
paspauskite viršutiniame dešiniajame reguliavimo skydelio kampe esantį mygtuką [X].

Infraraudonųjų spindulių nuotolinio valdymo pulte paspauskite priskiriamą
mygtuką, kuriam priskirta funkcija [Direct Menu] (tiesioginis meniu).

Mygtukas [Direct Menu] (tiesioginis meniu) pagal numatytuosius gamyklinius nustatymus
priskiriamas 1 priskiriamam mygtukui.
Oranžiniu žymekliu galima pasirinkti tik tuos elementus ekrane, kurie gali būti
konfigūruojami naudojant tiesioginį meniu.

1

GUI valdymo skydelyje esančiais rodyklių mygtukais perkelkite žymeklį ant norimo
nustatyti elemento ir paspauskite mygtuką [Set] (nustatyti).

Bus rodomas meniu arba elementas baltame fone.

2

Rodyklių mygtukais pasirinkite nustatymą ir paspauskite mygtuką [Set] (nustatyti).

Meniu arba baltas fonas dings ir naujas nustatymas bus rodomas su oranžiniu žymekliu.
Jei norite išjungti tiesioginį meniu, dar kartą paspauskite priskiriamą mygtuką, kuriam
priskirta funkcija [Direct Menu] (tiesioginis meniu), arba palaukite 3 sekundes neatlikdami
jokių veiksmų.

3
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Pagal numatytuosius gamyklinius nustatymus priskiriamiems mygtukams būna priskirtos toliau
nurodytos funkcijos.
1 mygtukas: [Direct Menu] (tiesioginis meniu)
2 mygtukas: [Focus Setting] (fokusavimo nustatymas)
3 mygtukas: [Rec Review] (įrašo peržiūra)

1–3 mygtukai atitinka tuos pačius skaičių mygtukus pridedamame infraraudonųjų spindulių
nuotolinio valdymo pulte.

4 mygtukas: [Push Auto ND] (automatinis ND spaudžiant)
5 mygtukas: [Crop Select] (apkirpimo pasirinkimas)
6 mygtukas: [Marker] (žymeklis)
7 mygtukas: [Video Signal Monitor] (vaizdo signalo stebėjimas)
8 mygtukas: [Clip Flag OK] (klipo žymė OK)
9 mygtukas: [Color Bars] (spalvų juostos)
Fokusavimo užlaikymo mygtukas: [Focus Hold] (fokusavimo užlaikymas)

Fokusavimo užlaikymo mygtukas atitinka fokusavimo užlaikymo mygtuką E tipo tvirtinimo
objektyvuose.

Mygtuko funkcijos keitimas
Fotoaparato meniu naudokite [Project] > [Assignable Button] (projektas > priskiriamas
mygtukas).
Jei pakeičiate priskirtą funkciją, pasikeičia ir rodomas priskiriamų mygtukų sąrašas.
Išsamesnė informacija apie priskiriamas funkcijas pateikiama „Priskiriamas mygtukas“ dalyje
„Fotoaparato meniu ir išsamūs nustatymai“.

[104] Naudingos funkcijos

Sulėtintas ir pagreitintas filmavimas

Kai įrašymo formatui nustatytos toliau išvardytos reikšmės, fiksavimo kadrų spartai ir atkūrimo
kadrų spartai galite nurodyti skirtingas reikšmes.
Toliau esančioje lentelėje pateikiama konfigūruojama kadrų sparta.

Sistemos dažnis: 59.94/50/29.97/25/23.98, jutiklio skenavimo režimas: FF
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Sistemos dažnis: 59.94/50/29.97/25/23.98, jutiklio skenavimo režimas: S35

Sistemos dažnis: 24, jutiklio skenavimo režimas: FF

Pastaba

Sulėtintas ir pagreitintas filmavimas negali būti nustatytas įrašymo ir atkūrimo metu arba kai rodomas
miniatiūrų ekranas.

Garso įrašymas sulėtinto ir pagreitinto filmavimo režimu nepalaikomas.

Automatinio fokusavimo funkcija, automatinės diafragmos funkcija ir automatinio išlaikymo funkcija
sulėtinto ir pagreitinto filmavimo režimu yra išjungtos. Tačiau automatinio fokusavimo funkcija gali
būti naudojama kai nustatytas toks kadrų dažnis:

Kadrų sparta, kai sistemos dažnis nustatytas kaip 59.94/29.97/23.98: 30, 60, 120, 240
Kadrų sparta, kai sistemos dažnis nustatytas kaip 50/25: 25, 50, 100, 200

Išsamesnė informacija apie RAW išvestį pateikiama dalyje „RAW vaizdo įrašų fiksavimas“.

[105] Naudingos funkcijos

Vaizdo įrašymas su pertrūkiais („Interval Rec“)

Kodekas Vaizdo įrašo formatas Konfigūruojama kadrų sparta

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Kodekas Vaizdo įrašo formatas Konfigūruojama kadrų sparta

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Kodekas Vaizdo įrašo formatas Konfigūruojama kadrų sparta

XAVC-I 4096×2160P 1–60
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Įrašymo intervalais funkcija leidžia vaizdo įrašą fiksuoti su pertrūkiais ir įrašyti į įrenginio vidinę
atmintį. Ši funkcija yra veiksmingas būdas lėtai judantiems objektams filmuoti.
Kai pradedate įrašymą, įrenginys automatiškai įrašo nurodytą kadrų skaičių („Number of
Frames“) nurodytais laiko intervalais („Interval Time“).

A: fiksavimo intervalas („Interval Time“)
B: vieno fiksavimo kadrų skaičius („Number of Frames“)

Pastaba

Vienu metu gali būti naudojama tik viena speciali filmavimo funkcija, tokia kaip filmavimas intervalais.

Jei vykstant filmavimui intervalais įjungiamas kitas specialus filmavimo režimas, filmavimas
intervalais automatiškai išjungiamas.

Filmavimo intervalais režimas automatiškai išjungiamas pakeitus sistemos nustatymus, pavyzdžiui,
vaizdo įrašo formatą.

Filmavimo intervalais nustatymų negalima pakeisti filmavimo ar atkūrimo metu arba, kai rodomas
miniatiūrų ekranas.

Ribojimai filmuojant
Garsas neįrašomas.
Įrašo peržiūra („Rec Review“) negalima.

Jei įrenginys išjungiamas įrašymo metu
Jei įrenginio maitinimo jungiklis nustatytas į budėjimo režimo padėtį, keletą sekundžių vyksta
iki tol atmintyje išsaugotų vaizdų įrašymas į laikmeną, tada automatiškai įjungiamas įrenginio
budėjimo režimas.
Jei atjungiamas nuolatinės srovės maitinimo laidas, išjungiamas maitinimas iš kintamosios
srovės adapterio arba atjungiamas PoE++ maitinimo tiekimas, iki tol užfiksuoti kadrai gali
būti prarasti (maks. 10 sek.). Turite būti atsargūs.

Kadrų skaičiaus ir intervalo tarp fiksavimo nustatymas

Žiniatinklio meniu [Project] > [Interval Rec] > [Setting] (projektas > įrašymas intervalais >
nustatymas) nustatykite kaip [On] (įjungta) ir nustatykite [Number of Frames] (kadrų skaičius) ir



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

[Interval Time] (intervalo laikas).
Įrenginyje įrašymo intervalais režimas išjungiamas, kai įrenginys išjungiamas, tačiau nustatymai
[Number of Frames] (kadrų skaičius) ir [Interval Time] (intervalo laikas) išsaugomi. Jų nereikės
nustatyti iš naujo, kai kitą kartą filmuosite filmavimo intervalais režimu.

Patarimas

Galite nustatyti ir fotoaparato meniu naudodami [Project] > [Interval Rec] (projektas > įrašymas
intervalais).

Fiksavimo pradėjimas

Paspauskite filmavimo mygtuką START/STOP, kad pradėtumėte filmuoti. Pakaitomis pasirodo
„Int?Rec“ ir „Int?Stby“.

Fiksavimo sustabdymas

Sustabdykite filmavimą.
Kai filmavimas baigsis, iki tol atmintyje laikomi vaizdo įrašo duomenys bus įrašyti į laikmeną.
Jei norite išjungti įrašymo intervalais režimą, atlikite vieną iš toliau nurodytų veiksmų.

Įrenginio maitinimo tiekimą perjunkite į budėjimo režimą.
Veikiant įrašymo budėjimo režimui [Project] > [Interval Rec] > [Setting] (projektas > įrašymas
intervalais > nustatymas) nustatykite kaip [Off] (išjungta).

Be to, įrašymo intervalais režimas automatiškai išjungiamas įrenginį paleidus iš naujo.

[106] Naudingos funkcijos

Talpykloje esančių nuotraukų įrašymas („Picture
Cache Rec“)

Funkcija „Picture Cache Rec“ leidžia užfiksuoti vaizdo įrašą vėliau, kai fiksuojant vaizdus
įrašymas pradedamas išlaikant nurodytos trukmės vidinės talpyklos atmintį.

Talpyklos dydžio nustatymas

Žiniatinklio meniu [Project] > [Picture Cache Rec] > [Setting] (projektas > talpykloje esančių
nuotraukų įrašymas) nustatykite kaip [On] (įjungta), tada nustatykite talpyklos dydį naudodami
[Cache Size] (talpyklos dydis).

Nustatymas [Cache Size] (talpyklos
dydis) Įrašymo į talpyklą laikas (apytikslis)

[Short] (trumpas) 5 sek.

[Medium] (vidutinis) 10 sek.
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Pastaba

Talpykloje esančių nuotraukų įrašymo funkcijos negalima naudoti kartu su įrašymo intervalais,
įrašymo į 2 korteles vienu metu ir tarpinio įrašymo funkcijomis. Kai talpykloje esančių nuotraukų
įrašymas nustatytas kaip įjungtas, šie kiti specialieji įrašymo režimai priverstinai išjungiami.

Režimo „Picture Cache Rec“ negalima rinktis įrašymo metu arba veikiant „Rec Review“.

Jei talpykloje esančių nuotraukų įrašymas nustatytas kaip įjungtas, veikiant režimui [Free Run]
(laisvas veikimas) laiko kodas įrašomas, net jei nustatyta kaip [Regen] (tęsiamas) arba [Rec Run]
(veikimas įrašant).

Nustatymo [Output Format] (išvesties šaltinis) gali nepavykti sukonfigūruoti veikiant talpykloje
esančių nuotraukų įrašymo režimui. Jei taip nutinka, laikinai išjunkite talpykloje esančių nuotraukų
įrašymą, tada pakeiskite nustatymą.

Patarimas

Įrašymo į talpyklą laikas gali būti trumpesnis, nes tai priklauso nuo įrašymo formato. Patikrinkite laiką,
kuris rodomas žiniatinklio meniu [Project] > [Picture Cache Rec] > [Cache Rec Time] (projektas >
talpykloje esančių nuotraukų įrašymas > talpyklos įrašymo laikas).

Galite nustatyti ir fotoaparato meniu naudodami [Project] > [Picture Cache Rec] (projektas >
talpykloje esančių nuotraukų įrašymas).

Be to, įjungti arba išjungti [Picture Cache Rec] (talpykloje esančių nuotraukų įrašymas) galite
naudodami priskiriamą mygtuką.

Talpykloje esančių nuotraukų įrašymo paleidimas

Kai [Picture Cache Rec] (talpykloje esančių nuotraukų įrašymas) nustatoma kaip „On“ (įjungta),
pasirodo „?Cache“ (? yra žalias).
Kai paspaudžiate įrašymo PRADĖJIMO / SUSTABDYMO mygtuką, pradedamas įrašymas, o
vaizdo įrašas įrašomas į atminties korteles pradedant nuo vaizdo įrašo, įrašyto talpyklos
atmintyje.

Pastaba

Pakeitus įrašymo formatą ar bazinį vaizdą iš vaizdų talpyklos atminties pašalinamas iki šiol
išsaugotas vaizdo įrašas, o į talpyklą pradedamas įrašyti naujas vaizdo įrašas. Taigi vaizdų talpyklos
įrašymas prieš pakeičiant formatą negalimas, net jei pradedate įrašymą vos pakeitę formatą.

Jei talpykloje esančių nuotraukų įrašymas paleidžiamas arba sustabdomas vos įdėjus atminties
kortelę, talpyklos duomenys gali būti neįrašyti kortelėje.

Jei talpykloje esančių nuotraukų įrašymo funkcija įjungta, vaizdo įrašas išsaugomas talpyklos
atmintyje. Vaizdo įrašas prieš funkciją nustatant kaip „On“ (įjungta) neįrašomas į talpyklą.

Vaizdo įrašas neišsaugomas talpyklos atmintyje, kai atminties kortelė naudojama, pvz., atkūrimo
metu, veikiant „Rec Review“ arba rodant miniatiūrų ekraną. Vaizdo įrašų įrašymas į vaizdų talpyklą

[Long] (ilgas) 20 sek.

[Max] (maks.)
Didžiausia reikšmė kiekvienam įrašymo
formatui
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tuo metu negalimas.

Talpykloje esančių nuotraukų įrašymo atšaukimas

Žiniatinklio meniu [Project] > [Picture Cache Rec] > [Setting] (projektas > talpykloje esančių
nuotraukų įrašymas > nustatymas) nustatykite kaip [Off] (įjungta) arba paspauskite priskiriamą
mygtuką, kuriam priskirta funkcija [Picture Cache Rec] (talpykloje esančių nuotraukų įrašymas).

[107] Naudingos funkcijos

Įrašymas į A ir B atminties korteles vienu metu („2-slot
Simul Rec“)

Į A ir B atminties korteles vienu metu galite įrašyti žiniatinklio meniu arba fotoaparato meniu
[Project] > [Simul Rec] > [Setting] (projektas > sinchroniškas įrašymas > nustatymas) nustatę
kaip [On] (įjungta).

Įrašymas į A ir B atminties korteles atskirai

Įrašymą į kiekvieną atminties kortelę atskirai galite pradėti / sustabdyti naudodami įrašymo
PRADĖJIMO / SUSTABDYMO mygtuką arba mygtuką [2nd Rec START/STOP] (2-osios
įrašymo PRADĖJIMAS / SUSTABDYMAS) skirtuke  (kita).
Pagal numatytuosius nustatymus abu mygtukai nustatyti sinchroniniam įrašymo pradėti /
sustabdyti A ir B atminties kortelėse.
Jei nustatoma, kad šiais mygtukais būtų valdomas įrašomas skirtingose atminties kortelėse,
[SDI/HDMI Rec Control] (SDI/HDMI įrašymo valdymas) įrašymo pradėjimo / sustabdymo
valdymas atitinka A lizdo įrašymo būseną.

Nustatymo keitimas

Fotoaparato meniu nustatykite [Project] > [Simul Rec] > [Rec Button Set] (projektas >
sinchroniškas įrašymas > įrašymo mygtuko nustatymas).

Nustatymas [Rec
Button Set]

(įrašymo mygtuko
nustatymas)

Mygtukai ir atminties kortelės

Įrašymo mygtukas:
[SlotA SlotB] 
2-asis įrašymo
mygtukas: [SlotA
SlotB]

spaudžiant mygtuką vienu metu paleidžiamas / sustabdomas
įrašymas A ir B atminties kortelėse.

Įrašymo mygtukas:
[SlotA] 
2-asis įrašymo

Įrašymo PRADĖJIMO / SUSTABDYMO mygtukas pradeda / sustabdo
įrašymą į A atminties kortelę, o mygtukas [2nd Rec START/STOP]
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[108] Naudingos funkcijos

Vaizdo signalo stebėjimas

Galite nustatyti, kad vaizdo signalas fotoaparato vaizdo ekrane būtų rodomas kaip kreivė,
vektorskopas arba histograma, tam fotoaparato meniu naudokite [Monitoring] > [Video Signal
Monitor] > [Setting] (stebėjimas > vaizdo signalo stebėjimas > nustatymas).
Oranžinė linija rodo nustatytas [Level Marker 1] (1 lygio žymeklio) ir [Level Marker 2] (2 lygio
žymeklio) reikšmes.
Be to, funkciją [Video Signal Monitor] (vaizdo signalo stebėjimas) galite priskirti priskiriamam
mygtukui.

Stebėjimo numatytasis rodinys
Veikiant „Cine EI“ režimui spalvų erdvės nustatymo arba stebėjimo LUT nustatymo informacija
rodoma vaizdo signalo stebėjimo viršuje dešinėje, kurioje nurodomas stebėjimo tikslas.

[109] Naudingos funkcijos

Klipo žymės

Klipo žymę [OK] prie klipo galite pridėti spausdami priskiriamą mygtuką, kuriam priskirta funkcija
[Clip Flag OK] (klipo žymė OK), ir pasirinkdami [Add OK] (pridėti OK).
Klipo žymę [OK] galite ištrinti spausdami mygtuką dukart ir pasirinkdami [Delete Clip Flag] (trinti
klipo žymę).

Patarimas

Be to, klipo žymę galite pridėti fotoaparato meniu naudodami [Thumbnail] > [Set Clip Flag]
(miniatiūros > nustatyti klipo žymę).

Miniatiūrų ekranas gali būti rodomas turinį surūšiavus pagal klipo žymių tipą (filtruotas klipų

mygtukas: [SlotB]
skirtuke  (kita) pradeda / sustabdo įrašymą į B atminties kortelę.

Įrašymo mygtukas:
[SlotB] 
2-asis įrašymo
mygtukas: [SlotA]

Įrašymo PRADĖJIMO / SUSTABDYMO mygtukas pradeda / sustabdo
įrašymą B atminties kortelėje, o mygtukas [2nd Rec START/STOP]
skirtuke  (kita) pradeda / sustabdo įrašymą A atminties kortelėje.
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miniatiūrų ekranas). Išsamesnė informacija pateikiama „Veiksmai su įrašytais klipais“ dalyje
„Miniatiūrų ekranas“.

[110] Naudingos funkcijos

Pulsuojantis kompensavimas

Fotoaparato meniu naudodami [Technical] > [Lens] > [Breathing Compensation] (techniniai >
objektyvas > pulsuojantis kompensavimas) galite nustatyti, ar objektyvui bus taikomas
pulsuojantis kompensavimas.
Ši funkcija pataiso reiškinį, kai keičiant fokusavimo padėtį pasikeičia matymo kampas.
Taikant pulsuojantį kompensavimą vaizdo dalis yra elektroniškai apkarpoma, kad būtų išlaikytas
matymo kampas ir neatsirastų pulsavimo reiškinys.

Pastaba

Veikiant pulsuojančiam kompensavimui gali šiek tiek pasikeisti matymo kampas ir vaizdo kokybė.

Atsižvelgiant į naudojamą objektyvą, įjungus pulsuojantį kompensavimą matymo kampo pakoreguoti
gali nepavykti.

Kompensavimas negalimas, kai uždedamas pulsuojančio kompensavimo nepalaikant objektyvas.

Ši funkcija būna išjungta („Off“) (fiksuota) toliau nurodytais atvejais.
Kai fotoaparato meniu [Technical] > [Lens] > [Distortion Comp.] (techniniai > objektyvas >
iškraipymo kompensavimas) nustatyta kaip [Off] (išjungta)
Kai žiniatinklio meniu arba fotoaparato meniu [Shooting] > [S&Q Motion] > [Setting] (vaizdų
fiksavimas > sulėtintas ir pagreitintas filmavimas > nustatymas) nustatyta kaip [On] (įjungta)
Kai žiniatinklio meniu arba fotoaparato meniu [Project] > [Rec Format] > [Codec] (projektas >
įrašymo formatas > kodekas) nustatyta kaip [RAW] arba [RAW & XAVC-I]

[111] Naudingos funkcijos Tarpinis įrašymas

Tarpinio įrašymo apžvalga

Ši funkcija leidžia vienu metu įrašyti mažos raiškos duomenis ir tuo pačiu metu įrašyti didelės
raiškos originalius vaizdo įrašo duomenis.

Išsamesnė informacija apie palaikomas atminties korteles, atminties kortelių formatavimą ir
likusios talpos tikrinimą patiekiama „Palaikomos atminties kortelės“ dalyje „Atminties kortelių
paruošimas“.

Apie įrašytą failą
Failo pavadinimo plėtinys yra „.mp4“.
Laiko kodas taip pat įrašomas tuo pačiu metu.
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Įrašyto failo išsaugojimo paskirties vieta
Įrašytas failas išsaugomas toliau nurodytame aplanke.

Apie failo pavadinimą
Failo pavadinimą sudaro atminties kortelėje įrašyto klipo pavadinimas ir priesaga „S03“.
Informacija apie klipų pavadinimus pateikiama fotoaparato meniu [TC/Media] > [Clip Name
Format] (laiko kodas / laikmena > klipo pavadinimo formatas).

[112] Naudingos funkcijos Tarpinis įrašymas

Tarpinio įrašo fiksavimas

Įrašymą galite pradėti, kai įjungtas tarpinis įrašymas.

Įrašoma laikmena Aplanko kelias

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub

Žiniatinklio meniu arba fotoaparato meniu [Project] > [Proxy Rec] > [Setting]
(projektas > tarpinis įrašymas > nustatymas) nustatykite kaip [On] (įjungta).

1

Įdėkite atminties kortelę į „CFexpress“ A tipo / SD kortelės lizdą.

Jei naudojate „CFexpress“ kortelę, ją įdėkite etikete į viršų.
Jei naudojate SD kortelę, ją įdėkite etikete žemyn nuožulniu kampu apačioje.

Pastaba

Įrašymas mažesne raiška negali būti įjungtas tuo pačiu metu, kai nustatytas sulėtintas ir
pagreitintas filmavimas arba filmavimas intervalais. Kai įjungiamas įrašymas mažesne raiška,
šie kiti įrašymo režimai priverstinai išjungiami.

2

Paspauskite įrašymo PRADĖJIMO / SUSTABDYMO mygtuką.

Pradedamas tarpinis įrašymas.

Pastaba

Jei įrenginys išjungiamas arba atminties kortelė išimama tuo metu, kai vyksta duomenų
įrašymas ar nuskaitymas, duomenų saugumas negali būti užtikrintas.
Visi kortelėje įrašyti duomenys gali būti sugadinti. Prieš išjungdami įrenginį arba išimdami
atminties kortelę visada įsitikinkite, kad prieigos indikatorius nešviečia.

Pasirūpinkite, kad atminties kortelė neiššoktų ją įdedant ar išimant.

3
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Kaip sustabdyti filmavimą
Sustabdykite filmavimą.

Garso kanalo nustatymas tarpiniam įrašymui
Garso kanalą tarpinių duomenų įrašymui nustatykite fotoaparato meniu naudodami [Project] >
[Proxy Rec] > [Audio Channel] (projektas > tarpinis įrašymas > garso kanalas).

[113] Naudingos funkcijos Vaizdų fiksavimas su norimu vaizdu

Vaizdo apžvalga

Kai įrenginys veikia pasirinktiniu režimu, galite pridėti juodos spalvos, matricos ir kitų parametrų
reguliavimus, kad sukurtumėte „vaizdą“ remdamiesi baziniu vaizdu.

Be to, galite greitai pasirinkti kitą vaizdą, išsaugoję įvairius nustatymų derinius siužeto failuose.
Įrenginyje yra iš viso šeši iš anksto nustatyti vaizdai.

[114] Naudingos funkcijos Vaizdų fiksavimas su norimu vaizdu

Vaizdo pasirinkimas

Šioje temoja aprašoma, kaip pasirinkti vaizdą.

Patikrinkite, ar žiniatinklio meniu arba fotoaparato meniu [Project] > [Base Setting] >
[Shooting Mode] (projektas > bazinis nustatymas > fiksavimo režimas) nustatyta
kaip [Custom] (pasirinktinis).

Patarimas

Veikiant režimui [Custom] (pasirinktinis), mygtukai [ISO/Gain] (ISO / stiprinimas) ir [Scene File]
(scenos failas) rodomi pagrindinių fotoaparato funkcijų konfigūravimo skydelyje.

1

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką
[Scene File] (scenos failas).

Mygtuko [Scene File] (scenos failas) rėmelis pasikeičia į oranžinį.

2
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[115] Naudingos funkcijos Vaizdų fiksavimas su norimu vaizdu

Norimo bazinio vaizdo importavimas

Kaip bazinį vaizdą galite importuoti 3D LUT failą, sukurta kompiuteriu arba kitu įrenginiu. Galima
importuoti iki 16 failų.
Failo formatas: CUBE failas (*.cube), skirtas 17 taškų arba 33 taškų 3D LUT, sukurtas
naudojant „Catalyst Browse“, „RAW Viewer“ ar „DaVinci Resolve“* (išleistą „Blackmagic Design
Pty. Ltd.“).

Pasirodo scenos failo reguliavimo skydelis.

Reguliavimo skydelyje spauskite mygtuką [Scene File] (scenos failas) ir iš sąrašo
pasirinkite scenos failą su norimu vaizdu.

Toliau pateikti išankstiniai nustatymai yra sukonfigūruoti kaip gamykliniai nustatymai.

Patarimas

Be to, vaizdą galite pasirinkti fotoaparato meniu naudodami [Paint/Look] > [Scene File] >
[Recall] (piešinys / vaizdas > scenos failas > atkurti). Be to, galite atkurti iš anksto nustatytą
vaizdą naudodami [Scene File] > [Preset Recall] (scenos failas > išankstinio nustatymo
atkūrimas).

3

[Target Display] (numatytasis rodinys) [SDR(BT.709)] [HDR(HLG)]

1 siužeto failas [S-Cinetone] [HLG Live]

2 siužeto failas [Standard] [HLG Natural]

3 siužeto failas [Still] (Not registered)

4 siužeto failas [ITU709] (Not registered)

5–16 scenos failai (Not registered) (Not registered)

Patikrinta naudojant „Resolve“ V9.0, V10.0 ir V11.0.*
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Įvesties spalvų erdvė / gama: [S-Gamut3.Cine/S-Log3] arba [S-Gamut3/S-Log3]

Nepakankamos ekspozicijos koregavimas
Jei pasirinkus automatinę ekspoziciją, kai naudojamas importuotas bazinis vaizdas, yra
nepakankamos ekspozicijos tikimybė, pakoreguokite vaizdą žiniatinklio meniu naudodami
[Paint/Look] > [Base Look] > [AE Level Offset] (piešinys / vaizdas > bazinis vaizdas > AE lygio
poslinkis).

3D LUT failą išsaugokite įrenginyje, kuriame įdiegta žiniatinklio programa.1

Žiniatinklio menu atidarykite [Paint/Look] > [Base Look] (piešinys / vaizdas > bazinis
vaizdas).

Pasirodo registruotų bazinių vaizdų sąrašas.

2

Spauskite mygtuką [Import] (importuoti) eilutėje, kurioje norite importuoti failą.

Pasirodo failo pasirinkimo dialogo langas.

3

Pasirinkite paruoštą 3D LUT failą.

Importuotas 3D LUT failas tampa baziniu įrenginio vaizdu.

4

Importuotą 3D LUT failą pasirinkite fotoaparato meniu naudodami [Paint/Look] >
[Base Look] > [Select] (piešinys / vaizdas > bazinis vaizdas > pasirinkti).

5

Fotoaparato meniu sukonfigūruokite [Paint/Look] > [Base Look] > [Input] (piešinys /
vaizdas > bazinis vaizdas > įvestis) ir [Output] (išvestis) taip, kad atitiktų importuoto
3D LUT failo atributus.

6
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Pastaba

Tik importavus 3D LUT failą vaizdas nepasikeičia. Importuotą 3D LUT failą įkelkite fotoaparato meniu
naudodami [Paint/Look] > [Base Look] > [Select] (piešinys / vaizdas > bazinis vaizdas > pasirinkti).

Jei [Input] (įvestis) nėra tinkamai nustatyta, tinkamas vaizdas nebus išgautas.

Meniu [Input] (įvestis), [Output] (išvestis) ir [AE Level Offset] (AE lygio poslinkis) elementų nustatymai
taikomi baziniam vaizdui, pasirinktam naudojant [Select] (pasirinkti). Jei importavote kelis 3D LUT
failus, kiekvieną 3D LUT failą pasirinkite naudodami [Select] (pasirinkti), tada kiekvienam failui
atskirai sukonfigūruokite [Input] (įvestis), [Output] (išvestis) ir [AE Level Offset] (AE lygio poslinkis).

Sukonfigūruoti nustatymai [Input] (įvestis), [Output] (išvestis) ir [AE Level Offset] (AE lygio poslinkis)
išsaugomi kiekvienam 3D LUT failui.

Bazinio vaizdo / LUT pasirinkimo parinktys importuotiems 3D LUT failams yra bendros
[SDR(BT.709)], [HDR(HLG)] ir „Cine EI“ režimams, bet spalvų erdvės ir gama konvertavimas pagal
šiuos režimus neatliekamas.

3D LUT failai neištrinami, jei žiniatinklio meniu pasinaudojate [Maintenance] > [Reset] > [All Reset
(except for Network Settings)] (priežiūra > nustatyti iš naujo > viską nustatyti iš naujo (išskyrus tinklo
nustatymus).

[116] Naudingos funkcijos Vaizdų fiksavimas su norimu vaizdu

Vaizdo pritaikymas

Vaizdą galite pritaikyti pagal bazinį vaizdą naudodami pagrindinių fotoaparato funkcijų
konfigūravimo skydelyje esančio scenos failo reguliavimo skydelio slankiklius [Master Black]
(pagrindinė juoda), [R Black] (R juoda) ir [B Black] (B juoda) bei [Paint/Look] > [Matrix] (piešinys
/ vaizdas > matrica) ir kitus fotoaparato meniu sąrankos elementus.
Prijunkite įrenginį prie televizoriaus arba monitoriaus ir sureguliuokite vaizdo kokybę stebėdami
vaizdą, įjungtą televizoriaus arba monitoriaus ekrane.

1: [R Black] (R juoda) slankiklis / reguliavimo mygtukai
2: [B Black] (B juoda) slankiklis / reguliavimo mygtukai
3: [Master Black] (pagrindinė juoda) slankiklis / reguliavimo mygtukai

Pastaba

Kai importuojate 3D LUT failą ir pritaikote jį vaizdui, norimas vaizdas, nustatytas 3D LUT faile, nebus
sukurtas, jei pakeisite [Paint/Look] > [Matrix] piešinys / vaizdas > matrica) ir kitus nei bazinio vaizdo
nustatymus naudodami fotoaparato meniu.
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Visus pritaikytus nustatymus galite nustatyti iš naujo fotoaparato meniu naudodami [Paint/Look] >
[Reset Paint Settings] > [Reset without Base Look] (piešinys / vaizdas > iš naujo nustatyti piešinio
nustatymus > nustatyti iš naujo be bazinio vaizdo).

[117] Naudingos funkcijos Vaizdų fiksavimas su norimu vaizdu

Vaizdo išsaugojimas

Dabartinį vaizdą galite išsaugoti kaip scenos failą vidinėje atmintyje fotoaparato meniu
naudodami [Paint/Look] > [Scene File] > [Store] (piešinys / vaizdas > scenos failas > išsaugoti).
Išsaugotą vaizdą galite greitai pritaikyti naudodami scenos failo reguliavimo skydelį arba
tiesioginį meniu.

Pastaba

Jei pasirinksite kitą vaizdą neišsaugoję esamo vaizdo, esamas vaizdas bus panaikintas.

Patarimas

Galite pakeisti iš anksto nustatytus siužeto failus. Jei norite atkurti iš anksto nustatytą scenos failą,
įkelkite norimą atkurti vaizdą fotoaparato meniu naudodami [Paint/Look] > [Scene File] > [Preset
Recall] (piešinys / vaizdas > scenos failas > išankstinio nustatymo atkūrimas), tada išsaugokite
scenos failą naudodami [Scene File] > [Store] (scenos failas > išsaugoti).

Išsaugoto vaizdo trynimas
Vidinėje atmintyje išsaugotą scenos failą galite ištinti fotoaparato meniu naudodami [Paint/Look]
> [Scene File] > [Delete] (piešinys / vaizdas > scenos failas > trinti).

Patarimas

Failą ištrynus jis neberodomas scenos failo reguliavimo skydelyje arba tiesioginiame meniu.

[118] Naudingos funkcijos Vaizdų fiksavimas su norimu vaizdu

Bazinio vaizdo trynimas

Importuotus 3D LUT failus galite ištrinti atskirai fotoaparato meniu naudodami [Paint/Look] >
[Base Look] > [Delete] (piešinys / vaizdas > bazinis vaizdas > trinti).
Visus importuotus 3D LUT failus vienu kartu galite ištrinti fotoaparato meniu naudodami
[Paint/Look] > [Base Look] > [Delete All] (piešinys / vaizdas > bazinis vaizdas > trinti visus).

Pastaba

Prieš panaikindami patikrinkite, ar šis bazinis vaizdas nėra naudojamas jokiuose siužeto failuose. Jei
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panaikinamas bazinis vaizdas, kuris yra naudojamas, atitinkamų siužeto failų vaizdas bus
neteisingas.

Importuoti 3D LUT failai neištrinami, jei žiniatinklio meniu pasinaudojate [Maintenance] > [Reset] >
[All Reset (except for Network Settings)] (priežiūra > nustatyti iš naujo > viską nustatyti iš naujo
(išskyrus tinklo nustatymus).

Ištrinto bazinio vaizdo nebebus galima naudoti kaip LUT veikiant „Cine EI“ režimui.

[119] Naudingos funkcijos Vaizdų fiksavimas koreguojant vaizdą vėlesnio redagavimo metu

Vaizdų fiksavimas koreguojant vaizdą vėlesnio
redagavimo metu

Naudodami įrenginį „Cine EI“ režimu ir įrašę tolygius perėjimus iš tamsių zonų į šviesias, tikslius
koregavimus, tokius kaip tamsių ir šviesių zonų perėjimų lokalus atkūrimas, galite atlikti vėlesnio
redagavimo metu.
Tačiau peržiūrint įrašytą vaizdą įprastame monitoriuje, bendras kontrastingumo lygis atrodys
žemas, todėl bus sudėtinga atlikti fokusavimo ir eksponavimo koregavimus.
Stebimam vaizdui įrenginyje galite pritaikyti LUT, kad fiksuojant vaizdus būtų patogiau atlikti
įvairius nustatymus. Be to, galite taikyti LUT atkuriamam vaizdo įrašui, kad galėtumėte įvertinti
galutinį rezultatą.
LUT taikomi toliau nurodytoms sistemoms. Tačiau gali būti pritaikytas tik vienas LUT.

SDI išvestis
HDMI išvestis ir transliacija
Tarpinis klipas, įrašytas įrašymo laikmenoje
Didelės raiškos (pagrindinis) klipas, įrašytas įrašymo laikmenoje

[120] Naudingos funkcijos Vaizdų fiksavimas koreguojant vaizdą vėlesnio redagavimo metu

LUT taikymas HDMI išvesčiai ir transliacijai

LUT gali būti taikoma HDMI išvesčiai ir transliacijai.

Patikrinkite, ar žiniatinklio meniu arba fotoaparato meniu [Project] > [Base Setting] >
[Shooting Mode] (projektas > bazinis nustatymas > fiksavimo režimas) nustatyta
kaip [Cine EI].

Patarimas

Veikiant režimui [Cine EI], mygtukai [Base ISO/Exposure Index] (bazinis ISO / ekspozicijos
indeksas) ir [Base Look/LUT] (bazinis vaizdas / LUT) rodomi pagrindinių fotoaparato funkcijų
konfigūravimo skydelyje.

1
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Pastaba

Transliuojamame vaizde rodomas ir žiniatinklio programos fotoaparato vaizdo skydelis.

Patarimas

Tai taip pat galima nustatyti fotoaparato meniu naudojant [Shooting] > [LUT On/Off] > [HDMI/Stream]
(vaizdų fiksavimas > LUT įjungimas / išjungimas > HDMI / transliacija).

SDI išvestį galima nustatyti tokiu pat būdu.

Vaizdo įrašams įrašymo laikmenoje tai galite nustatyti fotoaparato meniu naudodami [Shooting] >
[LUT On/Off] > [Internal Rec] (vaizdų fiksavimas > LUT įjungimas / išjungimas > vidinis įrašymas) ir
[Proxy] (tarpinis).

[121] Naudingos funkcijos Vaizdų fiksavimas koreguojant vaizdą vėlesnio redagavimo metu

LUT keitimas

Galite keisti taikomą LUT.

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką
[Base Look/LUT] (bazinis vaizdas / LUT).

Mygtuko [Base Look/LUT] (bazinis vaizdas / LUT) rėmelis pasikeičia į oranžinį.

Pasirodo bazinio vaizdo / LUT reguliavimo skydelis.

2

Pasirinkite [HDMI/Stream] > [MLUT] (HDMI / transliacija > MLUT).3

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką
[Base Look/LUT] (bazinis vaizdas / LUT).

Mygtuko [Base Look/LUT] (bazinis vaizdas / LUT) rėmelis pasikeičia į oranžinį.

1
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Patarimas

Įrenginyje [s709], [709(800%)] ir [S-Log3] yra pateikiami kaip iš anksto nustatyti LUT.

Be to, 3D LUT failą galite importuoti ir pritaikyti. Išsamesnė informacija pateikiama dalyje „Norimo
bazinio vaizdo importavimas“ ir „Bazinio vaizdo trynimas“.

Tai galima nustatyti ir fotoaparato meniu naudojant [Paint/Look] > [Base Look] > [Select] (piešinys /
vaizdas > bazinis vaizdas > pasirinkti).

[122] Naudingos funkcijos Vaizdų fiksavimas koreguojant vaizdą vėlesnio redagavimo metu

Tamsių ir šviesių sričių pasiskirstymo keitimas
įrašytame vaizde

Galite pakeisti tamsių ir šviesių sričių pasiskirstymą, pavyzdžiui, jei norite suteikti pirmumą
tamsioms sritims prieš šviesias sritis, pakeisdami bazinio jautrumo ekspozicijos indeksą.

Pasirodo bazinio vaizdo / LUT reguliavimo skydelis.

Paspauskite mygtuką [Base Look/LUT] (bazinis vaizdas / LUT) ir pasirinkite norimą
taikyti bazinį vaizdą.

2

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką
[Base Look/LUT] (bazinis vaizdas / LUT).

Mygtuko [Base Look/LUT] (bazinis vaizdas / LUT) rėmelis pasikeičia į oranžinį.

Pasirodo bazinio vaizdo / LUT reguliavimo skydelis.

1

Pasirinkite [HDMI/Stream] > [MLUT] (HDMI / transliacija > MLUT).2
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Patarimas

Tai taip pat galima nustatyti fotoaparato meniu naudojant [Shooting] > [ISO/Gain/EI] > [Exposure
Index] (vaizdų fiksavimas > ISO / stiprinimas / EI > ekspozicijos indeksas).

SDI išvestį galima naudoti tokiu pat būdu.

Parametro antra skaitinė reikšmė rodo, kiek šviesumo informacijos lygių priskiriama šviesioms sritims
(didesnis šviesumas nei 18 % pilkos spalvos). Šviesesnės sritys bus per šviesios.
Pavyzdys: naudojant „400EI/5.0E“, 5.0 lygiai priskiriami šviesiai daliai.

Be to, tai galite naudoti kaip pagalbą tikrinant tamsių ir šviesių sričių toną, kai filmuojate. Patikrinę
ekspoziciją nepamirškite grąžinti pradinės EI reikšmės.

[123] Naudingos funkcijos RAW įrašymas

RAW vaizdo įrašymas

LUT taikomas HDMI išvesčiai ir transliacijai.

Pagrindinių fotoaparato funkcijų konfigūravimo skydelyje paspauskite mygtuką
[Base ISO/Exposure Index] (bazinis ISO / ekspozicijos indeksas).

Mygtuko [Base ISO/Exposure Index] (bazinis ISO / ekspozicijos indeksas) rėmelis
pasikeičia į oranžinį.

Pasirodo bazinio ISO / ekspozicijos indekso reguliavimo skydelis.

3

Ekspozicijos indeksą sureguliuokite pagal pageidaujamą tamsių ir šviesių sričių
pasiskirstymą naudodami slankiklį [Exposure Index] (ekspozicijos indeksas) arba
reguliavimo mygtukus [Exposure Index] (ekspozicijos indeksas).

4

Sureguliuoti apšvietimą ir (arba) ND filtrą taip, kad fotoaparato vaizdo išvestis iš
[HDMI/Stream] (HDMI / transliacija) būtų tinkamos ekspozicijos.

5
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RAW vaizdo signalo išvestį iš įrenginio jungties SDI OUT galite įrašyti į palaikomą išorinį
įrašymo įrenginį.
Toliau parodyti palaikomi RAW išvesties formatai.

Sistemos dažnis [Codec]
(kodekas)

[RAW Output Format] (RAW išvesties
formatas)

59,94 / 50 / 29,97 / 25 /
23,98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Prijunkite išorinį RAW įrašymo įrenginį prie įrenginio jungties SDI OUT.1

Žiniatinklio meniu arba fotoaparato meniu [Project] > [Base Setting] > [Shooting
Mode] (projektas > bazinis nustatymas > fiksavimo režimas) nustatykite kaip [Cine
EI].

2

Matymo kampą (tik FF) nustatykite žiniatinklio meniu arba fotoaparato meniu
naudodami [Project] > [Rec Format] > [Imager Scan Mode] (projektas > įrašymo
formatas > jutiklio skenavimo režimas).

3

Žiniatinklio meniu arba fotoaparato meniu [Project] > [Rec Format] > [Codec]
(projektas > įrašymo formatas > kodekas) nustatykite kaip [RAW].

Pasirinkus [RAW&XAVC-I] vienu metu bus įrašomas RAW vaizdo įrašas į išorinį RAW
įrašymo įrenginį ir vaizdo įrašas į įrenginio atminties kortelę.

4

Nustatykite raišką žiniatinklio meniu arba fotoaparato meniu naudodami [Project] >
[Rec Format] > [RAW Output Format] (projektas > įrašymo formatas > RAW išvesties
formatas).

5

Patikrinkite, ar išorinis įrašymo įrenginys įjungtas, tada tiesioginio valdymo ekrane
paspauskite įrašymo PRADĖJIMO / SUSTABDYMO mygtuką.

RAW vaizdo įrašo fiksavimo būseną rodo piktograma fotoaparato vaizdo skydelyje.

6
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Pastaba

Kai išoriniame įrašymo įrenginyje įrašymas paleidžiamas nenaudojant įrašymo PRADĖJIMO /
SUSTABDYMO mygtuko tiesioginio valdymo ekrane, klipai gali būti neįrašyti tinkamai.

[124] Naudingos funkcijos RAW įrašymas

RAW vaizdo įrašų fiksavimas naudojant sulėtinto ir
pagreitinto filmavimo režimą

RAW vaizdo įrašą galite fiksuoti naudodami sulėtinto ir pagreitinto filmavimo režimą.

Išsamesnė informacija apie fiksuojant vaizdus palaikomą kadrų spartą pateikiama dalyje
„Sulėtintas ir pagreitintas filmavimas“.

[125] Naudingos funkcijos „Bokeh“ reguliavimas („Bokeh“ valdymo funkcija)

„Bokeh“ valdymo funkcijos įjungimas / išjungimas

„Bokeh“ laipsnį galite lengvai reguliuoti ND filtrą ir stiprinimą susieję diafragmos veikimu.

„Bokeh“ valdymo funkcijos įjungimas / išjungimas

Šią funkciją galima įjungti, tik kai ekspozicija reguliuojama rankiniu būdu. Nustatykite kintamąjį
ND filtro režimą, tada nustatykite rankinį diafragmos, stiprinimo, užrakto ir ND filtro reguliavimą.
„Bokeh“ valdymo funkcija įjungti / išjungti galite fotoaparato meniu naudodami [Shooting] > [Iris]

Pastaba

Įrašymo valdymo signalo išvestis siunčiama iš įrenginio jungties SDI OUT, bet nepavyksta
gauti išorinio įrašymo įrenginio būsenos. Dėl šios priežasties įrenginys gali rodyti, kad vyksta
RAW vaizdo įrašymas, nors iš tikrųjų išorinis įrašymo įrenginys neįrašinėja. Teisingą darbinę
būseną sužinosite patikrinę išorinio įrašymo įrenginio indikatorių.
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> [Bokeh Control] (vaizdų fiksavimas > diafragma > „bokeh“ valdymas).
Kai „bokeh“ valdymo funkcija yra nustatyta kaip „On“ (įjungta), ant ND filtro ir stiprinimo
indikatorių rodoma  (B) piktograma.

Pastaba

Ši funkcija įjungiama tik su E tipo tvirtinimo objektyvais, kurie gali palaikyti ryšį su įrenginiu.

Visas šios funkcijos galimybes galima išnaudoti su „Sony“ E tipo tvirtinimo objektyvu.

Be to, funkciją [Bokeh Control] („bokeh“ valdymas) galite priskirti priskiriamam mygtukui ir „bokeh“
valdymo funkciją įjungti ar išjungti spausdami mygtuką.

„Bokeh“ valdymo funkcija nustatoma kaip „Off“ (išjungta), kai atliekamas kuris nors iš toliau nurodytų
veiksmų.

Kai įrenginys išjungiamas
Kai nustatomas automatinis diafragmos, stiprinimo, užrakto ar ND filtro režimas
Kai perjungiamas fiksavimo režimas
Kai įjungiamas skaidrus ar išankstinis ND filtro režimas
Kai nuimamas objektyvas
Kai įrenginys paleidžiamas iš naujo, pvz., perjungus dažnį

[126] Naudingos funkcijos „Bokeh“ reguliavimas („Bokeh“ valdymo funkcija)

„Bokeh“ laipsnio reguliavimas

Pastaba

Išvaizda gali skirtis ir priklauso nuo veikimo greičio, objektyvo, vaizdų fiksavimo nustatymų ir objekto,
be to, gali keisti šviesumas. Primygtinai rekomenduoja prieš pradedant fiksuoti vaizdus atlikti
fotoaparato patikrinimą.

Šviesumas gali pasikeisti pasikeitus diafragmos veikimo krypčiai, pvz., kai diafragma atidaroma ją
uždarius arba kai ji uždaroma ją atidarius. Tokiu atveju iš pradžių dar šiek tiek pakoreguokite, tada
truputį paeikite atgal, patikrinkite šviesumą ir pradėkite fiksuoti vaizdus. Pavyzdžiui, jei norite
diafragmą atidaryti iki F8 diafragmos ir sulieti foną, pirma uždarykite diafragmą daugiau nei F8 ir vėl
sugrąžinkite F8 nustatymą, patikrinkite šviesumą ir pradėkite fiksuoti vaizdus.

„Bokeh“ valdymo veiksmus atlikite iš lėto. Jei veiksmus reikia atlikti greičiau, pabandykite reguliuoti
palaipsniui tikrindami pasikeitimus vaizde.

„Bokeh“ valdymo funkciją nustatykite kaip „On“ (įjungta).1

Sureguliuokite ND filtrą ir stiprinimą, kad nustatytumėte ekspoziciją.2

Sureguliuojama diafragma.

Pasikeičia „bokeh“ laipsnis.

3
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Patarimas

Kai „bokeh“ valdymo funkcija nustatyta kaip „On“ (įjungta), ND filtras ir stiprinimas veikia kartu ir
kompensuoja ekspozicijos pasikeitimus dėl diafragmos reguliavimo, todėl galite keisti „bokeh“ laipsnį.

„Bokeh“ valdymas pirmiausia yra susietas su ND filtru ir veikia pagal diafragmos veikimą. Kai ND
filtro nebegalima keisti, susiejamas stiprinimas.

Veikiant MF režimui rekomenduojama pirma atidaryti diafragmą, tada sureguliuoti fokusavimą.

Jei vietoje „bokeh“ valdymo funkcijos naudojate automatinį ND filtro režimą, ND filtras bus
reguliuojamas pagal objekto šviesumo pasikeitimus.

Rodinys susiejus stiprinimą
Kai „bokeh“ valdymo funkcija yra nustatyta kaip „On“ (įjungta), reguliuojant diafragmą gali keistis
stiprinimas.
Kai susiejus stiprinimą ir jis pasikeičia, ekrano viršuje parodomas pranešimas, o ant stiprinimo
indikatoriaus pradeda mirksėti  (B) piktograma.

[127] Naudingos funkcijos Konfigūravimo duomenų išsaugojimas ir įkėlimas

Konfigūravimo duomenų išsaugojimo ir įkėlimo
apžvalga

Naudodami žiniatinklio programą įrenginio nustatymus galite išsaugoti kaip konfigūracijos
duomenis. Tokiu būdu galėsite greitai atkurti esamą situaciją atitinkanti meniu nustatymų rinkinį.
Naudodami šį įrenginį beveik visus nustatymus, susijusius su fotoaparato funkcijomis (išskyrus
nurodytąsias toliau esančioje pastaboje), galite išsaugoti ALL faile (faile su visais nustatymais).

Pastaba

Tinklo funkcijų nustatymai ir tapatybės patvirtinimo informacija neišsaugomi. Išsamesnė informacija
apie išsaugomus elementus pateikiama dalyje „Meniu elementų sąrašas“.

[128] Naudingos funkcijos Konfigūravimo duomenų išsaugojimas ir įkėlimas

ALL failo išsaugojimas

Šioje temoje aprašoma, kaip išsaugoti ALL failą.

Žiniatinklio meniu atidarykite [Project] > [All File] (projektas > ALL failas).1

Paspauskite mygtuką [Save All File] > [Save] (išsaugoti ALL failą > išsaugoti).

Žiniatinklio naršyklė iškart atsisiųs failą pavadinimu all-file.ALL.

2
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[129] Naudingos funkcijos Konfigūravimo duomenų išsaugojimas ir įkėlimas

ALL failo įkėlimas

Šioje temoje aprašoma, kaip įkelti ALL failą.

Pastaba

Įkėlus konfigūravimo duomenis įrenginys pasileis iš naujo automatiškai. Paleidę iš naujo naršyklėje
dar kartą įkelkite puslapį.

[130] Tinklo funkcijos Failų perdavimas

Apie failų perdavimą

Įrenginyje įrašytus tarpinį ir originalų failus galite įkelti į serverį internete arba serverį vietiniame

Nurodykite atsisiųsto failo all-file.ALL vietą ir failo pavadinimą, tada jį išsaugokite.

Išsamesnė informacija apie veiksmus su failais pateikiama įrenginio naudojimo
instrukcijose.

3

Žiniatinklio meniu atidarykite [Project] > [All File] (projektas > ALL failas).1

Paspauskite mygtuką [Load All File] > [Load] (įkelti ALL failą > įkelti).

Įrenginyje, kuriame paleista žiniatinklio programa, pasirodo failo atidarymo dialogo langas.

2

Atidarykite norimą įkelti failą.

Išsamesnė informacija apie veiksmus su failais pateikiama įrenginio naudojimo
instrukcijose.

3

Kai pasirodo failo pavadinimo įkėlimo patvirtinimo ekranas, paspauskite mygtuką
[OK].

4

Kai pasirodo vykdymo rezultato ekranas, paspauskite mygtuką [OK].5

Palaukite, kol įrenginys bus paleistas iš naujo, tada vėl prisijunkite prie žiniatinklio
programos.

6
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tinkle.

Pastaba

Kai maitinimo tiekimas veikia budėjimo režimu, failų perdavimai sulaikomi, net jei įrenginiui veikti
energijos pakanka.

[131] Tinklo funkcijos Failų perdavimas

Failų perdavimo paskirties vietos registravimas

Prieš pradėdami failų perdavimą galite užregistruoti perdavimo paskirties vietos serverį.

Žiniatinklio meniu pasirinkite [Network] > [File Transfer] > [Default Upload Server] >
[Server Settings1] (tinklas > failų perdavimas > numatytasis įkėlimo serveris > 1
serverio nustatymai) (arba [Server Settings2] (2 serverio nustatymai), [Server
Settings3] (3 serverio nustatymai).

Patarimas

Pasirinkimo parinkties pavadinimas priklausys nuo [Display Name] (rodomas pavadinimas),
kuris bus sukonfigūruotas kitame veiksme.

1

Žiniatinklio meniu sukonfigūruokite toliau nurodytus [Network] > [FTP Server 1]
(tinklas 1 FTP serveris)–[FTP Server 3] (3 FTP serveris) elementus.

[Display Name] (rodomas pavadinimas)
Rinkdamiesi perdavimo paskirties vietos serverį perdavimo užduočių sąraše įveskite
serverio pavadinimą.
[Service] (paslauga)
Rodo serverio tipą.
[FTP]: FTP serveris
[Host Name] (pagrindinio kompiuterio pavadinimas)
Įveskite serverio adresą arba pagrindinio kompiuterio pavadinimą.
[Port] (prievadas)
Įveskite serverio prisijungimo prievado numerį.
[User Name] (naudotojo vardas)
Įvesti naudotojo vardą.
[Password] (slaptažodis)
Įveskite slaptažodį.
[Passive Mode] (pasyvusis režimas)
Įjunkite arba išjunkite pasyvų režimą.
[Destination Directory] (paskirties katalogas)
Įveskite aplanko paskirties serveryje pavadinimą.

Pastaba

Jei dalyje [Destination Directory] (paskirties katalogas) įvedate simbolių, kurie neleidžiami

2
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[132] Tinklo funkcijos Failų perdavimas Failo pasirinkimas ir įkėlimas

Atminties kortelėje esančio tarpinio failo įkėlimas iš
miniatiūrų lango

Atminties kortelėje saugomus tarpinius failus galite įkelti atskirai iš miniatiūrų ekrano.

paskirties serveryje, failai bus persiųsti į naudotojo šakninį katalogą. Neleidžiami simboliai gali
skirtis atsižvelgiant į serverį.

[Using Secure Protocol] (saugaus protokolo naudojimas)
Nustatykite, ar bus vykdomas saugusis FTP perdavimas.
[Root Certificate] (šakninis sertifikatas)
Sertifikato įkėlimas / pašalinimas.
[Load] (įkelti): įkelkite CA sertifikatą. Įkeliami PEM formato sertifikatai.
[Clear] (valyti): išvalomas CA sertifikatas.
[None] (joks): neįkelti arba pašalinti sertifikatą.

Pastaba

Prieš įkeldami CA sertifikatą nustatykite teisingą laiką įrenginio laikrodyje.

Kai įrašote XAVC-I 4096×2160P/3840×2160P 59.94/50P formatu, parinkties [Load] (įkelti)
pasirinkti negalima.

[Root Certificate Status] (šakninio sertifikato būsena): parodoma sertifikato įkėlimo
būsena.
[Reset] (nustatyti iš naujo): iš naujo nustatomi serverio nustatymai ir atkuriamos
numatytosios reikšmės.

Žiniatinklio programos tiesioginio valdymo ekrane paspauskite mygtuką
[Thumbnail] (miniatiūros).

Rodinys ekrane pasikeičia iš fotoaparato vaizdo į miniatiūrų ekraną.

1

Fotoaparato meniu pasirinkite [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip]
(miniatiūros > perduoti klipą (tarpinį) > pasirinkti klipą).

Jei vienu metu norite perduoti visus tarpinius failus, pasirinkite [Transfer Clip (Proxy)] > [All
Clips] (perduoti klipą (tarpinį) > visi klipai).
Klipus galima persiųsti iš miniatiūrų ekrano arba filtruoto klipų miniatiūrų ekrano.

2

Norimą perduoti klipą pasirinkite mygtuku [Set] (nustatyti) ir paspauskite mygtuką
[Menu] (meniu).

Bus rodomas persiuntimo patvirtinimo langas.

3
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Pastaba

Galima registruoti iki 200 siuntimo užduočių.

[133] Tinklo funkcijos Failų perdavimas Failo pasirinkimas ir įkėlimas

Atminties kortelėje esančio originalaus failo įkėlimas
iš miniatiūrų ekrano

Atminties kortelėje esantį originalų failą galite įkelti iš miniatiūrų ekrano.

Pasirinkite [Execute] (vykdyti).

Tarpinis failas, atitinkantis pasirinktą klipą, bus užregistruotas kaip perdavimo užduotis ir
prasidės įkėlimas.
Kai siuntimo užduotis sėkmingai registruojama, pasirodo rezultato langas.

4

Paspauskite mygtuką [OK] (gerai).5

Žiniatinklio programos tiesioginio valdymo ekrane paspauskite mygtuką
[Thumbnail] (miniatiūros).

Rodinys ekrane pasikeičia iš fotoaparato vaizdo į miniatiūrų ekraną.

1

Fotoaparato meniu pasirinkite [Thumbnail] > [Transfer Clip] > [Select Clip]
(miniatiūros > perduoti klipą > pasirinkti klipą).

Jei vienu metu norite perduoti visus originalius failus, pasirinkite [Transfer Clip] > [All Clips]
(perduoti klipą > visi klipai).
Klipus galima persiųsti iš miniatiūrų ekrano arba filtruoto klipų miniatiūrų ekrano.

2

Norimą perduoti klipą pasirinkite mygtuku [Set] (nustatyti) ir paspauskite mygtuką
[Menu] (meniu).

Bus rodomas persiuntimo patvirtinimo langas.

3

Pasirinkite [Execute] (vykdyti).

Pasirinkto klipo originalus failas bus užregistruotas kaip perdavimo užduotis ir prasidės
įkėlimas.
Kai siuntimo užduotis sėkmingai registruojama, pasirodo rezultato langas.

4

Paspauskite mygtuką [OK] (gerai).5
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Pastaba

Galima registruoti iki 200 siuntimo užduočių.

[134] Tinklo funkcijos Failų perdavimas Failo pasirinkimas ir įkėlimas

Failų perdavimo būsenos tikrinimas

Failų perdavimo būseną galite patikrinti fotoaparato meniu pasirinkę [Network] > [File Transfer]
> [View Job List] (tinklas > failų perdavimas > peržiūrėti užduočių sąrašą).

Pastaba

Galima registruoti iki 200 siuntimo užduočių.

Perdavimo užduotys išsaugomos, kai įrenginys perjungiamas į budėjimo būseną, tačiau atjungus
maitinimą kitais būdais gali būti prarasta iki 10 min. vėliausio įkėlimo eigos informacijos.

Jei failų perdavimo metu įvyksta klaida, klipo su tuo pačiu pavadinimu, kaip perduotasis klipas,
perdavimas gali nebūti tęsiamas (tai priklauso nuo perdavimo paskirties vietos serverio nustatymų ir
būsenos). Tokiu atveju patikrinkite perdavimo paskirties vietos serverio nustatymus ir būseną.

Patarimas

Jei fotoaparato meniu [Network] > [File Transfer] > [Auto Upload (Proxy)] (tinklas > failų perdavimas
> automatinis įkėlimas (tarpinis) nustatyta kaip [On] (įjungta) ir yra prisijungta prie tinklo, pasibaigus
įrašymui tarpiniai failai bus automatiškai įkeliami į serverį, kuris nurodytas naudojant [Default Upload
Server] (numatytasis įkėlimo serveris).

[135] Tinklo funkcijos Failų perdavimas

Įkėlimas naudojant saugų FTP

Galite įkelti užšifruotus failus naudodami FTPS atviru režimu (FTPES) ryšiui su paskirties failo
serveriu.
Jei norite vykdyti saugųjį FTP perdavimą, paskirties failo serverio nustatymuose [Using Secure
Protocol] (naudojant saugųjį protokolą) nustatykite kaip [On] (įjungta) ir įkelkite sertifikatą.

Išsamesnė informacija apie konfigūraciją pateikiama dalyje „Failų perdavimo paskirties
vietos registravimas“.

[136] Tinklo funkcijos Transliacijos konfigūravimas
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Apie transliavimą

Įrenginys gali vienu metu transliuoti vaizdą ir garsą, kurių išvesties signalas siunčiamas iš HDMI
jungties.

Pastaba

Jei transliaciją norite naudoti kaip pagrindinį vaizdą, žiniatinklio meniu [Monitoring] > [Output Display]
> [SDI] (stebėjimas > išvesties rodymas > SDI) nustatykite kaip [On] (įjungta), o [HDMI/Stream]
(HDMI / transliacija) kaip [Off] (išjungta), tada stebėkite fotoaparato būseną SDI monitoriuje.

Jei prie HDMI jungties prijungtas monitorius nepalaiko HDMI išvesties formato, sukonfigūruoto
žiniatinklio meniu arba fotoaparato meniu esančiame meniu [Monitoring] (stebėjimas), fotoaparato
vaizdas nebus rodomas žiniatinklio programoje. Transliuojamo vaizdo išvestis taip pat nebus
rodoma.

Nustatyta transliacijos vaizdo raiška negali būti didesnė nei HDMI išvesties signalo raiška.

Jei vaizdą žiūri keli naudotojai, jis gali būti iškraipytas dėl kodekų nustatymų.

Įrenginys palaiko toliau nurodytus transliacijos metodus. Galimi vaizdo kodekai nurodyti
skliaustuose.

RTSP (H.264, H.265)
SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Transliacijos formato nustatymą, vaizdo kodeko nustatymą ir garso kodeko nustatymą
sukonfigūruokite nurodyta tvarka.

?: įjungta, –: išjungta

Patarimas

Transliavimo
formatas

Kodeko nustatymas

1 vaizdo
transliacija

2 vaizdo
transliacija

3 vaizdo
transliacija

„Audio Stream“ (garso
transliavimas)

RTSP
? 
1 vaizdas

? 
2 vaizdas

– ?

SRT ? – – ?

NDI|HX
? 
pagrindinis

? 
pagalbinis

– ?

Žiniatinklio
programa

– – ? –
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Vaizdas žiniatinklio programos fotoaparato vaizdo skydelyje yra ir transliacijos sistema.

[137] Tinklo funkcijos Transliacijos konfigūravimas

Transliavimo formato nustatymas

Transliacijos formatą nustatykite žiniatinklio meniu naudodami [Stream] > [Stream] > [Stream
Setting] > [Setting] (transliacija > transliacijos nustatymas > nustatymas).

Kai [Setting] (nustatymas) nustatyta kaip [RTSP]

RTSP transliacijos metu vaizdą iš vieno fotoaparato vienu metu gali žiūrėti net penki naudotojai.
Galite nustatyti du vaizdo kodekų režimus.
[Port Number] (prievado numeris)
Nustatomas prievado numeris, naudojamas RTSP transliacijai. Numatytoji reikšmė yra 554.
Pakeitus šį nustatymą RTSP serveris bus paleistas iš naujo.
[Time Out] (skirtasis laikas)
Nurodomas komandos išlaikymo skirtasis laikas RTSP transliacijos metu. Skirtąjį laiką galima
nustatyti diapazone nuo 0 iki 600 sek. Numatytoji reikšmė yra 60 sek.
Jei nustatoma 0 sek., komandos išlaikymo skirtasis laikas netaikomas.
[Authentication] (autentiškumo nustatymas)
Nustatoma, ar bus reikalaujama autentiškumo nustatymo.
[Video Port Number 1] (1 vaizdo prievado numeris), [Video Port Number 2] (2 vaizdo
prievado numeris)
Nurodomas vaizdo duomenų ryšio prievado numeris, naudojamas RTSP transliacijai unikaliais
adresais. Gamyklinė numatytoji Video Port Number 1 (1 vaizdo prievado numeris) reikšmė yra
51000. Gamyklinė numatytoji Video Port Number 2 (2 vaizdo prievado numeris) reikšmė yra
53000. Nurodykite lyginį skaičių diapazone nuo 1024 iki 65534. Čia nustatytas numeris ir
vėlesni nelyginiai skaičiai, gauti pridedant 1, tampa dviem prievadų numeriais, kurie naudojami
vaizdo duomenų ryšiui ir valdymui.
[Video Port Number 1] (1 vaizdo prievado numeris) ir [Video Port Number 2] (2 vaizdo prievado
numeris) atitinka [Stream] > [Video Stream] > [Video Stream 1] (transliacija > vaizdo transliacija
. 1 vaizdo transliacija) ir [Video Stream 2] (2 vaizdo transliacija).
[Audio Port Number] (garso prievado numeris)
Nurodomas garso duomenų ryšio prievado numeris, naudojamas RTSP transliacijai unikaliais
adresais. Numatytoji reikšmė yra 57000. Nurodykite lyginį skaičių diapazone nuo 1024 iki
65534. Čia nustatytas numeris ir vėlesni nelyginiai skaičiai, gauti pridedant 1, tampa dviem
prievadų numeriais, kurie naudojami garso duomenų ryšiui ir valdymui.

Kai [Setting] (nustatymas) nustatyta kaip [SRT-Caller] (SRT siuntėjas)
arba [SRT-Listener] (SRT gavėjas)

Vaizdo kodo režimas yra tik H.264.
[Destination] (paskirties vieta)
Parodoma, kai transliacijos režimas yra nustatytas kaip [SRT-Caller] (SRT siuntėjas).
Nustatomas ryšio paskirties URL.
[Port Number] (prievado numeris)
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Parodoma, kai transliacijos režimas yra nustatytas kaip [SRT-Listener] (SRT gavėjas).
Nustatomas prievado numeris, kuriuo gaunamas signalas. Numatytoji reikšmė yra 4201.
[Latency] (delsa)
Nustatoma delsa diapazone nuo 20 ms iki 8000 ms. Numatytoji reikšmė yra 120.
[TTL]
Nustatoma TTL reikšmė diapazone nuo 1 iki 255. Numatytoji reikšmė yra 64.
[Encryption] (šifravimas)
Pasirenkamas šifravimo metodas. Pasirinkite „Off“ (išjungta), AES128 arba AES256. Numatytoji
reikšmė yra „Off“ (išjungta).
[Passphrase] (prieigos kodas)
Nustatomas prieigos kodas, naudojamas šifravimui. Paspaudus mygtuką [Reset] (nustatyti iš
naujo) sukonfigūruotas prieigos kodas bus nustatytas iš naujo.
[ARC]
Jei norite įjungti prisitaikančios spartos valdymo („Adaptive Rate Control“) funkciją, nustatykite
kaip „On“ (įjungta).
Kai įjungta prisitaikančios spartos valdymo funkcija, galima sumažinti dėl ryšio linijos perkrovos
atsirandančių pertraukimų skaičių.

Kai [Setting] (nustatymas) nustatyta kaip [NDI|HX]

Įrenginys atitinka NDI|HX 2 versijos iš „NewTek“ reikalavimus.
Jei norite naudoti NDI|HX, būtina įsigyti licencijos kodą.
Licencijos kodo įsigijimas
Įsigyti galite apsilankę nurodytu „NewTek“ URL.
http://new.tk/ndi_sony

Pastaba

Atsisiųskite naujausią NDI|HX tvarkyklę ir ją įdiekite „NewTek“ gaminyje.

Išsamesnė informacija apie NDI|HX registraciją ir naudojimą pateikiama „NewTek“ gaminio
naudojimo instrukcijose.

[License] (licencija)
Parodoma įjungtos licencijos informacija.
[Source Name] (šaltinio pavadinimas)
Parodomas šaltinio pavadinimas.
[Group] (grupė)
Jei norite įjungti NDI grupavimo funkciją, nustatykite kaip „On“ (įjungta).
[Group Name] (grupės pavadinimas): nustatomas NDI grupės pavadinimas. Galima
sukonfigūruoti įvairius nustatymus, kuriuos reikia atskirti kableliu.
[Discovery Server 1] (1 aptikimo serveris), [Discovery Server 2] (2 aptikimo serveris)
Nustatomas 1 NDI aptikimo serveris ir 2 NDI aptikimo serveris.
[Reliable UDP Mode] (patikimo UDP režimas)
Jei norite įjungti patikimo UDP režimą, nustatykite kaip „On“ (įjungta).
[Multicast Mode] (daugiaadresio perdavimo režimas)
Jei norite įjungti daugiaadresio perdavimo transliaciją, nustatykite kaip „On“ (įjungta).
[Multicast Prefix] (daugiaadresio perdavimo priešdėlis): nustatomas priešdėlis, naudojamas
daugiaadresio perdavimo transliacijai.
[Multicast Netmask] (daugiaadresio perdavimo tinklo kaukė): nustatoma tinklo kaukė, kuria
nustatomas daugiaadresio perdavimo adresų diapazonas.



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

[Multicast TTL] (daugiaadresio perdavimo TTL): nustatoma TTL reikšmė, skirta daugiaadresio
perdavimo transliacijai, diapazone nuo 1 iki 256. Numatytoji reikšmė yra 3.
[Multi-TCP Mode] (kelių TCP režimas)
Jei norite įjungti kelių TCP režimą, nustatykit kaip „On“ (įjungta).
[Unicast UDP Mode] (transliacijos unikaliais adresais UDP režimas)
Jei norite įjungti transliacijos unikaliais adresais UDP režimą, nustatykite kaip „On“ (įjungta).

Apie trečiųjų šalių paslaugas ir programinę įrangą
Gali būti taikomos skirtingos naudojimo sąlygos.

Paslaugų ir programinės įrangos naujinių teikimas gali būti pertrauktas arba nutrauktas iš
anksto nepranešus.
Paslaugų ir programinės įrangos aprašymai gali būti keičiami iš anksto nepranešus.
Gali būti reikalinga atskira registracija arba prenumerata.

„Sony“ nebus atsakinga už jokias naudotojų ar trečiosios šalies pretenzijas dėl naudojimosi kitų
įmonių paslaugomis ir programine įranga.

[138] Tinklo funkcijos Transliacijos konfigūravimas

Transliavimo vaizdo kodeko nustatymas

Vaizdo kodeką nustatykite žiniatinklio meniu naudodami [Stream] > [Video Stream] (transliacija
> vaizdo transliacija).

[Video Stream 1] (1 vaizdo transliacija), [Video Stream 2] (2 vaizdo transliacija),
[Video Stream 3] (3 vaizdo transliacija)
Galite nustatyti tris vaizdo kodekų režimus. Kiekvienam vaizdo kodekui atskirai sukonfigūruokite
toliau nurodytus nustatymus.
[Video Stream 3] (3 vaizdo transliacija) yra naudojama žiniatinklio programos fotoaparato vaizdo
skydeliui rodyti.

Pastaba

Kai [Stream] > [Stream Setting] > [Setting] (transliacija > transliacijos nustatymas > nustatymas)
nustatyta kaip [SRT-Caller] (SRT siuntėjas) arba [SRT-Listener] (SRT gavėjas), kai kuriems [Video
Stream 1] (1 vaizdo transliacija), [Video Stream 2] (2 vaizdo transliacija) ir [Video Stream 3] (3 vaizdo
transliacija) nustatymams ([Codec] (kodekas), [Size] (dydis), [Frame Rate] (kadrų sparta), [Bit Rate
Compression Mode] (spartos bitais glaudinimo režimas) bus naudojamos numatytosios reikšmės.

[Codec 1] (1 kodekas), [Codec 2] (2 kodekas), [Codec 3] (3 kodekas)
Pasirinkite [H.264], [H.265] arba [Off] (išjungta). Atminkite, kad [Codec 1] (1 kodekas) negalima
nustatyti kaip [Off] (išjungta). Be to, [Codec 3] (3 kodekas) nustatyta kaip [JPEG] (fiksuota).

Pastaba

Toliau nurodytus požymius galite pastebėti, jei naudosite derinius su įvairiais nustatymais, pvz.,
[Codec 1] (1 kodekas), [Codec 2] (2 kodekas) ir [Codec 3] (3 kodekas) vaizdo dydis, kadrų sparta ir
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sparta bitais.
Padidėjusi vaizdo delsa.
Atkuriant vaizdo įrašą praleidžiami kadrai.
Trūkinėjantis garsas.
Sulėtėjęs fotoaparato reakcijos laikas atliekant įvairias komandas.
Sulėtėjęs fotoaparato reakcijos laikas atliekant veiksmus nuotoliniu valdikliu.
Lėtas monitoriaus ekrano rodinys ir konfigūravimo veiksmai.

Jei pajuntate tokius požymius, problemai pašalinti sumažinkite vaizdo dydžio, kadrų spartos ir
spartos bitais parametrų reikšmes arba pakeiskite kitų sąrankos parametrų reikšmes.

Kai [Stream] > [Stream Setting] > [Setting] (transliacija > transliacijos nustatymas > nustatymas)
nustatyta kaip [SRT-Caller] (SRT siuntėjas) arba [SRT-Listener] (SRT gavėjas), [Codec 1] (1
kodekas) nustatyta kaip [H.264] (fiksuota). [Codec 2] (2 kodekas) nustatyta kaip [Off] (išjungta)
(fiksuota).

Jei pakeičiamas HDMI išvesties vaizdo dydis arba sistemos dažnis, [Codec 2] (2 kodekas)
nustatoma kaip [Off] (išjungta).

[Size 1] (1 dydis), [Size 2] (2 dydis), [Size 3] (3 dydis)
Pasirenkamas vaizdo dydis, naudojamas transliacijai iš fotoaparato.
Galimos vaizdo dydžio parinktys priklauso nuo HDMI išvesties vaizdo dydžio.

Pastaba

Kai pakeičiamas HDMI išvesties vaizdo dydis arba sistemos dažnis, pasirenkamas didžiausias
vaizdo dydis.

[Frame Rate 1] (1 kadrų sparta), [Frame Rate 2] (2 kadrų sparta), [Frame Rate 3] (3 kadrų
sparta)
Nustatoma vaizdo kadrų sparta.
Vienetai „kadr./sek.“ rodo kadrų skaičių, kuris perduodamas transliacijos metu per vieną
sekundę.
Galimos kadrų spartos parinktys priklauso nuo HDMI išvesties vaizdo dydžio.

Pastaba

Kai pakeičiamas HDMI išvesties vaizdo dydis arba sistemos dažnis, pasirenkamas didžiausia kadrų
sparta.

[I-Picture Mode 1] (1 „I-Picture“ režimas), [I-Picture Mode 2] (2 „I-Picture“ režimas)
„I-picture“ įterpimo intervalo nurodymo būdas naudojant H.264 ir H.265 nustatomas kaip [Time]
(laikas) arba [Frame] (kadras).
Negalima nustatyti naudojant [Codec 3] (3 kodekas).
[Time] (laikas): „I-picture“ įterpimo intervalas nustatomas kaip laikas.
[Frame] (kadras): „I-picture“ įterpimo intervalas nustatomas kaip kadrų skaičius.
[I-Picture Interval 1] (1 „I-Picture“ intervalas), [I-Picture Interval 2] (2 „I-Picture“
intervalas)
„I-picture“ įterpimo intervalas nustatomas sekundėmis. Nustatoma reikšmė diapazone nuo 1
sekundės iki 5 sekundžių. Numatytoji reikšmė yra 1 sekundė.
Negalima nustatyti naudojant [Codec 3] (3 kodekas).
[I-Picture Ratio 1] (1 „I-Picture“ santykis), [I-Picture Ratio 2] (2 „I-Picture“ santykis)
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„I-picture“ įterpimo intervalas naudojant H.264 ir H.265 nustatomas kaip kadrų skaičius
diapazone nuo 15 iki 300. Numatytoji reikšmė yra 300 kadrų.
Negalima nustatyti naudojant [Codec 3] (3 kodekas).
[Profile 1] (1 profilis), [Profile 2] (2 profilis)
Nustatomas H.264 arba H.265 vaizdo kodekų profilis.
[H.264]: pasirinkite profilį [high] (didelis), [main] (pagrindinis) arba [baseline] (bazinis).
[H.265]: pasirinkite profilį [main] (pagrindinis) arba [main10] (10 pagrindinis). Jei įjungiami du
vaizdo kodekai, galima tik profilio [main] (pagrindinis pasirinkimo parinktis.
Vaizdo glaudinimo efektyvumas didėja tokia tvarka: [high] (didelis), [main] (pagrindinis) ir
[baseline] (bazinis). Pasirinkite jūsų sistemos palaikomą profilį.
Jei [H.265] nustatoma kaip [main10] (10 pagrindinis), kai HDMI išvestis yra YCrCb, naudojama
[main10] (10 pagrindinis), o kai HDMI išvestis yra RGB, naudojama [main] (pagrindinis).
Negalima nustatyti naudojant [Codec 3] (3 kodekas).
[Bit Rate Compression Mode 1] (1 spartos bitais glaudinimo režimas), [Bit Rate
Compression Mode 2] (2 spartos bitais glaudinimo režimas)
Pasirinkite [CBR] arba [VBR].
Kad būtų išlaikyta pastovi sparta bitais, pasirinkite [CBR]. Kad būtų išlaikyta vaizdo kokybė,
pasirinkite [VBR].
Negalima nustatyti naudojant [Codec 3] (3 kodekas).

Pastaba

Reali transliacijos kadrų sparta ir sparta bitais gali skirtis nuo nustatytų reikšmių – tai priklauso nuo
vaizdo dydžio, fiksuojamos scenos, tinklo aplinkos ir kitų veiksnių.

Kai [Stream] > [Stream Setting] > [Setting] (transliacija > transliacijos nustatymas > nustatymas)
nustatyta kaip [SRT-Caller] (SRT siuntėjas) arba [SRT-Listener] (SRT gavėjas), [Bit Rate
Compression Mode 1] (1 spartos bitais glaudinimo režimas) nustatyta kaip [CBR] (fiksuota).

[Bit Rate 1] (1 sparta bitais), [Bit Rate 2] (2 sparta bitais)
Vaizdo transliacijos spartą bitais galite nustatyti, kai [Bit Rate Compression Mode] (spartos
bitais glaudinimo režimas) nustatyta kaip [CBR]. Nustačius didelę spartą bitais galima transliuoti
aukštos kokybės vaizdą.
Negalima nustatyti naudojant [Codec 3] (3 kodekas).
[Quality 1] (1 kokybė), [Quality 2] (2 kokybė), [Quality 3] (3 kokybė)
Nustatoma vaizdo kokybė diapazone nuo 1 iki 10. Reikšme 10 nustatoma aukščiausia vaizdo
kokybė. Numatytoji reikšmė yra 6.
Parinktims [Quality 1] (1 kokybė) ir [Quality 2] (2 kokybė) H.264 vaizdo kokybę galite nustatyti
[Bit Rate Compression Mode] (spartos bitais glaudinimo režimas) nustatydami kaip [VBR], o
[Codec] (kodekas) kaip [H.264]. H.265 vaizdo kokybę galite nustatyti [Bit Rate Compression
Mode] (spartos bitais glaudinimo režimas) nustatydami kaip [VBR], o [Codec] (kodekas) kaip
[H.265].

[139] Tinklo funkcijos Transliacijos konfigūravimas

Transliavimo garso kodeko nustatymas

Garso kodeką nustatykite žiniatinklio meniu naudodami [Stream] > [Audio Stream] (transliacija >
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garso transliacija).
[Setting] (nustatymas)
Jei norite įjungti garso transliaciją, nustatykite kaip „On“ (įjungta).
[Codec] (kodekas)
Pasirenkamas kodeko tipas, naudojamas garso transliacijai.
[AAC (256kbps)]: pasirinkite, kad pirmenybė būtų teikiama garso kokybei.
[AAC (128kbps)]: pasirinkite, kad pirmenybė būtų teikiama duomenų talpai.
Šis nustatymas neturi įtakos įrenginiu įrašytam klipui arba HDMI/SDI signale esančiam garso
signalui.

[140] Tinklo funkcijos Transliacijos konfigūravimas

Transliavimo pradėjimas / sustabdymas

Naudojant [RTSP], [SRT-Listener] (SRT siuntėjas) ir [NDI|HX]

Įrenginys laukia transliacijos perdavimo užklausos.
Paleiskite kliento programą transliacijos peržiūrai ir prisijunkite prie toliau esančioje lentelėje
pateikiamo URL.
Įveskite įrenginyje sukonfigūruotą naudotojo vardą ir slaptažodį.

<camera_address>: įrenginio IP adresas
<Port>: gavėjo prievadas, sukonfigūruotas naudojant [Port Number] (prievado numeris)

RTSP transliacijos pavyzdys
Įrenginyje galima įjungti dvi transliacijas. Toliau nurodytas kiekvienos transliacijos URL.
rtsp://<camera_address>:<Port>/video1 ([Video Stream 1] (1 vaizdo transliacija)
rtsp://<camera_address>:<Port>/video2 ([Video Stream 2] (2 vaizdo transliacija)

Pastaba

Atkūrimas negarantuojamas naudojant visas programas ar įrenginius.

Naudojant [SRT-Caller] (SRT siuntėjas)

Jei norite pradėti transliaciją, paspauskite mygtuką [Stream now] (transliuoti dabar), esantį
tiesioginio valdymo ekrano skirtuke  (transliacija). Mygtuko etiketė pasikeičia į [Stop stream]

Transliavimo formatas URL

RTSP
1 vaizdo transliacija rtsp://<camera_address>:<Port>/video1

2 vaizdo transliacija rtsp://<camera_address>:<Port>/video2

SRT gavėjas srt://<camera_address>:<Port>

NDI|HX Žr. NDI|HX palaikančio kliento įrenginio naudojimo instrukcijas.
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(stabdyti transliaciją), o fotoaparato vaizdo skydelio viršuje pasirodo piktograma [Stream]
(transliacija).
Transliacijos metu spauskite mygtuką [Stop stream] (stabdyti transliaciją), kad transliaciją
sustabdytumėte. Mygtuko etiketė vėl pasikeičia į [Stream now] (transliuoti dabar), o fotoaparato
vaizdo skydelio viršuje dingsta piktograma [Stream] (transliacija).

SRT gavėjo transliacijos pavyzdys
Toliau parodytas transliacijos URL.
srt://<camera_address>:<Port>
<camera_address>: įrenginio IP adresas
<Port>: gavėjo prievadas, sukonfigūruotas naudojant [Port Number] (prievado numeris)

Pastaba

Atkūrimas negarantuojamas naudojant visas programas ar įrenginius.

[141] Miniatiūrų ekranas

Miniatiūrų ekranas

Jei paspaudžiamas mygtukas [Thumbnail] (miniatiūros) atkūrimo valdymo ekrane arba
mygtukas THUMBNAIL infraraudonųjų spindulių nuotolinio valdymo pute, fotoaparato vaizdo
skydelyje parodomi atminties kortelėje įrašyti klipai. Šis rodinys fotoaparato vaizdo skydelyje
vadinamas miniatiūrų ekranu.
Galite pasirinkti klipą miniatiūrų ekrane ir paleisti to klipo atkūrimą.
Paspaudus mygtuką [Thumbnail] (miniatiūros) esant miniatiūrų ekrano rodinyje miniatiūrų
ekranas uždaromas ir grįžtama į fiksavimo vaizdo ekraną.
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Pastaba

Miniatiūrų ekrane rodomi tik klipai, įrašyti šiuo metu pasirinktu įrašymo formatu. Jei norimas įrašytas
klipas nerodomas, patikrinkite įrašymo formatą. Būtinai atsižvelkite į šį faktą prieš formatuodami
(inicijuodami) laikmeną.

Lango išdėstymas

Pasirinkto klipo miniatiūra parodoma su oranžiniu fonu.
Pasirinkto klipo informacija parodoma ekrano apačioje.

Pasirinkta atminties kortelė
Jei atminties kortelė yra apsaugota nuo įrašymo, dešinėje pusėje pasirodo spynos

1.
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[142] Miniatiūrų ekranas Klipų leidimas ir kiti veiksmai su klipais

Įrašytų klipų leidimas

Įrašytus klipus galite paleisti, kai įrenginys veikia įrašymo budėjimo („Stby“) režimu.
Šioje temoje aprašoma, kaip paleisti įrašytus klipus naudojant GUI valdymo skydelį.

piktograma.

Klipo numeris / bendras klipų skaičius2.

Miniatiūra (nuorodos paveikslėlis)
Rodo klipo nuorodos paveikslėlį. Kai klipas įrašomas, jo pirmas kadras automatiškai
nustatomas kaip nuorodos paveikslėlis.
Klipo / kadro informacija rodoma po miniatiūra. Rodomą informaciją galite keisti fotoaparato
meniu naudodami [Thumbnail] > [Customize View] > [Thumbnail Caption] (miniatiūros >
pasirinktinis vaizdas > miniatiūros duomenys).

3.

Klipo pavadinimas
Rodo pasirinkto klipo pavadinimą.

4.

Įrašymo formatas
Rodo pasirinkto klipo failo formatą.

5.

Speciali įrašymo informacija
Rodo filmavimo režimą tik jei klipas buvo įrašytas naudojant specialų filmavimo režimą.
Sulėtintų ir pagreitintų klipų kadrų dažnis rodomas dešinėje.

6.

Klipo trukmė7.

Sukūrimo data8.

Įstatykite atminties kortelę, iš kurios norite peržiūrėti klipus.1

Paspauskite mygtuką [Thumbnail] (miniatiūros).

Parodomos klipų miniatiūros.

2
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GUI valdymo skydelio rodyklių mygtukais perkelkite žymeklį ant norimo paleisti
klipo miniatiūros.

Pastaba

Klipų negalima pasirinkti jutikliniu valdymu.

3

Paspauskite GUI valdymo skydelyje esantį mygtuką [Set] (nustatyti).

Atkūrimas prasidės nuo pasirinkto klipo pradžios.

4

Prireikus pasinaudokite atkūrimo valdymo skydeliu.5

Mygtukas Function
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Pastaba

Tarp klipų vaizdas gali trumpam dingti arba gali būti rodomas sustabdytas vaizdas. Tuo metu naudoti
įrenginio negalite.

Kai pasirenkate klipą miniatiūrų ekrane ir paleidžiate atkūrimą, klipo pradžioje gali trumpam dingti
vaizdas. Jei norite peržiūrėti klipo pradžią be pertraukimo, įrenginyje įjunkite atkūrimo režimą,
pristabdykite, paspauskite mygtuką  (ankstesnis), kad sugrįžtumėte į klipo pradžią, tada vėl
paleiskite atkūrimą.

[143] Miniatiūrų ekranas Klipų leidimas ir kiti veiksmai su klipais

Veiksmai su įrašytais klipais

Miniatiūrų ekrane valdyti klipus arba peržiūrėti klipų savybes galite naudodami fotoaparato
meniu esančiu meniu [Thumbnail] (miniatiūros).
Atkūrimo valdymo ekrane paspauskite mygtuką [Menu] (meniu), kad fotoaparato vaizdo
skydelyje būtų parodytas fotoaparato meniu.
Fotoaparato meniu esančiame meniu [Thumbnail] (miniatiūros) galite atlikti toliau nurodytus
veiksmus.

Patarimas

Be to, valdymo veiksmus galite atlikti GUI valdymo skydelyje.
Paleisti: paspauskite mygtuką [Set] (nustatyti).
Pristabdyti atkūrimą: atkūrimo metu paspauskite mygtuką [Set] (nustatyti). Paspauskite dar
kartą, kad atkūrimas tęstųsi.
Pereiti į klipo pradžią / kito klipo pradžią: paspauskite mygtuką į kairę / dešinę.
Greitai pirmyn / atgal: paspauskite ir palaikykite mygtuką į kairę / dešinę. Įprastas atkūrimo
greitis grąžinamas atleidus mygtuką.
Stabdyti atkūrimą: paspauskite mygtuką [Cancel/Back] (atšaukti / atgal).

Mygtukas  (leisti /
pristabdyti)

Paleidžiamas klipas. Atkūrimo metu klipas
pristabdomas.

 (sukimo pirmyn)
mygtukas,  (sukimo atgal)
mygtukas

Klipas paleidžiamas didžiausiu greičiu. Spaudžiant
mygtuką atkūrimo greitis keičiamas trimis žingsniais.

Mygtukas  (ankstesnis),
mygtukas  (kitas)

Pereinama į klipo pradžią arba prie ankstesnio / kito
klipo.

 (stabdymo) mygtukas atkūrimas sustabdomas.
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Patarimas

Be to, kad būtų parodytas fotoaparato meniu, galite spausti mygtuką [Menu] (meniu) tiesioginio
valdymo ekrane.

Veiksmai naudojant fotoaparato meniu esantį meniu [Thumbnail]
(miniatiūros)
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Pasirinkite norimą funkciją naudodami GUI valdymo skydelio rodyklių mygtukus ir paspauskite
mygtuką [Set] (nustatyti).
Kad sugrįžtumėte į ankstesnį ekraną, paspauskite mygtuką [Cancel/Back] (atšaukti / atgal).

Pastaba

Kai kurių elementų negalima pasirinkti, tai priklauso nuo būsenos, kai rodomas meniu.

Meniu elementai veiksmams su klipais

Fotoaparato meniu esančiame meniu [Thumbnail] (miniatiūros) yra toliau nurodyti meniu
elementai, kuriuos naudodami galite atlikti veiksmus su klipais.
[Display Clip Properties] (klipo savybių rodymas)
[Set Clip Flag] (nustatyti klipo žymę)
[Lock/Unlock Clip] (užrakinti / atrakinti klipą)
[Delete Clip] (ištrinti klipą)
[Transfer Clip] (klipo perdavimas)
[Transfer Clip (Proxy)] (klipo pardavimas (tarpinis)
[Filter Clips] (filtruoti klipus)
[Customize View] (pasirinktinis vaizdas)

Išsamesnė informacija apie kiekvieną meniu elementą pateikiama dalyje „Meniu [Thumbnail]
(miniatiūros)“.

Jei norite įjungti klipų ypatybių ekraną
Kad būtų parodytas klipų ypatybių ekranas, fotoaparato meniu pasirinkite [Thumbnail] > [Display
Clip Properties] (miniatiūros > rodyti klipų ypatybes).
Jei norite pereiti prie ankstesnio / kito klipo, spauskite mygtuką  (ankstesnis) arba mygtuką 

 (kitas).

Jei norite pridėti klipų žymių
Klipuose galite pridėti klipo žymių (OK, NG arba KP), kad rodomus klipus galėtumėte filtruoti
pagal klipų žymes.
Pasirinkite klipo, kuriam norite pridėti žymę, piktogramą ir pasirinkite klipo žymę fotoaparato
meniu naudodami [Thumbnail]] > [Set Clip Flag] (miniatiūros > nustatyti klipo žymę).

Patarimas

Be to, klipų žymėms pridėti galite naudoti priskiriamą mygtuką, kuriam priskirta klipo žymėjimo
funkcija.

Nustatymas Pridėta klipo žymė

[Add OK] (pridėti OK) OK

[Add NG] (pridėti NG) NG

[Add KEEP] (pridėti KEEP) KP
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Kad būtų parodytas filtruotas klipų miniatiūrų ekranas
Fotoaparato meniu pasirinkite [Thumbnail] > [Filter Clips] (miniatiūros > filtruoti klipus) ir
pasirinkite klipų žymių tipą, kad būtų parodyti tik klipai su nurodyta žyme.
Kad būtų parodyti visi klipai, pasirinkite [All] (visi).
Be to, jei rodomas miniatiūras norite surūšiuoti pagal žymes, galite spausti mygtuką [Display]
(rodyti).

Jei norite ištrinti klipus
Galite ištrinti klipus iš atminties kortelės.
Fotoaparato meniu pasirinkite [Thumbnail] > [Delete Clip] > [Select Clip] (miniatiūros > trinti
klipą > rinktis klipą) arba [All Clips] (visi klipai).
[Select Clip] (rinktis klipą): ištrinamas pasirinktas klipas. Galima pasirinkti visus klipus.
[All Clips] (visi klipai): ištrinami visi rodomi klipai.

Jei norite keisti miniatiūrų ekrane rodomą informaciją
Galite pakeisti klipo / kadro informaciją, rodomą po miniatiūra.
Fotoaparato meniu pasirinkite [Thumbnail] > [Customize View] > [Thumbnail Caption]
(miniatiūros > pritaikytas vaizdas > miniatiūros duomenys), tada pasirinkite norimą rodyti
informaciją.
[Date Time] (data ir laikas): parodoma klipo sukūrimo ir modifikavimo data ir laikas.
[Time Code] (laiko kodas): parodomas laiko kodas.
[Duration] (trukmė): parodoma klipo trukmė.
[Sequential Number] (sekos numeris): parodomas kiekvieno klipo sekos numeris.

[144] Fotoaparato meniu ir išsamūs nustatymai

Fotoaparato meniu konfigūravimas 

Kai paspaudžiamas GUI valdymo skydelio mygtukas [Menu] (meniu) arba infraraudonųjų
spindulių nuotolinio valdymo pulto mygtukas MENU, fotoaparato vaizdo skydelyje parodomas
fotoaparato meniu, kuriame galite konfigūruoti įvairius vaizdų fiksavimo ir atkūrimo nustatymus.
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Meniu sudaro toliau nurodyti meniu.

Meniu konfigūracija

Meniu [User] (naudotojas)
Jame yra meniu elementai, kuriuos gali sukonfigūruoti naudotojas.
Galima redaguoti naudojant [Edit User Menu] (naudotojo redagavimo meniu).
Meniu [Edit User] (redaguoti naudotoją)
Jame yra meniu elementai, skirti meniu [User] (naudotojas) redaguoti.
Meniu [Shooting] (vaizdų fiksavimas)
Pateikiami su vaizdų fiksavimu susiję nustatymai.
Meniu [Project] (projektas)
Jame yra pagrindiniai projekto nustatymai.
Meniu [Paint/Look] (piešimas / vaizdas)
Jame yra nustatymai, susijęs vaizdo kokybe.
Meniu [Pan-Tilt] (pasukimas / pakreipimas)
Jame pateikiami su pasukimu / pakreipimu susiję nustatymai.
Meniu [TC/Media] (laiko kodas / laikmena)
Jame yra nustatymai, susiję su laiko kodais ir įrašymo laikmenomis.
Meniu [Monitoring] (stebėjimas)
Jame yra nustatymai, susiję su vaizdo išvestimi ir ekrano rodiniu.
Meniu [Audio] (garsas)
jame yra su garsu susiję nustatymai.
Meniu [Thumbnail] (miniatiūros)
jame yra nustatymai, susiję su miniatiūrų rodymu.
Meniu [Technical] (techniniai)
Jame yra techninių elementų nustatymai
Meniu [Network] (tinklas)
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jame yra nustatymai, susiję su tinklais.
Meniu [Maintenance] (priežiūra)
Jame yra įrenginio nustatymai, tokie kaip laikrodis ir kalba.

Fotoaparato meniu konfigūravimas ir hierarchija

1 lygis 2 lygis

„User“ (naudotojas)
(gamykliniai nustatymai)

„Base Setting“ (bazinis nustatymas)

Fokusavimas

„S&Q Motion“

„LUT On/Off“ (LUT įjungimas / išjungimas)

„Simul Rec“ (sinchroniškas įrašymas)

„Proxy Rec“ (įrašymas mažesne raiška)

„Interval Rec“ (filmavimas intervalais)

„Picture Cache Rec“ (nuotraukų talpyklos įrašymas)

Priskiriamas mygtukas

„Scene File“ (siužeto failai)

„Base Look“ (bazinis vaizdas)

„P/T Acceleration“ (P/T spartinimas)

„Clip Name Format“ (klipo pavadinimo formatas)

„Format Media“ (laikmenos formatavimas)

„Video Signal Monitor“ (vaizdo signalo stebėjimas)

„Marker“ (žymeklis)

Zoom

Objektyvas

Naudotojo redagavimo meniu

„ISO/Gain/EI“ (ISO / stiprinimas / EI)

„ND Filter“ (ND filtras)

Shutter

Diafragma

„Auto Exposure“ (automatinė ekspozicija)
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Vaizdų fiksavimas

Baltas

„White Setting“ (baltos spalvos balanso nustatymas)

„Offset White“ (baltos spalvos balanso poslinkis)

Fokusavimas

„S&Q Motion“

„LUT On/Off“ (LUT įjungimas / išjungimas)

„Noise Suppression“ (triukšmo slopinimas)

„Flicker Reduce“ (mirgėjimo sumažinimas)

SteadyShot

Projektas

„Base Setting“ (bazinis nustatymas)

„Rec Format“ (įrašymo formatas)

„Cine EI Setting“ („Cine EI“ nustatymas)

„Simul Rec“ (sinchroniškas įrašymas)

„Proxy Rec“ (įrašymas mažesne raiška)

„Interval Rec“ (filmavimas intervalais)

„Picture Cache Rec“ (nuotraukų talpyklos įrašymas)

„SDI/HDMI Rec Control“ (SDI/HDMI įrašymo
valdymas)

Priskiriamas mygtukas

„Paint/Look“ (piešinys / vaizdas)

„Scene File“ (siužeto failai)

„Base Look“ (bazinis vaizdas)

„Reset Paint Settings“ (atkurti piešinio nustatymus)

Juodas

Knee

Detail

„Matrix“ (matrica)

„Multi Matrix“ (daugybinė matrica)

„Pan-Tilt“ (pasukimas /
pakreipimas)

„P/T Acceleration“ (P/T spartinimas)
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„TC/Media“ (laiko kodas / laikmena)

Laiko kodas

„TC Display“ (TC rodymas)

„Users Bit“ (naudotojo bitai)

„HDMI TC Out“ (HDMI TC išvestis)

„Clip Name Format“ (klipo pavadinimo formatas)

„Update Media“ (laikmenos naujinimas)

„Format Media“ (laikmenos formatavimas)

„Media Life“ (laikmenos naudojimo laikas)

Monitoring

„Output Format“ (išvesties formatas)

„Display On/Off“ (rodymo įjungimas / išjungimas)

„Video Signal Monitor“ (vaizdo signalo stebėjimas)

„Marker“ (žymeklis)

Audio
„Audio Input“ (garso įvestis)

Garso išvestis

„Thumbnail“ (miniatiūra)

„Display Clip Properties“ (klipo savybių rodymas)

„Set Clip Flag“ (nustatyti klipo žymę)

„Lock/Unlock Clip“ (užrakinti / atrakinti klipą)

„Delete Clip“ (panaikinti klipą)

„Transfer Clip“ (klipo persiuntimas)

„Transfer Clip (Proxy)“ (klipo persiuntimas žema
raiška)

„Filter Clips“ (klipų filtravimas)

„Customize View“ (pasirinktinis vaizdas)

„Technical“ (techninis)

„Color Bars“ (spalvų juostos)

„Genlock“

„Tally“ (įspėjimo lemputė)

„Rec Review“ (įrašo peržiūra)

Zoom

Objektyvas
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[145] Fotoaparato meniu ir išsamūs nustatymai Fotoaparato meniu naudojimas

Fotoaparato meniu naudojimas

Kai paspaudžiamas GUI valdymo skydelio mygtukas [Menu] (meniu) arba infraraudonųjų
spindulių nuotolinio valdymo pulto mygtukas MENU, fotoaparato vaizdo skydelyje parodomas
fotoaparato meniu, kuriame galite konfigūruoti įvairius vaizdų fiksavimo ir atkūrimo nustatymus.
Meniu valdomas GUI valdymo skydelio mygtukais.

Mygtukas [Menu] (meniu): paspauskite, kad būtų parodytas fotoaparato meniu. Jei
fotoaparato meniu norite paslėpti, kai jis rodomas, paspauskite mygtuką dar kartą.
Rodyklių mygtukai: spausdami rodyklių mygtukus perkelkite fotoaparato meniu žymeklį
aukštyn / žemyn / į kairę / į dešinę ir pasirinkite meniu elementus ar nustatymus.
Mygtukas [Set] (nustatyti): paspauskite ir pritaikykite pasirinktą elementą.
Mygtukas [Cancel/Back] (atšaukti / atgal): paspausdami sugrįžkite į ankstesnį meniu.
Nebaigti pakeitimai bus atšaukti.

Pastaba

Kai kurių elementų negalima pasirinkti, tai priklauso nuo būsenos, kai rodomas meniu.

Nustatymų meniu elementai

GUI valdymo skydelyje esančiais rodyklių mygtukais perkelkite žymeklį ant norimo nustatyti
elemento ir paspauskite mygtuką [Set] (nustatyti), kad nustatymas būtų pritaikytas.

APR

Tinklas
Laidinis LAN

File Transfer

Techninė priežiūra

Kalba

„Clock Set“ (laikrodžio nustatymas)

„Hours Meter“ (valandų matuoklis)
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Meniu elemento pasirinkimo sritis rodoma iki aštuonių eilučių. Jei visos galimos elemento
parinktys negali būti parodytos vienu metu, slinkite ekraną perstumdami žymeklį aukštyn
arba žemyn.
Elementų, kurių nustatymų diapazonas didelis (pvz., nuo –99 iki +99), nustatymų sritis
nerodoma. Pasirinktas nustatymas paryškinamas, parodant, kad jo reikšmė gali būti
keičiama.
Pasirinkus funkcijos parinktį [Execute] (vykdyti) bus vykdoma atitinkama funkcija.
Pasirinkus elementą, kuriam prieš vykdant reikalingas patvirtinimas, meniu bus laikinai
paslėptas ir bus rodomas patvirtinimo pranešimas. Peržiūrėkite pranešimą ir pasirinkite
vykdyti arba atšaukti funkciją.

[146] Fotoaparato meniu ir išsamūs nustatymai Fotoaparato meniu naudojimas

Simbolių eilutės įvedimas

Kai pasirenkate elementą, pavyzdžiui, failo pavadinimą, kuriam reikia įvesti tekstą, pasirodys
teksto įvedimo langas.

Spausdami GUI valdymo skydelyje esančius rodyklių mygtukus pasirinkite simbolių
tipą ir pritaikykite nustatymą.

[ABC]: didžiosios raidės
[abc]: mažosios raidės
[123]: skaitmenys
[!#$]: specialieji simboliai

1

Pasirinkite simbolį ir spauskite mygtuką [Set] (nustatyti), kad nustatymą
pritaikytumėte.

Žymeklis pereis prie kito laukelio.
[Space] (tarpas): žymeklio vietoje įvedamas tarpo simbolis.
[?] [?]: perkeliama žymeklio padėtis.
[BS]: ištrinamas simbolis žymeklio kairėje (grįžtis).

2

Baigę paspauskite mygtuką [Done] (atlikta), kad nustatymą pritaikytumėte.3
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[147] Fotoaparato meniu ir išsamūs nustatymai Naudotojo meniu

Naudotojas

Šioje temoje aprašomos kiekvieno meniu elemento funkcijos ir nustatymai.

Simbolių eilutė bus patvirtinta ir simbolių įvedimo langas dings.

Elementas Aprašas

„Base Setting“ (bazinis
nustatymas)

„Project“ > „Base Setting“ (projektas > bazinis nustatymas)
elementas

Fokusavimas
„Shooting“ > „Focus“ (vaizdų fiksavimas > fokusavimas)
elementas

„S&Q Motion“
„Shooting“ > „S&Q Motion“ (vaizdų fiksavimas > sulėtintas ir
pagreitintas filmavimas) elementas

„LUT On/Off“ (LUT įjungimas
/ išjungimas)

„Shooting“ > „LUT On/Off“ (vaizdų fiksavimas > LUT
įjungimas / išjungimas) elementas

„Simul Rec“ (sinchroniškas
įrašymas)

„Project“ > „Simul Rec“ (projektas > sinchroniškas įrašymas)
elementas

„Proxy Rec“ (įrašymas
mažesne raiška)

„Project“ > „Proxy Rec“ (projektas > tarpinis įrašymas)
elementas

„Interval Rec“ (filmavimas
intervalais)

„Project“ > „Interval Rec“ (projektas > įrašymas intervalais)
elementas

„Picture Cache Rec“
(nuotraukų talpyklos
įrašymas)

„Project“ > „Picture Cache Rec“ (projektas > nuotraukų
talpyklos įrašymas) elementas

Priskiriamas mygtukas
„Project“ > „Assignable Button“ (projektas > priskiriamas
mygtukas) elementas

„Scene File“ (siužeto failai) „Project“ > „Scene File“ (projektas > scenos failas) elementas

„Base Look“ (bazinis
vaizdas)

„Paint/Look“ > „Base Look“ (piešinys / vaizdas > bazinis
vaizdas) elementas

„P/T Acceleration“ (P/T
spartinimas)

„Pan-Tilt“ > „P/T Acceleration“ (pasukimas / pakreipimas >
pasukimo / pakreipimo spartinimas) elementas

„Clip Name Format“ (klipo
pavadinimo formatas)

„TC/Media“ > „Clip Name Format“ (laiko kodas / laikmena >
klipo pavadinimo formatas) elementas
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Pastaba

Naudodami meniu [Edit User] (redaguoti naudotoją) galite pridėti ir pašalinti elementų meniu [User]
(naudotojas). Galima konfigūruoti iki 20 elementų.

[148] Fotoaparato meniu ir išsamūs nustatymai Naudotojo redagavimo meniu

Naudotojo redagavimas

Kai meniu [User] (naudotojas) pasirenkama [Edit User Menu] (redaguoti naudotojo meniu),
viršutiniame lygyje parodomas meniu [Edit User] (redaguoti naudotoją).

„Format Media“ (laikmenos
formatavimas)

„TC/Media“ > „Format Media“ (laiko kodas / laikmena >
formatuoti laikmeną) elementas

„Video Signal Monitor“
(vaizdo signalo stebėjimas)

„Monitoring“ > „Video Signal Monitor“ (stebėjimas > vaizdo
signalo stebėjimas) elementas

„Marker“ (žymeklis) „Monitoring“ > „Marker“ (stebėjimas > žymeklis) elementas

Zoom „Technical“ > „Zoom“ (techniniai > priartinimas) elementas

Objektyvas „Technical“ > „Lens“ (techniniai > objektyvas) elementas

Naudotojo redagavimo
meniu

Parodomas naudotojo redagavimo meniu.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Add Item“
(pridėti elementą)
Pridėti elementą
meniu [User]
(naudotojas)

– –
Meniu [User] (naudotojas) pridedamas
2 lygio meniu elementas.

„Customize
Reset“
(pritaikymo
nustatymas iš
naujo)
Meniu [User]
(naudotojas)
elementai
nustatomi iš
naujo

– –
Atkuriami gamykliniai numatytieji meniu
[User] (naudotojas) registruotų
elementų nustatymai.
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[149] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

ISO / stiprinimas / EI

Nustato stiprinimo parametrus.

Redaguojant
pasirenkami 2
lygio meniu
elementai

Delete –
Ištrinamas registruotas 2 lygio meniu
elementas iš meniu [User] (naudotojas).

„Move“
(perkelti)

–
Pertvarkomi meniu [User] (naudotojas)
registruoti meniu elementai.

„Edit Sub Item“
(redaguoti
papildomą
elementą)

–

Redaguojamas (registruojamas /
ištrinamas) registruotas 3 lygio meniu
papildomas elementas meniu [User]
(naudotojas).

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

Režimas ISO/dB dB

Pasirenka
stiprinimo
nustatymo
režimą.

„ISO/Gain<L>“
(ISO /
stiprinimas
<L>)

Išsamesnė informacija apie
nustatymus pateikiama dalyje
„ISO / stiprinimo nustatymai ir
numatytosios reikšmės“.

–

Pasirenka <L>
stiprinimo
nustatytąją
reikšmę.

„Exposure
Index<L>“
(ekspozicijos

Kai bazinis ISO nustatytas kaip
ISO 800: 
200EI / 4.0E 
250EI / 4.3E 
320EI / 4.7E 
400EI / 5.0E 
500EI / 5.3E 
640EI / 5.7E 
800EI / 6.0E 
1000EI / 6.3E 
1250EI / 6.7E 
1600EI / 7.0E 
2000EI / 7.3E 
2500EI / 7.7E 
3200EI / 8.0E
Kai bazinis ISO nustatytas kaip

Kai bazinis ISO
nustatytas kaip
ISO 800: 800EI /
6.0E 
Kai bazinis ISO

Nustatoma
ekspozicijos
indekso<L>
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[150] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

ND filtras

Nustato numatytąsias ND filtro reikšmes.

indeksas<L>) ISO 12800: 
3200EI / 4.0E 
4000EI / 4.3E 
5000EI / 4.7E 
6400EI / 5.0E 
8000EI / 5.3E 
10000EI / 5.7E 
12800EI / 6.0E 
16000EI / 6.3E 
20000EI / 6.7E 
25600EI / 7.0E 
32000EI / 7.3E 
40000EI / 7.7E 
51200EI / 8.0E

nustatytas kaip
ISO 12800:
12800EI / 6.0E

reikšmė.

„Shockless
Gain“ (tolydus
stiprinimas)

On (įjungti) / „Off“ (išjungti) Išjungta

Tolydaus
stiprinimo
funkcijos
įjungimas /
išjungimas.

„Base
Sensitivity“
(bazinis
jautrumas)

High (aukštas) / Low (žemas) Low

Nustatomas
bazinis jautrumas
veikiant
pasirinktiniam
režimui.

„Base ISO“
(bazinis ISO)

ISO 12800 / ISO 800 ISO 800
Nustato bazinį
ISO jautrumą
„Cine EI“ režimu.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Režimas
Išankstinis nustatymas
/ kintamas

Variable
Pasirenkamas ND filtro
režimas.

„Preset1“
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/4
Nustato 1 numatytąją ND
filtro reikšmę.

„Preset2“
1/4 / 1/8 / 1/16 / 1/32 /

1/16
Nustato 2 numatytąją ND
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[151] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

Užraktas

Nustatomas elektroninis užrakto veikimas.

1/64 / 1/128 filtro reikšmę.

„Preset3“
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/64
Nustato 3 numatytąją ND
filtro reikšmę.

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

Režimas Speed (išlaikymas) / „Angle“ (kampas) Speed

Pasirenka
elektroninio užrakto
veikimo režimą.
„Speed“ (greitis):
režimas užrakto
greičiui vienetais per
sekundę nustatyti.
Pasirinkite, jei norite
ryškiai užfiksuoti
greitai judančius
objektus.
„Angle“ (kampas):
režimas užrakto
greičiui kaip užrakto
kampui nustatyti.

„Shutter
Speed
On/Off“
(išlaikymo
įjungimas /
išjungimas)

On (įjungti) / „Off“ (išjungti) Išjungta

Nustatoma, ar
pasirinkus greičio
režimą ekspozicijos
laikas atitinka [Shutter
Speed] (užrakto
greitis) reikšmę, ar
nustatomas
maksimalia
ekspozicija.

Nuo 64F iki 1/8000 
Galimos reikšmės priklauso nuo
pasirinkto vaizdo įrašo formato kadrų
dažnio.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F /
5F / 4F / 3F / 2F / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
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[152] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

Diafragma

Nustatomi diafragmos nustatymai.

Shutter
Speed

1/2000 / 1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F
/ 4F / 3F / 2F / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F /
5F / 4F / 3F / 2F / 1/30 / 1/40 / 1/50 /
1/60 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F
/ 4F / 3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 /
1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F /
6F / 5F / 4F / 3F / 2F / 1/24 / 1/32 /
1/48 / 1/50 / 1/60 / 1/96 / 1/100 / 1/120
/ 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000

59.94P: 
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

Nustatomas užrakto
greitis, kai
pasirenkamas greičio
režimas.

„Shutter
Angle“
(užrakto
kampas)

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 360,0° / 300,0° / 270,0° /
240,0° / 216,0° / 210,0° / 180,0° /
172,8° / 150,0° / 144,0° / 120,0° / 90,0°
/ 86,4° / 72,0° / 45,0° / 30,0° / 22,5° /
11,25° / 5,6°

180,0°

Nustatomas užrakto
kampas, kai
pasirenkamas kampo
režimas.

„ECS
On/Off“
(LUT
įjungimas /
išjungimas)

On (įjungti) / „Off“ (išjungti) Išjungta
Įjungia arba išjungia
funkciją „Extended
Clear Scan“.

„ECS
Frequency“
(ECS
dažnis)

Nuo 23,99 iki 8000 
Galimos reikšmės priklauso nuo
pasirinkto įrašymo formato kadrų
dažnio.

59.94P:
60.00
50P: 50.00
29.97P:
30.00
23.98P:
23.99
25P: 25.02
24P: 24.02

Nustato ECS dažnį,
kai režimas
nustatytas į ECS.
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[153] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

Automatinė ekspozicija

Nustato automatinės ekspozicijos koregavimo parametrus.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Bokeh Control“
(„bokeh“
valdymas)

On (įjungti) / „Off“
(išjungti)

„Off“ (išjungta)
Įjungiama / išjungiama
„Bokeh“ valdymo funkcija.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0
/ +1.75 / +1.5 / +1.25 / +1.0 /
+0.75 / +0.5 / +0.25 / ±0 / ?0.25 /
?0.5 / ?0.75 / ?1.0 / ?1.25 / ?1.5 /
?1.75 / ?2.0 / ?2.25 / ?2.5 / ?2.75
/ ?3.0

±0
Nustato automatiškai
aptinkamos ekspozicijos
šviesumo lygį.

Režimas

„Backlight“ (foninis apšvietimas) /
Standard (standartinis) /
„Spotlight“ (koncentruotas
apšvietimas)

Standard

Nustato automatinės
ekspozicijos koregavimo
režimą.
„Backlight“ (foninis
apšvietimas): foninio
apšvietimo režimas
(režimas, skirtas objekto
patamsėjimui sumažinti,
kai jis apšviečiamas iš
galo)
„Standard“
(standartinis):
standartinis režimas
„Spotlight“
(koncentruotas
apšvietimas):
koncentruoto apšvietimo
režimas (režimas, skirtas
per daug šviesioms sritims
patamsinti, kai
apšviečiama koncentruota
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šviesa)

Speed nuo –99 iki +99 ±0
Nustato automatinės
ekspozicijos išlaikymo
koregavimą

AGC On (įjungti) / „Off“ (išjungti) Išjungta
Įjungia arba išjungia AGC
(automatinio stiprinimo
valdymo) funkciją.

AGC Limit

Išsamesnė informacija apie
nustatymus pateikiama dalyje
„AGC ribų nustatymai ir
numatytosios reikšmės“.

–
Nustato maksimalų AGC
funkcijos stiprinimą.

„AGC Point“
(AGC
taškas)

F2.8 / F4 / F5.6 F2,8

Nustato diafragmos F
žingsnio reikšmę, kuriai
esant pradeda veikti AGC,
kai įjungta AGC funkcija.

„Auto
Shutter“
(automatinis
išlaikymas)

On (įjungti) / „Off“ (išjungti) Išjungta
Įjungia arba išjungia
automatinio užrakto
valdymo funkciją.

„A.SHT
Limit“
(A.SHT riba)

1/100 / 1/150 / 1/200 / 1/250 /
1/2000

1/2000
Nustato trumpiausią
automatinio išlaikymo
funkcijos reikšmę.

„A.SHT
Point“
(A.SHT
taškas)

F5.6 / F8 / F11 / F16 F11

Nustato diafragmos F
žingsnio reikšmę, kuriai
esant pradeda veikti
automatinis išlaikymas.

„Clip High
light“
(ryškios
šviesos
ribojimas)

On (įjungti) / „Off“ (išjungti) Išjungta

Įjungia arba išjungia
funkciją, kuri ignoruoja
šviesiausias sritis,
naudodama mažesnį
jautrumą esant stipriam
apšvietimui.

„Detect
Window“
(lango
aptikimas)

1 / 2 / 3 / 4 / 5 / 6 / Custom
(pasirinktinis)

1

Nustato šviesos matavimo
diapazoną automatiniam
ekspozicijos koregavimui
pagal objekto šviesumą.
(Negalima, kai ekspozicija
reguliuojama rankiniu
būdu)

„Detect
Window

Įjungia arba išjungia
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[154] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

Balta spalva

Nustato baltos spalvos balanso parametrus.

Indication“
(lango
aptikimo
indikacija)

On (įjungti) / „Off“ (išjungti) Išjungta šviesumo matavimo
diapazono indikaciją.

„Custom
Width“
(pasirinktinis
plotis)

nuo 40 iki 999 500
Nustato šviesos matavimo
diapazono plotį.

„Custom
Height“
(pasirinktinis
aukštis)

nuo 70 iki 999 500
Nustato šviesos matavimo
diapazono aukštį.

„Custom H
Position“
(pasirinktinė
H padėtis)

nuo –479 iki +479 ±0
Nustato šviesos matavimo
diapazono horizontalią
padėtį.

„Custom V
Position“
(pasirinktinė
V padėtis)

nuo –464 iki +464 ±0
Nustato šviesos matavimo
diapazono vertikalią
padėtį.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Preset White“
(numatytasis
baltos spalvos
balansas)

nuo 2000K
iki 15000K

3200K
Nustato baltos spalvos balanso numatytąją
reikšmę.

„Color Temp
<A>“ (spalvos
temperatūra
<A>)

nuo 2000K
iki 15000K

3200K

Nustato baltos spalvos balanso spalvos
temperatūrą, saugomą atmintyje A.

Pastaba

Kadangi spalvos temperatūra ribojama
ties 2000K ir 15000K, kai naudojamas R/B
stiprinimas, gali būti neįmanoma rodyti
teisingą R/B stiprinimo spalvos
temperatūros reikšmę.
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[155] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

Baltos spalvos nustatymas

Reguliuoja baltos spalvos balanso nustatymus.

[156] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

Baltos spalvos balanso poslinkis

„Tint<A>“
(atspalvis <A>)

nuo –99 iki
+99

±0

Nustato baltos spalvos balanso atspalvio
reikšmę, saugomą atmintyje A.

Pastaba

Kadangi atspalvis ribojamas ± 99 ribose,
kai naudojamas R/B stiprinimas, gali būti
neįmanoma rodyti teisingą R/B stiprinimo
atspalvio reikšmę.

„R Gain <A>“
(R stiprinimas
<A>)

nuo –99,0
iki +99,0

±0,0
Nustato baltos spalvos balanso R stiprinimo
reikšmę, saugomą atmintyje A.

„B Gain <A>“
(B stiprinimas
<A>)

nuo –99,0
iki +99,0

±0,0
Nustato baltos spalvos balanso B stiprinimo
reikšmę, saugomą atmintyje A.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Shockless White“
(tolydus baltos
spalvos balansas)

„Off“(išjungtas)
/ 1 / 2 / 3

2

Nustato baltos spalvos balanso
reagavimo greitį, kai įjungiamas
baltos spalvos balanso režimas.
„Off“ (išjungta): perjungiama iškart.
1–3: kuo didesnis skaičius, tuo
lėčiau perjungiama.

„ATW Speed“
(ATW greitis)

1 / 2 / 3 / 4 / 5 3

Nustato reagavimo greitį ATW
režimu. 
Trumpiausias reakcijos laikas yra
pasirinkus 1, o ilgiausias – 5.
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Nustato baltos spalvos balanso poslinkio parametrus.

[157] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

Fokusavimas

Nustato fokusavimo parametrus.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Offset White
<A>“ (baltos
spalvos balanso
poslinkis <A>)

On (įjungti) /
„Off“
(išjungti)

Išjungta
Pasirenka, ar pridėti („On“), ar nepridėti
(„Off“) poslinkio reikšmę prie baltos spalvos
balanso atmintyje A.

„Offset Color
Temp<A>“
(spalvos temp.
poslinkis <A>)

nuo –99 iki
+99

±0

Nustato spalvos temperatūros poslinkį,
kuris turi būti pridėtas prie baltos spalvos
balanso atmintyje A, kai [Offset White <A>]
(baltos spalvos balanso poslinkis <A>)
nustatyta kaip „On“ (įjungta).

„Offset Tint<A>“
(atspalvio
poslinkis <A>)

nuo –99 iki
+99

±0

Nustato atspalvio reikšmės poslinkį, kuris
turi būti pridėtas prie baltos spalvos balanso
atmintyje A, kai [Offset White <A>] (baltos
spalvos balanso poslinkis <A>) nustatyta
kaip „On“ (įjungta).

„Offset White
<ATW>“ (baltos
spalvos balanso
poslinkis
<ATW>)

On (įjungti) /
„Off“
(išjungti)

On
Pasirenka, ar pridėti („On“), ar nepridėti
(„Off“) poslinkio reikšmę prie ATW baltos
spalvos balanso.

„Offset Color
Temp<ATW>“
(spalvos temp.
poslinkis
<ATW>)

nuo –99 iki
+99

±0

Nustato spalvos temperatūros poslinkį,
kuris turi būti pridėtas prie ATW baltos
spalvos balanso, kai [Offset White<ATW>]
(baltos spalvos balanso poslinkis <ATW>)
nustatyta kaip „On“ (įjungta).

„Offset
Tint<ATW>“
(atspalvio
poslinkis
<ATW>)

nuo –99 iki
+99

±0

Nustato atspalvio reikšmės poslinkį, kuris
turi būti pridėtas prie ATW baltos spalvos
balanso, kai [Offset White<ATW>] (baltos
spalvos balanso poslinkis <ATW>)
nustatyta kaip „On“ (įjungta).



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

AF Transition
Speed

1(lėtas) / 2 / 3
/ 4 / 5 / 6 / 7
(greitas)

5
Nustato fokusavimo greitį, kai objektas
keičiasi automatinio fokusavimo metu.

AF Subj. Shift
Sens.

1 (fiksuotas) /
2 / 3 / 4 / 5
(reaguojantis)

5(Responsive)
Nustato objekto fokusavimo kitimo jautrumą
automatinio fokusavimo metu.

Focus Area

Wide (plati) /
„Zone“ (zona)
/ „Flexible
Spot“ (lanksti
sritis)

plačiakampis
režimas

Nustato automatinio fokusavimo sritį
automatiniam fokusavimui ir automatiniam
fokusavimui (AF) spaudžiant.

Žr. „Automatinis fokusavimo
reguliavimas (automatinis
fokusavimas)“ ir „Automatinio
fokusavimo srities / padėties
nustatymas (fokusavimo sritis)“.

„Wide“ (plačiakampis): fokusuojant ieško
objekto plataus matymo kampo vaizdo
srityje.
„Zone“ (zona): automatiškai ieško
fokusavimo taško nurodytoje zonoje.
„Flexible Spot“ (lankstus taškas):
sufokusuoja nurodytą vaizdo vietą.

„Focus Area
(AF-S)“
(fokusavimo
zona (AF-S)

Flexible Spot Flexible Spot
Nustato laikino automatinio fokusavimo
(AF-S) sritį.

„Face/Eye
Detection AF“
(veido / akių
aptikimo AF)

„Face/Eye
Only AF“ (tik
veido / akių
AF) / 
Face/Eye
Priority AF
(veido / akių
pirmumo AF)
/ Off
(išjungta)

„Face/Eye
Priority AF“
(veido / akių
pirmumo AF)

Įjungia / išjungia veido aptikimo AF.
Žr. „Sekimas naudojant veido ir akių
aptikimą (veido / akių aptikimo AF)“.

„Push AF
Mode“
(laikino AF
režimas)

AF / Single-
shot AF(AF-
S) (vieno
kadro AF(AF-
S)

AF
Nustato laikino automatinio fokusavimo
režimą.
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[158] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

Sulėtintas ir pagreitintas filmavimas

Nustatomi sulėtinto ir pagreitinto filmavimo režimo nustatymai (žr. „Sulėtintas ir pagreitintas
filmavimas“).

„Touch
Function in
MF“ (lietimo
funkcija
veikiant
rankiniam
fokusavimui)

„Tracking AF“
/ „Spot
Focus“
(sekimo AF /
taškinis
fokusavimas)

„Tracking AF“
(sekimo AF)

Nustatomas veikimas, kai fotoaparato
vaizdo ekranas paliečiamas veikiant MF
režimui.

„AF Assist“
(AF pagalba)

On (įjungti) /
„Off“ (išjungti)

On

Kai nustatyta „On“ (įjungtas), galite laikinai
išjungti automatinį fokusavimą ir fokusuoti
rankiniu būdu.

Žr. „Rankinis automatinio fokusavimo
taikinio nustatymas (AF pagalba)
naudojant žiniatinklio programą“ ir
„Rankinis fokusavimas veikiant
automatiniam fokusavimui naudojant
pridedamą infraraudonųjų spindulių
nuotolinio valdymo pultą“.

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas On (įjungti) / „Off“ (išjungti) Išjungta
Įjungia / išjungia
sulėtinto ir pagreitinto
filmavimo režimą.

Frame Rate

Nuo 1 kadr./sek. iki 60 kadr./sek. /
100 kadr./sek. / 120 kadr./sek. / 150
kadr./sek. / 180 kadr./sek. / 200
kadr./sek. / 240 kadr./sek.

–

Nustato kadrų dažnį
sulėtintam ir
pagreitintam
filmavimui.

Pastaba

Galimi nustatymai
skiriasi
atsižvelgiant į
pasirinktą
sistemos dažnį,
kodeką ir vaizdo
įrašo formatą.
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[159] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

LUT įjungimas / išjungimas

Nustato LUT parametrus.

[160] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

Triukšmo slopinimas

Nustato triukšmo slopinimo parametrus.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

SDI
MLUT On (MLUT įjungtas)
/ MLUT Off (MLUT
išjungtas)

„MLUT Off“
(MLUT
išjungta)

Pasirenkama, ar
monitoriaus LUT bus
taikomas SDI išvesties
vaizdui.

„HDMI/Stream“
(HDMI /
transliacija)

MLUT On (MLUT įjungtas)
/ MLUT Off (MLUT
išjungtas)

„MLUT Off“
(MLUT
išjungta)

Pasirenka, ar
monitoriaus LUT taikyti
HDMI ir transliacijos
išvesties vaizdui.

Proxy
MLUT On (MLUT įjungtas)
/ MLUT Off (MLUT
išjungtas)

„MLUT Off“
(MLUT
išjungta)

Pasirenka, ar
monitoriaus LUT taikyti
tarpiniam vaizdo
įrašymui.

„Internal Rec“
(vidinis įrašymas)

MLUT On (MLUT įjungtas)
/ MLUT Off (MLUT
išjungtas)

„MLUT Off“
(MLUT
išjungta)

Pasirenka, ar
monitoriaus LUT taikyti
pagrindiniam vaizdo
įrašymui.

„LUT On/Off
Button Target“ (
LUT įjungimo /
išjungimo mygtuko
tikslas)

SDI / „HDMI/Stream“ /
„SDI & HDMI/Stream“
(SDI / HDMI / transliacija /
SDI ir HDMI / transliacija)

„HDMI/Stream“
(HDMI /
transliacija)

Nustatoma numatyta
išvestis, valdoma
priskiriamu mygtuku,
kuriam priskirta LUT
įjungimo / išjungimo
funkcija.
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Patarimas

Nustatymai [Setting(Custom)] (pasirinktinis nustatymas) ir [Level(Custom)] (pasirinktinis lygis) yra
pateikiami pasirinkus nustatymą [Target Display] (numatytas rodinys).

[161] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

Mirgėjimo mažinimas

Nustato mirgėjimo koregavimo parametrus.

[162] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

SteadyShot

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Setting(Custom)“
(pasirinktinis
nustatymas)

On (įjungti) / „Off“
(išjungti)

On
Įjungia / išjungia triukšmo
slopinimo funkciją
pasirinktiniu režimu.

„Level(Custom)“
(pasirinktinis lygis)

„Low“ (žemas) / Mid
(vidutinis) / „High“
(aukštas)

Mid
Nustato triukšmo slopinimo
lygį pasirinktiniu režimu.

„Setting(Cine EI)“
(„Cine EI“
nustatymas)

On (įjungti) / „Off“
(išjungti)

Išjungta
Įjungia / išjungia triukšmo
slopinimo funkciją „Cine EI“
režimu.

„Level(Cine EI)“
(„Cine EI“ lygis)

„Low“ (žemas) / Mid
(vidutinis) / „High“
(aukštas)

Mid
Nustato triukšmo slopinimo
lygį „Cine EI“ režimu.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Režimas
„Auto“ (automatinis) /
„On“ (įjungtas) / Off
(išjungtas)

Išjungta
Nustato mirgėjimo koregavimo
režimą.

Dažnis 50 Hz / 60 Hz 60Hz
Nustato apšvietimo maitinimo
šaltinio dažnį, dėl kurio atsiranda
mirgėjimas.
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Nustato vaizdo stabilizavimo parametrus.

[163] Fotoaparato meniu ir išsamūs nustatymai Projekto meniu

Bazinis nustatymas

Nustato bazinius nustatymus.

[164] Fotoaparato meniu ir išsamūs nustatymai Projekto meniu

Įrašymo formatas

Nustato įrašymo formato parametrus.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas

„Active“ (aktyvus) /
Standard
(standartinis) / „Off“
(išjungtas)

Išjungta

Nustato vaizdo stabilizavimo funkciją.

Pastaba

Įjungtas, kai prijungtas suderinamas
objektyvas.

Kai nustatyta kaip „Active“ (aktyvus)
arba „Standard“ (standartinis),
pasukimo / pakreipimo funkcija gali
veikti nenumatytai.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Fiksavimo
režimas

Custom
(pasirinktinis) /
„Cine EI“

Custom

Nustatomas fiksavimo režimas.
Žr. „Fiksavimo režimo nustatymas“
dalyje „Pagrindinių funkcijų
konfigūravimas“.

Numatytasis
rodinys

SDR(BT.709) /
HDR(HLG)

SDR(BT.709)
Nustatoma įrašymo / išvesties spalvų
erdvė veikiant pasirinktiniam režimui.
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Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Dažnis
59.94 / 50 / 29.97 / 25 / 24 /
23.98

59,94 Pasirenka sistemos dažnį.

„Imager
Scan
Mode“
(jutiklio
skenavimo
režimas)

FF / S35 FF Pasirenkamas jutiklio dydis.

Kodekas
RAW / RAW & XAVC-I /
XAVC-I / XAVC-L

XAVC-I

Nustatomas klipų įrašymo /
atkūrimo kodekas.

Pastaba

Kai [Imager Scan Mode]
(jutiklio skenavimo
režimas) nustatyta kaip
[S35], [RAW] ir [RAW &
XAVC-I] negalima rinktis.

RAW
išvesties
formatas

Galimi nustatymai priklauso
nuo nustatymo [Frequency]
(dažnis).

Žr. toliau esančią dalį
„Nustatymai [RAW Output
Format] (RAW išvesties
formatas)“.

–

Nustatomas RAW vaizdo
išvesties dydis išoriniame RAW
įrašymo įrenginyje.

Pastaba

Kai [Codec] (kodekas)
nustatyta kaip [RAW &
XAVC-I], nustatymas
[Video Format] (vaizdo
įrašo formatas) pasikeičia
pagal nustatymą [RAW
Output Format] (RAW
išvesties formatas).

„Video
Format“
(vaizdo
įrašo
formatas)

Galimi nustatymai priklauso
nuo nustatymų [Frequency]
(dažnis), [Imager Scan Mode]
(jutiklio skenavimo režimas) ir
[Codec] (kodekas).

Žr. toliau pateikiamą dalį
„Nustatymai [Video
Format] (Vaizdo įrašo
formatas)“.

–
Nustatomas vaizdo dydis ir
sparta bitais.
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Nustatymai [RAW Output Format] (RAW išvesties formatas)

Numatytosios reikšmės nurodytos paryškintuoju šriftu.
Praleistos sąlygos, kurioms esant negalima nustatyti [RAW Output Format] (RAW išvesties
formatas).

Nustatymai [Video Format] (vaizdo įrašo formatas)

Numatytosios reikšmės nurodytos paryškintuoju šriftu.

Dažnis „Imager Scan Mode“ (jutiklio
skenavimo režimas) Kodekas Nustatymas

59,94 / 50 / 29,97 /
25 / 23,98

FF
RAW / RAW &
XAVC-I

4096×2160 
3840×2160

24 FF
RAW / RAW &
XAVC-I

4096×2160

Dažnis „Imager Scan Mode“ (jutiklio
skenavimo režimas) Kodekas Nustatymas

59,94 / 50 / 29,97 /
25 / 23,98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L

3840×2160P
1920×1080P
50 
1920×1080P
35

S35

XAVC-I 1920×1080P

XAVC-L

1920×1080P
50 
1920×1080P
35

24 FF

RAW –

RAW & XAVC-I /
XAVC-I

4096×2160P
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[165] Fotoaparato meniu ir išsamūs nustatymai Projekto meniu

„Cine EI“ nustatymas

Nustatomi „Cine EI“ režimo nustatymai (žr. „Fiksavimo režimo nustatymas“ dalyje „Pagrindinių
funkcijų konfigūravimas“).

[166] Fotoaparato meniu ir išsamūs nustatymai Projekto meniu

Sinchroniškas įrašymas

Nustatomi 2 lizdų sinchroniško įrašymo režimo nustatymai (žr. „Įrašymas į atminties korteles A ir
B vienu metu (2 lizdų sinchroniškas įrašymas)“).

[167] Fotoaparato meniu ir išsamūs nustatymai Projekto meniu

Tarpinis įrašymas

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Color Gamut“
(spalvų gama)

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

Nustato spalvų erdvę
„Cine EI“ režimu.

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas On (įjungti) / „Off“ (išjungti) Išjungta

Įjungiamas /
išjungiamas 2
lizdų
sinchroniško
įrašymo
režimas.

„Rec Button
Set“
(įrašymo
mygtuko
nustatymas)

Įrašymo mygtukas: [SlotA SlotB] 2-asis
įrašymo mygtukas: [SlotA SlotB] / Įrašymo
mygtukas: [SlotA] 2-asis įrašymo
mygtukas: [SlotB] / Įrašymo mygtukas:
[SlotB] 2-asis įrašymo mygtukas: [SlotA]

Įrašymo
mygtukas:
[SlotA SlotB]
2-asis įrašymo
mygtukas:
[SlotA SlotB]

priskiriami
įrašymo
mygtukai,
naudojami
kiekvienai
įrašymo
laikmenai
valdyti.
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Nustatomi tarpinio įrašymo režimo nustatymai (žr. „Tarpinis įrašymas“).

[168] Fotoaparato meniu ir išsamūs nustatymai Projekto meniu

Įrašymas intervalais

Nustatomi įrašymo intervalais režimo nustatymai (žr. „Vaizdo įrašymas su pertrūkiais
(filmavimas intervalais)“).

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
On (įjungti) / „Off“
(išjungti)

Išjungta
Įjungia / išjungia įrašymo
mažesne raiška režimą.

„Audio Channel“
(garso kanalas)

CH1/CH2 /
CH3/CH4

CH1/CH2
Pasirenka garso kanalą
mažesnės raiškos duomenims
įrašyti.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
On (įjungti) / „Off“
(išjungti)

Išjungta

Įjungia / išjungia
filmavimo intervalais
režimą. (Nustačius šį
režimą į „On“ (įjungti)
visi kiti specialūs
režimai bus nustatyti į
„Off“ (išjungta).

„Interval
Time“
(intervalo
laikas)

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 /
9 / 10 / 15 / 20 / 30 / 40 /
50 (sek.) 
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 /
9 / 10 / 15 / 20 / 30 / 40 /
50 (min.) 
1 / 2 / 3 / 4 / 6 / 12 / 24
(val.)

1

Nustato intervalą tarp
įrašymų veikiant
įrašymo intervalais
režimui (kai „Interval
Rec“ (įrašymas
intervalais) nustatyta
kaip „On“ (įjungta).

„Number of

1frame / 2frames /
3frames / 
6frames / 9frames /
12frames 
Galimi nustatymai

Nustato, kiek kadrų
įrašyti vienu filmavimo
intervalu filmavimo
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[169] Fotoaparato meniu ir išsamūs nustatymai Projekto meniu

Nuotraukų talpyklos įrašymas

Nustatomi nuotraukų talpyklos įrašymo režimo nustatymai (žr. „Talpykloje esančių nuotraukų
įrašymas („Picture Cache Rec“).

[170] Fotoaparato meniu ir išsamūs nustatymai Projekto meniu

SDI/HDMI įrašymo valdymas

Nustato SDI/HDMI įrašymo valdymo parametrus.

Frames“
(kadrų
skaičius)

priklauso nuo pasirinkto
vaizdo įrašo formato
kadrų dažnio. 
59.94P/50P: 2frames /
6frames / 12frames 
29.97P/25P/24P/23.98P:
1frame / 3frames /
6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

intervalais režimu (kai
parametras „Interval
Rec“ (filmavimas
intervalais) nustatytas į
„On“ (įjungtas).

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
On (įjungti) / „Off“
(išjungti)

Išjungta
Įjungiama / išjungiama nuotraukų
talpyklos funkcija.

„Cache Size“
(talpyklos
dydis)

„Short“ / „Medium“ /
„Long“ / „Max“ (trumpas
/ vidutinis / ilgas /
maks.)

„Max“
(maks.)

Nustatomas vaizdų kaupimo
vaizdų talpyklos atmintyje laikas
(vaizdų talpyklos įrašymo laikas).

„Cache Rec
Time“
(talpyklos
įrašymo
laikas)

– –
Parodomas vaizdų kaupimo
vaizdų talpyklos atmintyje laikas
(vaizdų talpyklos įrašymo laikas).

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas
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[171] Fotoaparato meniu ir išsamūs nustatymai Projekto meniu

Priskiriamas mygtukas

Funkcijos priskiriamos priskiriamiems mygtukams (<1>–<9>) ir [Focus Hold Button] (fokusavimo
užlaikymo mygtukas).
Galima priskirti toliau nurodytas funkcijas.
[Off] (išjungta): nepriskirta jokia funkcija.
[Base ISO/Sensitivity] (bazinis ISO / jautrumas): perjungiamas bazinis vaizdo jutiklio
jautrumas.
[AGC]: įjungiama / išjungiama AGC funkcija.
[Push AGC] (AGC spaudžiant): įjungiama AGC funkcija, kai nuspaustas mygtukas.
[ND Filter] (ND filtras)

Veikiant kintamajam režimui: reguliuojamas ND filtro skaidrumas. Paspausdami ir
palaikydami perjunkite – skaidrus / rankinis / automatinis.
Išankstinių nustatymų režimas: paspausdami ir palaikydami perjunkite išankstinius
nustatymus.

Nustatymas

Off (išjungtas) /
„SDI/HDMI Remote
I/F“ (SDI/HDMI
nuotolinis I/F) /
„Parallel Rec“
(lygiagretus
įrašymas)

Išjungta

Nustatomas prijungto išorinio įrenginio
įrašymo paleidimo / sustabdymo
valdymas naudojant SDI/HDMI išvesties
signalą.
„Off“ (išjungta): nenaudoti nuotolinio
valdymo pulto.
„SDI/HDMI Remote I/F“ (SDI/HDMI
nuotolinis I/F): prijungto išorinio
įrenginio įrašymo sustabdymo /
paleidimo valdymas, kai įrenginyje
neįdėta laikmena. Nesinchronizuojama
su kadrų tikslumu įrenginyje įdėtoje
laikmenoje.
„Parallel Rec“ (lygiagretus
įrašymas): prijungto išorinio įrenginio
įrašymo sustabdymo / paleidimo
valdymas, kai įrenginyje įdėta laikmena.
Sinchronizuojama su kadrų tikslumu
įrenginyje įdėtoje laikmenoje.

Pastaba

Kad būtų valdoma naudojant HDMI
išvesties signalą, fotoaparato meniu
[TC/Media] > [HDMI TC Out] >
[Setting] (laiko kodas / laikmena >
HDMI TC išvestis > nustatymas)
nustatykite kaip [On] (įjungta).
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[ND Filter Position] (ND filtro padėtis): perjungiami ND filtrai.
[Auto ND Filter] (automatinis ND filtras): įjungiama / išjungiama automatinio ND filtro funkcija.
[Push Auto ND] (automatinis ND spaudžiant): įjungiama automatinio ND filtro funkcija, kai
nuspaudžiamas mygtukas.
[Auto Iris] (automatinė diafragma): įjungiama / išjungiama diafragmos funkcija.
[Push Auto Iris] (automatinė diafragma spaudžiant): įjungiama automatinės diafragmos
funkcija, kai nuspaudžiamas mygtukas.
[Bokeh Control] („bokeh“ valdymas): įjungiamas / išjungiamas „bokeh“ valdymo režimas.
[Auto Shutter] (automatinis užraktas): įjungiama / išjungiama automatinio užrakto funkcija.
[AE Level/Mode] (AE lygis / režimas): reguliuojamas AE lygis. Paspausdami ir palaikydami
perjunkite AE režimą.
[Backlight] (foninis apšvietimas): įjungiamas foninis apšvietimas arba standartinis
apšvietimas.
[Spotlight] (koncentruotas apšvietimas): įjungiamas koncentruotas arba standartinis
apšvietimas.
[Preset White Select] (išankstinio baltos spalvos balanso pasirinkimas): perjungiama
baltos spalvos balanso išankstinio nustatymo režimo reikšmė.
[ATW]: įjungiama / išjungiama ATW funkcija.
[ATW Hold] (ATW užlaikymas): pristabdomas ATW funkcijos veikimas.
[AF Speed/Sens.] (AF greitis / jautrumas): perjungiamas AF perėjimo greičio nustatymas ir
AF objekto poslinkio jautrumo nustatymas.
[Focus Setting] (fokusavimo nustatymas): nustatoma fokusavimo sritis.
[Face/Eye Detection AF] (veido / akių aptikimo AF): perjungiami veido aptikimo AF
nustatymai.
[Push AF Mode] (AF režimas spaudžiant): perjungiamas AF režimo spaudžiant nustatymas.
[Push AF/MF] (AF/MF spaudžiant): veikiant rankinio fokusavimo režimui suaktyvinamas AF,
kol laikomas nuspaustas mygtukas. AF fokusavimo režimu aktyvina MF, kol laikomas
paspaustas mygtukas.
[Focus Hold] (fokusavimo užlaikymas): veikiant AF fokusavimo režimui fokusavimas
užfiksuojamas, kol laikomas nuspaustas mygtukas.
[S&Q Motion] (sulėtintas ir pagreitintas filmavimas): įjungiama / išjungiama sulėtinta ir
pagreitinta filmavimo funkcija. Laikant nuspaudus nustatoma fiksavimo kadrų sparta.
[LUT On/Off]: (LUT įjungimas / išjungimas) įjungiama / išjungiama LUT funkcija.
Perjungiamas tikslas yra nustatomas naudojant [Shooting] > [LUT On/Off] > [LUT On/Off Button
Target] (vaizdų fiksavimas > LUT įjungimas / išjungimas > LUT įjungimo / išjungimo mygtuko
tikslas).
[SteadyShot]: perjungiama tarp „Active“ (aktyvus), „Standard“ (standartinis) ir „Off“ (išjungta).
[Crop Select] (apkirpimo pasirinkimas): perjungiamas jutiklio skenavimo režimas.
Perjungimas galimas nustatytame diapazone nekeičiant įrašymo formato.
[Rec] (įrašyti): paleidžiamas / sustabdomas įrašymas.
[Picture Cache Rec] (nuotraukų talpyklos įrašymas): įjungiamas / išjungiamas nuotraukų
talpyklos įrašymo režimas.
[Rec Review] (įrašo peržiūra): įjungiama / išjungiama įrašo peržiūros funkcija.
[Clip Flag OK] (klipo žymė OK): vykdoma OK pridėjimo funkcija. Paspaudus dukart, klipo
žymė panaikinama.
[Clip Flag NG] (klipo žymė NG): vykdoma NG pridėjimo funkcija. Paspaudus dukart, klipo
žymė panaikinama.
[Clip Flag KEEP] (klipo žymė KEEP): vykdoma KEEP pridėjimo funkcija. Paspaudus dukart,
klipo žymė panaikinama.
[Slot Select] (lizdo pasirinkimas): įjungiamas (A) arba (B) atminties lizdas.
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[Color Bars] (spalvų juostos): įjungiamos / išjungiamos spalvų juostos.
[DURATION/TC/U-BIT]: įjungiamas laiko kodas, naudotojo bitai ir trukmė.
[Display] (rodyti): įjungiami / išjungiami ekrano indikatoriai.
[Lens Info] (objektyvo informacija): įjungiamas lauko gylio indikatorius.
[Video Signal Monitor] (vaizdo signalo stebėjimas): perjungiam vaizdo signalo stebėjimą
(pvz., kreivės rodymą).
[Marker] (žymeklis): įjungiama / išjungiama žymeklio funkcija.
[Thumbnail] (miniatiūros): parodomas / išjungiamas miniatiūrų ekranas.
[Auto Upload (Proxy)] (automatinis įkėlimas (tarpinis): įjungiamas / išjungiamas automatinis
tarpinio failo perdavimas.
[Direct Menu] (tiesioginis meniu): parodomas / išjungiamas tiesioginis meniu.
[User Menu] (naudotojo meniu): parodomas / išjungiamas naudotojo meniu.

[172] Fotoaparato meniu ir išsamūs nustatymai Piešinio / vaizdo meniu

Scenos failas

Nustatomi su scenos failais susiję nustatymai (žr. „Vaizdų fiksavimas su norimu vaizdu“).

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

Recall – –

Įkelia siužeto failą,
išsaugotą vidinėje
atmintyje, ir pritaiko
nustatymus kaip esamus
vaizdo kokybės
nustatymus.

„Store“
(išsaugoti)

– –

Išsaugo esamą vaizdo
kokybės būseną vidinėje
atmintyje kaip siužeto
failą.

Delete – –
Panaikina siužeto failą,
laikomą vidinėje
atmintyje.

„Preset
Recall“
(išankstinio
nustatymo
atkūrimas)

Kai fiksavimo režimas nustatytas
kaip pasirinktinis, o tikslo
rodymas – kaip SDR(BT.709): „S-
Cinetone“ / „Standard“ / „Still“ /
ITU709
Kai fiksavimo režimas nustatytas
kaip pasirinktinis, o tikslo
rodymas – kaip HDR(HLG): „HLG
Live“ / „HLG Natural“

–

Taiko iš anksto
nustatytus vaizdo
kokybės nustatymus
(neperrašomus) kaip
dabartinius vaizdo
kokybės nustatymus.
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[173] Fotoaparato meniu ir išsamūs nustatymai Piešinio / vaizdo meniu

Bazinis vaizdas

Nustato parametrus, susijusius su baziniu vaizdu.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Pasirinkti

Kai fiksavimo režimas
nustatytas kaip
pasirinktinis, o tikslo
rodymas – kaip
SDR(BT.709): „S-Cinetone“ /
„Standard“ / „Still“ / ITU709 /
„User1“–„User16“
Kai fiksavimo režimas
nustatytas kaip
pasirinktinis, o tikslo
rodymas – kaip HDR(HLG):
„HLG Live“ / „HLG Natural“ /
„User1“–„User16“
Kai fiksavimo režimas
nustatytas kaip „Cine EI“:
s709 / 709(800) / „S-Log3“ /
„User1“–„User16“

Kai fiksavimo
režimas nustatytas
kaip pasirinktinis,
o tikslo rodymas –
kaip SDR(BT.709):
„S-Cinetone“
Kai fiksavimo
režimas nustatytas
kaip pasirinktinis,
o tikslo rodymas –
kaip HDR(HLG):
„HLG Live“
Kai fiksavimo
režimas nustatytas
kaip „Cine EI“:
s709

Pasirenkamas bazinis
vaizdas.

Delete – –
Panaikinamas
pasirinktas bazinis
vaizdas.

Delete All – –
Panaikina visus
bazinius vaizdus.

Input
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

Nustatoma įvesties
gama, naudojama
baziniam vaizdui, kuris
pasirenkamas
naudojant [Select]
(pasirinkti).

Išvestis BT.709 / HLG BT.709

Nustatoma išvesties
gama, naudojama
baziniam vaizdui, kuris
pasirenkamas
naudojant [Select]
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[174] Fotoaparato meniu ir išsamūs nustatymai Piešinio / vaizdo meniu

Piešinio nustatymų nustatymas iš naujo

Atkuriami meniu [Paint/Look] (piešinio / vaizdo) nustatymai, išskyrus bazinį vaizdą.

[175] Fotoaparato meniu ir išsamūs nustatymai Piešinio / vaizdo meniu

Juoda spalva

Nustato juodos spalvos parametrus.

(pasirinkti).

„AE Level
Offset“ (AE
lygio
poslinkis)

0EV / 1/3EV / 2/3EV / 1EV /
4/3EV / 5/3EV / 2EV

0EV

Nustatoma
ekspozicijos atskaitos
reikšmė, naudojama
baziniam vaizdui, kuris
pasirenkamas
naudojant [Select]
(pasirinkti).

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Reset without Base
Look“ (atkurti be
bazinio vaizdo)

„Execute“
(vykdyti) /
„Cancel“
(atšaukti)

–

Atkuriami meniu [Paint/Look]
(piešinio / vaizdo) nustatymai,
išskyrus bazinį vaizdą.
„Execute“ (vykdyti): vykdoma
funkcija.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Master Black“
(pagrindinė juoda)

nuo –99,0 iki +99,0 ±0,0
Nustato pagrindinį
juodos spalvos lygį.

„R Black“ (R juoda) nuo –99,0 iki +99,0 ±0,0
Nustato R juodos
spalvos lygį.

„B Black“ (B juoda) nuo –99,0 iki +99,0 ±0,0
Nustato B juodos
spalvos lygį.
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[176] Fotoaparato meniu ir išsamūs nustatymai Piešinio / vaizdo meniu

Lenkimo taškas

Nustato lenkimo taško koregavimo parametrus.

[177] Fotoaparato meniu ir išsamūs nustatymai Piešinio / vaizdo meniu

Detalės

nustato detalius nustatymų reguliavimus.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas

Kai numatytasis
rodinys nustatytas
kaip SDR(BT.709):
„On“ (įjungta) / „Off“
(išjungta) / ---
Kai numatytasis
rodinys nustatytas
kaip HDR(HLG): „On“
(įjungta) / „Off“
(išjungta) / ---

Kai numatytasis
rodinys
nustatytas kaip
SDR(BT.709):„Off“
(išjungta)
Kai numatytasis
rodinys
nustatytas kaip
HDR(HLG):„Off“
(išjungta)

Įjungia / išjungia lenkimo taško
koregavimo funkciją.

Pastaba

Įjungiama, kai [Base Look]
> [Select] (bazinis vaizdas >
pasirinkti) nustatomas kaip
[Standard] (standartinis),
[ITU709], [HLG Live] arba
[HLG Natural].

„Auto Knee“
(automatinis
lenkimo
taškas)

Kai numatytasis
rodinys nustatytas
kaip SDR(BT.709):
„On“ (įjungta) / „Off“
(išjungta) / ---
Kai numatytasis
rodinys nustatytas
kaip HDR(HLG): „On“
(įjungta) / „Off“
(išjungta) / ---

Kai numatytasis
rodinys
nustatytas kaip
SDR(BT.709):„On“
(įjungta)
Kai numatytasis
rodinys
nustatytas kaip
HDR(HLG):„Off“
(išjungta)

Įjungia / išjungia automatinio
lenkimo taško funkciją.

Pastaba

Įjungiama, kai [Base Look]
> [Select] (bazinis vaizdas >
pasirinkti) nustatoma kaip
[Standard] (standartinis)
arba [ITU709].

„Point“
(taškas)

Nuo 75% iki 109 % 90 % nustatomas lenkimo taškas

„Slope“
(nuolydis)

nuo –99 iki +99 ±0
nustatomas lenkimo taško
nuolydis
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[178] Fotoaparato meniu ir išsamūs nustatymai Piešinio / vaizdo meniu

Matrica

Nustato matricos koregavimo parametrus.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
On (įjungti) /
„Off“
(išjungti)

On Įjungia / išjungia detalumo funkciją.

Level
nuo –7 iki
+7

±0 Nustato detalumo lygį.

„Manual
Setting“
(rankinis
nustatymas)

„On“ (įjungti)
/ Off
(išjungti) / --
-

Išjungta
Įjungia / išjungia rankinio detalumo reguliavimo
funkciją.

„V/H
Balance“
(V/H
balansas):

nuo –2 iki
+2

±0
Nustato balansą tarp vertikalus (V) ir
horizontalus (H) detalumo atliekant rankinį
detalumo reguliavimą.

„B/W
Balance“
(juodos /
baltos
spalvos
balansas)

Type1 /
Type2 /
Type3 /
Type4 /
Type5

Type3

Nustato balansą tarp juodos spalvos (B)
detalumo silpnai apšviestose srityse ir baltos
spalvos (W) detalumo stipriai apšviestose
srityse atliekant rankinį detalumo reguliavimą.

„Limit“ (riba) Nuo 0 iki 7 7
Nustato detalumo ribos lygį rankiniam
detalumo reguliavimui.

„Crispening“
(ryškumas)

Nuo 0 iki 7 0
Nustato ryškumo lygį atliekant rankinį
detalumo reguliavimą.

„High Light
Detail“
(stipriai
apšviestas
detalumas)

Nuo 0 iki 4 0
Nustato detalumo lygį stipriai apšviestoms
vietoms atliekant rankinį detalumo reguliavimą.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas
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[179] Fotoaparato meniu ir išsamūs nustatymai Piešinio / vaizdo meniu

Daugybinė matrica

Nustato daugybinės matricos koregavimo parametrus.

„User Matrix“
(naudotojo matrica)

On (įjungti) /
„Off“ (išjungti)

Išjungta
Įjungia / išjungia naudotojo
matricos koregavimo
funkciją.

„User Matrix Level“
(naudotojo matricos
lygis)

nuo –99 iki +99 ±0
Koreguoja viso vaizdo
spalvų sotį.

„User Matrix Phase“
(naudotojo matricos
fazė)

nuo –99 iki +99 ±0
Koreguoja viso vaizdo
spalvų toninimą (fazę).

„User Matrix R-G“
(naudotojo matrica R-
G)

nuo –99 iki +99 ±0
Nustato naudotojo nustatytą
R-G naudotojo matricą.

„User Matrix R-B“
(naudotojo matrica R-
B)

nuo –99 iki +99 ±0
Nustato naudotojo nustatytą
R-B naudotojo matricą

„User Matrix R-R“
(naudotojo matrica R-
R)

nuo –99 iki +99 ±0
Nustato naudotojo nustatytą
G-R naudotojo matricą

„User Matrix G-R“
(naudotojo matrica G-
R)

nuo –99 iki +99 ±0
Nustato naudotojo nustatytą
G-B naudotojo matricą.

„User Matrix B-R“
(naudotojo matrica B-
R)

nuo –99 iki +99 ±0
Nustato naudotojo nustatytą
B-R naudotojo matricą

„User Matrix B-G“
(naudotojo matrica B-
G)

nuo –99 iki +99 ±0
Nustato naudotojo nustatytą
B-G naudotojo matricą

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas On (įjungti) / „Off“ (išjungti) Išjungta
Įjungia / išjungia daugybinės
matricos koregavimo
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[180] Fotoaparato meniu ir išsamūs nustatymai Pasukimo / pakreipimo meniu

Pasukimo / pakreipimo spartinimas

Nustatomi su pasukimo / pakreipimo funkcijos spartinimu susiję nustatymai.

[181] Fotoaparato meniu ir išsamūs nustatymai Laiko kodo / laikmenos meniu

Laiko kodas

Nustato laiko kodo parametrus.

funkciją.

Reset
„Execute“ (vykdyti) / „Cancel“
(atšaukti)

–
Nustato kiekvienos ašies
spalvos atspalvį ir sotį į
numatytąsias reikšmes.

„Axis“ (ašis)
B / B+ / MG? / MG / MG+ / R /
R+ / YL? / YL / YL+ / G? / G /
G+ / CY / CY+ / B?

B Pasirenka ašį.

Hue nuo –99 iki +99 ±0

Nustato spalvos,
naudojamos daugybinės
matricos koregavimui,
atspalvį.

Saturation nuo –99 iki +99 ±0
Nustato spalvos,
naudojamos daugybinės
matricos koregavimui, sotį.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Ramp
Curve“(kylanti
kreivė)

nuo 1 iki 9 8
Pasirenkamas pasukimo / pakreipimo
funkcijos spartinimas / sulėtinimas. Kuo
didesnis skaičius, tuo didesnis spartinimas.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustato laiko kodo naudojimo
režimą.



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

[182] Fotoaparato meniu ir išsamūs nustatymai Laiko kodo / laikmenos meniu

Laiko kodo rodymas

Nustato laiko duomenų rodymo parametrus.

[183] Fotoaparato meniu ir išsamūs nustatymai Laiko kodo / laikmenos meniu

Naudotojo bitai

Režimas
Preset (nustatytas) /
„Regen“ (tęsiamas) /
„Clock“ (laikrodis)

Preset

„Preset“ (išankstinis
nustatymas): paleidžiama
naudojant iš anksto nustatytą
reikšmę.
„Regen“ (tęsiamas): pradeda
veikti nuo ankstesnio klipo
pabaigos laiko kodo.
„Clock“ (laikrodis): laiko kodui
naudojamas vidinis laikrodis.

„Run“
(veikimas)

Rec Run / Free Run Rec Run

„Rec Run“ (veikimas įrašant):
veikia tik įrašant.
„Free Run“ (laisvas veikimas):
veikia visada nepaisant pasirinktos
įrašymo operacijos.

Nustatymas – –

Nustato laiko kodo pasirinktinę
reikšmę.
„Set“ (nustatyti): nustatykite
reikšmę.

Reset
„Execute“ (vykdyti) /
„Cancel“ (atšaukti)

–
Nustato laiko kodą į 00:00:00:00.
„Execute“ (vykdyti): vykdoma
funkcija.

TC Format DF / NDF DF
Nustato laiko kodo formatą.
DF: praleidžiamas kadras
NDF: nepraleidžiamas kadras

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

„Display Select“
(rodymo
pasirinkimas)

„Timecode“ / „Users Bit“ /
„Duration“ (laiko kodas / naudotojų
bitai / trukmė)

Laiko kodas
Perjungia laiko
duomenų
rodymą.
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Nustato parametrus, susijusius su naudotojo bitais.

[184] Fotoaparato meniu ir išsamūs nustatymai Laiko kodo / laikmenos meniu

HDMI laiko kodo išvestis

nustato parametrus, susijusius su laiko kodo išvestimi, kai naudojamas HDMI.

[185] Fotoaparato meniu ir išsamūs nustatymai Laiko kodo / laikmenos meniu

Klipo pavadinimo formatas

Nustato parametrus, susijusius su klipo pavadinimo suteikimu ir naikinimu.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Režimas
Fix (fiksuotas)
/ „Time“
(laikas)

Taisymas

Nustato naudotojo bitų režimą.
„Fix“ (fiksuotas): naudoja pasirinktą
fiksuotą reikšmę naudotojo bituose.
„Time“ (laikas): naudotojų bitams
naudojama dabartinio laiko valanda,
minutės ir sekundės.

Nustatymas – –
Nustato naudotojo bitų pasirenkamą
reikšmę.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
On (įjungti) /
„Off“ (išjungti)

Išjungta
Nustato, ar išvestis laiko kodą į
įrenginius kitiems tikslams naudojant
HDMI.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

nnn_ (nnn yra
Nustato klipo pavadinimo antraštės dalį (nuo 4
iki 46 simbolių). 
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Antraštės nustatymas

[186] Fotoaparato meniu ir išsamūs nustatymai Laiko kodo / laikmenos meniu

Laikmenos atnaujinimas

Atnaujinamas tvarkymo failas atminties kortelėse (žr. „Atminties kortelių taisymas“).

„Title Prefix“
(pavadinimo
prefiksas)

3 paskutiniai
serijos
numerio
skaitmenys)
(Maks. 7
skaitmenys)

nnn

Atidaro simbolių eilutės įvedimo langą.
Išsamesnė informacija apie antraščių
nustatymą ir simbolių įvedimo ekraną
pateikiama toliau esančiose dalyse
„Antraštės nustatymas“ ir „Simbolių eilutės
įvedimo lango struktūra“.

„Number
Set“
(skaičių
nustatymas)

Nuo 0001 iki
9999

0001
Nustato 4 skaitmenų skaičių kaip klipo
pavadinimo priesagą.

GUI valdymo skydelyje esančiais rodyklių mygtukais simbolių pasirinkimo srityje
pasirinkite simbolį (simbolis paryškinamas), kurį norite įterpti žymeklio vietoje
srityje [Title Prefix] (antraštės priešdėlis), tada GUI valdymo skydelyje paspauskite
mygtuką [Set] (nustatyti).

Pasirinktas simbolis bus įvestas, o žymeklis persikels į dešinę.

1

Pakartodami 1 veiksmą nustatykite antraštę.

Prireikus naudokite [BS].

2

Nustatę pavadinimą pasirinkite [Done] (atlikta), kad uždarytumėte simbolių įvedimo
ekraną.

Išsamesnė informacija apie veiksmus simbolių įvedimo ekrane pateikiama dalyje
„Simbolių eilutės įvedimas“.

Galima rinktos toliau nurodytus simbolius.
!#$%()+,-.;=@[ ]^_~ tarpas 
0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3

Papildomo Gamyklinis
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[187] Fotoaparato meniu ir išsamūs nustatymai Laiko kodo / laikmenos meniu

Laikmenos formatavimas

Suformatuojamos (inicijuojamos) atminties kortelės (žr. „Atminties kortelių formatavimas
(inicijavimas)“).

[188] Fotoaparato meniu ir išsamūs nustatymai Laiko kodo / laikmenos meniu

Laikmenos naudojimo laikas

Parodomas likęs atminties kortelių naudojimo laikas.

Elementas elemento
nustatymas

numatytasis
nustatymas

Aprašas

„Media(A)“
(laikmena
A)

„Execute“ (vykdyti) /
„Cancel“ (atšaukti)

–

Atnaujina valdymo failą
atminties kortelėje, esančioje
lizde A.
„Execute“ (vykdyti): vykdoma
funkcija.

„Media (B)“
(laikmena
B)

„Execute“ (vykdyti) /
„Cancel“ (atšaukti)

–

Atnaujina valdymo failą
atminties kortelėje, esančioje
lizde B.
„Execute“ (vykdyti): vykdoma
funkcija.

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

„Media(A)“
(laikmena
A)

„Full Format“ / „Quick Format“ / „Cancel“
(išsamus formatavimas / greitas
formatavimas / atšaukti)

–
Formatuoja
atminties
kortelę lizde A.

„Media (B)“
(laikmena
B)

„Full Format“ / „Quick Format“ / „Cancel“
(išsamus formatavimas / greitas
formatavimas / atšaukti)

–
Formatuoja
atminties
kortelę lizde B.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Media(A)“
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Pastaba

Reikalinga atminties kortelė, kuri palaiko likusio laikmenos naudojimo laiko rodymo funkciją.

[189] Fotoaparato meniu ir išsamūs nustatymai Stebėjimo meniu

Išvesties formatas

Nustato išvesties formato parametrus.

[190] Fotoaparato meniu ir išsamūs nustatymai Stebėjimo meniu

Rodymo įjungimas / išjungimas

Nustato rodomų elementų parametrus.
Kad elementas būtų rodomas, pasirinkite „On“ (įjungta). Jei elementą norite paslėpti, pasirinkite
„Off“ (išjungta).

(laikmena
A)

– –
Parodomas likęs A lizde esančios
atminties kortelės naudojimo laikas.

„Media (B)“
(laikmena
B)

– –
Parodomas B lizde esančios
atminties kortelės naudojimo laikas.

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

SDI Išsamesnė informacija apie nustatymus
pateikiama dalyje „Išvesties formatai ir
ribojimai“.

– Nustato SDI ir
HDMI išvesties
raišką.HDMI –

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

„File Transfer Status“ (failo persiuntimo
būsena)

On (įjungti) / „Off“
(išjungti)

On

„Rec/Play Status“ (įrašymo / atkūrimo
būsena)

On (įjungti) / „Off“
(išjungti)

On
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„RAW Output Control Status“ (RAW
išvesties valdymo būsena)

On (įjungti) / „Off“
(išjungti)

On

„Tally“ (įspėjimo lemputė)
On (įjungti) / „Off“
(išjungti)

On

Focus Mode
On (įjungti) / „Off“
(išjungti)

On

„Focus Position“ (fokusavimo padėtis)
On (įjungti) / „Off“
(išjungti)

On

„Focus Area Indicator“ (fokusavimo
srities indikatorius)

On (įjungti) / „Off“
(išjungti)

On

„Focus Area Ind.(AF-S)“ (fokusavimo
srities indikatorius AF-S)

On (įjungti) / „Off“
(išjungti)

On

„Face/Eye Detection Frame“ (veido /
akių aptikimo rėmelis)

On (įjungti) / „Off“
(išjungti)

On

„Lens Info“ (objektyvo informacija)
On (įjungti) / „Off“
(išjungti)

Išjungta

„Imager Scan Mode“ (jutiklio skenavimo
režimas)

On (įjungti) / „Off“
(išjungti)

On

„Rec Format“ (įrašymo formatas)
On (įjungti) / „Off“
(išjungti)

On

Frame Rate
On (įjungti) / „Off“
(išjungti)

On

„Zoom Position“ (išdidinimo padėtis)
On (įjungti) / „Off“
(išjungti)

On

SteadyShot
On (įjungti) / „Off“
(išjungti)

On

„Base Look“ / „Rec Look“ (bazinis
vaizdas / įrašymo vaizdas)

On (įjungti) / „Off“
(išjungti)

On

„SDI/HDMI Rec Control“ (SDI/HDMI
įrašymo valdymas)

On (įjungti) / „Off“
(išjungti)

On

„Monitoring Look“ (stebėjimo vaizdas)
On (įjungti) / „Off“
(išjungti)

On

„Proxy Status“ (mažos raiškos failo
būsena)

On (įjungti) / „Off“
(išjungti)

On

„Base ISO/Sensitivity“ (bazinis ISO /
jautrumas)

On (įjungti) / „Off“
(išjungti)

On
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„Media Status“ (laikmenos būsena)
On (įjungti) / „Off“
(išjungti)

On

„Clip Name“ (klipo pavadinimas)
On (įjungti) / „Off“
(išjungti)

On

White Balance
On (įjungti) / „Off“
(išjungti)

On

„Scene File“ (siužeto failai)
On (įjungti) / „Off“
(išjungti)

On

„Focus Indicator“ (fokusavimo
indikatorius)

On (įjungti) / „Off“
(išjungti)

On

„Auto Exposure Mode“ (automatinės
ekspozicijos režimas)

On (įjungti) / „Off“
(išjungti)

On

„Auto Exposure Level“ (automatinės
ekspozicijos lygis)

On (įjungti) / „Off“
(išjungti)

On

Laiko kodas
On (įjungti) / „Off“
(išjungti)

On

„ND Filter“ (ND filtras)
On (įjungti) / „Off“
(išjungti)

On

Diafragma
On (įjungti) / „Off“
(išjungti)

On

„ISO/Gain/EI“ (ISO / stiprinimas / EI)
On (įjungti) / „Off“
(išjungti)

On

Shutter
On (įjungti) / „Off“
(išjungti)

On

„Level Gauge“ (lygio matuoklis)
On (įjungti) / „Off“
(išjungti)

On

„Audio Level Meter“ (garso lygio
matuoklis)

On (įjungti) / „Off“
(išjungti)

On

„Video Level Warning“ (vaizdo lygio
įspėjimas)

On (įjungti) / „Off“
(išjungti)

On

„Clip Number“ (klipo numeris)
On (įjungti) / „Off“
(išjungti)

On

„Notice Message“ (pranešimas)
On (įjungti) / „Off“
(išjungti)

On
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[191] Fotoaparato meniu ir išsamūs nustatymai Stebėjimo meniu

Vaizdo signalo stebėjimas

Nustatomi vaizdo signalo stebėjimo nustatymai.

[192] Fotoaparato meniu ir išsamūs nustatymai Stebėjimo meniu

Žymeklis

Nustato žymeklio rodymo parametrus.

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
„Off“ / „Waveform“ / „Vector“ /
„Histogram“ (išjungta / kreivė /
vektorius / histograma)

Išjungta
Nustatomas vaizdo
signalo stebėjimo
tipas.

„Level Marker
1“ (1 lygio
žymeklis)

Nuo 0 % iki 109 % 70 %
Nustatomas 1
šviesos intensyvumo
lygio žymeklis.

„Level Marker
2“ (2 lygio
žymeklis)

Nuo 0 % iki 109 % 100 %
Nustatomas 2
šviesos intensyvumo
lygio žymeklis.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas On (įjungti) / „Off“ (išjungti) On
Įjungia / išjungia visų
žymeklių rodymą.

Color

„White“ / „Yellow“ / „Cyan“ /
„Green“ / „Magenta“ / „Red“ /
„Blue“ (balta / geltona / žydra /
žalia / rausva / raudona / mėlyna)

Baltas
Pasirenka žymeklio
signalo spalvą.

Center Marker 1 / 2 / 3 / 4 / Off (išjungtas) Išjungta
Pasirenka centrinį
žymeklį.

Saugos zona On (įjungti) / „Off“ (išjungti) Išjungta
Įjungia / išjungia
saugos zonos žymeklį.

„Safety Area“
Pasirenka saugos
zonos žymeklio dydį
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(saugos
plotas)

80 % / 90 % / 92,5 % / 95 % 90 %
(procentais nuo viso
ekrano dydžio).

Aspect Marker
„Line“ (linija) / „Mask“ (šablonas) /
Off (išjungtas)

Išjungta
Pasirenka kraštinių
santykio žymeklio tipą.

„Aspect Mask“
(kraštinių
santykio
šablonas)

nuo 0 iki 15 12
Nustato vaizdo signalo
lygį už žymeklio ribų.

„Aspect
Safety Zone“
(kraštinių
santykio
saugos zona)

On (įjungti) / „Off“ (išjungti) Išjungta
Įjungia / išjungia
kraštinių santykio
saugos zonos žymeklį.

„Aspect
Safety Area“
(kraštinių
santykio
saugos
plotas)

80 % / 90 % / 92,5 % / 95 % 90 %

Pasirenka kraštinių
santykio saugos zonos
žymeklio dydį
(procentais nuo viso
ekrano dydžio).

„Aspect
Select“
(kraštinių
santykio
pasirinkimas)

1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 /
17:9 / 1.66:1 / 1.85:1 / 2.35:1 /
2.39:1 / „Custom“ (pasirinktinis)

2.39:1
Nustato režimą, kai
rodomas kraštinių
santykio žymeklis.

„Custom
Aspect Ratio“
(pasirinktinis
kraštinių
santykis)

Įveskite pasirinktą reikšmę. 01.00:01,00

Nustato pasirinktinę
kraštinių santykio
reikšmę.

Pastaba

Įjungiama, kai
[Aspect Select]
(vaizdo formatas)
nustatyta kaip
[Custom]
(pasirinktinis).

„Guide
Frame“
(kreipiamasis
rėmelis)

On (įjungti) / „Off“ (išjungti) Išjungta
Įjungia / išjungia
kreipiamojo rėmelio
rodymą.

„100%
Marker“ (100
% žymeklis)

On (įjungti) / „Off“ (išjungti) Išjungta
Įjungia / išjungia 100 %
žymeklį.
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[193] Fotoaparato meniu ir išsamūs nustatymai Garso meniu

Garso įvestis

Nustato garso įvesties parametrus.

„User Box“
(naudotojo
langelis)

On (įjungti) / „Off“ (išjungti) Išjungta
Įjungia / išjungia
naudotojo langelio
žymeklio rodymą.

„User Box
Width“
(naudotojo
langelio plotis)

nuo 3 iki 479 240

Nustato naudotojo
langelio žymeklio plotį
(atstumą nuo centro iki
kairiojo ir dešiniojo
kraštų).

„User Box
Height“
(naudotojo
langelio
aukštis)

nuo 3 iki 269 135

Nustato naudotojo
langelio žymeklio
aukštį (atstumą nuo
centro iki viršutinio ir
apatinio kraštų).

„User Box H
Position“
(naudotojo
langelio H
padėtis)

nuo –476 iki +476 0

Nustato naudotojo
langelio žymeklio
centro horizontalią
padėtį.

„User Box V
Position“
(naudotojo
langelio V
padėtis)

nuo –266 iki +266 0
Nustato naudotojo
langelio žymeklio
centro vertikalią padėtį.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„AUDIO IN
Select“
(AUDIO IN
pasirinkimas)

MIC / LINE MIC
Pasirenkamas prie jungties AUDIO IN
prijungto įrenginio tipas.

Fantominis
maitinimas
+48V

On (įjungti) /
„Off“
(išjungti)

Išjungta
Parodoma +48 V fantominio maitinimo tiekimo
būsena.

„CH1 Input
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Select“ (CH1
įvesties
pasirinkimas)

AUDIO IN
CH1

AUDIO IN
CH1

Parodomas įvesties šaltinis įrašymui 1 kanale.

„CH2 Input
Select“ (CH2
įvesties
pasirinkimas)

AUDIO IN
CH1 /
AUDIO IN
CH2

AUDIO IN
CH2

Perjungia įvesties šaltinį įrašymui 2 kanale.

„CH3 Input
Select“ (CH3
įvesties
pasirinkimas)

„Off
(išjungta) /
AUDIO IN
CH1

AUDIO IN
CH1

Perjungia įvesties šaltinį įrašymui 3 kanale.

„CH4 Input
Select“ (CH4
įvesties
pasirinkimas)

„Off“
(išjungta) /
AUDIO IN
CH1 /
AUDIO IN
CH2

AUDIO IN
CH2

Perjungia įvesties šaltinį įrašymui 4 kanale.

AUDIO IN
CH1 MIC
Ref.

?80dB / ?
70dB / ?
60dB / ?
50dB / ?
40dB / ?
30dB

?50dB
Nustatomas atskaitos įrašymo lygis, skirtas
XLR mikrofono įvesčiai iš AUDIO IN CH1.

AUDIO IN
CH2 MIC
Ref.

?80dB / ?
70dB / ?
60dB / ?
50dB / ?
40dB / ?
30dB

?50dB
Nustatomas atskaitos įrašymo lygis, skirtas
XLR mikrofono įvesčiai iš AUDIO IN CH2.

„Line Input
Reference“
(linijos
įvesties
nominalas)

+4dB / 0dB /
?3dB / EBUL

+4dB
Pasirenkamas atskaitos įvesties lygis, kai
[AUDIO IN Select] (AUDIO IN pasirinkimas)
nustatyta kaip LINE.

„Reference
Level“
(nominalus
lygis)

?20dB / ?
18dB / ?
16dB / ?
12dB / EBUL

?20dB
Pasirenka 1 kHz nominalaus toninio signalo
įrašymo lygį.

„CH1 Wind
Filter“ (CH1
vėjo filtras)

On (įjungti) /
„Off“
(išjungti)

Išjungta
Įjungia / išjungia vėjo triukšmo sumažinimo
filtrą įrašymo 1 kanalui.

„CH2 Wind
Filter“ (CH2

On (įjungti) /
„Off“ Išjungta

Įjungia / išjungia vėjo triukšmo sumažinimo
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vėjo filtras) (išjungti)
filtrą įrašymo 2 kanalui.

„CH3 Wind
Filter“ (CH3
vėjo filtras)

On (įjungti) /
„Off“
(išjungti)

Išjungta
Įjungia / išjungia vėjo triukšmo sumažinimo
filtrą įrašymo 3 kanalui.

„CH4 Wind
Filter“ (CH4
vėjo filtras)

On (įjungti) /
„Off“
(išjungti)

Išjungta
Įjungia / išjungia vėjo triukšmo sumažinimo
filtrą įrašymo 4 kanalui.

„CH1 Level
Control“
(CH1 lygio
valdymas)

Auto
(automatinis)
/ „Manual“
(rankinis)

Auto
Pasirenkamas automatinis garso įvesties lygio
reguliavimas arba rankinis reguliavimas 1
įrašymo kanalui.

„CH2 Level
Control“
(CH2 lygio
valdymas)

Auto
(automatinis)
/ „Manual“
(rankinis)

Auto
Pasirenkamas automatinis garso įvesties lygio
reguliavimas arba rankinis reguliavimas 2
įrašymo kanalui.

„CH3 Level
Control“
(CH3 lygio
valdymas)

Auto
(automatinis)
/ „Manual“
(rankinis)

Auto
Pasirenkamas automatinis garso įvesties lygio
reguliavimas arba rankinis reguliavimas 3
įrašymo kanalui.

„CH4 Level
Control“
(CH4 lygio
valdymas)

Auto
(automatinis)
/ „Manual“
(rankinis)

Auto
Pasirenkamas automatinis garso įvesties lygio
reguliavimas arba rankinis reguliavimas 4
įrašymo kanalui.

„CH1 Input
Level“ (CH1
įvesties
lygis)

Nuo 0 iki 99 49 Nustato įvesties lygį 1 įrašymo kanalui.

„CH2 Input
Level“ (CH2
įvesties
lygis)

Nuo 0 iki 99 49 Nustato įvesties lygį 2 įrašymo kanalui.

„CH3 Input
Level“ (CH3
įvesties
lygis)

Nuo 0 iki 99 49 Nustato įvesties lygį įrašymo 3 kanalui.

„CH4 Input
Level“ (CH4
įvesties
lygis)

Nuo 0 iki 99 49 Nustato įvesties lygį įrašymo 4 kanalui.

„Master Input
Level“
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[194] Fotoaparato meniu ir išsamūs nustatymai Garso meniu

Garso išvestis

Nustato garso išvesties parametrus.

(pagrindinis
įvesties
lygis)

Nuo 0 iki 99 99 Nustatomas pagrindinis garso įvesties lygis.

„Limiter
Mode“
(ribotuvo
režimas)

„Off“
(išjungta) / ?
6dB / ?9dB /
?12dB / ?
15dB / ?
17dB

Išjungta
Pasirenka ribotuvo charakteristikas aukšto
lygio įvesties signalams, kai garso įvesties
lygis reguliuojamas rankiniu būdu.

„CH1&2
AGC Mode“
(CH1&2
AGC
režimas)

Mono /
Stereo

Stereo
Nustato automatinį lygio reguliavimo režimą
įrašant 1 ir 2 kanalus. Kai nustatoma „Stereo“,
AGC yra susietas tarp kanalų.

„CH3&4
AGC Mode“
(CH1&2
AGC
režimas)

Mono /
Stereo

Stereo
Nustato automatinį lygio reguliavimo režimą
įrašant 3 ir 4 kanalus. Kai nustatoma „Stereo“,
AGC yra susietas tarp kanalų.

„AGC Spec“
(AGC
specifikacija)

?6dB / ?9dB
/ ?12dB / ?
15dB / ?
17dB

?6dB Pasirenka AGC charakteristiką.

1 kHz tonas
su spalvų
juostomis

On (įjungti) /
„Off“
(išjungti)

Išjungta

Išjungia / išjungia 1 kHz toninį signalą, kai
rodomos spalvų juostos.

Pastaba

Kai nustatyta kaip [On] (įjungta), įrašymui 3
ir 4 kanaluose nustatomas 1 kHz toninis
signalas, net jei nustatymai [CH3 Input
Select] (CH3 įvesties pasirinkimas) ir [CH4
Input Select] (CH4 įvesties pasirinkimas) yra
nustatyti kaip [Off] (išjungta).

Elementas
Papildomo
elemento

Gamyklinis
numatytasis Aprašas
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[195] Fotoaparato meniu ir išsamūs nustatymai Miniatiūrų meniu

Klipo ypatybių rodymas

Rodo klipo savybių langą.

[196] Fotoaparato meniu ir išsamūs nustatymai Miniatiūrų meniu

Klipo žymės nustatymas

Nustato klipo žymės parametrus.

[197] Fotoaparato meniu ir išsamūs nustatymai Miniatiūrų meniu

nustatymas nustatymas

„HDMI/Stream Output CH“
(HDMI / transliacijos
išvesties kanalas)

CH1/CH2 /
CH3/CH4

CH1/CH2
Nustatomas HDMI /
transliacijos išvesčiai skirtų
garso kanalų derinys.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Display Clip Properties“
(klipo savybių rodymas)

– –
Rodo klipo
savybių langą.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Add OK“ (pridėti OK) – –
Prideda žymę
OK.

„Add NG“ (pridėti NG) – –
Prideda žymę
NG.

„Add KEEP“ (pridėti
KEEP)

– –
Pridedama
žymė KEEP.

„Delete Clip Flag“
(panaikinti klipo žymę)

– –
Naikina visas
žymes.
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Klipo užrakinimas / atrakinimas

Nustato klipo apsaugos parametrus.

[198] Fotoaparato meniu ir išsamūs nustatymai Miniatiūrų meniu

Klipo trynimas

Naikina klipus.

[199] Fotoaparato meniu ir išsamūs nustatymai Miniatiūrų meniu

Klipo perdavimas

Persiunčia klipus.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Select Clip“
(pasirinkti klipą)

– –
Pasirenka ir užrakina
/ atrakina klipą.

„Lock All Clips“
(užrakinti visus klipus)

– –
Užrakina visus
klipus.

„Unlock All Clips“
(atrakinti visus klipus)

– – Atrakina visus klipus.

Elementas Papildomo elemento
nustatymas

Gamyklinis numatytasis
nustatymas Aprašas

„Select Clip“
(pasirinkti klipą)

– –
Panaikina
pasirinktą klipą.

„All Clips“ (visi
klipai)

– –
Panaikina visus
klipus.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Select Clip“
– –

Persiunčiami pasirinkti



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

[200] Fotoaparato meniu ir išsamūs nustatymai Miniatiūrų meniu

Klipo perdavimas (tarpinis)

Persiunčiami mažesnės raiškos klipai.

[201] Fotoaparato meniu ir išsamūs nustatymai Miniatiūrų meniu

Klipų filtravimas

Nustato, kuriuos klipus rodyti.

(pasirinkti klipą) klipai.

„All Clips“ (visi
klipai)

– –

Persiunčiami visi klipai.

Pastaba

Galima registruoti iki
200 siuntimo
užduočių.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Select Clip“
(pasirinkti
klipą)

– –
Persiunčiami mažesnės raiškos
klipai, atitinkantys pasirinktus
klipus.

„All Clips“
(visi klipai)

– –

Persiunčiami mažesnės raiškos
klipai, atitinkantys visus klipus.

Pastaba

Galima registruoti iki 200
siuntimo užduočių.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

OK – – Rodomi tik klipai su žyme OK.
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[202] Fotoaparato meniu ir išsamūs nustatymai Miniatiūrų meniu

Pasirinktinis vaizdas

Perjungia miniatiūrų ekrano rodinį.

[203] Fotoaparato meniu ir išsamūs nustatymai Techninis meniu

Spalvų juostos

Nustato spalvų juostų parametrus.

NG – – Rodomi tik klipai su žyme NG.

KEEP – –
Rodomi tik klipai su žyme
KEEP.

„None“
(Nieko
nedaryti)

– – Rodomi tik klipai be žymės

All – –
Rodomi visi klipai, nesvarbu, ar
jie turi kokias nors žymes.

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

„Thumbnail
Caption“
(miniatiūros
duomenys)

„Date Time“ / „Time Code“ / „Duration“ /
„Sequential Number“ (data ir laikas / laiko
kodas / trukmė / eilės numeris)

„Time Code“
(laiko kodas)

Keičia po
miniatiūromis
rodomą
informaciją.

Elementas Papildomo elemento
nustatymas

Gamyklinis numatytasis
nustatymas Aprašas

Nustatymas
On (įjungti) / „Off“
(išjungti)

Išjungta
Įjungia / išjungia
spalvų juostas.

Tipas
ARIB / 100 % / 75 % /
SMPTE

ARIB
Pasirenka spalvų
juostos tipą.
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[204] Fotoaparato meniu ir išsamūs nustatymai Techninis meniu

Genlock

Sukonfigūruojamas „Genlock“ būsenos rodymas (žr. „Vaizdo signalo fazės („Genlock“)
sinchronizavimas“).

[205] Fotoaparato meniu ir išsamūs nustatymai Techninis meniu

Įspėjimo lemputė

Nustatomi įrašymo / įspėjimo lemputės nustatymai (žr. „Įspėjamojo signalo prijungimas“).

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

Nuoroda
„Internal“ (vidinis) / „External(HD)“
(išorinis (HD) / „External(SD)“
(išorinis (SD)

–
Parodomas
„Genlock“ atskaitos
signalo tipas.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Tally Lamp
Brightness“
(įspėjamosios
lemputės
ryškumas)

„High“ (didelis)
/ „Low“
(mažas) / „Off“
(išjungta)

High
Nustatomas įrašymo / įspėjimo
lemputės ryškumas.

„G Tally Lamp“ (G
įspėjimo lemputė)

„Enable“
(įjungti) /
Disable
(išjungti)

Enable
Įjungiama / išjungiama G įspėjimo
lemputė.

„Tally Control“
(įspėjimo
valdymas)

„External“
(išorinis) /
„Internal“
(vidinis)

„Internal“
(vidinis)

Pasirenkama paskirties vieta, kuri
naudojama priimant įrenginio įrašymo
/ įspėjimo lemputės valdymo
informaciją.
„External“ (išorinis): įspėjimo
valdymas iš fotoaparato išorės.
„Internal“ (vidinis): valdymas
naudojant fotoaparato įrašymo
funkciją.
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[206] Fotoaparato meniu ir išsamūs nustatymai Techninis meniu

Įrašo peržiūra

Nustatomi įrašo peržiūros nustatymai (žr. „Įrašo peržiūra („Rec Review“).

[207] Fotoaparato meniu ir išsamūs nustatymai Techninis meniu

Priartinimas

Nustatomi priartinimo nustatymai („Priartinimo reguliavimas“).

[208] Fotoaparato meniu ir išsamūs nustatymai Techninis meniu

Objektyvas

Nustato parametrus, susijusius su objektyvais.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
3s / 10s / Clip
(klipas)

3s
Nustatomas ką tik įrašyto klipo
atkūrimui skirtas laikas, kai atliekama
įrašo peržiūra.

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

„Zoom Type“
(transfokavimo
tipas)

„Optical Zoom Only“ / „On(Clear Image
Zoom)“ (tik optinis priartinimas / įjungta
(„Clear Image Zoom“)

Tik optinis
transfokavimas

Nustato
transfokavimo
tipą.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Lens
Calibration“
(objektyvo

„Execute“ (vykdyti)
/ „Cancel“ –

Paleidžiama funkcija, kuri pataiso
priartinimo padėties skirtumus dėl
kiekvieno objektyvo skirtingų
savybių, kai naudojamas
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[209] Fotoaparato meniu ir išsamūs nustatymai Techninis meniu

kalibravimas)
(atšaukti)

automatizuotas kintamo židinio
nuotolio objektyvas.

„Zoom Ring
Direction“
(transfokavimo
žiedo kryptis)

Left(W)/Right(T)
(kairėn(W) /
dešinėn(T) /
„Right(W)/Left(T)“
(dešinėn(W) /
kairėn(T)

Left(W)/Right(T)

Nustato transfokavimo žiedo
valdymo kryptį.

Pastaba

Veikia tik kai naudojamas
objektyvas su E tipo
tvirtinimu, kuris palaiko
transfokavimo žiedo krypties
perjungimą.

„Shading
Compensation“
(atspalvių
kompensavimas)

Auto (automatinis)
/ „Off“ (išjungtas)

Auto
Nustatomas automatinis atspalvių
kompensavimas.

„Chroma
Aberration
Comp.“
(chromatinės
aberacijos
kompensavimas)

Auto (automatinis)
/ „Off“ (išjungtas)

Auto
Nustatomas automatinis
chromatinės aberacijos
kompensavimas.

„Distortion
Comp.“
(iškraipymi
kompensavimas)

Auto (automatinis)
/ „Off“ (išjungtas)

Auto
Nustatomas automatinis
iškraipymų kompensavimas.

Pulsuojantis
kompensavimas

Auto (automatinis)
/ „Off“ (išjungtas)

Išjungta

Nustatomas pulsuojantis
objektyvo kompensavimas.

Žr. „Pulsuojantis
kompensavimas“.

„Distance
Display“
(atstumo
rodymas)

Meter (metrai) /
„Feet“ (pėdos)

Meter (metrai)
Nustato objektyvo informacijos ir
fokusavimo padėties rodymo
vienetus.

„Zoom Position
Display“
(transfokavimo
padėties
rodymas)

„Focal Length“
(židinio nuotolis) /
Number (skaičius)
/ „Bar“ (stulpelis)

Numeris
Nustato transfokavimo padėties
rodymo formatą.
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APR

Vykdo APR.

[210] Fotoaparato meniu ir išsamūs nustatymai Tinklo meniu

Laidinis LAN

Nustato parametrus, susijusius su laidiniu LAN ryšiu.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

APR

„Execute“
(vykdyti) /
„Cancel“
(atšaukti)

–

Vykdo APR (automatinį pikselių
atkūrimą) automatiniam vaizdo jutiklio
koregavimui.
„Execute“ (vykdyti): vykdoma
funkcija.

Pastaba

Prieš vykdydami APR, visada
uždėkite objektyvo dangtelį.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

HTTP Port
(HTTP
prievadas)

– 80
Parodomas HTTP prieigos
prievadas.

„Detail
Settings“
(išsamūs

– –
Parodomos laidinio LAN ryšio
ypatybės.

„DHCP 
On / Off“ (DHCP
įjungimas /
išjungimas)

On
Parodoma, ar DHCP yra įjungtas
(„On“) arba išjungtas („Off“).

IP Address –
Parodomas įrenginio IP adresas,
kai [DHCP] nustatyta kaip [Off]
(išjungta).

Parodoma įrenginio potinklio
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[211] Fotoaparato meniu ir išsamūs nustatymai Tinklo meniu

Failų perdavimas

Nustatomi failų perdavimo nustatymai (žr. „Apie failų perdavimą“).

nustatymai)
Subnet Mask – kaukė, kai [DHCP] nustatyta kaip

[Off] (išjungta).

„Gateway“ (šliuzas) –
Parodoma numatytoji tinklo
sąsaja, kai [DHCP] nustatyta
kaip [Off] (išjungta).

„DNS Auto
On / Off“
(automatinio DNS
įjungimas /
išjungimas)

On
Parodomas DNS automatinio
gavimo nustatymas.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Auto Upload
(Proxy)“
(automatinis
mažos raiškos
failo įkėlimas)

On (įjungti) / „Off“
(išjungti)

Išjungta
Įjungiamas / išjungiamas tarpinio
failo įkėlimas.

„Default
Upload
Server“
(Numatytasis
įkėlimo
serveris)

„Server Settings1 to
3“ (1–3 serverio
nustatymai) >
„Display Name“
(rodomas
pavadinimas)

–

Pasirenka failų įkėlimo serverį. Čia
pasirinktas serveris tampa
mažesnės raiškos failų automatinio
įkėlimo paskirties vieta ir failų iš
miniatiūrų ekrano įkėlimo paskirties
vieta. 
Parodomi [Display Name] (rodomas
pavadinimas) nustatymai,
sukonfigūruoti dalyje [Server
Settings1 to 3] (1–3 serverio
nustatymai).

„Clear
Completed
Jobs“
(pašalinti
atliktas
užduotis)

„Execute“ (vykdyti) /
„Cancel“ (atšaukti)

–

Pašalina atliktas persiuntimo
užduotis iš sąrašo.
„Execute“ (vykdyti): vykdoma
funkcija.
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[212] Fotoaparato meniu ir išsamūs nustatymai Priežiūros meniu

Kalba

Nustato ekrano kalbą.

[213] Fotoaparato meniu ir išsamūs nustatymai Priežiūros meniu

Laikrodžio nustatymas

Nustato vidinio laikrodžio duomenis.

„Clear All
Jobs“
(pašalinti
visas
užduotis)

„Execute“ (vykdyti) /
„Cancel“ (atšaukti)

–

Pašalina visas persiuntimo užduotis
iš sąrašo.
„Execute“ (vykdyti): vykdoma
funkcija.

„View Job
List“ (rodyti
užduočių
sąrašą)

– – Rodo persiuntimo užduočių sąrašą.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Pasirinkti – –
Nustato ekrano kalbą.
„Set“ (nustatyti):
nustatykite reikšmę.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Time Zone
Nuo UTC – 12.00
iki UTC + 14.00

–
Nustato laiko skirtumą nuo
UTC 30 minučių intervalais.

„Date Mode“
(datos
režimas)

YYMMDD /
MMDDYY /
DDMMYY

YYMMDD

Pasirenka datos rodymo
formatą.
YYMMDD: metai, mėnuo,
diena
MMDDYY: mėnuo, diena,
metai
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[214] Fotoaparato meniu ir išsamūs nustatymai Priežiūros meniu

Valandų skaitiklis

Rodo sukauptą veikimo laiką.

[215] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu nustatymai ir
numatytosios reikšmės

ISO / stiprinimo nustatymai ir numatytosios reikšmės

DDMMYY: diena, mėnuo,
metai

12H/24H 12H / 24H 24H

Pasirenka laiko rodymo
formatą.
12H: 12 val. režimas
24H: 24 val. režimas

„Date“ (data) – –
nustato esamą datą.
„Set“ (nustatyti): nustatykite
reikšmę.

laikas – –
Nustato esamą laiką.
„Set“ (nustatyti): nustatykite
reikšmę.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Hours(System)“
(sistemos valandos)

– –
Rodo sukauptas naudojimo
valandas (negali būti
nustatytos iš naujo).

„Hours(Reset)“
(valandų
nustatymas iš
naujo)

– –
Rodo sukauptas naudojimo
valandas (gali būti nustatytos iš
naujo).

Reset

„Execute“
(vykdyti) /
„Cancel“
(atšaukti)

–

Iš naujo nustatomas
kaupiamasis veikimo laikas
atkuriant 0 reikšmę.
„Execute“ (vykdyti): vykdoma
funkcija.
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[ISO/Gain<L>] (ISO / stiprinimas <L>) nustatymai ir numatytosios reikšmės priklauso nuo
nustatymų [Mode] (režimas), [Base Look] > [Select] (bazinis vaizdas > pasirinkti) ir [Base
Sensitivity] (bazinis jautrumas).
Numatytosios reikšmės lentelėse nurodytos paryškintuoju šriftu.

Kai [Mode] (režimas) nustatyta kaip [ISO]

Kai [Base Look] > [Select] (bazinis vaizdas > pasirinkti) nustatyta kaip [S-
Cinetone], [Standard] (standartinis), [ITU709] arba [Still] (nuotraukos)

Kai [Base Look] > [Select] (bazinis vaizdas > pasirinkti) nustatyta kaip [HLG
Live] arba [HLG Natural]

Kai [ISO/Gain/EI] > [Base Sensitivity] (ISO
/ stiprinimas / EI > bazinis jautrumas)

nustatyta kaip [Low] (mažas)

Kai [ISO/Gain/EI] > [Base Sensitivity] (ISO
/ stiprinimas / EI > bazinis jautrumas)

nustatyta kaip [High] (didelis)

ISO 320 
ISO 400 
ISO 500 
ISO 640 
ISO 800 
ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600

Kai [ISO/Gain/EI] > [Base Sensitivity] (ISO
/ stiprinimas / EI > bazinis jautrumas)

nustatyta kaip [Low] (mažas)

Kai [ISO/Gain/EI] > [Base Sensitivity] (ISO
/ stiprinimas / EI > bazinis jautrumas)

nustatyta kaip [High] (didelis)

ISO 800 
ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 

ISO 128000 
ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
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Kai [Base Look] > [Select] (bazinis vaizdas > pasirinkti) nustatyta kaip [User1]–
[User16]

Kai [Mode] (režimas) nustatyta kaip [dB]

1dB intervalais galima sukonfigūruoti reikšmę diapazone nuo ?3dB iki +30dB.
Numatytoji reikšmė yra 0dB.

[216] Fotoaparato meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu nustatymai ir
numatytosios reikšmės

AGC ribų nustatymai ir numatytosios reikšmės

Meniu [AGC Limit] (AGC riba) nustatymų ir numatytųjų reikšmių diapazonas priklauso nuo
nustatymų [Mode] (režimas), [Base Look] > [Select] (bazinis vaizdas > pasirinkti) ir [Base

ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600

Kai [ISO/Gain/EI] > [Base Sensitivity] (ISO
/ stiprinimas / EI > bazinis jautrumas)

nustatyta kaip [Low] (mažas)

Kai [ISO/Gain/EI] > [Base Sensitivity] (ISO
/ stiprinimas / EI > bazinis jautrumas)

nustatyta kaip [High] (didelis)

ISO 800 
ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600
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Sensitivity] (bazinis jautrumas).
Numatytosios reikšmės lentelėse nurodytos paryškintuoju šriftu.

Kai [Mode] (režimas) nustatyta kaip [ISO]

Kai [Base Look] > [Select] (bazinis vaizdas > pasirinkti) nustatyta kaip [S-
Cinetone], [Standard] (standartinis), [ITU709] arba [Still] (nuotraukos)

Kai [Base Look] > [Select] (bazinis vaizdas > pasirinkti) nustatyta kaip [HLG
Live] arba [HLG Natural]

Kai [ISO/Gain/EI] > [Base Sensitivity] (ISO
/ stiprinimas / EI > bazinis jautrumas)

nustatyta kaip [Low] (mažas)

Kai [ISO/Gain/EI] > [Base Sensitivity] (ISO
/ stiprinimas / EI > bazinis jautrumas)

nustatyta kaip [High] (didelis)

ISO 400 
ISO 500 
ISO 640 
ISO 800 
ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600

Kai [ISO/Gain/EI] > [Base Sensitivity] (ISO
/ stiprinimas / EI > bazinis jautrumas)

nustatyta kaip [Low] (mažas)

Kai [ISO/Gain/EI] > [Base Sensitivity] (ISO
/ stiprinimas / EI > bazinis jautrumas)

nustatyta kaip [High] (didelis)

ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 

ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
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Kai [Base Look] > [Select] (bazinis vaizdas > pasirinkti) nustatyta kaip [User1]–
[User16]

Kai [Mode] (režimas) nustatyta kaip [dB]

Pasirinkite iš 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Numatytoji reikšmė yra 15dB.

[217] Fotoaparato meniu ir išsamūs nustatymai

Vaizdo kokybės nustatymai, išsaugoti kiekvienam
fiksavimo režimui

Konfigūravimo elementų, susijusių su vaizdo kokybe, esama būsena yra išsaugota kiekvienam
šių fiksavimo režimų. Kai pakeičiate fiksavimo režimą, atitinkami nustatymai, kurie yra išsaugoti,
pritaikomi numatytam fiksavimo režimui.

Pasirinktinio režimo SDR(BT.709) numatytasis rodinys
Pasirinktinio režimo HDR(HLG) numatytasis rodinys
„Cine EI“ režimas

ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600

Kai [ISO/Gain/EI] > [Base Sensitivity] (ISO
/ stiprinimas / EI > bazinis jautrumas)

nustatyta kaip [Low] (mažas)

Kai [ISO/Gain/EI] > [Base Sensitivity] (ISO
/ stiprinimas / EI > bazinis jautrumas)

nustatyta kaip [High] (didelis)

ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600
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Toliau esančiose lentelėse nurodyti su vaizdo kokybe susiję konfigūravimo elementai, kurie yra
išsaugoti kiekvienam fiksavimo režimui.
„Taip“ rodo išsaugomą nustatymą, o „Ne“ – neišsaugomą. „Taip“ per kelis stulpelius rodo
bendrus nustatymus.

Elementas

Fiksavimo režimas

Pasirinktinis režimas „Cine
EI“

režimasSDR(BT.709) HDR(HLG)

Vaizdų
fiksavimo
meniu

„ISO/Gain/EI“
(ISO /
stiprinimas /
EI)

„ISO/Gain“ (ISO /
stiprinimas) Taip1) Ne

„Exposure Index“
(ekspozicijos
indeksas)

Ne Taip

„Base Sensitivity“
(bazinis jautrumas)

Taip Ne

„Base ISO“ (bazinis
ISO)

Ne Taip

Baltas

„Preset White“
(numatytasis baltos
spalvos balansas)

Taip Taip

Kiti nei aukščiau
paminėti

Taip

„White Setting“ (baltos spalvos
balanso nustatymas)

Taip

„Offset White“ (baltos spalvos
balanso poslinkis)

Taip Ne

„LUT On/Off“ (LUT įjungimas /
išjungimas)

Ne Taip

„Noise
Suppression“
(triukšmo
slopinimas)

„Setting(Custom)“
(pasirinktinis
nustatymas)

Taip Taip Ne

„Level(Custom)“
(pasirinktinis lygis)

Taip Taip Ne

„Setting(Cine EI)“
(„Cine EI“
nustatymas)

Ne Taip

„Level(Cine EI)“
(„Cine EI“ lygis)

Ne Taip
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[218] Žiniatinklio meniu ir išsamūs nustatymai

Žiniatinklio meniu konfigūravimas

Paspauskite valdymo ekrano [Settings] (nustatymai) perjungimo skirtuką, kad būtų parodytas
nustatymų ekranas.
Nustatymų ekrane naudodami žiniatinklio meniu galite konfigūruoti įvairius įrenginio sąrankos
elementus, įskaitant pradinius nustatymus, tinklo nustatymus , fiksavimo / atkūrimo nustatymus.

„Paint/Look“
(piešimo /
vaizdo
meniu)

„Base Look“
(bazinis
vaizdas)

Pasirinkti Taip Taip Taip

Įvestis2) Taip

Išvestis2) Taip

„AE Level Offset“
(AE lygio
poslinkis)2)

Taip

Juodas Taip Taip Ne

Knee

„Auto Knee“
(automatinis
lenkimo taškas)

Taip Ne Ne

Kiti nei aukščiau
paminėti

Taip Taip Ne

Detail Taip Taip Ne

„Matrix“ (matrica) Taip Taip Ne

„Multi Matrix“ (daugybinė matrica) Taip Taip Ne

Atskiri ISO jautrumo nustatymai išsaugomi abiem pasirinktiniams režimams [SDR(BT.709)] ir [HDR(HLG)].1)
Nustatymai išsaugomi kiekvienam [Base Look] (baziniam vaizdui) ir nepriklauso nuo fiksavimo režimo.2)
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Meniu sudaro toliau nurodyti meniu.

Meniu konfigūravimas ir hierarchija

1 lygis 1 lygio aprašymas 2 lygis

Vaizdų fiksavimas jame yra filmavimo nustatymai. Fokusavimas

Projektas
Jame yra pagrindiniai projekto
nustatymai.

„Base Setting“ (bazinis nustatymas)

„Rec Format“ (įrašymo formatas)

„Simul Rec“ (sinchroniškas
įrašymas)

„Proxy Rec“ (įrašymas mažesne
raiška)

„Interval Rec“ (filmavimas
intervalais)

„Picture Cache Rec“ (nuotraukų
talpyklos įrašymas)

„All File“ (ALL failas)

„Paint/Look“
(piešinys /
vaizdas)

Jame yra nustatymai, susijęs
vaizdo kokybe.

„Base Look“ (bazinis vaizdas)
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„Pan-Tilt“
(pasukimas /
pakreipimas)

Jame pateikiami su pasukimu /
pakreipimu susiję nustatymai.

„P/T Speed“ (P/T greitis)

„P/T Acceleration“ (P/T
spartinimas)

„P/T Range Limit“ (P/T diapazono
apribojimas)

„P/T Direction“ (P/T kryptis)

„P/T Preset“ (P/T išankstinis
nustatymas)

Monitoring
Jame yra nustatymai, susiję su
vaizdo išvestimi ir ekrano rodiniu.

„Output Format“ (išvesties
formatas)

„Output Display“ (išvesties
rodymas)

Audio
jame yra su garsu susiję
nustatymai.

Audio

„Technical“
(techninis)

Jame yra techninių elementų
nustatymai

„Tally“ (įspėjimo lemputė)

„IR Remote“ (IR nuotolinis
valdymas)

Tinklas
jame yra nustatymai, susiję su
tinklais.

„Camera Name“ (fotoaparato
pavadinimas)

User

Laidinis LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

„Referer Check“ (nuorodos
tikrinimas)

„Brute Force Attack Protection“
(apsauga nuo grubios jėgos
atakos)

Stream
Pateikiami su transliacija susiję

Stream

„Video Stream“ (vaizdo įrašo
transliavimas)
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Pastaba

[Accessibility] (pritaikymas neįgaliesiems) yra tik Š. Amerikos rinkai skirtuose modeliuose.

[219] Žiniatinklio meniu ir išsamūs nustatymai

Žiniatinklio meniu naudojimas

Paspauskite [Settings] (nustatymai) valdymo ekrano perjungimo skirtuką, kad būtų parodytas
nustatymų ekranas, kuriame naudojant žiniatinklio meniu galima sukonfigūruoti įvairius įrenginio
sąrankos elementus, įskaitant pradinius nustatymus, tinklo nustatymus, fiksavimo / atkūrimo
nustatymus.
Nustatymus sukonfigūruokite žiniatinklio meniu naudodami planšetinio kompiuterio jutiklinį
valdymą arba kompiuteryje naudodamiesi pele.
Spauskite norimų konfigūruoti elementų meniu, kad būtų parodyti sąrankos elementai ir jų
nustatymai meniu.

nustatymai.

„Audio Stream“ (garso
transliavimas)

Techninė priežiūra
Jame yra įrenginio nustatymai,
tokie kaip laikrodis ir kalba.

Kalba

„Accessibility“ (pritaikymas
neįgaliesiems)

„Clock Set“ (laikrodžio nustatymas)

Reset

Information

„System Log“ (sistemos žurnalas)

„HTTP Access Log“ (HTTP prieigos
žurnalas)

„Service“ (Paslauga)

EULA

Programinė įranga
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Konfigūravimo būdas

Reikšmės pasirinkimas

Paspauskite akutės mygtuką prie elemento. Pasirinkto elemento akutės mygtukas parodomas
oranžine spalva.

Elemento įjungimas / išjungimas

Paspausdami jungiklį elementą įjunkite / išjunkite. Jungiklis yra oranžinis, kai elementas
įjungtas, o jį išjungus – baltas.

Reikšmės pasirinkimas iš sąrašo

Meniu (1 lygis)1.

Meniu (2 lygis)2.

Nustatymai3.
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Paspauskite išskleidžiamojo meniu mygtuką ir pasirodžiusiame sąraše pasirinkite elementą.

Skaitinės reikšmės pasirinkimas

Spausdami < arba > pakeiskite skaitinę reikšmę. Jei skaitinė reikšmė yra pabraukta, šią skaitinę
reikšmė galite įvesti iš tiesiogiai.

Simbolio / skaitmens įvedimas

Konfigūravimas atskirame ekrane
Paspauskite mygtuką, kad sąrankos veiksmus atliktumėte atskirame ekrane.

Nurodymo pranešimas

Rodoma informacija, kuri padeda sukonfigūruoti tam tikrus nustatymus, ir pranešimai, kurie
atkreipia naudotojo dėmesį.

Nustatymo išsaugojimas

Baigę konfigūravimo nustatymą, paspauskite mygtuką [OK], kad nustatymą išsaugotumėte.
Paspausdami mygtuką [Cancel] (atšaukti) atmeskite nustatymo pakeitimus ir grąžinkite
ankstesnį nustatymą.
Spauskite mygtuką [Reload] (įkelti iš naujo), kad būtų atnaujintas ekrano rodinys.

Pastaba

Jei mygtuką [Reload] (įkelti iš naujo) paspausite neišsaugoję nustatymo, nustatymo pakeitimai bus
panaikinti.

Jei neišsaugoję nustatymo pereisite į kitą puslapį, nustatymo pakeitimai bus panaikinti.

[220] Žiniatinklio meniu ir išsamūs nustatymai Vaizdų fiksavimo meniu

Fokusavimas
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Nustato fokusavimo parametrus.

[221] Žiniatinklio meniu ir išsamūs nustatymai Projekto meniu

Bazinis nustatymas

Nustato bazinius nustatymus.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Push AF Mode“
(laikino AF
režimas)

AF / Single-shot
AF(AF-S)
(vieno kadro
AF(AF-S)

AF
Nustato laikino automatinio
fokusavimo režimą.

„Touch Function
in MF“ (lietimo
funkcija veikiant
rankiniam
fokusavimui)

„Tracking AF“ /
„Spot Focus“
(sekimo AF /
taškinis
fokusavimas)

„Tracking
AF“ (sekimo
AF)

Nustatomas veikimas, kai fotoaparato
vaizdo ekranas paliečiamas veikiant
MF režimui.

„AF Assist
Control“ (AF
pagalbos
valdymas)

On (įjungti) /
„Off“ (išjungti)

On

Kai nustatyta kaip [On] (įjungta),
fokusavimo slankiklį žiniatinklio
programoje galite naudoti veikiant
automatiniam fokusavimui ir reguliuoti
fokusavimo padėtį.

Išsamesnė informacija pateikiama
dalyje „Rankinis automatinio
fokusavimo taikinio nustatymas
(AF pagalba) naudojant žiniatinklio
programą“.

Pastaba

Šis elementas įjungiamas, tik kai
fotoaparato meniu [AF Assist] (AF
pagalba) nustatyta kaip [On]
(įjungta).

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas
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[222] Žiniatinklio meniu ir išsamūs nustatymai Projekto meniu

Įrašymo formatas

Nustato įrašymo formato parametrus.

Fiksavimo
režimas

Custom
(pasirinktinis) /
„Cine EI“

Custom

Nustatomas fiksavimo režimas.
Žr. „Fiksavimo režimas“ dalyje
„Pagrindinių funkcijų
konfigūravimas“.

Numatytasis
rodinys

SDR(BT.709) /
HDR(HLG)

SDR(BT.709)
Nustatoma įrašymo / išvesties spalvų
erdvė veikiant pasirinktiniam režimui.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Dažnis
59.94 / 50 / 29.97 / 25 / 24 /
23.98

59,94

Pasirenka sistemos dažnį.

Pastaba

Jei dažnis pakeičiamas,
fotoaparatas bus paleistas
iš naujo. Paleidę iš naujo
naršyklėje dar kartą įkelkite
puslapį.

„Imager
Scan
Mode“
(jutiklio
skenavimo
režimas)

FF / S35 FF Pasirenkamas jutiklio dydis.

Kodekas
RAW / RAW & XAVC-I /
XAVC-I / XAVC-L

XAVC-I

Nustatomas klipų įrašymo /
atkūrimo kodekas.

Pastaba

Kai [Imager Scan Mode]
(jutiklio skenavimo
režimas) nustatyta kaip
[S35], [RAW] ir [RAW &
XAVC-I] negalima rinktis.

Nustatomas RAW vaizdo



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

Nustatymai [RAW Output Format] (RAW išvesties formatas)

Numatytosios reikšmės nurodytos paryškintuoju šriftu.
Praleistos sąlygos, kurioms esant negalima nustatyti [RAW Output Format] (RAW išvesties
formatas).

Nustatymai [Video Format] (vaizdo įrašo formatas)

RAW
išvesties
formatas

Galimi nustatymai priklauso
nuo nustatymo [Frequency]
(dažnis).

Žr. toliau esančią dalį
„Nustatymai [RAW Output
Format] (RAW išvesties
formatas)“.

–

išvesties dydis išoriniame RAW
įrašymo įrenginyje.

Pastaba

Kai [Codec] (kodekas)
nustatyta kaip [RAW &
XAVC-I], nustatymas
[Video Format] (vaizdo
įrašo formatas) pasikeičia
pagal nustatymą [RAW
Output Format] (RAW
išvesties formatas).

„Video
Format“
(vaizdo
įrašo
formatas)

Galimi nustatymai priklauso
nuo nustatymų [Frequency]
(dažnis), [Imager Scan Mode]
(jutiklio skenavimo režimas) ir
[Codec] (kodekas).

Žr. toliau pateikiamą dalį
„Nustatymai [Video
Format] (Vaizdo įrašo
formatas)“.

–
Nustatomas vaizdo dydis ir
sparta bitais.

Dažnis „Imager Scan Mode“ (jutiklio
skenavimo režimas) Kodekas Nustatymas

59,94 / 50 / 29,97 /
25 / 23,98

FF
RAW / RAW &
XAVC-I

4096×2160
3840×2160

24 FF
RAW / RAW &
XAVC-I

4096×2160

Dažnis „Imager Scan Mode“ (jutiklio
skenavimo režimas) Kodekas Nustatymas

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

4096×2160P
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Numatytosios reikšmės nurodytos paryškintuoju šriftu.

[223] Žiniatinklio meniu ir išsamūs nustatymai Projekto meniu

Sinchroniškas įrašymas

Nustatomi 2 lizdų sinchroniško įrašymo režimo nustatymai (žr. „Įrašymas į atminties korteles A ir
B vienu metu (2 lizdų sinchroniškas įrašymas)“).

59,94 / 50 / 29,97 /
25 / 23,98

FF
XAVC-I 3840×2160P

1920×1080P

XAVC-L

3840×2160P
1920×1080P
50 
1920×1080P
35

S35

XAVC-I 1920×1080P

XAVC-L

1920×1080P
50 
1920×1080P
35

24 FF

RAW –

RAW & XAVC-I /
XAVC-I

4096×2160P

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
On (įjungti) /
„Off“
(išjungti)

Išjungta
Įjungia / išjungia sinchroniško įrašymo funkciją ir
nustato įrašymo paskirties laikmeną.

Įrašymo
mygtukas

SlotA /
SlotB /
SlotA/SlotB

SlotA/SlotB
Parodomas įrašymo mygtuko priskyrimas,
skirtas kiekvienai įrašymo laikmenai. 
Fotoaparato meniu nustatykite [Project] > [Simul
Rec] > [Rec Button Set] (projektas >
sinchroniškas įrašymas > įrašymo mygtuko
nustatymas).

2-asis
įrašymo
mygtukas

SlotA /
SlotB /
SlotA/SlotB

SlotA/SlotB
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[224] Žiniatinklio meniu ir išsamūs nustatymai Projekto meniu

Tarpinis įrašymas

Nustatomi tarpinio įrašymo režimo nustatymai (žr. „Tarpinis įrašymas“).

[225] Žiniatinklio meniu ir išsamūs nustatymai Projekto meniu

Įrašymas intervalais

Nustatomi įrašymo intervalais režimo nustatymai (žr. „Vaizdo įrašymas su pertrūkiais
(filmavimas intervalais)“).

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
On (įjungti) / „Off“
(išjungti)

Išjungta
Įjungia / išjungia įrašymo
mažesne raiška režimą.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
On (įjungti) / „Off“
(išjungti)

Išjungta

Įjungia / išjungia
filmavimo intervalais
režimą. (Nustačius šį
režimą į „On“ (įjungti)
visi kiti specialūs
režimai bus nustatyti į
„Off“ (išjungta).

„Interval
Time“
(intervalo
laikas)

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 /
9 / 10 / 15 / 20 / 30 / 40 /
50 (sek.) 
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 /
9 / 10 / 15 / 20 / 30 / 40 /
50 (min.) 
1 / 2 / 3 / 4 / 6 / 12 / 24
(val.)

1

Nustato intervalą tarp
įrašymų veikiant
įrašymo intervalais
režimui (kai Interval
Rec (įrašymas
intervalais) nustatyta
kaip „On“ (įjungta).

„Number of
Frames“

1frame / 2frames /
3frames / 6frames /
9frames / 12frames 
Galimi nustatymai
priklauso nuo pasirinkto
vaizdo įrašo formato

59.94P/50P: 2frames

Nustato, kiek kadrų
įrašyti vienu įrašymo
intervalu veikiant
įrašymo intervalais
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[226] Žiniatinklio meniu ir išsamūs nustatymai Projekto meniu

Nuotraukų talpyklos įrašymas

Nustatomi nuotraukų talpyklos įrašymo režimo nustatymai (žr. „Talpykloje esančių nuotraukų
įrašymas („Picture Cache Rec“).

[227] Žiniatinklio meniu ir išsamūs nustatymai Projekto meniu

ALL failas

Atliekami veiksmai su ALL failu (žr. „Konfigūravimo duomenų išsaugojimas ir įkėlimas“).

(kadrų
skaičius)

kadrų dažnio.
59.94P/50P: 2frames /
6frames / 12frames
29.97P/25P/24P/23.98P:
1frame / 3frames /
6frames / 9frames

29.97P/25P/24P/23.98P:
1frame

režimui (kai Interval
Rec (įrašymas
intervalais) nustatyta
kaip „On“ (įjungta).

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
On (įjungti) / „Off“
(išjungti)

Išjungta
Įjungiama / išjungiama nuotraukų
talpyklos funkcija.

„Cache Size“
(talpyklos
dydis)

„Short“ / „Medium“ /
„Long“ / „Max“ (trumpas
/ vidutinis / ilgas /
maks.)

„Max“
(maks.)

Nustatomas vaizdų kaupimo
vaizdų talpyklos atmintyje laikas
(vaizdų talpyklos įrašymo laikas).

„Cache Rec
Time“
(talpyklos
įrašymo
laikas)

– –
Parodomas vaizdų kaupimo
vaizdų talpyklos atmintyje laikas
(vaizdų talpyklos įrašymo laikas).

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Įkelkite ALL failą į įrenginį iš įrenginio su
žiniatinklio programa.
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[228] Žiniatinklio meniu ir išsamūs nustatymai Piešinio / vaizdo meniu

Bazinis vaizdas

Įrenginyje galite įkelti bazinį vaizdą.
Ekrane parodomas galimų bazinių vaizdų sąrašas. Šiuo metu taikomas bazinis vaizdas yra
nurodytas žymekliu ? kairėje bazinio vaizdo numerio pusėje.

[No.] (numeris): bazinio vaizdo numeris
[Base Look Name] (bazinio vaizdo pavadinimas): bazinio vaizdo pavadinimas
[Input] (įvestis): bazinio vaizdo įvesties signalas
[Output] (išvestis): bazinio vaizdo išvesties signalas
[AE Level Offset] (AE lygio poslinkis): bazinio vaizdo ekspozicijos atskaitos reikšmė

Bazinio vaizdo pridėjimas
Paspauskite mygtuką [Import] (importuoti) ir naują bazinį vaizdą importuokite. Vykdykite ekrane

„Load All
File“ (įkelti
ALL failą)

– –
Pastaba

Kai ALL failas įkeliamas į įrenginį,
įrenginys paleidžiamas iš naujo. Paleidę iš
naujo naršyklėje dar kartą įkelkite puslapį.

„Save All
File“
(išsaugoti
ALL failą)

– –
Išsaugokite įrenginio su žiniatinklio programa
nustatymus kaip ALL failą.
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pateiktas instrukcijas.
Importavę nustatykite reikalingas nustatymų [Input] (įvestis), [Output] (išvestis) ir [AE Level
Offset] (AE lygio poslinkis) reikšmes. Išsamesnė informacija pateikiama dalyje „Norimo bazinio
vaizdo importavimas“.

[229] Žiniatinklio meniu ir išsamūs nustatymai Pasukimo / pakreipimo meniu

Pasukimo / pakreipimo greitis

Nustatomi pasukimo / pakreipimo greičio nustatymai.

[230] Žiniatinklio meniu ir išsamūs nustatymai Pasukimo / pakreipimo meniu

Pasukimo / pakreipimo spartinimas

Nustatomi pasukimo / pakreipimo greičio nustatymai.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Speed
Step“
(greičio
žingsnis)

„Normal“
(įprastas) /
„Extended“
(išplėstinis)

„Extended“
(išplėstinis)

Nustatomas pasukimo / pakreipimo mechanizmo
greičio žingsnių skaičius.
„Normal“ (įprastas): greitį galima nustatyti
naudojant 24 žingsnių diapazoną. Šį nustatymą
naudokite suderinamumui su esamais „Sony“
nuotoliniu būdu valdomais fotoaparatais
užtikrinti.
„Extended“ (išplėstinis): greitį galima nustatyti
naudojant 50 žingsnių diapazoną.

„Speed
Mode“
(greičio
režimas)

„Normal“
(įprastas) /
„Slow“
(lėtas)

Įprasta

Nustatomas pasukimo / pakreipimo mechanizmo
greičio režimas. 
Įjungiama, tik kai [Speed Step] (greičio žingsnis)
nustatoma kaip [Normal] (įprastas).
„Normal“ (įprastas): veikia įprasto greičio
diapazone (min.–maks. (60 laipsnių per
sekundę).
„Slow“ (lėtas): veikia mažo greičio diapazone
(min.–maks. (40 laipsnių per sekundę).

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas
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[231] Žiniatinklio meniu ir išsamūs nustatymai Pasukimo / pakreipimo meniu

Pasukimo / pakreipimo diapazono apribojimas

Nustatomi pasukimo / pakreipimo diapazono apribojimo nustatymai.
Toliau pateikiamame ekrane nustatykite pasukimo / pakreipimo veikimo diapazono apribojimus.

Pastaba

Kai įrenginys įjungiamas arba atliekamas pasukimo / pakreipimo funkcijos nustatymas iš naujo, šio
diapazono apribojimo nustatymo nepaisoma. Šios funkcijos negalima naudoti šalia įrenginio
esančioms kliūtims išvengti.

„Acceleration“
(spartinimas)

nuo 1 iki 9 8
Pasirenkamas pasukimo / pakreipimo
funkcijos spartinimas / sulėtinimas. Kuo
didesnis skaičius, tuo didesnis spartinimas.

Jungiklį [Setting] (nustatymas) nustatykite į įjungimo padėtį.

Įjungiama pasukimo / pakreipimo veikimo diapazono apribojimo funkcija.

1

Patikrinkite vaizdą naudodami pasukimo / pakreipimo valdiklius ant fotoaparato.2
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Pastaba

Fotoaparato padėčių, kurios yra už apribojimų padėčių ribų, negalima išsaugoti kaip išankstinių
nustatymų.

Jei pakeičiamas nustatymas [Pan-Tilt] > [P/T Direction] > [Ceiling] (pasukimas / pakreipimas >
pasukimo / pakreipimo kryptis > lubos), sukonfigūruotiems apribojimo padėčių nustatymams
atkuriamos gamyklinės numatytosios reikšmės.

Šio nustatymo negalima keisti atkūrimo metu, miniatiūrų rodinyje, įvykus pasukimo / pakreipimo
klaidai, kai pasukimo / pakreipimo funkcija nėra inicijuota ir kai pasukimo / pakreipimo funkcija yra
užrakinta.

[232] Žiniatinklio meniu ir išsamūs nustatymai Pasukimo / pakreipimo meniu

Pasukimo / pakreipimo kryptis

Nustatomi pasukimo / pakreipimo krypties nustatymai.

Jei norite nustatyti padėtis, kuriomis bus nustatyti veikimo apribojimai, šiose
padėtyse spauskite mygtuką [Left] (kairė), [Right] (dešinė), [Up] (viršus), [Down]
(apačia) > [Set Current Value] (nustatyti dabartinę reikšmę).

[Left] (kairė): kairė fotoaparato pusė
[Right] (dešinė): dešinė fotoaparato pusė
[Up] (viršus): viršutinė fotoaparato dalis
[Down] (apačia): apatinė fotoaparato dalis

Apribojimo padėtys nustatomos ir reguliuojamos kaip skaitinės reikšmės (kampas).
Jei norite atšaukti apribojimą, paspauskite mygtuką [Reset] (nustatyti iš naujo) prie
reikiamų padėčių.

3

Paspauskite mygtuką [OK] (gerai).

Pasukimo / pakreipimo veikimas apribojamas, kad įrenginys išliktų sukonfigūruotų
apribojimo padėčių ribose.

4

Elementas
Papildomo
elemento

Gamyklinis
numatytasis Aprašas
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Pastaba

Jei pritaikomas nustatymas [Ceiling] (lubos), visos iš anksto nustatytos padėtys ištrinamos, nes
pasukimo / pakreipimo koordinatės tampa atvirkštinės.

Pasukimo / pakreipimo mechanizmo veikimo diapazonas pagal nustatymą [Ceiling] (lubos)
keičiamas taip, kaip nurodyta toliau esančioje lentelėje.

A: kai [Ceiling] (lubos) nustatyta kaip [Off] (išjungta)
B: kai [Ceiling] (lubos) nustatyta kaip [On] (įjungta)

[233] Žiniatinklio meniu ir išsamūs nustatymai Pasukimo / pakreipimo meniu

Pasukimo / pasukimo išankstinis nustatymas

nustatymas nustatymas

Lubos
On (įjungti) /
„Off“
(išjungti)

Išjungta

Jei įrenginys yra sumontuotas ant stalo,
nustatykite kaip [Off] (išjungta). Jei įrenginys
sumontuotas prie lubų, nustatykite kaip [On]
(įjungta). Jei [Ceiling] (lubos) nustatoma kaip
[On] (įjungta), [Pan Direction] (pasukimo kryptis)
automatiškai nustatoma kaip [Opposite]
(priešinga).

„Pan
Direction“
(pasukimo
kryptis)

Normal
(įprasta) /
„Opposite“
(priešinga)

Įprasta

Nustatoma pasukimo mechanizmo veikimo
kryptis. Kai šis nustatymas pakeičiamas,
mechanizmo veikimo kryptis pakeičiama į
priešingą.

„Tilt
Direction“
(pakreipimo
kryptis)

Normal
(įprasta) /
„Opposite“
(priešinga)

Įprasta

Nustatoma pakreipimo mechanizmo veikimo
kryptis. Kai šis nustatymas pakeičiamas,
mechanizmo veikimo kryptis pakeičiama į
priešingą.
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Nustatomi fotoaparato nustatymai, susiję su išankstiniais nustatymais.

[234] Žiniatinklio meniu ir išsamūs nustatymai Stebėjimo meniu

Išvesties formatas

Nustato išvesties formato parametrus.

[235] Žiniatinklio meniu ir išsamūs nustatymai Stebėjimo meniu

Išvesties rodymas

Nustatomi su išvesties signalais susiję nustatymai.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Speed
Select“
(greičio
pasirinkimas)

„Separate“
(atskirti) /
„Common“
(bendras)

„Separate“
(atskirti)

Nustatoma, ar iš anksto nustatyti greičiai bus
konfigūruojami atskirai ar bus naudojamas
bendras nustatymas.

„Common
Speed“
(bendras
greitis)

nuo 1 iki 50 50

Nustatomas bendras išankstinių nustatymų
greitis.

Pastaba

Didžiausias mechanizmo greitis – 24 yra
naudojamas, jei nustatoma 25 ar didesnė
reikšmė, kai [Pan-Tilt] > [P/T Speed] >
[Speed Step] (pasukimas / pakreipimas >
pasukimo / pakreipimo greitis > greičio
žingsnis) nustatyta kaip [Normal] (įprastas).

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

SDI Išsamesnė informacija apie nustatymus
pateikiama dalyje „Išvesties formatai ir
ribojimai“.

– Nustato SDI ir
HDMI išvesties
raišką.HDMI –
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Pastaba

Šis nustatymas taikomas ir HDMI išvesties signalo vaizdui, transliacijos išvesties vaizdui ir vaizdui
žiniatinklio programos fotoaparato vaizdo skydelyje.

[236] Žiniatinklio meniu ir išsamūs nustatymai Garso meniu

Garso įvestis

Nustatomi su CH1–CH4 garso įvesties kanalais susiję nustatymai.

Nustatomas pagrindinis garso įvesties lygis. Pagrindinio garso įvesties lygis naudojamas
visiems kanalams nuo 1 iki 4.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

SDI
On (įjungti) /
„Off“ (išjungti)

Išjungta
Nustatoma, ar meniu ir būsena
bus įtraukta į SDI išvesties
signalą.

„HDMI/Stream“
(HDMI /
transliacija)

On (įjungti) /
„Off“ (išjungti)

On
Nustatoma, ar meniu ir būsena
bus įtraukta į HDMI išvesties
signalą.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Level Control
Auto (automatinis) /
„Manual“ (rankinis)

Auto
Pasirenkamas automatinis garso
įvesties lygio reguliavimas arba
rankinis reguliavimas.

Level Nuo 0 iki 99 49 Nustatomas įvesties lygis.

„Input Select“
(įvesties
pasirinkimas)

AUDIO IN CH1 /
AUDIO IN CH2 /
„Off“ (išjungta)

CH1 ir CH3:
AUDIO IN CH1
CH2 ir CH4:
AUDIO IN CH2

Nustatomas garso įvesties šaltinis.

Pastaba

CH1 yra [AUDIO IN CH1]
(fiksuotas).

„Wind Filter“
(vėjo filtras)

On (įjungti) / „Off“
(išjungti)

Išjungta
Įjungiama / išjungiama vėjo keliamo
triukšmo slopinimo filtro funkcija.
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[237] Žiniatinklio meniu ir išsamūs nustatymai Garso meniu

Garso išvestis

Nustatomi su garso išvestimi susiję nustatymai.

Pastaba

Šis nustatymas gali būti taikomas ir transliacijos išvesties garsui.

[238] Žiniatinklio meniu ir išsamūs nustatymai Techninis meniu

Įspėjimo lemputė

Nustatomi įrašymo / įspėjimo lemputės nustatymai (žr. „Įspėjamojo signalo prijungimas“).

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Master“
(pagrindinis)

Nuo 0 iki 99 99
Nustatomas pagrindinis
įvesties lygis.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„HDMI/Stream Output CH“
(HDMI / transliacijos
išvesties kanalas)

CH1/CH2 /
CH3/CH4

CH1/CH2
Nustatomas HDMI /
transliacijos išvesčiai skirtų
garso kanalų derinys.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Tally Lamp
Brightness“
(įspėjamosios
lemputės
ryškumas)

„High“ (didelis)
/ „Low“
(mažas) / „Off“
(išjungta)

High
Nustatomas įrašymo / įspėjimo
lemputės ryškumas.

„G Tally Lamp“ (G
įspėjimo lemputė)

„Enable“
(įjungti) /
Disable

Enable
Įjungiama / išjungiama G įspėjimo
lemputė.
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[239] Žiniatinklio meniu ir išsamūs nustatymai Techninis meniu

IR nuotolinio valdymo pultas

Nustatomi su infraraudonųjų spindulių nuotolinio valdymo pultu susiję nustatymai.

[240] Žiniatinklio meniu ir išsamūs nustatymai Tinklo meniu

Fotoaparato pavadinimas

Nustatomi su fotoaparato pavadinimu (įrenginio pavadinimu) susiję nustatymai.

Nustatant fotoaparato pavadinimą galite įvesti iki aštuonių (0–8) toliau nurodytų simbolių.
Raidiniai ir skaitiniai simboliai
Simboliai (tarpas !#$`*+-./;<=>?@[\]^_`{|})

[241] Žiniatinklio meniu ir išsamūs nustatymai Tinklo meniu

Naudotojas

(išjungti)

„Tally Control“
(įspėjimo
valdymas)

„External“
(išorinis) /
„Internal“
(vidinis)

„Internal“
(vidinis)

Pasirenkama paskirties vieta, kuri
naudojama priimant įrenginio įrašymo
/ įspėjimo lemputės valdymo
informaciją.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
On (įjungti) /
„Off“ (išjungti)

On
Įjungia / išjungia įrenginio valdymą
infraraudonųjų spindulių nuotolinio
valdymo pultu.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Camera Name“
(fotoaparato
pavadinimas)

– FR7
Nustatomas
fotoaparato
pavadinimas.
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Nustatomi su įrenginio naudotojų prieiga susiję nustatymai.

Su administratoriaus naudotojais (administratoriumi) susiję nustatymai
(būtina)

Su bendraisiais naudotojais (1–9 naudotojais) susiję nustatymai (pasirenkama)

[242] Žiniatinklio meniu ir išsamūs nustatymai Tinklo meniu

Laidinis LAN

Būsena

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„User Name“
(Naudotojo vardas)

– admin
Nustatomas naudotojo
vardas.

„Current Password“
(dabartinis
slaptažodis)

– –
Keisdami slaptažodį
įveskite dabartinį
slaptažodį.

„New Password“
(naujas slaptažodis)

– – Įveskite naują slaptažodį.

Dar kartą įveskite
slaptažodį

– –
Patvirtindami dar kartą
įveskite naują slaptažodį.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„User Name“
(Naudotojo vardas)

– –
Nustatomas naudotojo
vardas.

„Current Password“
(dabartinis
slaptažodis)

– –
Keisdami slaptažodį
įveskite dabartinį
slaptažodį.

„New Password“
(naujas slaptažodis)

– – Įveskite naują slaptažodį.

Dar kartą įveskite
slaptažodį

– –
Patvirtindami dar kartą
įveskite naują slaptažodį.
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Parodoma tinklo būsena.

IPv4
Nustatomi su IPv4 tinklu susiję nustatymai.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Host name“ (Pagrindinio
kompiuterio pavadinimas)

– –
Parodomas pagrindinio
kompiuterio
pavadinimas.

MAC Address – –
Parodomas įrenginio
MAC adresas.

„Ethernet Status“ (eterneto
būsena)

– –
Parodomas dabartinė
ryšio sparta.

IP Address – –
Parodomas įrenginio IP
adresas.

Subnet Mask – –
Parodoma įrenginio
potinklio kaukė.

„Gateway“ (šliuzas) – –
Parodoma įrenginio
IPv4 numatytoji tinklo
sąsaja.

„Primary DNS Server“
(pirminis DNS serveris)

– –
Parodomas pirminis
įrenginio DNS serveris.

„Secondary DNS Server“
(antrinis DNS serveris)

– –
Parodomas antrinis
įrenginio DNS serveris.

„IPv6 Address 1“ (1 IPv6
adresas)

– –
Parodomas įrenginio 1
IPv6 adresas.

„IPv6 Address 2“ (2 IPv6
adresas)

– –
Parodomas įrenginio 2
IPv6 adresas.

„IPv6 Gateway“ (IPv6
tinklo sąsaja)

– –
Parodoma įrenginio
IPv6 numatytoji tinklo
sąsaja.

„Link-local IPv6 Address“
(vietinės sąsajos IPv6
adresas)

– –
Parodomas įrenginio
vietinės sąsajos IPv6
adresas.

Elementas
Papildomo
elemento

Gamyklinis
numatytasis Aprašas
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IPv6
Nustatomi su IPv6 tinklu susiję nustatymai.

„Common“ (bendra)
Nustatomi bendri IPv4/IPv6 tinklų nustatymai.

nustatymas nustatymas

DHCP
On (įjungti) /
„Off“ (išjungti)

On Įjungiama / išjungiama funkcija [DHCP].

IP Address – –
Nustatomas IPv4 adresas, kai [DHCP]
nustatyta kaip „Off“ (išjungta).

Subnet
Mask

– –
Nustatoma potinklio kaukė, kai [DHCP]
nustatyta kaip „Off“ (išjungta).

„Gateway“
(šliuzas)

– –
Nustatoma IPv4 numatytoji tinklo
sąsaja, kai [DHCP] nustatyta kaip „Off“
(išjungta).

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Obtain an IP
Address
Automatically“
(gauti IP adresą
automatiškai)

On (įjungti) /
„Off“
(išjungti)

On
Įjungiamas / išjungiamas automatinis
IPv6 adreso gavimas.

IP Address – –

Nustatomas IPv6 adresas, kai [Obtain
an IP Address Automatically] (gauti IP
adresą automatiškai) nustatyta kaip
„Off“ (išjungta).

„Prefix Length“
(priešdėlio ilgis)

– –

Nustatomas priešdėlis, kai [Obtain an
IP Address Automatically] (gauti IP
adresą automatiškai) nustatyta kaip
„Off“ (išjungta).

„Gateway“ (šliuzas) – –

Nustatoma IPv6 numatytoji tinklo
sąsaja, kai [Obtain an IP Address
Automatically] (gauti IP adresą
automatiškai) nustatyta kaip „Off“
(išjungta).

Elementas
Papildomo
elemento

Gamyklinis
numatytasis Aprašas
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[243] Žiniatinklio meniu ir išsamūs nustatymai Tinklo meniu

Failų perdavimas

Nustato parametrus, susijusius su failų persiuntimais.

nustatymas nustatymas

HTTP Port (HTTP
prievadas)

80, 1024–
65534

80 Nustatomas HTTP prievado numeris.

„DNS Auto“
(automatinis
DNS)

On (įjungti) /
„Off“ (išjungti)

On
Nustatoma, ar DNS adresai bus
gaunami iš DHCP serverio.

„Primary DNS
Server“ (pirminis
DNS serveris)

„IPv4/IPv6
address“
(IPv4/IPv6
adresas)

–
Įveskite pagrindinį DNS serverį, kai
[DNS Auto] (automatinis DNS)
nustatyta kaip „Off“ (išjungta).

„Secondary DNS
Server“ (antrinis
DNS serveris)

„IPv4/IPv6
address“
(IPv4/IPv6
adresas)

–
Įveskite pagalbinį DNS serverį, kai
[DNS Auto] (automatinis DNS)
nustatyta kaip „Off“ (išjungta).

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Auto Upload
(Proxy)“
(automatinis
mažos
raiškos failo
įkėlimas)

On (įjungti) / „Off“
(išjungti)

Išjungta
Įjungiamas / išjungiamas tarpinio
failo įkėlimas.

„Default
Upload
Server“
(Numatytasis
įkėlimo
serveris)

„Server Settings1 to
3“ (1–3 serverio
nustatymai) >
„Display Name“
(rodomas
pavadinimas)

„Server
Settings1“
(serverio 1
nustatymai)

Pasirenka failų įkėlimo serverį. Čia
pasirinktas serveris tampa mažesnės
raiškos failų automatinio įkėlimo
paskirties vieta ir failų iš miniatiūrų
ekrano įkėlimo paskirties vieta. 
Parodomi [Display Name] (rodomas
pavadinimas) nustatymai,
sukonfigūruoti dalyje [Server
Settings1 to 3] (1–3 serverio
nustatymai).
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[244] Žiniatinklio meniu ir išsamūs nustatymai Tinklo meniu

1–3 FTP serveris

Nustatomi su failų FTP perdavimais susiję nustatymai.
Šie nustatymai bendrai taikomi 1–3 FTP serveriams.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Display Name“
(Rodomas
pavadinimas)

– –
Nustato persiuntimo paskirties
nustatymų meniu rodomą
pavadinimą.

„Service“ (Paslauga) – – Rodo serverio tipą.

„Host name“
(Pagrindinio
kompiuterio
pavadinimas)

– –
Nustato paskirties serverio
pagrindinio kompiuterio
pavadinimą.

„Port“ (Prievadas)
21, 990,
1024–65534

21
Nustato persiuntimo paskirties
serverio prievado numerį.

„User Name“
(Naudotojo vardas)

– –
Nustato prisijungimo prie
persiuntimo paskirties serverio
autentifikavimo naudotojo vardą.

„Password“
(Slaptažodis)

– –
Nustato prisijungimo prie
persiuntimo paskirtis serverio
autentifikavimo slaptažodį.

„Passive Mode“
(Pasyvusis režimas)

On (įjungti) /
„Off“
(išjungti)

Išjungta
Įjungiamas / išjungiamas pasyvusis
režimas.

„Destination
Directory“ (Paskirties
vietos aplankas)

– –
Įveskite perdavimo paskirties
katalogo pavadinimą.

„Using Secure
Protocol“ (Saugaus
protokolo naudojimas)

On (įjungti) /
„Off“
(išjungti)

Išjungta
Nustatoma, ar naudoti („On“), ar
nenaudoti („Off“) saugų FTP
perdavimą.

„Root Certificate“
(šakninis sertifikatas)

– –

Įkeliamas saugiojo FTP perdavimo
šakninis sertifikatas. 
Paspauskite [Load] (įkelti) ir
pasirodžiusiame ekrane pasirinkite
šakninį sertifikatą. 
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[245] Žiniatinklio meniu ir išsamūs nustatymai Tinklo meniu

SSL

Nustatomi su SSL susiję nustatymai.

SSL
Įjungiama / išjungiama SSL funkcija.

SSL serverio autentiškumo nustatymas
Nustatomi su SSL serverio autentiškumo nustatymu susiję nustatymai.

Paspauskite mygtuką [Delete]
(ištrinti) ir ištrinkite įkeltą šakninį
sertifikatą.

„Root Certificate
Status“ (šakninio
sertifikato būsena)

– –
Parodoma šakninio sertifikato
įkėlimo būsena.

Reset – –
Atkuriamos nustatymų [Server
Settings] (serverio nustatymai)
numatytosios reikšmės.

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

Function
„Disable“ (išjungti) / „Enable“ (įjungti) /
„Enable“ (įjungti) (leisti HTTP ryšius kai
kuriems klientams)

Disable
Įjungiama /
išjungiama
SSL funkcija.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Certificate
Options“
(sertifikato
parinktys)

„Use a self-signed
certificate (For test
use)“ (naudoti pačių
pasirašytą sertifikatą)
(bandomajam
naudojimui) / „Use an
external certificate“
(naudoti išorinį
sertifikatą)

–
Nustatomas SSL serverio
sertifikato diegimo būdas.
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Būsena – –

Parodoma SSL serverio sertifikato
galiojimo būsena, kai [Certificate
Options] (sertifikato parinktys)
nustatyta kaip [Use a self-signed
certificate (For test use)] (naudoti
pačių pasirašytą sertifikatą)
(bandomajam naudojimui).

„Issuer DN“
(išdavėjo DN)

– –

Parodomas SSL serverio sertifikato
išdavėjo pavadinimas, kai
[Certificate Options] (sertifikato
parinktys) nustatyta kaip [Use a
self-signed certificate (For test
use)] (naudoti pačių pasirašytą
sertifikatą) (bandomajam
naudojimui).

„Subject DN“
(subjekto
DN)

– –

Parodomas SSL serverio sertifikato
subjekto pavadinimas, kai
[Certificate Options] (sertifikato
parinktys) nustatyta kaip [Use a
self-signed certificate (For test
use)] (naudoti pačių pasirašytą
sertifikatą) (bandomajam
naudojimui).

„Available
Period“
(galimas
laikotarpis)

– –

Parodomas SSL serverio sertifikato
galiojimo laikotarpis, kai [Certificate
Options] (sertifikato parinktys)
nustatyta kaip [Use a self-signed
certificate (For test use)] (naudoti
pačių pasirašytą sertifikatą)
(bandomajam naudojimui).

„Extended
Key Usage“
(išplėstinis
rakto
naudojimas)

– –

Parodomas išplėstinio rakto
naudojimo būdas, kai [Certificate
Options] (sertifikato parinktys)
nustatyta kaip [Use a self-signed
certificate (For test use)] (naudoti
pačių pasirašytą sertifikatą)
(bandomajam naudojimui).

Delete – –

Šis mygtukas parodomas, kai
[Certificate Options] (sertifikato
parinktys) nustatyta kaip [Use a
self-signed certificate (For test
use)] (naudoti pačių pasirašytą
sertifikatą) (bandomajam
naudojimui). 
Ištrinamas įdiegtas SSL serverio
sertifikatas.
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[246] Žiniatinklio meniu ir išsamūs nustatymai Tinklo meniu

Nuorodos tikrinimas

Nustatomi su nuorodos tikrinimu susiję nustatymai.

Išimčių sąrašas
Nustatomi su nuorodos tikrinimo išimčių sąrašu susiję nustatymai.

„Import“
(importuoti)

– –

Įdiegiamas išorinis SSL serverio
sertifikatas iš sąrašo, kai
[Certificate Options] (sertifikato
parinktys) nustatyta kaip [Use an
external certificate] (naudoti išorinį
sertifikatą).

Privačiojo
rakto
slaptažodis

– –

Nustatomas privačiojo rakto
informacijos SSL serverio
sertifikate slaptažodis, kai
[Certificate Options] (sertifikato
parinktys) nustatyta kaip [Use an
external certificate] (naudoti išorinį
sertifikatą).

Reset – –
Šiuo mygtuku išvalomas rodomas
privatusis raktas, kad galėtumėte
įvesti naują slaptažodį.

„Self-Signed
Certificate
Generation“
(pačių
pasirašyto
sertifikato
generavimas)

– –

Paspauskite mygtuką [Generate]
(pačių pasirašyto sertifikato
generavimas), kad būtų sukurtas
pačių pasirašytas sertifikatas, kai
[Certificate Options] (sertifikato
parinktys) nustatyta kaip [Use a
self-signed certificate (For test
use)] (naudoti pačių pasirašytą
sertifikatą) (bandomajam
naudojimui).

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
On (įjungti) / „Off“
(išjungti)

On
Įjungiama / išjungiam
nuorodos tikrinimo funkcija.
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[247] Žiniatinklio meniu ir išsamūs nustatymai Tinklo meniu

Apsauga nuo grubios jėgos atakos

Nustatomi su apsauga nuo grubios jėgos atakos susiję nustatymai.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Ne. nuo 1 iki 10 – Nustatomas išimties numeris iš sąrašo.

„Host name“
(Pagrindinio
kompiuterio
pavadinimas)

– –
Nustatomas išimties pagrindinio
kompiuterio pavadinimas.

„Port Number“
(prievado
numeris)

– – Nustatymas išimties prievado numeris.

Set – –
Paspauskite ir užregistruokite
sukonfigūruotą išimtį išimčių sąraše.

Delete – –
Pasirinkite išimtį, kurią norite ištrinti, ir
paspauskite mygtuką, kad ištrintumėte
registruotą išimtį iš išimčių sąrašo.

Elementas
Papildomo
elemento

Gamyklinis
numatytasis Aprašas
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Jei atakos rengėjas aptinkamas, parodoma jo sąrašo informacija.

[248] Žiniatinklio meniu ir išsamūs nustatymai Transliavimo meniu

Transliacija

Nustatomi transliavimo nustatymai (žr. „Apie transliavimą“).

Transliacijos nustatymas
Nustatomi su transliacijos protokolu susiję nustatymai.

nustatymas nustatymas

Nustatymas
On (įjungti) /
„Off“
(išjungti)

On
Įjungiama / išjungiama funkcija [Brute Force
Attack Protection] (apsauga nuo grubios jėgos
atakos).

„Count“
(skaičius)

nuo 3 iki
100

8

Nustatomas bandymų skaičius, kuris bus
laikomas ataka. 
Įjungiama, kai [Setting] (nustatymas) nustatyta
kaip „On“ (įjungta).

„Release
Mode“
(išleidimo
režimas)

„Always“
(visada) /
„Timer“
(laikmatis)

Laikmatis

Nustatoma išleidimo sąlyga. 
Įjungiama, kai [Setting] (nustatymas) nustatyta
kaip „On“ (įjungta).
„Always“ (visada): neištrinti iš atakų rengėjų
sąrašo.
„Timer“ (laikmatis): ištrinama iš atakų rengėjų
sąrašo pasibaigus išleidimo laikui, nustatytam
naudojant [Release Time] (išleidimo laikas).

„Release
Time“
(išleidimo
laikas)

30–86400 s 60

Nustatomas išleidimo laikas. 
Įjungiama, kai [Setting] (nustatymas) nustatyta
kaip „On“ (įjungta). 
Kai Release Mode: (išleidimo laikas) nustatoma
kaip [Timer] (laikmatis), įrašai ištrinami iš atakų
rengėjų sąrašo pasibaigus šiam išleidimo laikui.

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
RTSP / „SRT-Caller“ (SRT siuntėjas) /
„SRT-Listener“ (SRT gavėjas) / NDI|HX /
„Off“ (išjungta)

RTSP
Pasirenkamas
transliacijos
protokolas.
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RTSP
Kai [Stream Setting] (transliacijos nustatymas) nustatoma kaip [RTSP], parodomi toliau pateikti
elementai.
Nustatomi su RTSP transliacija susiję nustatymai.

SRT
Kai [Stream Setting] (transliacijos nustatymas) nustatoma kaip [SRT-Caller] (SRT siuntėjas)
arba [SRT-Listener] (SRT gavėjas), parodomi toliau patiekti elementai.
Nustatomi su SRT transliacija susiję nustatymai.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Port Number“
(prievado
numeris)

554, 1024–
65534

554 Nustatomas RTSP prievado numeris.

„Time Out“
(skirtasis laikas)

nuo 0 iki
600

60
Nustatomas komandos [Keep Alive]
(išlaikyti) skirtasis laikas RTSP
transliacijai.

„Authentication“
(autentiškumo
nustatymas)

On (įjungti) /
„Off“
(išjungti)

On
Įjungiama / išjungiama RTSP
autentiškumo nustatymo funkcija.

„Video Port
Number 1“ (1
vaizdo prievado
numeris)

nuo 1024 iki
65534

51000
Nustatomas 1 vaizdo siuntimui
naudojamo prievado numeris vykstant
RTSP transliacijai unikaliais adresais.

„Video Port
Number 2“ (2
vaizdo prievado
numeris)

nuo 1024 iki
65534

53000
Nustatomas 2 vaizdo siuntimui
naudojamo prievado numeris vykstant
RTSP transliacijai unikaliais adresais.

„Audio Port
Number“ (garso
prievado numeris)

nuo 1024 iki
65534

57000
Nustatomas garso siuntimui naudojamo
prievado numeris vykstant RTSP
transliacijai unikaliais adresais.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Paskirties
vieta

– –
Nustatomas ryšio paskirties URL, kai
įrenginys veikia kaip siuntėjas.

„Port
Number“
(prievado

nuo 1024 iki
65534

4201
Nustatomas prievado numeris,
naudojamas gavimui, kai įrenginys
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NDI|HX
Kai [Stream Setting] (transliacijos nustatymas) nustatoma kaip [NDI|HX], parodomi toliau
pateikti elementai.
Nustatomi su NDI|HX susiję nustatymai.

numeris)
veikia kaip gavėjas.

„Latency“
(delsa)

20–8000 ms 120 Nustatoma delsa.

TTL nuo 1 iki 255 64 Nustatoma TTL reikšmė.

„Encryption“
(šifravimas)

„Off“ (išjungta)
/ AES128 /
AES256

Išjungta
Įjungiamas / išjungiamas šifravimas ir
nustatomas šifravimo būdas.

„Passphrase“
(prieigos
kodas)

0 arba 10–79
simbolių eilutė

0

Nustatomas prieigos kodas,
naudojamas šifravimui. 
Paspauskite „Nustatyti iš naujo“, kad
išvalytumėte įvestą prieigos kodą.

ARC
On (įjungti) /
„Off“ (išjungti)

On
Įjungiama / išjungiama funkcija
[Adaptive Rate Control] (prisitaikančios
spartos valdymas).

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Licencija – –
Parodoma NDI licencijos kodo
įdiegimo būsena.

„Source Name“ (šaltinio
pavadinimas)

– –
Parodomas NDI šaltinio
pavadinimas.

„Group“ (grupė)
On (įjungti) /
„Off“
(išjungti)

Išjungta
Įjungiama / išjungiama NDI
grupavimo funkcija.

„Group Name“ (grupės
pavadinimas)

– –

Rodoma, kai NDI grupavimo
funkcija nustatoma kaip „On“
(įjungta). 
Nustatomas grupės pavadinimas.

„Discovery Server 1“ (1
aptikimo serveris)

– –
Nustatomas 1 NDI aptikimo
serveris.

„Discovery Server 2“ (2
aptikimo serveris)

– –
Nustatomas 2 NDI aptikimo
serveris.

On (įjungti) /
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[249] Žiniatinklio meniu ir išsamūs nustatymai Transliavimo meniu

Vaizdo įrašo transliavimas

Nustatomi su vaizdo įrašų transliavimo kodekais susiję nustatymai.

1 vaizdo transliacija
Nustatomi su 1 vaizdo įrašų kodeku susiję nustatymai.

„Reliable UDP Mode“
(patikimo UDP režimas)

„Off“
(išjungti)

On
Įjungiamas / išjungiamas patikimo
UDP režimas.

„Multicast Mode“
(daugiaadresis režimas)

On (įjungti) /
„Off“
(išjungti)

Išjungta
Įjungiamas / išjungiamas
daugiaadresis transliavimo
režimas.

„Multicast Prefix“
(daugiaadresio
perdavimo priešdėlis)

239.255.0.0 239.255.0.0

Rodoma, kai [Multicast Mode]
(daugiaadresio perdavimo režimas)
nustatyta kaip „On“ (įjungta). 
Nustatomas priešdėlis,
naudojamas daugiaadresiam
transliavimui.

„Multicast Netmask“
(daugiaadresio
perdavimo tinklo kaukė)

255.255.0.0 255.255.0.0

Rodoma, kai [Multicast Mode]
(daugiaadresio perdavimo režimas)
nustatyta kaip „On“ (įjungta). 
Nustatoma tinklo kaukė, kuria
nustatomas daugiaadresio
perdavimo adresų diapazonas.

„Multicast TTL“
(daugiaadresio
perdavimo TTL)

nuo 1 iki
256

3

Rodoma, kai [Multicast Mode]
(daugiaadresio perdavimo režimas)
nustatyta kaip „On“ (įjungta). 
Nustatoma daugiaadresio
transliavimo TTL reikšmė.

„Multi-TCP Mode“ (kelių
TCP režimas)

On (įjungti) /
„Off“
(išjungti)

Išjungta
Įjungiamas / išjungiamas kelių TCP
režimas.

„Unicast UDP Mode“
(transliacijos unikaliais
adresais UDP režimas)

On (įjungti) /
„Off“
(išjungti)

On
Įjungiamas / išjungiamas
transliacijos unikaliais adresais
UDP režimas.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas
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„Codec 1“ (1
kodekas)

H.264 / H.265 H.264
Nustatomas 1 vaizdo
kodekas.

„Size 1“ (1 dydis)
4096×2160 / 3840×2160 /
2048×1080 / 1920×1080 /
1280×720 / 640×360

1920×1080
Nustatomas 1 vaizdo
dydis.

„Frame Rate 1“
(1 kadrų sparta)

Išsamesnė informacija
apie palaikomą kadrų
spartą pateikiama dalyje
„Transliavimo vaizdo
kodeko nustatymas“.

–
Nustatoma 1 vaizdo
kadrų sparta.

„I-Picture Mode
1“ (1 „I-Picture“
režimas)

„Time“ (laikas) / „Frame“
(kadras)

„Time“
(laikas)

Nustatomas 1 vaizdo
[IDR-Frame] įterpimo
intervalas, nurodomas
kaip laikas arba kadrų
skaičius.

„I-Picture Interval
1“ (1 „I-Picture“
intervalas)

1 / 2 / 3 / 4 / 5 s 1

Rodoma, kai [I-Picture
Mode 1] (1 „I-Picture“
režimas) nustatyta kaip
Time (laikas). 
Nustatomas H.264 ir
H.265 skirtas „IDR-
Frame“ įterpimo
intervalas, nurodomas
kaip laikas.

„I-Picture Ratio
1“ (1 „I-Picture“
sparta)

15–300 kadrų 30

Rodoma, kai [I-Picture
Mode 1] (1 „I-Picture“
režimas) nustatyta kaip
Frame (kadras). 
Nustatomas H.264 ir
H.265 skirtas „IDR-
Frame“ įterpimo
intervalas, nurodomas
kaip kadrų skaičius.

„Profile 1“ (1
profilis)

H.264: „high“ / „main“ /
„baseline“
H.265: „main“ / „main10“

H.264: „high“
Nustatomas H.264 arba
H.265 profilis.

„Bit Rate
Compression
Mode 1“ (1
spartos bitais
glaudinimo
režimas)

CBR / VBR VBR
Nustatomas 1 vaizdui
skirtas spartos bitais
glaudinimo režimas.
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2 vaizdo transliacija
Nustatomi su 2 vaizdo įrašų kodeku susiję nustatymai.

„Bit Rate 1“ (1
sparta bitais)

512 / 768 / 1000 / 2000 / 3000
/ 4000 / 5000 / 6000 / 7000 /
8000 / 16000 / 24000 / 32000 /
50000 / 64000 / 80000 kbps

16000

Rodoma, kai [Bit Rate
Compression Mode 1] (1
spartos bitais
glaudinimo režimas)
nustatyta kaip „On“
(įjungta). 
Nustatoma numatyta
spartos bitais reikšmė,
kai spartos bitais
glaudinimo režimas
nustatomas kaip CBR.

„Quality 1“ (1
kokybė)

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 10 6
Nustatoma H.264 arba
H.265 kokybė.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Codec 2“ (2
kodekas)

H.264 / H.265 / „Off“
(išjungta)

Išjungta Nustatomas 2 vaizdo kodekas.

„Size 2“ (2
dydis)

4096×2160 / 3840×2160 /
2048×1080 / 1920×1080 /
1280×720 / 640×360 /
512×270

1920×1080 Nustatomas 2 vaizdo dydis.

„Frame Rate
2“ (2 kadrų
sparta)

Išsamesnė informacija
apie palaikomą kadrų
spartą pateikiama
dalyje „Transliavimo
vaizdo kodeko
nustatymas“.

–

Rodoma, kai [Codec 2] (2
kodekas) nenustatyta kaip „Off“
(išjungta). 
Nustatoma 2 vaizdo kadrų
sparta.

„I-Picture
Mode 2“ (2 „I-
Picture“
režimas)

„Time“ (laikas) / „Frame“
(kadras)

laikas

Rodoma, kai [Codec 2] (2
kodekas) nenustatyta kaip „Off“
(išjungta). 
Nustatomas 2 vaizdo „IDR-
Frame“ įterpimo intervalas,
nurodomas kaip laikas arba
kadrų skaičius.

„I-Picture

Rodoma, kai [Codec 2] (2
kodekas) nenustatyta kaip „Off“
(išjungta), o [I-Picture Mode 2]
(2 „I-Picture“ režimas) nustatyta
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3 vaizdo transliacija

Interval 2“ (2
„I-Picture“
intervalas)

1 / 2 / 3 / 4 / 5 s 1 kaip [Time] (laikas). 
Nustatomas H.264 ir H.265
skirtas „IDR-Frame“ įterpimo
intervalas, nurodomas kaip
laikas.

„I-Picture
Ratio 2“ (2 „I-
Picture“
sparta)

15–300 kadrų 30

Rodoma, kai [Codec 2] (2
kodekas) nenustatyta kaip „Off“
(išjungta), o [I-Picture Mode 2]
(2 „I-Picture“ režimas) nustatyta
kaip [Frame] (kadras). 
Nustatomas H.264 ir H.265
skirtas „IDR-Frame“ įterpimo
intervalas, nurodomas kaip
kadrų skaičius.

„Profile 2“ (2
profilis)

H.264: „high“ / „main“ /
„baseline“
H.265: „main“

–
Nustatomas H.264 arba H.265
profilis.

„Bit Rate
Compression
Mode 2“ (2
spartos bitais
glaudinimo
režimas)

CBR / VBR VBR

Rodoma, kai [Codec 2] (2
kodekas) nenustatyta kaip „Off“
(išjungta). 
Nustatomas 2 vaizdui skirtas
spartos bitais glaudinimo
režimas.

„Bit Rate 2“ (2
sparta bitais)

512 / 768 / 1000 / 2000 /
3000 / 4000 / 5000 / 6000
/ 7000 / 8000 / 16000 /
24000 / 32000 / 50000 /
64000 / 80000 kbps

8000

Rodoma, kai [Codec 2] (2
kodekas) nenustatyta kaip „Off“
(išjungta), o Bit Rate
Compression Mode 2] (2
spartos bitais glaudinimo
režimas) nustatyta kaip [On]
(įjungta). 
Nustatoma numatyta spartos
bitais reikšmė, kai spartos bitais
glaudinimo režimas nustatomas
kaip CBR.

„Quality 2“ (2
kokybė)

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 /
9 / 10

6

Rodoma, kai [Codec 2] (2
kodekas) nustatyta kaip H.264,
o [Bit Rate Compression Mode
2] (2 spartos bitais glaudinimo
režimas) nustatyta kaip „Off“
(išjungta). 
Nustatoma H.264 arba H.265
kokybė.
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Nustatomi su 3 vaizdo įrašų kodeku susiję nustatymai.

[250] Žiniatinklio meniu ir išsamūs nustatymai Transliavimo meniu

Garso transliavimas

Nustatomi su garso transliavimo kodekais susiję nustatymai.

[251] Žiniatinklio meniu ir išsamūs nustatymai Priežiūros meniu

Kalba

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

„Codec 3“
(3 kodekas)

JPEG JPEG
Nustatomas
3 vaizdo
kodekas.

„Size 3“ (3
dydis)

1280×720 / 1024×540 / 640×360 1280×720
Nustatomas
3 vaizdo
dydis.

„Frame
Rate 3“ (3
kadrų
sparta)

Išsamesnė informacija apie palaikomą
kadrų spartą pateikiama dalyje
„Transliavimo vaizdo kodeko nustatymas“.

–
Nustatoma 3
vaizdo kadrų
sparta.

„Quality 3“
(3 kokybė)

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6
Nustatoma
kokybė.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Nustatymas
On (įjungti) / „Off“
(išjungti)

Išjungta
Įjungiama / išjungiama garso
transliacijos išvestis.

Kodekas
AAC (128 kb/s) /
AAC (256 kb/s)

AAC (128 kb/s)

Rodoma, kai [Setting]
(nustatymas) nustatyta kaip „On“
(įjungta). 
Nustatomas transliacijos garso
kodekas.
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Nustato ekrano kalbą.

Pastaba

Galimos kalbos priklauso nuo šalies ar regiono.

[252] Žiniatinklio meniu ir išsamūs nustatymai Priežiūros meniu

Pritaikymas neįgaliesiems

Nustatomi su skaitymo garsu (teksto vertimo kalba) susiję nustatymai.

Pastaba

Ši funkcija galima tik Š. Amerikos rinkai skirtuose modeliuose. Ekrano skaitytuvo funkcija gali būti
naudojama, tik kai kalba nustatyta kaip „English“ (anglų k.) (atsižvelgiant į išleidimo datą).

Įrenginyje su žiniatinklio programa įjunkite žiniatinklio naršyklės ekrano skaitytuvo funkciją.

Elementas Papildomo elemento
nustatymas

Gamyklinis numatytasis
nustatymas Aprašas

Kalba – –
Nustato ekrano
kalbą.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Screen
Reader“
(ekrano
skaitytuvas)

On (įjungti) / „Off“
(išjungti)

Išjungta 

Įjungiama / išjungiama ekrano
skaitytuvo funkcija žiniatinklio
programos fotoaparato vaizdo
skydelyje.

„Speech
Rate“
(kalbėjimo
greitis)

Slow2 / Slow1 /
Normal / Fast1 /
Fast2 / Fast3 /
Fast4

Įprasta

Nustatomas ekrano skaitytuvo
funkcijos greitis. 
Ištraukos pavyzdys perskaitomas
balsu sukonfigūruotu greičiu.

„Speech
Volume“
(kalbos
garsumas)

nuo 1 iki 15 7

Nustatomas žiniatinklio programos
ekrano skaitytuvo funkcijos garsumas. 
Ištraukos pavyzdys perskaitomas
balsu sukonfigūruotu garsumu.
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[253] Žiniatinklio meniu ir išsamūs nustatymai Priežiūros meniu

Laikrodžio nustatymas

Nustato vidinio laikrodžio duomenis.

Elementas Papildomo elemento nustatymas
Gamyklinis
numatytasis
nustatymas

Aprašas

„Current
Date &
Time“
(dabartinė
data ir
laikas)

– –
Parodomas įrenginyje
sukonfigūruotas
dabartinis laikas.

„PC Clock“
(kompiuterio
laikrodis)

– –

Parodomas
konfigūravimui naudoto
planšetinio kompiuterio
ar kompiuterio
dabartinis laikas.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-
yyyy hh:mm:ss / dd-mm-yyyy
hh:mm:ss

yyyy-mm-dd
Nustatomas datos ir
laiko rodymo formatas.

12 h / 24 h 12 h / 24 h 24 h
Nustatomas 12 val. / 24
val. laiko rodymo
formatas.

„Time
Setting“
(laiko
nustatymas)

„Keep current setting“ (išlaikyti
dabartinį nustatymą) / „Synchronize
with PC“ (sinchronizuoti su
kompiuteriu) / „Manual setting“
(rankinis nustatymas) /
„Synchronize with NTP“
(sinchronizuoti su NTP)

–
Nustatomas datos ir
laiko konfigūravimo
būdas.

yy-mm-dd
hh:mm:ss

yy: nuo 19 iki 37 
mm: nuo 01 iki 12 
dd: nuo 01 iki 31 
hh: nuo 00 iki 23 
mm: nuo 00 iki 59 
ss: nuo 00 iki 59 (sek.)

–

Rodoma, kai [Time
Setting] (laiko
nustatymas) nustatyta
kaip Manual setting
(rankinis nustatymas). 
Rankiniu būdu
nustatoma data ir
laikas.

Rodoma, kai [Time
Setting] (laiko
nustatymas) nustatyta



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

[254] Žiniatinklio meniu ir išsamūs nustatymai Priežiūros meniu

Nustatymas iš naujo

Atkuriamos pradinės įrenginio nustatymų reikšmės.

Paleidimas iš naujo
Įrenginys paleidžiamas iš naujo.

NTP Auto On (įjungti) / „Off“ (išjungti) Išjungta
kaip Synchronize with
NTP (sinchronizuoti su
NTP). 
Nustatoma, ar gauti
NTP serverio IP adresą
iš DHCP serverio.

„NTP
Server“
(NTP
serveris)

IPv4/IPv6 adresas arba pagrindinio
kompiuterio pavadinimas

–

Rodoma, kai [Time
Setting] (laiko
nustatymas) nustatyta
kaip [Synchronize with
NTP] (sinchronizuoti su
NTP), o [NTP Auto]
(automatinis NTP)
nustatyta kaip „Off“
(išjungta). 
Nurodomas NTP
serveris, naudojamas
laikui sinchronizuoti.

Time Zone Nuo UTC – 12.00 iki UTC + 14.00 –
Pasirenkama laiko
juosta.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Paleidimas
iš naujo

„Execute“ (vykdyti) –

Įrenginys paleidžiamas iš
naujo.
„Execute“ (vykdyti): vykdoma
funkcija.

Pastaba

Paleidę iš naujo naršyklėje
dar kartą įkelkite puslapį.
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Reset
Atkuriamos pradinės įrenginio nustatymų reikšmės.

[255] Žiniatinklio meniu ir išsamūs nustatymai Priežiūros meniu

Informacija

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„All Reset (except for
Network Settings)“ (viską
nustatyti iš naujo) (išskyrus
tinklo nustatymus)

„Execute“
(vykdyti)

–

Atkuriamos pradinės įrenginio
nustatymų reikšmės (išskyrus
tinklo nustatymus).
„Execute“ (vykdyti): vykdoma
funkcija.

Pastaba

Importuotas bazinis vaizdas
ir LUT failai neištrinami.

„Network Reset“ (tinklo
nustatymas iš naujo)

„Execute“
(vykdyti)

–

Atkuriamos pradinės įrenginio
tinklo nustatymų reikšmės.
„Execute“ (vykdyti): vykdoma
funkcija.

Pastaba

Atlikus tinklo nustatymą iš
naujo, įrenginys
paleidžiamas iš naujo.
Paleidę iš naujo naršyklėje
dar kartą įkelkite puslapį.

„Factory Default“
(gamyklinis numatytasis
nustatymas)

„Execute“
(vykdyti)

–

Grąžinama gamyklinė
numatytoji įrenginio nustatymų
būsena.
„Execute“ (vykdyti): vykdoma
funkcija.

Pastaba

Atlikus gamyklinių
numatytųjų reikšmių
atkūrimą, įrenginys
paleidžiamas iš naujo.
Paleidę iš naujo naršyklėje
dar kartą įkelkite puslapį.
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Parodoma fotoaparato ir objektyvo informacija. Taip pat naudojama programinei įrangai
atnaujinti.

Fotoaparatas
Parodoma fotoaparato informacija ir atnaujinama programinė įranga.

Objektyvas
Parodoma objektyvo informacija ir atnaujinama programinė įranga.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Model
Name

– – Parodomas fotoaparato modelio pavadinimas.

Serijos
numeris

– – Parodomas fotoaparato serijos numeris.

„Version
Number“
(versijos
numeris)

– – Rodoma kameros programinės įrangos versija.

„Version
Up“
(versijos
naujinimas)

– –

Paspauskite mygtuką [Choose File] (rinktis failą)
ir vykdydami ekrane pateikiamas instrukcijas
atnaujinkite fotoaparato programinę įrangą.

Pastaba

Atnaujinus įrenginys bus paleistas iš naujo.
Paleidę iš naujo naršyklėje dar kartą įkelkite
puslapį.

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

Model
Name

– – Parodomas objektyvo modelio pavadinimas.

Serijos
numeris

– – Parodomas objektyvo serijos numeris.

„Version
Number“
(versijos

– –
Parodoma objektyvo programinės įrangos
versija.
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[256] Žiniatinklio meniu ir išsamūs nustatymai Priežiūros meniu

Sistemos žurnalas

Nustatomi su sistemos žurnalu susiję nustatymai.

Gautas žurnalas parodomas, kaip pateikiama toliau.

numeris)

„Version
Up“
(versijos
naujinimas)

– –

Paspauskite mygtuką [Choose File] (rinktis failą)
ir vykdydami ekrane pateikiamas instrukcijas
atnaujinkite objektyvo programinę įrangą.

Išsamesnė informacija pateikiama dalyje
„Objektyvo su E tipo tvirtinimu programinės
įrangos naujinimas“.

Pastaba

Atnaujinus objektyvą įrenginys paleidžiamas iš
naujo. Paleidę iš naujo naršyklėje dar kartą
įkelkite puslapį.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Log Level“
(žurnalo
lygis)

„Critical, Warning & Info“
(kritinis, įspėjimas ir
informacija) / „Critical &
Warning“ (kritinis ir
įspėjimas) / „Critical“
(kritinis)

„Critical,
Warning &
Info“ (kritinis,
įspėjimas ir
informacija)

Nustatomas įrašo pridėjimo prie
sistemos žurnalo lygis.

„Log Size“
(žurnalo
dydis)

nuo 200 iki 1024 1024
Nustatomas žurnalo dydis, kuris
išsaugomas sistemos žurnale.

„Download
as File“
(atsisiųsti
kaip failą)

– –

Rodomame ekrane paspauskite
mygtuką [Download] (atsisiųsti) ir
išsaugokite sistemos žurnalą
planšetiniame kompiuteryje ar
kompiuteryje.
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[257] Žiniatinklio meniu ir išsamūs nustatymai Priežiūros meniu

HTTP prieigos žurnalas

Nustatomi su HTTP prieigos žurnalu susiję nustatymai.

[258] Žiniatinklio meniu ir išsamūs nustatymai Priežiūros meniu

Paslauga

Gaunama informacija apie įrenginį. Pasinaudokite kreipdamiesi į „Sony“ techninės priežiūros
atstovą.

Elementas Papildomo elemento
nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„Log Level“
(žurnalo
lygis)

„Critical, Warning & Info“
(kritinis, įspėjimas ir
informacija) / „Critical &
Warning“ (kritinis ir
įspėjimas) / „Critical“
(kritinis)

„Critical,
Warning &
Info“ (kritinis,
įspėjimas ir
informacija)

Nustatomas įrašo pridėjimo prie
HTTP prieigos žurnalo lygis.

„Log Size“
(žurnalo
dydis)

nuo 200 iki 1024 1024
Nustatomas žurnalo dydis, kuris
išsaugomas HTTP prieigos
žurnale.

„Download
as File“
(atsisiųsti
kaip failą)

– –

Rodomame ekrane paspauskite
mygtuką [Download] (atsisiųsti) ir
išsaugokite HTTP prieigos
žurnalą planšetiniame
kompiuteryje ar kompiuteryje.



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

[259] Žiniatinklio meniu ir išsamūs nustatymai Priežiūros meniu

GNLS

Parodoma galutinio naudotojo licencijos sutartis (GNLS).

[260] Žiniatinklio meniu ir išsamūs nustatymai Priežiūros meniu

Programinė įranga

Parodoma programinės įrangos licencija.

[261] Išorinio įrenginio prijungimas

Išorinių monitorių ir įrašymo įrenginių prijungimas

Kad įrašomas / atkuriamas vaizdas būtų rodomas išoriniame monitoriuje, nustatykite išorinio
monitoriaus išvesties tipą ir prijunkite monitorių atitinkamu kabeliu.
Be to, galite prijungti išorinį įrašymo įrenginį ir įrašyti įrenginio išvesties signalą.
Tą pačią informaciją, kuri matoma įrenginyje, pvz., būsenos informaciją ir meniu, galite rodyti
išoriniame monitoriuje. Norimą ekrano rodinio sistemos tipą nustatykite kaip „On“ (įjungta)

Elementas
Papildomo
elemento

nustatymas

Gamyklinis
numatytasis
nustatymas

Aprašas

„I agree to download
device information.“
(sutinku atsisiųsti
įrenginio informaciją)

– –

Čia padėkite varnelę, kad
patvirtintumėte, jog sutinkate gauti
įrenginio informaciją, tada
paspauskite mygtuką [OK]. 
Paspauskite pasirodžiusį mygtuką
[Download] (atsisiųsti). Žiniatinklio
naršyklė iškart atsisiųs failą
pavadinimu deviceinformation.dat.

Pastaba

Baigus atsisiuntimą įrenginys
bus paleistas iš naujo. Paleidę
iš naujo naršyklėje dar kartą
įkelkite puslapį.
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žiniatinklio meniu naudodami [Monitoring] > [Output Display] (stebėjimas > išvesties rodymas).

Pastaba

Jei prie HDMI jungties prijungtas monitorius nepalaiko HDMI išvesties formato, sukonfigūruoto
žiniatinklio meniu arba fotoaparato meniu esančiame meniu [Monitoring] (stebėjimas), fotoaparato
vaizdas nebus rodomas žiniatinklio programoje. Transliuojamo vaizdo išvestis taip pat nebus
rodoma.

[Output Display] > [SDI] (išvesties rodymas) ir [HDMI/Stream] (HDMI / transliacija) galite nustatyti
kaip [Off] (išjungta), bet dėl to negalėsite naudoti fotoaparato menu ir funkcijų, kurios priklauso nuo
ekrano rodinio. Be to, įrenginio klaidų pranešimai bus pateikiami tik įrenginio lemputėmis (šviečiant
arba mirksint) ir viršutiniame dešiniajame žiniatinklio programos kampe parodant pranešimo ženklą.
Jei norite peržiūrėti išsamią informaciją apie būseną, [Output Display] (išvesties rodymas) nustatykite
kaip [On] (įjungta).

Patarimas

[Output Display] > [SDI] (išvesties rodymas > SDI) nustatyta kaip [Off] (išjungta), o [HDMI/Stream]
(HDMI / transliacija) nustatyta kaip [On] (įjungta) pagal numatytuosius gamyklinius nustatymus. Jei
transliuojamą vaizdą norite naudoti kaip pagrindinį vaizdą, [SDI] nustatykite kaip [On] (įjungta), o
[HDMI/Stream] HDMI / transliacija) kaip [Off] (išjungta), tada stebėkite fotoaparato būseną SDI
monitoriuje.

Jungtis SDI OUT (BNC tipo)

Išvesties formatą žiniatinklio meniu arba fotoaparato meniu nustatykite naudodami meniu
[Monitoring] (stebėjimas).
Prijunkite naudodami atskirai parduodamą 75 ? bendraašį kabelį.

Pastaba

Prieš įjungdami įrenginius patikrinkite, ar jungtis tarp įrenginio ir išorinio įrenginio yra įžeminta.

Rekomenduojama įrenginį ir išorinį įrenginį įjungti po to, kai bus prijungtas 75 ?
bendraašis kabelis.
Jei išorinis įrenginys turi būti prijungtas prie įrenginio, kai įrenginys yra įjungtas, pirmiausia
prijunkite 75 ? bendraašį kabelį prie išorinio įrenginio, tada prijunkite jį prie įrenginio.

Norėdami pradėti įrašymą į įrenginį ir į išorinį įrenginį vienu metu
Kai įjungta SDI signalo išvestis, fotoaparato meniu [Project] > [SDI/HDMI Rec Control] >
[Setting] (projektas > SDI / HDMI įrašymo valdymas > nustatymas) nustatykite kaip [SDI/HDMI
Remote I/F] (SDI / HDMI nuotolinis I/F) arba [Parallel Rec] (lygiagretus įrašymas), kad
įjungtumėte REC paleidiklio signalo išvestį per išorinį įrenginį, prijungta prie jungties SDI OUT.
Taip sinchronizuosite įrašymą į išorinį įrenginį su įrenginiu.

Pastaba

Jei prijungtas išorinis įrenginys nepalaiko įrašymo paleidimo signalo, tokio įrenginio negalima valdyti.

Kai fotoaparato meniu [Project] > [SDI/HDMI Rec Control] > [Setting] (projektas > SDI / HDMI
įrašymo valdymas > nustatymas) nustatyta kaip [SDI/HDMI Remote I/F] (SDI/HDMI nuotolinis I/F),
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pateikiama tik REC paleidiklio signalo išvestis, jei šiuo metu neįdėta jokia įrašymo laikmena ir
paspaudžiamas įrašymo PRADĖJIMO / SUSTABDYMO mygtukas.

Jungtis HDMI OUT (A tipo jungtis)

Nustatykite išvesties įjungimo / išjungimo nustatymą ir išvesties formatą meniu [Monitoring]
(stebėjimas) fotoaparato meniu.

Norėdami pradėti įrašymą į įrenginį ir į išorinį įrenginį vienu metu
Kai įjungta HDMI signalo išvestis, fotoaparato meniu [TC/Media] > [HDMI TC Out] > [Setting]
(laiko kodas / laikmena > HDMI TC išvestis > nustatymas) nustatykite kaip [On] (įjungta), o
[Project] > [SDI/HDMI Rec Control] > [Setting] (projektas > SDI/HDMI įrašymo valdymas >
nustatymas) nustatykite kaip [SDI/HDMI Remote I/F] (SDI/HDMI nuotolinis I/F) arba [Parallel
Rec] (lygiagretus įrašymas), kad įjungtumėte REC paleidiklio signalo išvestį per išorinį įrenginį,
prijungta prie jungties HDMI OUT. Taip sinchronizuosite įrašymą į išorinį įrenginį su įrenginiu.

Pastaba

Jei prijungtas išorinis įrenginys nepalaiko įrašymo paleidimo signalo, tokio įrenginio negalima valdyti.

Kai fotoaparato meniu [Project] > [SDI/HDMI Rec Control] > [Setting] (projektas > SDI / HDMI
įrašymo valdymas > nustatymas) nustatyta kaip [SDI/HDMI Remote I/F] (SDI/HDMI nuotolinis I/F),
pateikiama tik REC paleidiklio signalo išvestis, jei šiuo metu neįdėta jokia įrašymo laikmena ir
paspaudžiamas įrašymo PRADĖJIMO / SUSTABDYMO mygtukas.

[262] Išorinio įrenginio prijungimas Valdymas naudojant RM-IP500 nuotolinį valdiklį
(pasirenkama)

Apie valdymą naudojant RM-IP500 nuotolinį valdiklį
(pasirenkama)

Įrenginį galite valdyti naudodami „Sony“ RM-IP500 nuotolinį valdiklį su 2.2 ar naujesnės versijos
programine įranga. Įrenginiai ryšį palaiko naudodami VISCA per IP (LAN).
Atsižvelgiant į norimą naudoti elementą, jums gali tekti peržiūrėti įrenginio ekrano rodinį.
Paruoškite monitorių, kuris gali būti naudojamas ekrano rodiniui patikrinti.
Toliau nurodytus veiksmus galite atlikti naudodami RM-IP500 nuotolinį valdiklį.

Paskirties fotoaparato pasirinkimas
Kadravimo reguliavimas (pasukimas, pakreipimas, priartinimas)
Fokusavimo reguliavimas (išskyrus jutiklinį valdymą)
Išankstinių nustatymų registravimas ir naudojimas
Įrenginio meniu naudojimas (išskyrus žiniatinklio meniu)
Šviesumo reguliavimas
Baltos spalvos balanso reguliavimas
Juodos spalvos balanso reguliavimas
Garso įvesties lygio reguliavimas
Įrašymo pradėjimas / sustabdymas
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Įrenginio priskiriamų mygtukų funkcijų vykdymas

Išsamesnė informacija apie RM-IP500 naudojimą pateikiama RM-IP500 naudojimo
instrukcijose.

Patarimas

Jei naudojate RM-IP500, naudokite šiam įrenginiui skirtą skydelio plokštelę, kuri pridedama su RM-
IP500.

RM-IP500 (naudojant šiam įrenginiui skirtą skydelio plokštelę)

[263] Išorinio įrenginio prijungimas Valdymas naudojant RM-IP500 nuotolinį valdiklį
(pasirenkama)

RM-IP500 nuotolinio valdiklio prijungimas

Įrenginio 3 jungiklį SETUP nustatykite į padėtį ON (įjungta), kad įjungtumėte VISCA
per IP ryšį.

Pastaba

Jungiklio nustatymas pritaikomas, kai įrenginys kitą kartą įjungiamas.

1



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

Išsamesnė informacija apie funkcijų priskyrimą pateikiama RM-IP500 naudojimo
instrukcijose.

[264] Išorinio įrenginio prijungimas Sinchronizavimas su išoriniu įrenginiu

Apie sinchronizavimas su išoriniu įrenginiu

Kai vaizdai fiksuojami naudojant kelis įrenginius, juos galima sinchronizuoti pagal specialų
nuorodos signalą arba laiko kodą naudojant įrenginių GENLOCK jungtį.

Išsamesnė informacija apie „Genlock“ pateikiama dalyje „Vaizdo signalo fazės („Genlock“)
sinchronizavimas“.
Išsamesnė informacija apie laiko kodų sinchronizavimą pateikiama dalyje „Laiko kodo
susiejimas su kitais įrenginiais“.

[265] Išorinio įrenginio prijungimas Sinchronizavimas su išoriniu įrenginiu

Vaizdo signalo fazės („Genlock“) sinchronizavimas

Į jungtį GENLOCK galite siųsti nuorodos signalą, kad įjungtumėte „Genlock“.
Įvesties nuorodos signalas, kuris gali būti naudojamas, priklauso nuo pasirinkto įrašymo formato
sistemos dažnio.

RM-IP500 prijunkite prie to paties tinklo kaip įrenginys.2

Vadovaudamiesi procedūra RM-IP500 naudojimo instrukcijose sukonfigūruokite
VISCA per IP (LAN) ryšį RM-IP500.

Priskirkite šį įrenginį naudodami RM meniu > AUTO IP SETUP > ASSIGN CAM.

3

Šio įrenginio funkcijas prireikus priskirkite mygtukams ir rankenėlėms naudodami
toliau nurodytus RM-IP500 esančio RM meniu elementus.

SW ASSIGN
AE CONFIG2
WB MODE

4

Įrašymo formato sistemos dažnis Palaikomi įvesties nuorodos signalai

59,94P
1920×1080 59.94i 
720×486 59.94i
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Išorinio sinchronizavimo būseną galite patikrinti fotoaparato meniu naudodami [Technical] >
[Genlock] > [Reference] (techniniai > Genlock > nuoroda).

Pastaba

Jei nuorodos signalas nestabilus, „Genlock“ neveiks.

Pagalbinis operatorius nesinchronizuojamas.

[266] Išorinio įrenginio prijungimas Sinchronizavimas su išoriniu įrenginiu

Laiko kodo susiejimas su kitais įrenginiais

Nustatykite laiko kodą tiekiantį įrenginį režimu, kuriuo palaikomas laiko kodas (pavyzdžiui, „Free
Run“ (laisvas veikimas) arba „Clock“ (laikrodis).

50P
1920×1080 50i 
720×576 50i

29,97P
1920×1080 59.94i 
720×486 59.94i

25P
1920×1080 50i 
720×576 50i

24P 1920×1080 24PsF

23,98P 1920×1080 23.98PsF

59.94i
1920×1080 59.94i 
720×486 59.94i

50i
1920×1080 50i 
720×576 50i

Fotoaparato meniu nustatykite [TC/Media] > [Timecode] (laiko kodas / laikmena >
laiko kodas).

[Mode] (režimas) nustatykite kaip [Preset] (išankstinis nustatymas).
[Run] (vykdyti) nustatykite kaip [Free Run] (laisvas veikimas).

1

Paspauskite priskiriamą mygtuką, kuriam priskirta funkcija [DURATION/TC/U-BIT],
kad laiko kodas būtų parodytas ekrane.

2

HD arba SD nuorodos vaizdo signalą siųskite į jungtį GENLOCK, o nuorodos laiko
kodą – į jungtį TC IN.

Įrenginio laiko kodo generatorius sinchronizuojasi su nuorodos laiko kodu, o ekrane

3
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Pastaba

Patikrinkite, ar pateikiamas nuorodos laiko kodas ir nuorodos vaizdo signalas veikia fazių ryšiu, kuris
atitinka SMPTE laiko kodo standartą.

Kai valdoma naudojant išorinį susiejimą, laiko kodas iškart susiejamas su išoriniu laiko kodu ir
išorinio laiko kodo reikšmė parodoma laiko duomenų rodymo srityje. Tačiau nepradėkite iškart
filmuoti. Palaukite prieš filmuodami keletą sekundžių, kol laiko kodo generatorius stabilizuosis.

Jei įrenginio nuorodos vaizdo signalo dažnis ir kadrų dažnis nesutampa, susiejimas bus negalimas, o
įrenginys tinkamai neveiks. Tokiu atveju laiko kodas nebus sėkmingai susietas su išoriniu laiko kodu.

Jei atjungiamas išorinis laiko kodo šaltinis, laiko kodas gali pasislinkti vienu kadru per valandą,
atsižvelgiant į nuorodos laiko kodą.

Išorinio susiejimo atlaisvinimas
Fotoaparato meniu pakeiskite nustatymą [TC/Media] > [Timecode] (laiko kodas / laikmena >
laiko kodas).
Išorinis sinchronizavimas taip pat išjungiamas, jei pakeičiamas sistemos dažnis ir kai pradedate
filmuoti specialiu filmavimo režimu (sulėtintu ar pagreitintu filmavimu arba filmavimu intervalais).

[267] Išorinio įrenginio prijungimas

Išorinio mikrofono arba išorinio garso įrenginio
prijungimas

Įvesčiai galite naudoti signalą iš išorinio mikrofono ar išorinio garso įrenginio ir įterpti jį į įrašomo
vaizdo įrašo garse arba įrenginio vaizdo išvestyje.

parodoma „EXT-LK“.
Kai praeina maždaug dešimt sekundžių po laiko kodo susiejimo, išorinio susiejimo būsena
išlaikoma net jei išorinis referentinio laiko kodo šaltinis atjungiamas.

Išorinį mikrofoną arba išorinį garso įrenginį prijunkite naudodami XLR kabelį.

Kai garsas nustatomas kaip [LINE] fotoaparato meniu naudojant [Audio] > [Audio Input] >
[AUDIO IN Select] (garsas > garso įvestis > AUDIO IN pasirinkimas), jungtis AUDIO IN
veikia kaip jungtis AUDIO IN CH-1 ir jungtis AUDIO IN CH-2.

1
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[268] Išorinio įrenginio prijungimas

Kontakto Nr. Function

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1? (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2? (COLD)

Išjunkite įrenginį ir prijunkite XLR kabelį prie jungties AUDIO IN.2

Nustatykite 2 jungiklį SETUP, kad įjungtumėte fantominį maitinimo tiekimą.

Perjunkite +48 V maitinimo tiekimą (fantominį maitinimą) kaip aprašyta toliau.
2 jungiklis
Nustatoma, ar prijungus garso įvesties įrenginį +48 V maitinimo šaltinis (fantominis
maitinimas) bus įjungtas / išjungtas.

Pastaba

Šį jungiklį nustačius į įjungimo padėtį ON ir prijungus mikrofoną, kuris nepalaiko +48 V šaltinio,
prijungtą įrenginį galima sugadinti. Prieš jungdami įrenginį patikrinkite nustatymą.

3

Nustatymas Aprašas

OFF
(išjungta;
numatytasis)

Ši funkcija išjungia +48 V fantominį maitinimo tiekimą ir nustato LINE
arba MIC įvestį kaip CH-1 ir CH-2 garso šaltinį.

ON
Ši funkcija įjungia +48V fantominį maitinimo tiekimą ir nustato fantominį
maitinimo tiekimą palaikantį mikrofoną kaip CH-1 ir CH-2 garso šaltinį.

Įjunkite įrenginį ir prijungto įrenginio tipą nustatykite fotoaparato meniu naudodami
[Audio] > [Audio Input] > [AUDIO IN Select] (garsas > garso įvestis > AUDIO IN
pasirinkimas).

4
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Klipų tvarkymas / redagavimas naudojant kompiuterį

Klipus tvarkyti / redaguoti galite naudodami kompiuterį.

Klipų importavimas naudojant kortelių skaitytuvą (pasirenkama)

„CFexpress“ A tipo kortelių skaitytuvą arba SD kortelių skaitytuvą prijunkite prie savo
kompiuterio ir naudodami programinę įrangą, palaikančią šio įrenginio įrašymo formatą, pvz.,
„Catalyst Browse“, importuokite klipus.

Netiesinės redagavimo sistemos

Netiesinėje redagavimo sistemoje reikalinga redagavimo programinė įranga (įsigyjama atskirai),
kuri palaiko įrenginiu įrašytus formatus.

[269] Išorinio įrenginio prijungimas

Optinio signalo išvestis

Į optinį signalą konvertuoto SDI signalo išvestį galite siųsti prijungę SFP+ modulį (pasirenkama)
prie įrenginio jungties OPTICAL. Naudokite SFP+ modulį, kuris palaiko kiekvieno formato
signalo dažnių juostą.
Signalo dažnių juosta

4K (59.94p, 50p): 12G
4K (kitas nei 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (kitas nei 59.94p, 50p): 1.5G

Pastaba

Naudokite modulį, kuris atitinka toliau nurodytus standartus.
SFF standartai
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

SDI standartai
ST297/ST292/ST424/ST425/ST2081/ST2082

Per SFP+ modulį siunčiamas toks pat signalas kaip SDI išvesties jungtyje.

Įrenginys nepalaiko optinio signalo įvesties.

Optinio signalo išvesčiai naudokite SFP+ modulį. Išsamesnę informaciją apie patvirtintus SFP+
modulius pateiks pardavėjas arba „Sony“ techninės priežiūros atstovas.

* I galios lygis (1,0 W)
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[270] Išorinio įrenginio prijungimas

Įspėjamojo signalo prijungimas

Šioje temoje aprašomas įspėjimo signalo valdymas.

Įspėjimo lemputės įjungimas naudojant signalą iš nuotolinio valdiklio

Įspėjimo lemputę galite įjungti naudodami VISCA per IP komandą iš išorinio įrenginio, pvz., RM-
IP500.
Žiniatinklio meniu arba fotoaparato meniu [Technical] > [Tally] > [Tally Control] (techniniai >
įspėjimas > įspėjimo valdymas) nustatykite kaip [External] (išorinis).

Įspėjimo lemputės įjungimas iš išorinio įrenginio

Įrenginio įspėjimo lemputę galite įjungti, kad ji šviestų raudona ar žalia spalva, naudodami išorinį
įrenginį, pvz., RM-IP500 ar perjungiklį. Įspėjimą galite valdyti naudodami komandas, siunčiamas
tinklu ar naudodami įspėjimo signalo įvestį iš įrenginio jungties OPTION.
Žiniatinklio meniu arba fotoaparato meniu [Technical] > [Tally] > [Tally Control] (techniniai >
įspėjimas > įspėjimo valdymas) nustatykite kaip [External] (išorinis).
Kai įspėjimo signalo įvestis siunčiama į jungtį OPTION, trumpuoju jungimu sujunkite 7 kontaktas
su GND (4 arba 5 kontaktu), kad įspėjimo lemputė užsidegtų žalia spalva, arba 8 kontaktą su
GND (4 arba 5 kontaktu), kad įspėjimo lemputė šviestų raudona spalva.

Pastaba

Kai [Tally Control] (įspėjimo valdymas) nustatyta kaip [External] (išorinis), įrenginio įrašymo būsena
nenurodoma įspėjimo lempute.

Jei vienu metu siunčiamas raudonos ir žalios įspėjimo lemputės įvesties signalas, įspėjimo lemputė
užsidega raudona spalva.

Jungties OPTION kontaktų specifikacijos

Kontakto
Nr.

Signalo
kryptis Signalo specifikacijos

1 – Atbulinė

2 – Atbulinė

Žalios įspėjimo lemputės išvestis
Žemo lygio išvestis, kai šviečia žalia įspėjimo lemputė.
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Išorinio įrenginio įspėjimo lemputės įjungimas naudojant signalą iš
įrenginio

Išorinio įrenginio įspėjimo lemputę galite įjungti naudodami signalą iš įrenginio sujungdami
jungties OPTION 3 kontaktą su 6 kontaktu, kaip parodyta toliau.
Jungties OPTION 3 ir 6 kontaktų sujungimo pavyzdys

Pastaba

Nenukreipkite įtampos į 7 ir 8 kontaktus.

Nejunkite išorinio įrenginio, kuris tiekia įtampą į jungtį OPTION.

Jei į 3 arba 6 kontaktą bus tiekiama per didelė įjungimo arba atbulinė įtampa, gali įvykti gedimas, kilti
dūmai arba gaisras.

Išvesties signalą nustatykite žiniatinklio meniu arba fotoaparato meniu naudodami [Technical] >
[Tally] > [Tally Control] (techniniai > įspėjimas > įspėjimas valdymas).

3 OUT
Hi-Z išvestis, kai žalia įspėjimo lemputė nešviečia.

4 – GND (įžeminimas)

5 – GND (įžeminimas)

6 OUT

Raudonos įspėjimo lemputės išvestis
Žemo lygio išvestis, kai šviečia raudona įspėjimo lemputė.
Hi-Z išvestis, kai raudona įspėjimo lemputė nešviečia.

7 IN
Žalios įspėjimo lemputės išorinio valdymo įvestis 
Trumpasis jungimas su įžeminimu (4 arba 5 kontaktu) lemia, kad
įrenginio įspėjimo lemputė šviečia žalia spalva.

8 IN
Raudonos įspėjimo lemputės išorinio valdymo įvestis 
Trumpasis jungimas su įžeminimu (4 arba 5 kontaktu) lemia, kad
įrenginio įspėjimo lemputė šviečia raudona spalva.
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[Internal] (vidinis): įrenginio įrašymo būsena
[External] (išorinis): įrenginio per IN signalus ir nuotolinius valdiklius gaunami raudono / žalio įspėjimo
signalų „Logical-AND“.

[271] Priedas

Perspėjimai dėl naudojimo

Kondensacija
Jei įrenginys staiga pernešamas iš šaltos į šiltą vietą arba jei staiga pakyla aplinkos
temperatūra, ant įrenginio išorinių paviršių ir (arba) įrenginio viduje gali susiformuoti drėgmės.
Tai vadinama kondensatu. Susidarius kondensatui išjunkite įrenginį ir prieš naudodami įrenginį
palaukite, kol kondensatas išgaruos. Naudodami įrenginį susidarius kondensatui galite sugadinti
įrenginį.

Kameros CMOS vaizdo jutiklio fenomenas

Pastaba

Toliau aprašyti fenomenai, kurie gali atsirasti nufilmuotame vaizde, yra būdingi vaizdo jutikliams. Tai
nėra gedimas.

Balti taškeliai
Nors vaizdo jutikliai gaminami naudojant didelio tikslumo technologijas, retais atvejais ekrane
gali atsirasti smulkūs balti taškeliai, kurie atsiranda dėl kosminių spindulių ir pan.
Tai susiję su vaizdo jutiklių veikimo principu ir nėra gedimas.
Balti taškeliai gali būti ypač matomi šiais atvejais:

Kai filmuojate esant aukštai aplinkos temperatūrai
Kai padidinate stiprinimą (jautrumą)

Flicker
Jei filmuojama liuminescencinių lempų, natrio lempų, gyvsidabrio garų lempų arba LED
šviesoje, ekranas gali mirgėti arba gali kisti spalvos.

Objektyvo ir pasukimo / pakreipimo mechanizmo blokai
Jei objektyvo ir pasukimo / pakreipimo mechanizmai ilgai nenaudojami, gali padidėti viduje
užtepto tepalo klampumas, todėl mechanizmas gali nejudėti. Reguliariai pasinaudokite
objektyvo ir pasukimo / pakreipimo mechanizmu.

Apie susidėvinčias dalis
Ventiliatorius ir integruotas įkraunamasis maitinimo elementas yra susidėvinčios dalys ir jas
reikia periodiškai keisti.
Kai įrenginys naudojamas kambario temperatūroje, įprastas keitimo ciklas bus maždaug 5
metai. Tačiau šis keitimo ciklas yra tik bendrojo pobūdžio rekomendacija ir nereiškia, kad
toks šių dalių eksploatavimo laikas yra garantuojamas.
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Norėdami gauti informacijos apie dalių keitimą, kreipkitės į savo pardavimų atstovą.

Tikėtinas kintamosios srovės adapterio ir elektrolitinio kondensatoriaus eksploatavimo laikas
yra maždaug 5 metai naudojant įprastomis naudojimo sąlygomis (8 valandos per dieną; 25
dienos per mėnesį). Jei naudojama dažniau nei įprastas naudojimo dažnumas, tikėtinas
eksploatavimo laikas gali atitinkamai sumažėti.

Rekomenduojama juos reguliariai tikrinti, kad įrenginys tinkamai veiktų ir nesutrumpėtų jo
eksploatavimo laikas. Daugiau informacijos apie tikrinimus jums gali suteikti „Sony“ techninės
priežiūros atstovas.

Apie integruotą įkraunamą bateriją
Įrenginyje yra integruota įkraunama baterija datai, laikui ir kitiems nustatymams išsaugoti, kai
įrenginys yra išjungtas. Integruotasis įkraunamas maitinimo elementas bus įkrautas per 24
valandas, jei įrenginys bus prijungtas prie maitinimo šaltinio naudojant kintamosios srovės
adapterį arba jei prijungtas PoE++, nesvarbu, ar įrenginys įjungtas, ar išjungtas. Įkraunamasis
maitinimo elementas visiškai išsikraus maždaug per 2 mėnesius, jei kintamosios srovės
adapteris nebus prijungtas prie maitinimo šaltinio. Įrenginį naudokite įkrovę maitinimo elementą.
Tačiau net jei įkraunama baterija nebus įkrauta, tai neturės įtakos įrenginio veikimui, jei jums
nereikės įrašyti datos.

Naudojimo ir laikymo vietos
Laikykite lygioje, vėdinamoje vietoje.
Venkite laikyti įrenginį toliau nurodytose vietose.

Nuo lietaus ir vandens neapsaugotose vietose (įskaitant pastoges)
Lauke ir vietose, kuriose yra aukštesnė nei 40 °C (104 °F) temperatūra 
Atminkite vasarą šilto klimato zonose temperatūra automobilio viduje esant uždarytiems
langams gali lengvai viršyti 50 °C (122 °F).
Vietose, kuriose šalčiau nei 0 °C (32 °F).
Drėgnose ar dulkėtose vietose. Vietose, kur įrenginys gali sulyti
Vietose, kurios veikiamos vibracijos ar smūgių
Vietose, kurios veikiamos radiacijos, rentgeno spindulių ir stiprių magnetinių laukų.
Netoli radijo arba televizijos siųstuvų, sukuriančių stiprius elektromagnetinius laukus.
Ilgą laiką tiesioginėje saulės šviesoje arba šalia šildytuvų

Pastaba dėl lazerio spindulių
Lazerio spinduliai gali sugadinti CMOS vaizdo jutiklį. Jei filmuojate siužetą, kuriame yra lazerio
spindulių, saugokitės, kad lazerio spindulys nebūtų nukreiptas į įrenginio objektyvą. Ypač
medicininių prietaisų arba kitų įrenginių didelės galios lazerio spinduliai gali sukelti pažeidimus
dėl atsispindėjusios ar išsklaidytos šviesos.

Kaip išvengti nešiojamųjų ryšio įrenginių keliamų elektromagnetinių trukdžių
Naudojant mobiliuosius telefonus ir kitus ryšio įrenginius šalia šio įrenginio, galimas netinkamas
veikimas ir garso bei vaizdo signalų trukdžiai. Rekomenduojama išjungti šalia šio įrenginio
esančius nešiojamuosius ryšio įrenginius.

Nelaikykite šio gaminio prie medicininių prietaisų
Šiame gaminyje (įskaitant priedus) yra magnetas (-ų), kuris (-ie) gali kelti trikdžius širdies
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stimuliatoriams, programuojamiems šuntavimo vožtuvams hidrocefalijai gydyti ar kitiems
medicininiams prietaisams. Nelaikykite šio gaminio prie asmenų, naudojančių tokius
medicininius prietaisus. Jei turite kokį nors medicininį prietaisą, prieš naudodami ši gaminį
pasitarkite su gydytoju.

Perspėjimai dėl saugos
„SONY“ NĖRA ATSAKINGA UŽ JOKIĄ ŽALĄ AR NUOSTOLIUS, JEI NEPASIRŪPINAMA
TINKAMOMIS PERDAVIMO ĮRENGINIŲ APSAUGOS PRIEMONĖMIS, NEIŠVENGIAMA
DUOMENŲ NUTEKĖJIMO DĖL PERDAVIMO SPECIFIKACIJŲ ARBA JOKIŲ SAUGUMO
PROBLEMŲ.
Atsižvelgiant į naudojimo aplinką, tam leidimo neturinčios trečiosios šalys tinkle gali
prisijungti prie prietaiso. Jungiant prietaisą prie tinklo turite įsitikinti, kad tinklas yra tinkamai
apsaugotas.
Ryšiu perduodamas turinys gali būti nepastebimai perimtas neįgaliotų trečiųjų šalių, esančių
signalo zonoje. Kai naudojate belaidį LAN ryšį, imkitės tinkamų saugumo priemonių
perduodamam turiniui apsaugoti.
Kai jungiate šį gaminį prie ryšio tinklo, junkite per sistemą, kuri užtikrintų apsaugos funkciją,
pavyzdžiui, per maršruto parinktuvą arba užkardą. Jei jungiatės be tokios apsaugos, gali kilti
saugos problemų.

Maitinimo tiekimas
Įrenginyje nėra maitinimo jungiklio. Jei įrenginį norite išjungti, patikrinkite, ar užbaigtos visos
operacijos, o įrenginys veikia budėjimo režimu, tada atjunkite kintamosios srovės adapterį.
Jei naudojamas PoE++ maitinimo tiekimas, atjunkite LAN kabelį.
Esant galimybei naudokite maitinimo šaltinį tokioje vietoje, kurią lengva pasiekti norint
prijungti ar atjungti maitinimo kištuką.
Jei naudojate lizdą dulkėtoje vietoje, reguliariai nuvalykite sritį aplink lizdą, kad išvengtumėte
nuotėkio.

Atsargumo priemonės dėl judančių dalių
Pasirūpinkite, kad tarp judančių dalių nepatektų jokių pašalinių daiktų.
Reguliuodami judančias dalis ranka nenaudokite per didelės jėgos. Kitaip galite sukelti
gedimų.
Netrukdykite judančioms dalims veikti. Jei tai padarysite, galite susižeisti arba sugadinti
įrenginį.
Judančio dalys gali veikti netinkamai, jei įrenginys buvo ilgai nenaudojamas. Reguliariai
pasinaudokite įrenginio pasukimo / pakreipimo funkcijomis.

Atsargumo priemonės dėl įrašymo funkcijos
Visada atlikite bandomąjį filmavimą ir įsitikinkite, kad jis buvo sėkmingas. „SONY“ NĖRA
ATSAKINGA UŽ JOKIO POBŪDŽIO ŽALĄ, ĮSKAITANT (BET NEAPSIRIBOJANT)
KOMPENSACIJĄ ARBA ATLYGINIMĄ, DĖL ŠIO ĮRENGINIO AR JO ĮRAŠYMO
LAIKMENOS ARBA KITOS LAIKMENOS AR ĮRAŠANČIO ĮRENGINIO BET KOKIO TIPO
ĮRAŠYTŲ DUOMENŲ SUGADINIMO.
Prieš naudodami visada patikrinkite, ar įrenginys veikia tinkamai. „SONY“ NĖRA
ATSAKINGA UŽ JOKIUS NUOSTOLIUS, ĮSKAITANT (TAČIAU TUO NEAPSIRIBOJANT)
KOMPENSACIJAS ARBA NUOSTOLIŲ PADENGIMĄ, PATIRTUS NEGAVUS ESAMO AR
NUMATOMO PELNO DĖL ŠIO ĮRENGINIO GEDIMO AR BET KOKIŲ KITŲ PRIEŽASČIŲ,
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NESVARBU, AR TAI ĮVYKSTA GARANTINIU LAIKOTARPIU, AR PASIBAIGUS
GARANTINIAM LAIKOTARPIUI.
„SONY“ NĖRA ATSAKINGA DĖL ŠIO ĮRENGINIO NAUDOTOJO AR TREČIŲJŲ ŠALIŲ
PATEIKIAMŲ BET KOKIO TIPO PRETENZIJŲ.
„SONY“ NĖRA ATSAKINGA UŽ DUOMENŲ, ĮRAŠYTŲ Į VIDINĖS ATMINTIES SISTEMĄ,
ĮRAŠOMĄJĄ LAIKMENĄ ARBA KITAS LAIKMENAS AR ATMINTIES SISTEMAS,
PRARADIMĄ, TAISYMĄ AR ATKŪRIMĄ.
„SONY“ NĖRA ATSAKINGA UŽ BET KOKIŲ PASLAUGŲ, SUSIJUSIŲ SU ŠIUO
ĮRENGINIU, NUTRAUKIMĄ AR NEBETEIKIMĄ DĖL BET KOKIŲ PRIEŽASČIŲ.

[272] Priedas

Išvesties formatai ir ribojimai

Šioje temoje aprašomi išvesties formatai ir ribojimai.

Pastaba

Išvesties formato raiška yra ribojama naudojant žiniatinklio meniu arba fotoaparato meniu
nustatymais [Project] > [Rec Format] > [Frequency] (projektas > įrašymo formatas > dažnis), [Codec]
(kodekas) ir [Video Format] (vaizdo formatas).

Išvesties formato raišką taip pat riboja parametrų derinys su sulėtinto ir pagreitinto filmavimo kadrų
sparta. Be toliau pateikto lentelės su jungties SDI OUT/HDMI OUT išvesties formatų, HDMI išvestis
perjungiama į „Full HD“ ar žemesnę raišką, kai išpildomos visos toliau nurodytos sąlygos.

[Shooting] > [S&Q Motion] > [Setting] (vaizdų fiksavimas > sulėtintas ir pagreitintas filmavimas >
nustatymas) nustatyta kaip [On] (įjungta)
[Shooting] > [S&Q Motion] > [Frame Rate] (vaizdų fiksavimas > sulėtintas ir pagreitintas filmavimas
> kadrų sparta) yra didesnė nei 60 kadr./sek.

Kai išpildomos anksčiau nurodytos sąlygos, HDMI išvesties 4096×2160P ir 3840×2160P pasirinkimo
parinktys [Monitoring] > [Output Format] > [SDI/HDMI] (stebėjimas > išvesties formatas > SDI /
HDMI) užpilkinamos ir jų negalima rinktis.

Vaizdo išvestis neteikiama, jei sukonfigūruojama didesnė raiška nei atkuriamo vaizdo raiška.

Jungties SDI OUT/HDMI OUT išvesties formatai

Kai sistemos dažnis yra 50/59.94 Hz

Nustatymas Galimas rinktis išvesties formatas

Įrašymo / atkūrimo
režimas

RAW išvesties
raiška /

vidinė įrašymo
raiška

SDI HDMI

4096×2160 
(RAW)

(4096×2160 RAW)

4096×2160P 
3840×2160P 
1920×1080P
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Kai sistemos dažnis yra 25/29.97 Hz

RAW 
RAW & XAVC-I

(numatytasis) 
1920×1080i

3840×2160 
(RAW)

(3840×2160 RAW)

3840×2160P 
1920×1080P
(numatytasis) 
1920×1080i

XAVC-I 
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P 
1920×1080P 
1920×1080i

3840×2160 (2SI)
3840×2160P 
1920×1080P 
1920×1080i

1920×1080P (A lygis)
(numatytasis)

1920×1080P
(numatytasis) 
1920×1080i

1920×1080P (lygis B)
1920×1080P 
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P 
1920×1080P 
1920×1080i

1920×1080P (A lygis)
(numatytasis)

1920×1080P
(numatytasis) 
1920×1080i

1920×1080P (lygis B)
1920×1080P 
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (A lygis)
(numatytasis)

1920×1080P
(numatytasis) 
1920×1080i

1920×1080P (lygis B)
1920×1080P 
1920×1080i

1920×1080i 1920×1080i

(Išvestis sustabdyta)
720×480P1) 
720×576P2)

Kai sistemos dažnis yra 59.941)
Kai sistemos dažnis yra 502)
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Kai sistemos dažnis yra 23.98 Hz

Nustatymas Išvesties formatas (išvesties raiška)

Įrašymo / atkūrimo
režimas

RAW išvesties
raiška /

vidinė įrašymo
raiška

SDI HDMI

RAW 
RAW & XAVC-I

4096×2160 
(RAW)

(4096×2160 RAW)

4096×2160P 
3840×2160P 
1920×1080P 
1920×1080i
(numatytasis)

3840×2160 
(RAW)

(3840×2160 RAW)

3840×2160P 
1920×1080P 
1920×1080i
(numatytasis)

XAVC-I 
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P 
1920×1080P

3840×2160 (2SI)
3840×2160P 
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(numatytasis)

1920×1080i
(numatytasis)

3840×2160

3840×2160 (2SI)
3840×2160P 
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(numatytasis)

1920×1080i
(numatytasis)

1920×1080
1920×1080P 
1920×1080PsF

1920×1080P 
1920×1080i

Nustatymas Išvesties formatas (išvesties raiška)

Įrašymo / atkūrimo
režimas

RAW išvesties
raiška /

vidinė įrašymo
raiška

SDI HDMI

4096×2160 
(RAW)

(4096×2160 RAW)

4096×2160P 
3840×2160P 
1920×1080P
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Kai sistemos dažnis yra 24 Hz

[273] Priedas

Trikčių šalinimas

Maitinimo tiekimas

RAW 
RAW & XAVC-I

(numatytasis)

3840×2160 
(RAW)

(3840×2160 RAW)
3840×2160P 
1920×1080P
(numatytasis)

XAVC-I 
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P 
1920×1080P

3840×2160 (2SI)
3840×2160P 
1920×1080P

1920×1080P
(numatytasis)

1920×1080P
(numatytasis)

3840×2160

3840×2160 (2SI)
3840×2160P 
1920×1080P

1920×1080P
(numatytasis)

1920×1080P
(numatytasis)

1920×1080
1920×1080P
(numatytasis)

1920×1080P
(numatytasis)

Nustatymas Išvesties formatas (išvesties raiška)

Įrašymo / atkūrimo
režimas

RAW išvesties
raiška /

vidinė įrašymo
raiška

SDI HDMI

RAW 
RAW & XAVC-I

4096×2160 
(RAW)

(4096×2160 RAW)
4096×2160P 
1920×1080P
(numatytasis)

XAVC-I 4096×2160
4096×2160 (2SI) 
1920×1080P
(numatytasis)

4096×2160P 
1920×1080P
(numatytasis)

Požymis Priežastis Sprendimas
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Vaizdo išvestis

Įrenginys
neįsijungia.

Kintamosios srovės adapteris neprijungtas
tinkamai prie jungties DC IN.

Tvirtai įstatykite maitinimo laidą
jungtį įkišdami iki galo.

Kintamosios srovės maitinimo laidas
netinkamai prijungtas prie kintamosios
srovės adapterio arba kintamosios srovės
lizdo.

Tvirtai įstatykite maitinimo laidą
jungtį įkišdami iki galo.

LAN kabelis netinkamai prijungtas prie
PoE++ maitinimo tiekimo įrenginio arba
įrenginio.

Patikrinkite, ar kabelis įstatytas
iki galo ir yra užsifiksavęs.

LAN kabelis prijungtas prie jungties
OPTION, o ne prie jungties LAN.

LAN kabelį tinkamai prijunkite
prie jungties LAN.

Įrenginys prijungtas prie maitinimo tiekimo
įrenginio, kuris nepalaiko PoE++
(IEEE802.3bt, 4 tipo, 8 klasės).

Prijunkite maitinimo tiekimo
įrenginį, kuris palaiko PoE++
(IEEE802.3bt, 4 tipo, 8 klasės).

Bendros energijos sąnaudos viršija
didžiausią PoE++ maitinimo tiekimo
įrenginio nustatytą ribą.

Žr. PoE++ maitinimo tiekimo
įrenginio naudojimo instrukcijas.

Prijungtas tinklo kabelis, kurio kategorija
nepalaiko PoE++ maitinimo tiekimo.

Naudokite 5e ar aukštesnės
kategorijos tinklo kabelį ir
prijunkite jį prie jungties LAN.

Fotoaparatas, PoE++ maitinimo tiekimo
įrenginys ir prijungti įrenginiai neprijungti
prie įžeminimo.

Fotoaparatą, PoE++ maitinimo
tiekimo įrenginį ir prijungtus
įrenginius prijunkite prie
įžeminimo.

Požymis Priežastis Sprendimas

Nėra vaizdo
išvesties.

Prijungti įrenginiai netinkamai sujungti.
Prijungtus įrenginius
sujunkite tinkamai.

Neužbaigta pradinė sąranka.
Užbaikite pradinę
sąranką naudodami
žiniatinklio programą.

Nėra vaizdo
išvesties iš HDMI
jungties.

Siunčiamas išvesties signalas, kurio
nepalaiko HDMI išvesties paskirties įrenginys.

Pakeiskite HDMI
išvesties formato
nustatymą arba
naudokite įrenginį, kuris
palaiko naudojamą
išvesties signalą.

Naudojamas kabelis, kuris nepalaiko HDMI
Naudokite esamą HDMI
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išvesties standarto.
išvesties standartą
palaikantį kabelį.

Nėra vaizdo
išvesties iš SDI
jungties.

Naudojamas kabelis, kuris nepalaiko SDI
išvesties standarto.

Naudokite esamą SDI
išvesties standartą
palaikantį kabelį.

Prie SDI jungties prijungtas monitorius
nepalaiko išvesties signalo.

Naudokite monitorių,
kuris palaiko SDI
išvesties standartą.

Įrašymo formatas nustatytas kaip RAW
išvestis.

Įrašymo formato
nustatymą pakeiskite
kitu nustatymu nei RAW
išvestis.

HDMI išvesčiai nustatyta SD raiška.
HDMI išvesčiai
nustatykite kitą raišką
nei SD.

Iš optinės
jungties nėra
jokios vaizdo
išvesties arba
vaizdas
iškraipytas.

Naudojamas modulis neatitinka SFF arba
SMPTE standartų arba I galios lygio (1,0 W)
reikalavimų.

Žr. „Optinio signalo
išvestis“.

Nėra vaizdo
išvesties arba
vaizdas
iškraipytas, kai
naudojamas
išorinis
sinchronizavimas.

Negaunamas sukonfigūruotam vaizdo signalo
formatui tinkamas išorinio sinchronizavimo
signalas.

Pasirūpinkite, kad būtų
siunčiama
sukonfigūruotam vaizdo
signalo formatui tinkama
išorinio sinchronizavimo
signalo įvestis.

Garse girdimas
triukšmas.

Fotoaparatas, PoE++ maitinimo tiekimo
įrenginys ir prijungti įrenginiai neprijungti prie
įžeminimo.

Fotoaparatą, PoE++
maitinimo tiekimo
įrenginį ir prijungtus
įrenginius prijunkite prie
įžeminimo.

Įrenginys naudojamas aplinkoje su
įrenginiais, kurie sukuria stiprų elektros ar
magnetinį lauką (pvz., televizijos / radijo
siųstuvų antenos, mėgėjiški radijo siųstuvai,
oro kondicionierių varikliai, maitinimo tiekimo
transformatoriai).

Laikykitės toliau nuo
įrenginių, kurie sukuria
stiprius elektros ir
magnetinius laukus.

Objektyvas, objektyvo atrama ir pavaros
mechanizmas liečiasi su įrenginiu ar objektu

Tinkamai uždėkite
objektyvą.

Patikrinkite, ar prie
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Nuotolinis valdymas

Nuotolinis valdymas infraraudonaisiais spinduliais

RM-IP500

aplinkoje ir skleidžiamas neįprastas
triukšmas. fotoaparato nėra

kokių nors kliūčių.

Požymis Priežastis Sprendimas

Infraraudonųjų
spindulių nuotolinio
valdymo pultas
neveikia
spaudžiant
mygtukus.

Infraraudonųjų spindulių
nuotolinio valdymo pultas
išjungtas.

Žiniatinklio meniu [Technical] > [IR
Remote] > [Setting] (techniniai > IR
nuotolinio valdymo pultas > nustatymas)
nustatykite kaip [On] (įjungta).

Išsikrovė maitinimo
elementas arba netinkami
maitinimo elemento poliai.

Pabandykite infraraudonųjų spindulių
nuotolinio valdymo pultą naudoti šalia
įrenginio IR jutiklio. Jei LED lemputė
POWER mirksi, maitinimo elementą
pakeiskite.

Neužbaigta pradinė
sąranka.

Užbaikite pradinę sąranką naudodami
žiniatinklio programą.

Pasukimo /
pakreipimo funkcija
veikia lėtai.

Pasukimo / pakreipimo
greitis infraraudonųjų
spindulių nuotolinio
valdymo pultu
perjungiamas į įprastą
režimą.

Galiniame skydelyje 4 jungiklį SETUP
nustatykite į padėtį ON (įjungta).

Bandote valdyti
kitą fotoaparatą nei
numatyta.

Infraraudonųjų spindulių
signalą gauna kitas
fotoaparatas nei
numatyta.

Norimo valdymo fotoaparato žiniatinklio
meniu [Technical] > [IR Remote] >
[Setting] (techniniai > IR nuotolinio
valdymo pultas > nustatymas) nustatykite
kaip [Off] (išjungta).

Požymis Priežastis Sprendimas

Neprijungtas
fotoaparato
maitinimo
tiekimas.

Patikrinkite, ar fotoaparato lemputė
POWER šviečia žalia arba oranžine
spalva.

Fotoaparatas
arba nuotolinis
valdiklis nėra
prijungtas prie

Patikrinkite fotoaparato ir nuotolinio
valdiklio ryšius.
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Žiniatinklio programa

Fotoaparato nepavyksta
valdyti naudojant RM-IP500
nuotolinį valdiklį.

tinklo.

Nebuvo atlikti
pradinė
fotoaparato
sąranka.

Užbaikite pradinę sąranką naudodami
žiniatinklio programą.

Neįjungtas
VISCA per IP
ryšys.

Fotoaparato jungčių skydelyje 2 jungiklį
SETUP nustatykite į padėtį ON (įjungta)
ir paleiskite įrenginį iš naujo.

Pakeistas
fotoaparato IP
adresas.

Fotoaparato IP adresą patikrinkite
žiniatinklio meniu arba fotoaparato meniu
naudodami [Network] > [Wired LAN]
(tinklas > laidinis LAN).

Fotoaparato IP adresas buvo
pakeistas naudojant RM-
IP500 nuotolinio valdiklio
funkciją AUTO IP SETUP.

Praėjo daugiau
nei 20 min. nuo
fotoaparato
paleidimo.

Paleiskite fotoaparatą iš naujo. IP adresą
galima pakeisti naudojant funkciją AUTO
IP SETUP per pirmąsias 20 min. nuo
fotoaparato paleidimo.

Požymis Priežastis Sprendimas

Neprijungtas 5e ar
aukštesnės
kategorijos LAN
kabelis.

Prijunkite 5e ar aukštesnės kategorijos LAN
kabelį.

Nepavyko
tinkamai
prisijungti prie
LAN tinklo arba
prijungtas tinklas
veikia netinkamai.

Patikrinkite, ar šviečia LAN jungties LED lemputė
LINK. Jei LED lemputė LINK nešviečia, kreipkitės
į savo tinklo administratorių.

Neprijungtas
fotoaparato
maitinimo
tiekimas.

Žr. anksčiau esančią dalį „Maitinimo tiekimas“.

Įrenginiui
nesukonfigūruotas
tinkamas IP
adresas.

Atlikite tinklo nustatymą iš naujo.

Sukonfigūruotas
IP adresas jau
naudojamas
kitame įrenginyje.

Patikrinkite, ar prijungtų įrenginių IP adresai yra
unikalūs.
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Nepavyksta
prisijungti naudojant
žiniatinklio naršyklę.

Sukonfigūruota
potinklio kaukė
nesutampa su
naudojamo tinklo
potinkliu.

Atlikite tinklo nustatymą iš naujo.

Prie įrenginio
jungiamasi
naudojant tą patį
vietinį tinklą per
tarpinį serverį.

Pakeiskite konfigūraciją taip, kad nebūtų
naudojamas tarpinis serveris.

Sukonfigūruota
įrenginio
numatytoji tinklo
sąsaja yra
neteisinga.

Atlikite tinklo nustatymą iš naujo.

Įvestas
neteisingas URL.

Įveskite teisingą URL ir bandykite dar kartą.

Neteisingas HTTP
prievadas.

Įjunkite fotoaparato meniu išoriniame monitoriuje
ir patikrinkite [Network] > [Wired LAN] > [HTTP
Port] (tinklas > laidinis LAN > HTTP prievadas)
nustatymą. Jei sukonfigūruota kita reikšmė nei
80, įtraukite HTTP prievado numerį į pagrindinio
kompiuterio pavadinimą arba IP adresą, kurį
įvedėte į žiniatinklio naršyklę.
Pavyzdys: jei HTTP prievadas yra 8080, įveskite
http://<IP adresas>:8080

Įrenginio HTTP
prievado numeris
filtruojamas arba
blokuojamas.

Pakeiskite įrenginio HTTP prievado numerį tokiu
prievadu, kuris nebūtų filtruojamas arba
blokuojamas.

Neigiamą efektą
sukuria sena
žiniatinklio
naršyklės talpykla.

Ištrinkite talpyklą iš žiniatinklio naršyklės.

Nepavyksta
prisijungti prie
žiniatinklio
programos
naudojant 2D kodą
(QR kodą).

Naudojamas
įrenginys
nepalaiko mDNS.

Naudokite įrenginį, kuris palaiko mDNS. 
Jei naudojate įrenginį, kuris nepalaiko mDNS, IP
adresą įveskite tiesiogiai į žiniatinklio naršyklę.

Planšetinis
kompiuteris arba
kompiuteris yra
prijungtas prie kito
tinklo nei
fotoaparatas.

Planšetinį kompiuterį arba kompiuterį prijunkite
prie to paties tinklo kaip ir fotoaparatas.
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Nepavyksta
prisijungti prie
žiniatinklio
programos rankiniu
būdu įvedant URL.

Naudojamas
įrenginys
nepalaiko mDNS.

Naudokite įrenginį, kuris palaiko mDNS.

Planšetinis
kompiuteris arba
kompiuteris yra
prijungtas prie kito
tinklo nei
fotoaparatas.

Planšetinį kompiuterį arba kompiuterį prijunkite
prie to paties tinklo kaip ir fotoaparatas.

Nuolat rodomas
autentiškumo
patvirtinimo
ekranas.

Neįvestas
teisingas
naudotojo vardas
arba slaptažodis.

Įveskite registruotą naudotojo vardą ir slaptažodį.
Jei pamiršote registruotą naudotojo informaciją,
žr. „Jungiklis RESET“ dalyje „Jungčių blokas“ ir
atkurkite pradines prisijungimui prie tinklo
naudojamos informacijos reikšmes.

Naudotojo vardą ir
slaptažodį galėjo
pakeisti
naudotojas,
prisijungęs per
kitą žiniatinklio
naršyklę.

Pasiteiraukite fotoaparato administratoriaus, ar
naudotojo vardas ir slaptažodis yra teisingi.

Fotoaparato vaizdas
nerodomas
žiniatinklio
programoje.

Fotoaparato
HDMI išvestis
nustatyta kaip
720×480 arba
720×576.

Pakeiskite fotoaparato HDMI išvesties raišką.

Prijungtas HDMI
monitorius, kuris
nepalaiko
fotoaparato HDMI
išvesties signalo.

Atjunkite HDMI monitorių arba naudokite HDMI
monitorių, kuris palaiko HDMI išvesties signalą.

Įrenginys buvo
paleistas iš naujo,
o seansas
nutrauktas.

Palaukite apie minutę ir iš naujo įkelkite
žiniatinklio naršyklę.

Neigiamą efektą
sukuria sena
žiniatinklio
naršyklės talpykla.

Ištrinkite talpyklą iš žiniatinklio naršyklės.

Žiniatinklio
programoje rodomo
fotoaparato vaizdo

Žiniatinklio
programoje
naudojama 3
vaizdo

Padidinkite reikšmę žiniatinklio meniu naudodami
[Stream] > [Video Stream] > [Size 3] (transliacija
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Vaizdų fiksavimas

Fotoaparatas

raiška yra maža.
transliacijos raiška
yra nustatyta kaip
maža.

> vaizdo transliacija > 3 dydis).

Paspaudus mygtuką
[MENU]
neparodomas
fotoaparato meniu.

Fotoaparato
meniu
sukonfigūruotas
taip, kad nebūtų
įtrauktas į HDMI
išvesties signalą.

Žiniatinklio meniu [Monitoring] > [Output Display]
> [HDMI/Stream] (stebėjimas > išvesties
rodymas > HDMI / transliacija) nustatykite kaip
[On] (įjungta).

Nustatymo reikšmė
nustatymų ekrane
neatnaujinama /
rodoma netinkamai.

Žiniatinklio
programos
nustatymų ekrane
automatiškai
neparodomi kitoje
žiniatinklio
programoje
pakeisti
nustatymai.

Žiniatinklio programos nustatymų ekrano
apačioje paspauskite mygtuką [Reload] (įkelti iš
naujo). Rodomame sąrankos ekrane esančios
nustatymų reikšmės įkeliamos iš naujo ir
atnaujinamos.

Tam turi įtakos
laikinųjų interneto
failų nustatymai.

Ištrinkite talpyklą iš žiniatinklio naršyklės.

Nepavyksta
atsisiųsti
konfigūracijos failo
arba žurnalo.

Išjungta
žiniatinklio
naršyklės failų
atsisiuntimo
funkcija.

Įjunkite žiniatinklio naršyklės failų atsisiuntimo
funkciją.

Žiniatinklio
programos
nustatymų ekraną
galima pasiekti, bet
negalima atlikti
veiksmų tiesioginio
valdymo ir atkūrimo
valdymo ekranuose.

Žiniatinklio
programos
valdymo ekranas
užrakintas.

Valdymo užrakto jungiklį žiniatinklio programos
viršutiniame dešiniajame kampe nustatykite
padėtį  (valdymas atrakintas).

Žiniatinklio
programos ekranui
parodyti reikia šiek
tiek laiko.

Transliuojamą
įrenginio vaizdą
vienu metu žiūri
keli naudotojai.

Sumažinkite naudotojų skaičių, kuriam leidžiama
vienu metu naudotis žiniatinklio programa.

Požymis Priežastis Sprendimas
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Pasukimas / pakreipimas

Pasukimo / pakreipimo operacijos
pradžioje ir pabaigoje vaizdas
atrodo iškraipytas.

Vaizdas gali būti iškraipytas, jei
įjungta objektyvo vaizdo
stabilizavimo funkcija.

Išjunkite objektyvo
vaizdo
stabilizavimo
funkciją.

Naudotojui neatlikus veiksmų
pasikeičia matymo kampas.

Įvyko objektyvo pulsavimas.
Žr. „Pulsuojantis
kompensavimas“.

Negalima naudotis fokusavimo,
priartinimo ar diafragmos
funkcijomis.

Nustatymų jungikliai ant
objektyvo gali būti netinkamose
padėtyse.

Žr. „Objektyvo
jungiklių tikrinimas“.

Požymis Priežastis Sprendimas

Nepavyksta iš
naujo nustatyti
pasukimo /
pakreipimo.

Pasukimo /
pakreipimo
užrakto svirtelė
yra padėtyje
LOCK.

Paslinkite pasukimo / pakreipimo užrakto svirtelę į
padėtį UNLOCK (atrakinta).

Fotoaparatas
nesustoja
numatytoje
padėtyje.

Išsibalansavo
fotoaparato
blokatorius.

Fotoaparato blokatorių perkelkite pirmyn / atgal į
reikiama padėtį, kaip aprašyta dalyje „Objektyvo
uždėjimas“, tada vėl įjunkite įrenginį.

Uždėtas pasukimo
/ pakreipimo
nepalaikantis
objektyvas.

Žr. objektyvų suderinamumo informaciją ir uždėkite
pasukimą / pakreipimą palaikantį objektyvą, tada
vėl įjunkite fotoaparatą.

Nepavyksta iš
naujo nustatyti
pasukimo /
pakreipimo
funkcijos.

Atlikite pasukimo / pakreipimo funkcijos nustatymą
iš naujo, kaip aprašyta dalyje „Pasukimo /
pakreipimo nustatymas iš naujo“.

Fotoaparato
galvutė buvo
veikiama netikėtos
jėgos, todėl įvyko
pasukimo /
pakreipimo
valdymo klaida.

Fotoaparatas
negrįžta į
priekinę padėtį,
kai
paspaudžiamas
mygtukas [Pan-

Suaktyvintas
montavimo prie
lubų režimas.

Žiniatinklio meniu [Pan-Tilt] > [P/T Direction] >
[Ceiling] (pasukimas / pakreipimas > pasukimo /
pakreipimo kryptis > lubos) nustatykite pagal esamą
montavimo būdą, tada vėl įjunkite fotoaparatą. Jei
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Tilt Home]
(pasukimo /
pakreipimo
pradžia).

montuojama prie lubų, jungčių blokas yra
fotoaparato priekyje.

Apribotas
pasukimo /
pakreipimo
funkcijos
veikimas.

Sukonfigūruotas
pasukimo /
pakreipimo
diapazono
apribojimas.

Prireikus pašalinkite pasukimo / pakreipimo
diapazono apribojimo nustatymus, kaip aprašyta
dalyje „Pasukimo / pakreipimo diapazono
apribojimas“.

Fotoaparato
galvutė buvo
veikiama netikėtos
jėgos, todėl įvyko
pasukimo /
pakreipimo klaida.

Atlikite pasukimo / pakreipimo funkcijos nustatymą
iš naujo, kaip aprašyta dalyje „Pasukimo /
pakreipimo nustatymas iš naujo“.

Pasukimo /
pakreipimo
funkcija
fotoaparatą
pasuko į
priešingą pusę.

Montavimo prie
lubų režimo
nustatymas
skiriasi nuo
esamos
montavimo
būsenos.

Žiniatinklio meniu [Pan-Tilt] > [P/T Direction] >
[Ceiling] (pasukimas / pakreipimas > pasukimo /
pakreipimo kryptis > lubos) nustatykite pagal esamą
montavimo būdą.

Pakeisti su
pasukimo /
pakreipimo
kryptimi susiję
nustatymai.

Žiniatinklio meniu patikrinkite [Pan-Tilt] > [P/T
Direction] (pasukimas / pakreipimas > pasukimo /
pakreipimo kryptis) nustatymus.

Pasukimo /
pakreipimo
operacijos
pradžioje ir
pabaigoje
vaizdas juda
nesklandžiai.

Per didelis
pasukimo /
pakreipimo
spartinimo /
lėtinimo
nustatymas.

Sumažinkite pasukimo / pakreipimo spartinimo /
lėtinimo nustatymą, kad pasukimo / pakreipimo
operacijos pradžioje ir pabaigoje judėjimas būtų
sklandesnis – žiniatinklio meniu arba fotoaparato
meniu naudokite [Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] (pasukimas / pakreipimas >
pasukimo / pakreipimo spartinimas > kylanti kreivė).
Atminkite, kad dėl to objektyvui reikės daugiau laiko
didžiausiam greičiui pasiekti.

Pasukimo /
pakreipimo
funkcija sustojo.

Išsibalansavo
fotoaparato
blokatorius.

Fotoaparato blokatorių perkelkite pirmyn / atgal į
reikiama padėtį, kaip aprašyta dalyje „Objektyvo
uždėjimas“, tada vėl įjunkite įrenginį.

Kylančios kreivės
(spartinimo /
lėtinimo)
nustatymas yra
per didelis pagal
uždėtą objektyvą.

Jei uždėtas didelis objektyvas, žiniatinklio meniu
arba fotoaparato meniu [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] (pasukimas /
pakreipimas > pasukimo / pakreipimo spartinimas >
kylanti kreivė) reikšmę sumažinkite.
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Naudojamas
didelis objektyvas.

Kreipkitės į „Sony“ palaikymo tarnybos atstovą.

Veikiant
pasukimo /
pakreipimo
funkcijai
įrenginiui kažkas
trukdo.

Objektyvo atramos
pagrindo tvirtinimo
varžto
spaudžiamoji
svirtelė atsiremia į
fotoaparatą.

Objektyvo atramos pagrindo tvirtinimo varžto
spaudžiamąją svirtelę pasukite taip, kad ji būtų
nukreipta į viršų.

Objektyvo atramos
spaudžiamoji
svirtelė atsiremia į
fotoaparatą.

Objektyvo atramos spaudžiamąją svirtelę pasukite
taip, kad ji būtų nukreipta į viršų.

Fotoaparato
galvutės užrakto
svirtelė atsiremia į
fotoaparatą.

Patikrinkite, ar fotoaparato galvutės užrakto svirtelė
yra visiškai padėtyje LOCK.

Veikiant
pasukimo /
pakreipimo
funkcijai girdimas
neįprastas
triukšmas.

Fotoaparatas
išsibalansavo.

Perkelkite fotoaparato galvutę pirmyn / atgal į
reikiamą padėtį, kad slankusis pagrindas būtų
horizontalus.

Kylančios kreivės
(spartinimo /
lėtinimo)
nustatymas yra
per didelis pagal
uždėtą objektyvą.

Jei uždėtas didelis objektyvas, žiniatinklio meniu
arba fotoaparato meniu [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] (pasukimas /
pakreipimas > pasukimo / pakreipimo spartinimas >
kylanti kreivė) reikšmę sumažinkite.

Fotoaparato
galvutė
neužfiksuojama
padėtyje, o
veikiant girdimas
judėjimo
triukšmas.

Fotoaparato galvutės užrakto svirtelę nustatykite į
padėtį LOCK.

Nepavyksta
išsaugoti ar įkelti
išankstinio
nustatymo

Išankstinių
nustatymų
išsaugojimas ir
įkėlimas
negalimas, kai
[Zoom Type]
(priartinimo tipas)
nustatyta kaip
[On(Clear Image
Zoom)] (įjungta
(„Clear Image
Zoom“).

Fotoaparato meniu [Technical] > [Zoom] > [Zoom
Type] (techniniai > priartinimas > priartinimo tipas)
nustatykite kaip [Optical Zoom Only] (tik optinis
priartinimas).
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Įrašymas / atkūrimas

Žiniatinklio
programos
kadravimo
valdymo skydelis
yra užpilkintas ir
juo negalima
naudotis.

Kai rodomas
miniatiūrų ekranas
arba atkuriamas
įrašas, pasukimo /
pakreipimo
funkcija neveikia.

Išjunkite miniatiūrų ekraną arba sustabdykite
atkūrimą.

Pasukimo /
pakreipimo
funkcija neveikia,
jei fotoaparato
vaizdo nėra
galimybės rodyti
žiniatinklio
programoje.

Žr. „Žiniatinklio programa“ dalyje „Trikčių šalinimas“.

Pasukimo /
pakreipimo
užrakto svirtelė
yra padėtyje
LOCK.

Paslinkite pasukimo / pakreipimo užrakto svirtelę į
padėtį UNLOCK (atrakinta).

Žiniatinklio
programoje po
kadravimo
valdymo skydeliu
rodomas
pranešimas
„Execute Pan-Tilt
Reset“ (atlikite
pasukimo /
pakreipimo
nustatymą iš
naujo).

Fotoaparato
galvutė buvo
veikiama netikėtos
jėgos, todėl įvyko
pasukimo /
pakreipimo klaida.

Atlikite pasukimo / pakreipimo funkcijos nustatymą
iš naujo, kaip aprašyta dalyje „Pasukimo /
pakreipimo nustatymas iš naujo“.

Požymis Priežastis Sprendimas

Filmavimas
nepasileidžia,
kai
paspaudžiate
filmavimo

Atminties kortelė
užpildyta.

Pakeiskite atminties kortelę kita, kurioje yra
pakankamai laisvos vietos.

Atminties kortelę reikia
taisyti.

Atminties kortelę pataisykite, kaip aprašyta dalyje
„Atminties kortelių taisymas“.

Įrenginys veikia
naudodamas PoE++
maitinimą.

Prijunkite maitinimą prie jungties DC IN
naudodami kintamosios srovės adapterį.
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Failų perdavimas

IP transliacija

mygtuką
START/STOP.

Įrašymo / įspėjimo
lemputė yra
sukonfigūruota kaip
įspėjimo lemputė, todėl
įrašymo būsenos pagal
šią lemputę negalima
nustatyti.

Įrašymo / įspėjimo lemputę sukonfigūruokite kaip
įrašymo lemputę, kaip aprašyta dalyje
„Įspėjamojo signalo prijungimas“.

Neįrašomas
garsas.

Neprijungtas
mikrofonas.

Prijunkite mikrofoną ar garso įrenginį prie jungčių
bloke esančios jungties AUDIO IN.

Nustatyta mažiausia
nustatymo [Master Input
Level] (pagrindinis
įvesties lygis) reikšmė.

Sureguliuokite nustatymą [Master Input Level]
(pagrindinis įvesties lygis).

Įrašytas
garsas
iškraipytas.

Per didelis garso
įvesties lygio
nustatymas.

Sureguliuokite nustatymus nuo [CH1 Input Level]
(CH1 įvesties lygis) iki [CH4 Input Level] (CH4
įvesties lygis) ir [Master Input Level] (pagrindinis
įvesties lygis).

Įrašytas
garsas
pasižymi
aukštu
triukšmo lygiu.

Per mažas garso
įvesties lygio
nustatymas.

Sureguliuokite nustatymus [Audio Input Level]
(garso įvesties lygis) ir [Audio] > [Audio] > [Audio
Input] > [AUDIO IN CH1 MIC Ref.] (garsas >
garsas > garso įvestis > AUDIO IN CH1 MIC
Ref.) arba [AUDIO IN CH2 MIC Ref.] (AUDIO IN
CH2 MIC Ref.).

Nepavyksta
atkurti klipų.

Klipas redaguojamas.
Klipų atkurti nepavyks, jei pakeitėte failų
pavadinimus ar aplankus arba jei klipą naudoja
kompiuteris. Tai nėra gedimas.

Klipas buvo įrašytas kitu
fotoaparatu, ne šiuo
įrenginiu.

Kitu fotoaparatu (ne šiuo įrenginiu) įrašytų klipų
gali nepavykti paleisti arba jie gali būti rodomi
netinkamo dydžio. Tai nėra gedimas.

Požymis Priežastis Sprendimas

Nepavyko
įkelti failo.

Serveryje nurodytas
neteisingas naudotojo vardas
ir slaptažodis.

Serveryje gali būti nurodytas neteisingas
naudotojo vardas ir slaptažodis. Įveskite
teisingus įrašus.

Požymis Priežastis Sprendimas

Norint peržiūrėti Jei įrenginio transliacijos formatas
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Transliacija
negalima.

transliacijas iš įrenginio,
kliento programoje
įvestas neteisingas
naudotojo vardas arba
slaptažodis.

nustatytas kaip [RTSP], [SRT-Listener]
(SRT gavėjas) arba [NDI|HX], kliento
programoje būtina įveskite šio įrenginio
naudotojo vardą ir slaptažodį. Įveskite
teisingą naudotojo vardą ir slaptažodį.

Transliacijos protokolas
nesukonfigūruotas, o
transliacijos režimas
nustatytas kaip
[RTSP/SRT] arba
[Listener/NDI] (gavėjas
/ NDI).

Žiniatinklio meniu pasirinkite numatytą
protokolą naudodami [Stream] > [Stream
Setting] (transliacija > transliacijos
nustatymas).

Nustatyti šeši ar
daugiau RTSP seansai.

Nustatykite mažesnį seansų skaičių –
penkis ar mažiau.

Neteisingai nustatytas
UDP prievado numeris.

Žiniatinklio meniu nustatykite numatyto
protokolo prievado numerį ir kitus
nustatymus naudodami [Stream] > [Stream]
> [Stream Setting] (transliacija > transliacija
> transliacijos nustatymas).

Blokuojamas UDP
ryšys.

Patikrinkite apsaugos programinės įrangos
nustatymus.

Netransliuojamas
garsas.

Garso išvesties
transliacija nustatyta
kaip [Off] (išjungta).

Žiniatinklio meniu [Stream] > [Audio Stream]
> [Setting] (transliacija > garso transliacija >
nustatymas) nustatykite kaip [On] (įjungta).

Transliacija
nutrūko.

Transliacijos metu buvo
pakeistas protokolo
nustatymas arba
transliacijos kodeko
nustatymai.

Protokolo nustatymą ir transliacijos kodeko
nustatymus nustatykite prieš pradėdami
transliaciją.

[Video Stream 1] (1
vaizdo transliacijos)
vaizdo dydžio
negalima nustatyti
kaip 4096×2160
arba 3840×2160.

Vaizdo dydis yra
1920×1080, kai [Output
Format] (išvesties
formatas) nustatytas
kaip HDMI.

Transliacijos vaizdo dydis negali būti
didesnis nei HDMI vaizdo dydis. Žiniatinklio
meniu pakeiskite HDMI vaizdo dydį
naudodami [Monitoring] > [Output Format]
(stebėjimas > išvesties formatas).

[Video Stream 1] (1
vaizdo transliacijos)
kadrų spartos
negalima nustatyti
kaip 60 kadr./sek.
arba 50 kadr./sek.

Transliacijos kadrų
sparta nustatyta kaip
29,97 arba mažesnė.

Transliacijai naudojamą kadrų spartą riboja
sistemos dažnis. Žiniatinklio meniu
pakeiskite sistemos dažnį naudodami [Rec
Format] > [Frequency] (įrašymo formatas >
dažnis).

Nepavyksta
pasiekti [Video

[Video Stream 3] (3
Naudokite [Video Stream 1] (1 vaizdo
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Prijungimas prie išorinių įrenginių

Išorinis sinchronizavimas

Stream 3] (3 vaizdo
transliacija)
transliacijos.

vaizdo transliacija)
nepalaiko
RTSP/SRT/NDI.

transliacija) arba [Video Stream 2] (2 vaizdo
transliacija).

RTSP/SRT ekranas
neatnaujinamas /
rodomas
netinkamai.

RTSP arba SRT
naudojamas prievado
numeris filtruojamas
arba blokuojamas.

RTSP arba SRT prievado numerį pakeiskite
tokiu prievadu, kurio nefiltruotų arba
neblokuotų transliaciją priimantys įrenginiai.
Arba pakeiskite RTSP arba SRT naudojamą
prievado numerį įrenginyje.

Vaizdas iškraipytas
arba trūkinėja.

Vaizdo informacija
perduodama
netinkamai dėl ryšio
kelio apkrovos.

Sumažinkite transliacijos spartą bitais arba
[Video Stream 2] (2 vaizdo transliacija)
kodeką ([Codec 2]) nustatykite kaip [OFF]
(išjungta), kad ryšio dažnių juostoje būtų
sukurta riba.

Ryšio kanale pasikeitė
vaizdo paketų tvarka.

Fotoaparate ir gavėjo įrenginyje naudokite
tą patį interneto paslaugų teikėją.

Neaptinkamas kaip
NDI įrenginys.

Transliacijos protokolas
nenustatytas kaip
NDI|HX.

Transliacijos protokolas turi būti nustatytas
kaip NDI|HX, kad įrenginys būtų aptinkamas
kaip NDI įrenginys. Žiniatinklio meniu
[Stream] > [Stream Setting] (transliacija >
transliacijos nustatymas) nustatykite kaip
[NDI|HX].

Negalima naudoti
kaip NDI įrenginio.

Neįdiegta NDI|HX
licencija.

Įdiekite NDI|HX licenciją. Patikrinti, ar turite
NDI|HX licenciją, galite žiniatinklio meniu
naudodami [Stream] > [Stream] > [Stream
Setting] > [NDI|HX] > [License] (transliacija
> transliacija > transliacijos nustatymas >
NDI|HX > licencija).

Požymis Priežastis Sprendimas

Nepavyksta
sinchronizuoti
su išoriniu
šaltiniu.

Negaunamas
sukonfigūruotam vaizdo
signalo formatui tinkamas
išorinio sinchronizavimo
signalas.

Pasirūpinkite, kad būtų siunčiama
sukonfigūruotam vaizdo signalo formatui
tinkama išorinio sinchronizavimo signalo
įvestis.

Įrenginys jungiamas dviem
jungtimis.

Įrenginyje yra integruotas 75 ? terminatorius.
Junkite tiesiogiai prie signalo šaltinio (vienas
su vienu) arba naudokite skirstytuvą
(išskaidymo įrenginį).
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„Tally“ (įspėjimo lemputė)

[274] Priedas

Klaidų / įspėjimų pranešimai

Jei įrenginyje parodomas įspėjimas, perspėjimas ar susidaro sąlygos, reikalaujančios
patvirtinimo, fotoaparato vaizdo skydelyje parodomas pranešimas, o lemputė POWER ir
NETWORK priekiniame skydelyje bei įrašymo / įspėjimo lemputė pradeda mirksėti.

Pastaba

Įrašymo / įspėjimo lemputės mirksintis indikatorius veikia, tik kai žiniatinklio meniu arba fotoaparato
menu [Technical] > [Tally] > [Tally Control] (techniniai > įspėjimas > įspėjimo valdymas) nustatyta
kaip [Internal] (vidinis), o [Tally Lamp Brightness] (įspėjimo lemputės ryškumas) nustatyta kaip [Off]
(išjungta).

Klaidų pranešimai

Jei lemputė POWER ir NETWORK mirksi, kaip aprašyta toliau, atlikite toliau nurodytus
veiksmus.

Požymis Priežastis Sprendimas

Įspėjimo
lemputė
neužsidega.

Įspėjimo lemputės
ryškumas nustatytas kaip
„Off“ (išjungta).

Tinkamą ryškumą nustatykite žiniatinklio meniu
naudodami [Technical] > [Tally] > [Tally Lamp
Brightness] (techniniai > įspėjimas > įspėjimo
lemputės ryškumas).

Įrašymo / įspėjimo lemputė
sukonfigūruota kaip
įrašymo lemputė.

Įrašymo / įspėjimo lemputę sukonfigūruokite
kaip įspėjimo lemputę, kaip aprašyta dalyje
„Įspėjamojo signalo prijungimas“.

RM-IP500 prijungtas, o
VISCA per IP išjungtas.

Jungčių bloke 3 jungiklį SETUP nustatykite į
padėtį ON (įjungta).

Netinkama jungties
OPTION jungtis arba
paskirties kontaktas nėra
trumpai sujungtas su GND.

Trumpuoju jungimu sujunkite jungties OPTION 7
arba 8 kontaktą su GND, kaip aprašyta dalyje
„Įspėjamojo signalo prijungimas“.

Maitinimo
lemputė
POWER

Tinklo
lemputė

NETWORK
Priežastis ir sprendimas

Iš lėto
mirksi

Iš lėto
mirksi žalia

Įrenginys negali veikti įprastai. Išsamesnė informacija pateikiama
žiniatinklio meniu [Maintenance] > [System Log] (priežiūra >
sistemos žurnalas). Jei problema išlieka įjungus įrenginio
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Įrenginys nustos veikti, kai pasirodys toliau pateikiamas rodinys.

Įspėjantieji pranešimai

Vykdykite pateikiamus nurodymus, jei rodomi šie pranešimai.

oranžine
spalva

spalva budėjimo režimą arba išjungus ir vėl įjungus, kreipkitės į „Sony“
techninės priežiūros atstovą.

Greitai
mirksi
oranžine
spalva

Greitai
mirksi žalia
spalva

Įvyko įrenginio gedimas. Kreipkitės į „Sony“ techninės priežiūros
atstovą.

Pranešimo
rodinys

Filmavimo
/ įspėjimo
lemputė

Priežastis ir sprendimas

E + klaidos
kodas

Greitai
mirksi

Rodo netinkamą įrenginio veikimą. Įrašymas sustabdomas, net jei
fotoaparato vaizdo skydelyje rodoma ?REC. 
Išjunkite įrenginį ir patikrinkite, ar nėra problemų su prijungtais
įrenginiais, kabeliais ar laikmenomis. Jei vėl įjungus įrenginį
klaida išlieka, kreipkitės į „Sony“ techninės priežiūros atstovą.
Gali būti rodomas klaidos pranešimas arba pasigirsti įspėjamasis
garsas – tai priklauso nuo įrenginio būsenos.

Pranešimo rodinys
Filmavimo /

įspėjimo
lemputė

Priežastis ir sprendimas

„Temperature High“ (aukšta
temperatūra)

Mirksi
Aukšta vidinė temperatūra. 
Išjunkite vaizdo kamerą ir prieš pradėdami vėl
ją naudoti palaukite, kol atauš.

„Media Temperature High“
(aukšta laikmenos
temperatūra)

Mirksi
Aukšta „CFexpress“ kortelės temperatūra. 
Pakeiskite kortelę arba prieš pradėdami
naudoti palaukite, kol ji atauš.

„Voltage Low“ (žema įtampa) Mirksi
Į DC IN lizdą tiekiama įtampa yra žema (1
lygis). Patikrinkite maitinimo šaltinį.

„Insufficient Voltage“
(nepakankama įtampa)

Greitai
mirksi

Į DC IN lizdą tiekiama įtampa yra per žema (2
lygis). Įrašymo funkcija išjungta. 
Prijunkite kitą maitinimo šaltinį.

\„Media Near Full“ (laikmena
beveik užpildyta)

Mirksi
Liko nedaug vietos atminties kortelėje. 
Pakeiskite artimiausiu metu.

„Media Full“ (laikmena Greitai
Klipo negalima įrašyti arba nukopijuoti, nes



ILME-FR7 / ILME-FR7K | Žinynas

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/LT/print.html[11/16/2022 1:43:16 PM]

Perspėjamieji ir darbiniai pranešimai

Toliau pateikti įspėjimai ir darbiniai pranešimai gali būti rodomi ekrano centre. Vykdykite
nurodymus problemai išspręsti.

užpildyta) mirksi
nebėra vietos atminties kortelėje. 
Pakeiskite nedelsdami.

„Clips Near Full“ (klipai
beveik užpildyti)

Mirksi
Liko nedidelis kiekis klipų, kuriuos galima
įrašyti į atminties kortelę. 
Pakeiskite artimiausiu metu.

„Clips Full“ (klipai užpildyti)
Greitai
mirksi

Pasiektas maksimalus klipų skaičius, kiek
galima įrašyti į atminties kortelę. 
Daugiau klipų įrašyti arba nukopijuoti
negalima. Pakeiskite nedelsdami.

Įrašomas paskutinis klipas Mirksi

Šiuo metu filmuojamas klipas yra paskutinis,
kuris gali būti įrašytas, nes pasiektas
maksimalus klipų skaičius. 
Paruoškite naują atminties kortelę.

„(A) Life Near End“ (baigiasi
laikmenos (A) naudojimo
laikas)1)

Mirksi
Artėja atminties kortelės eksploatavimo
pabaigos data. Pakeiskite artimiausiu metu.

„Media(A) Life End“ (baigėsi
laikmenos (A) naudojimo
laikas)1)

Greitai
mirksi

Atminties kortelės eksploatavimo laikas
baigėsi. Pakeiskite nedelsdami.

„Media(A) Near Full“
(laikmena (A) beveik pilna)1) Mirksi

Kai naudojate įrašymo į abi korteles funkciją
„Simul Rec“

„Media(A) Full“ (laikmena (A)
pilna)1)

Greitai
mirksi

Kai naudojate įrašymo į abi korteles funkciją
„Simul Rec“

„Media(A) Clips Near Full“
(laikmenos (A) klipai beveik
pilni)1)

Mirksi
Kai naudojate įrašymo į abi korteles funkciją
„Simul Rec“

„Media(A) Clips Full“
(laikmenos (A) klipai pilni)1)

Greitai
mirksi

Kai naudojate įrašymo į abi korteles funkciją
„Simul Rec“

„Media(A) Last Clip Rec“ (į
laikmeną (A) įrašomas
paskutinis klipas)1)

Mirksi
Kai naudojate įrašymo į abi korteles funkciją
„Simul Rec“

„(B)“ rodoma kortelei lizde B.1)

Rodomas pranešimas Priežastis ir sprendimas
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„Backup Battery End
Please Change“ (atsarginis
maitinimo elementas išsikrovė.
Pakeiskite)

Nepakankama pagalbinės baterijos įkrova. 
Įkraukite pagalbinę bateriją.

„Unknown Media(A)1)

Please Change“ (nežinoma
laikmena (A). Pakeiskite)

Įdėta atminties kortelė, kuri buvo suskirstyta dalimis arba
kurioje yra daugiau klipų nei gali apdoroti įrenginys. 
Kortelė negali būti naudojama įrenginyje ir turi būti pakeista.

„Cannot Use Media(A)1)

Unsupported File System“
(negalima naudoti laikmenos
(A). Nepalaikoma failų
sistema)

Įstatyta kortelė, kurioje naudojama skirtinga failų sistema,
arba nesuformatuota kortelė. 
Kortelė negali būti naudojama įrenginyje ir turi būti pakeista
arba suformatuota naudojant įrenginį.

„Media Error
Media(A) Needs to be
Restored1)“ (laikmenos klaida.
Laikmeną (A) reikia taisyti)

Atminties kortelėje įvyko klaida ir kortelę reikia sutaisyti. 
Atlikite atminties kortelės taisymo procedūrą.

„Media Error
Cannot Record to Media(A)1)“
(laikmenos klaida. Negalima
įrašyti į laikmeną (A)

Atminties kortelė gali būti sugadinta ir nebegali būti
naudojama duomenims įrašyti. 
Atkūrimas yra galimas, todėl rekomenduojama padaryti
kopiją ir pakeisti atminties kortelę.

„Media Error
Cannot Use Media(A)1)“
(laikmenos klaida. Negalima
naudoti laikmenos (A)

Atminties kortelė gali būti sugadinta ir negali būti
naudojama duomenims įrašyti arba atkurti. 
Kortelė negali būti naudojama įrenginyje ir turi būti pakeista.

„Media(A) Error1)

Recording Halted
Playback Halted“ (laikmenos
(A) klaida. Įrašymas
sustabdytas. Atkūrimas
sustabdytas)

Įrašymas ir atkūrimas buvo sustabdytas, nes įvyko klaida
naudojant atminties kortelę. 
Jei problema išlieka, pakeiskite atminties kortelę.

„Media Reached Rewriting
Limit
Change Media(A)1)“ (pasiektas
laikmenos perrašymo
apribojimas. Pakeiskite
laikmeną (A)

Atminties kortelės eksploatavimo laikas baigėsi. 
Padarykite atsarginę kopiją ir nedelsdami pakeiskite
kortelę. Jei toliau naudosite kortelę, gali nepavykti į ją įrašyti
arba iš jos atkurti duomenis. 
Išsamios informacijos rasite atminties kortelės naudojimo
instrukcijose.

Nurodytas adresas yra
negaliojantis.

Nurodytas adresas yra negaliojantis. 
Patikrinkite, ar nustatymas teisingas.

„Cannot Use Specified Port
Number“

Nurodytas prievado numeris yra negaliojantis. 
Patikrinkite, ar nustatymas teisingas.

Aptikta objektyvo I/F ryšio klaida, kai prijungtas objektyvas
su E tipo tvirtinimu. 
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[275] Priedas

Meniu elementų sąrašas

Toliau esančiose lentelėse pateikiamas įrenginio meniu elementų sąrašas.

Legenda
„Fotoaparato meniu“ ir „žiniatinklio meniu“
?: galimas
?: galima kai kurie elementai
–: negalima

„All File“ (ALL failas) ir Scene File“ (scenos failas)
Taip: elementas išsaugomas ALL faile arba scenos faile
Ne: elementas neišsaugomas

„All Reset (except for Network Settings)“ (viską nustatyti iš naujo) (išskyrus tinklo
nustatymus)
Kai žiniatinklio meniu pasinaudojama [Reset]> [Reset] > [All Reset (except for Network
Settings)] (nustatyti iš naujo > nustatyti iš naujo > (visą nustatyti iš naujo) (išskyrus tinklo
nustatymus):
Taip: inicijuotas elementas (be tinklo nustatymų)
Ne: netaikoma

„Network Reset“ (tinklo nustatymas iš naujo)
Kai žiniatinklio meniu paleidžiama [Reset]> [Reset] > [Network Reset] (nustatyti iš naujo >
nustatyti iš naujo > tinklo nustatymas iš naujo):
Taip: inicijuotas elementas (tinklo nustatymas)
Ne: netaikoma

„Lens I/F Error(xx:xx)“
Patikrinkite objektyvo su E tipo tvirtinimu ryšio būseną. 
Jei problema išlieka, kreipkitės į savo „Sony“ techninės
priežiūros atstovą ir pateikite klaidos kodą (penki simboliai
skliaustuose).

„Cannot add auto upload job of
Proxy file because maximum
number of upload jobs was
reached.“

Pasiektas maksimalus persiuntimo užduočių skaičius. 
Pašalinkite visas nereikalingas užduotis. Taip pat gali būti
neteisingas mažesnės raiškos failų automatinio nusiuntimo
paskirties vietos nustatymas. Patikrinkite, ar nustatymas
teisingas.

„Fan Stopped“

Nustojo veikti ventiliatorius. 
Patikrinkite, ar viduje nėra dulkių ar pašalinių medžiagų. 
Jei problema išlieka pašalinus dulkes ir pašalinius daiktus,
kreipkitės į „Sony“ techninės priežiūros atstovą.

„(B)“ rodoma kortelei lizde B.1)
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„Factory Default“ (gamyklinis numatytasis nustatymas)
Taip: elementas nustatytas iš naujo atkuriant gamyklinę numatytąją reikšmę
Ne: netaikoma

Vaizdų fiksavimas

Elementas 
(2 lygis)

Fotoaparato
meniu

Žiniatinklio
meniu

„All
File“
(ALL

failas)

„Scene
File“

(siužeto
failai)

„All Reset
(except for

Network
Settings)“

(viską
nustatyti iš

naujo)
(išskyrus

tinklo
nustatymus)

„Network
Reset“
(tinklo

nustatymas
iš naujo)

„Factory
Default“

(gamyklinis
numatytasis
nustatymas)

„ISO/Gain/EI“
(ISO /
stiprinimas /
EI)

? – Taip Taip Taip Taip Taip

„ND Filter“
(ND filtras)

? – Taip Taip*1 Taip Ne Taip

Shutter ? – Taip Taip Taip Ne Taip

Diafragma ? – Taip Taip Taip Ne Taip

„Auto
Exposure“
(automatinė
ekspozicija)

? – Taip Taip*2 Taip Ne Taip

Baltas ? – Taip Taip*3 Taip Ne Taip

„White
Setting“
(baltos
spalvos
balanso
nustatymas)

? – Taip Ne Taip Ne Taip

„Offset White“
(baltos
spalvos
balanso
poslinkis)

? – Taip Ne Taip Ne Taip

Fokusavimas ? ? Taip Ne Taip Ne Taip
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Projektas

„S&Q Motion“ ? – Taip Ne Taip Ne Taip

„LUT On/Off“
(LUT
įjungimas /
išjungimas)

? – Taip Ne Taip Ne Taip

„Noise
Suppression“
(triukšmo
slopinimas)

? – Taip Taip Taip Ne Taip

„Flicker
Reduce“
(mirgėjimo
sumažinimas)

? – Taip Ne Taip Ne Taip

SteadyShot ? – Taip Ne Taip Ne Taip

[Mode] (režimas) netaikoma*1
[Clip High light] (ryškios šviesos ribojimas), [Detect Window] (lango aptikimas), [Average Peak Level Ratio]
(vidutinis išryškinimo lygio santykis), [Custom Width] (pasirinktinis plotis), [Custom H Position] (pasirinktinė H
padėtis), [Custom V Position] (pasirinktinė V padėtis) netaikoma

*2

[Preset White] (iš anksto nustatytas baltos spalvos balansas) netaikoma*3

Elementas 
(2 lygis)

Fotoaparato
meniu

Žiniatinklio
meniu

„All
File“
(ALL

failas)

„Scene
File“

(siužeto
failai)

„All Reset
(except for

Network
Settings)“

(viską
nustatyti iš

naujo)
(išskyrus

tinklo
nustatymus)

„Network
Reset“
(tinklo

nustatymas
iš naujo)

„Factory
Default“

(gamyklinis
numatytasis
nustatymas)

„Base Setting“
(bazinis
nustatymas)

? ? Taip Ne Taip Ne Taip

„Rec Format“
(įrašymo
formatas)

? ? Taip Ne Taip*1 Ne Taip

„Cine EI
Setting“
(„Cine EI“
nustatymas)

? – Taip Ne Taip Ne Taip

„Simul Rec“
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„Paint/Look“ (piešinys / vaizdas)

(sinchroniškas
įrašymas)

? ? Taip Ne Taip Ne Taip

„Proxy Rec“
(įrašymas
mažesne
raiška)

? ? Taip Ne Taip Ne Taip

„Interval Rec“
(filmavimas
intervalais)

? ? Taip*2 Ne Taip Ne Taip

„Picture
Cache Rec“
(nuotraukų
talpyklos
įrašymas)

? ? Taip*2 Ne Taip Ne Taip

„SDI/HDMI
Rec Control“
(SDI/HDMI
įrašymo
valdymas)

? – Taip Ne Taip Ne Taip

Priskiriamas
mygtukas

? – Taip Ne Taip Ne Taip

„All File“ (ALL
failas)

– ? Ne Ne Ne Ne Ne

[Frequency] (dažnis) netaikoma*1
[Setting] (nustatymas) netaikoma*2

Elementas 
(2 lygis)

Fotoaparato
meniu

Žiniatinklio
meniu

„All
File“
(ALL

failas)

„Scene
File“

(siužeto
failai)

„All Reset
(except for

Network
Settings)“

(viską
nustatyti iš

naujo)
(išskyrus

tinklo
nustatymus)

„Network
Reset“
(tinklo

nustatymas
iš naujo)

„Factory
Default“

(gamyklinis
numatytasis
nustatymas)

„Scene File“
(siužeto
failai)

? – Ne Ne Ne Ne Ne

„Base Look“
*1 *1 *1
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„Pan-Tilt“ (pasukimas / pakreipimas)

(bazinis
vaizdas)

? ? Taip Ne Taip Ne Taip

„Reset
Paint
Settings“
(atkurti
piešinio
nustatymus)

? – Ne Ne Ne Ne Ne

Juodas ? – Taip Taip Taip Ne Taip

Knee ? – Taip Taip Taip Ne Taip

Detail ? – Taip Ne Taip Ne Taip

„Matrix“
(matrica)

? – Taip Taip Taip Ne Taip

„Multi
Matrix“
(daugybinė
matrica)

? – Taip*2 Taip*2 Taip Ne Taip

LUT duomenims, importuotiems kaip baziniam vaizdui, netaikoma*1
[Axis] (ašis) netaikoma*2

Elementas 
(2 lygis)

Fotoaparato
meniu

Žiniatinklio
meniu

„All
File“
(ALL

failas)

„Scene
File“

(siužeto
failai)

„All Reset
(except for

Network
Settings)“

(viską
nustatyti iš

naujo)
(išskyrus

tinklo
nustatymus)

„Network
Reset“
(tinklo

nustatymas
iš naujo)

„Factory
Default“

(gamyklinis
numatytasis
nustatymas)

„P/T Speed“
(P/T greitis)

– ? Ne Ne Taip Ne Ne

„P/T
Acceleration“
(P/T
spartinimas)

? ? Ne Ne Taip Ne Ne

„P/T Range
Limit“ (P/T
diapazono
apribojimas)

– ? Ne Ne Taip Ne Ne
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„TC/Media“ (laiko kodas / laikmena)

„P/T
Direction“
(P/T kryptis)

– ? Ne Ne Taip Ne Ne

„P/T Preset“
(P/T
išankstinis
nustatymas)

– ? Ne Ne Taip Ne Ne

Elementas 
(2 lygis)

Fotoaparato
meniu

Žiniatinklio
meniu

„All
File“
(ALL

failas)

„Scene
File“

(siužeto
failai)

„All Reset
(except for

Network
Settings)“

(viską
nustatyti iš

naujo)
(išskyrus

tinklo
nustatymus)

„Network
Reset“
(tinklo

nustatymas
iš naujo)

„Factory
Default“

(gamyklinis
numatytasis
nustatymas)

Laiko kodas ? – Taip*1 Ne Taip Ne Taip

„TC Display“
(TC rodymas)

? – Taip Ne Taip Ne Taip

„Users Bit“
(naudotojo
bitai)

? – Taip*1 Ne Taip Ne Taip

„HDMI TC
Out“ (HDMI
TC išvestis)

? – Taip Ne Taip Ne Taip

„Clip Name
Format“ (klipo
pavadinimo
formatas)

? – *2 Ne Taip Ne Taip

„Update
Media“
(laikmenos
naujinimas)

? – Ne Ne Ne Ne Ne

„Format
Media“
(laikmenos
formatavimas)

? – Ne Ne Ne Ne Ne
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Monitoring

Audio

„Media Life“
(laikmenos
naudojimo
laikas)

? – Ne Ne Ne Ne Ne

[Setting] (nustatymas) netaikoma*1
[Auto Naming] (automatinis pavadinimų suteikimas) taikoma, [Camera ID] (fotoaparato ID) netaikoma*2

Elementas
(2 lygis)

Fotoaparato
meniu

Žiniatinklio
meniu

„All
File“
(ALL

failas)

„Scene
File“

(siužeto
failai)

„All Reset
(except for

Network
Settings)“

(viską
nustatyti iš

naujo)
(išskyrus

tinklo
nustatymus)

„Network
Reset“
(tinklo

nustatymas
iš naujo)

„Factory
Default“

(gamyklinis
numatytasis
nustatymas)

„Output
Format“
(išvesties
formatas)

? ? Taip Ne Taip Ne Taip

„Output
Display“
(išvesties
rodymas)

– ? Taip Ne Taip Ne Taip

„Display
On/Off“
(rodymo
įjungimas /
išjungimas)

? – Taip Ne Taip Ne Taip

„Video
Signal
Monitor“
(vaizdo
signalo
stebėjimas)

? – Taip Ne Taip Ne Taip

„Marker“
(žymeklis)

? – Taip Ne Taip Ne Taip

„All Reset
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„Thumbnail“ (miniatiūra)

Elementas
(2 lygis)

Fotoaparato
meniu

Žiniatinklio
meniu

„All
File“
(ALL

failas)

„Scene
File“

(siužeto
failai)

(except for
Network

Settings)“
(viską

nustatyti iš
naujo)

(išskyrus
tinklo

nustatymus)

„Network
Reset“
(tinklo

nustatymas
iš naujo)

„Factory
Default“

(gamyklinis
numatytasis
nustatymas)

„Audio
Input“
(garso
įvestis)

? ? Taip Ne Taip Ne Taip

Garso
išvestis

? ? Taip Ne Taip Ne Taip

Elementas 
(2 lygis)

Fotoaparato
meniu

Žiniatinklio
meniu

„All
File“
(ALL

failas)

„Scene
File“

(siužeto
failai)

„All Reset
(except for

Network
Settings)“

(viską
nustatyti iš

naujo)
(išskyrus

tinklo
nustatymus)

„Network
Reset“
(tinklo

nustatymas
iš naujo)

„Factory
Default“

(gamyklinis
numatytasis
nustatymas)

„Display Clip
Properties“
(klipo savybių
rodymas)

? – Ne Ne Ne Ne Ne

„Set Clip
Flag“
(nustatyti
klipo žymę)

? – Ne Ne Ne Ne Ne

„Lock/Unlock
Clip“
(užrakinti /
atrakinti
klipą)

? – Ne Ne Ne Ne Ne

„Delete Clip“
(panaikinti
klipą)

? – Ne Ne Ne Ne Ne
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„Technical“ (techninis)

„Transfer
Clip“ (klipo
persiuntimas)

? – Ne Ne Ne Ne Ne

„Transfer Clip
(Proxy)“
(klipo
persiuntimas
žema raiška)

? – Ne Ne Ne Ne Ne

„Filter Clips“
(klipų
filtravimas)

? – Ne Ne Ne Ne Ne

„Customize
View“
(pasirinktinis
vaizdas)

? – Taip Ne Taip Ne Taip

Elementas
(2 lygis)

Fotoaparato
meniu

Žiniatinklio
meniu

„All
File“
(ALL

failas)

„Scene
File“

(siužeto
failai)

„All Reset
(except for

Network
Settings)“

(viską
nustatyti iš

naujo)
(išskyrus

tinklo
nustatymus)

„Network
Reset“
(tinklo

nustatymas
iš naujo)

„Factory
Default“

(gamyklinis
numatytasis
nustatymas)

„Color
Bars“
(spalvų
juostos)

? – *1 Ne *1 Ne Taip

„Genlock“ ? – Ne Ne Ne Ne Ne

„Tally“
(įspėjimo
lemputė)

? ? Taip Ne Taip Ne Taip

„Rec
Review“
(įrašo
peržiūra)

? – Taip Ne Taip Ne Taip

Zoom ? – Taip Ne Taip Ne Taip
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Tinklas

„IR
Remote“
(IR
nuotolinis
valdymas)

– ? Ne Ne Taip Ne Taip

Objektyvas ? – Taip Ne Taip Ne Taip

APR ? – Ne Ne Ne Ne Ne

[Type] (tipas) taikoma, [Setting] (nustatymas) netaikoma*1

Elementas 
(2 lygis)

Fotoaparato
meniu

Žiniatinklio
meniu

„All
File“
(ALL

failas)

„Scene
File“

(siužeto
failai)

„All Reset
(except for

Network
Settings)“

(viską
nustatyti iš

naujo)
(išskyrus

tinklo
nustatymus)

„Network
Reset“
(tinklo

nustatymas
iš naujo)

„Factory
Default“

(gamyklinis
numatytasis
nustatymas)

„Camera
Name“
(fotoaparato
pavadinimas)

– ? Ne Ne Ne Ne Taip

User – ? Ne Ne Ne Taip Taip

Laidinis
LAN*1 ? ? Ne Ne Ne Taip Ne

File Transfer ? ? Taip Ne Taip Taip Taip

FTP Server 1 – ? Ne Ne Taip Ne Taip

FTP Server 2 – ? Ne Ne Taip Ne Taip

FTP Server 3 – ? Ne Ne Taip Ne Taip

SSL – ? Ne Ne Ne Taip Taip

„Referer
Check“
(nuorodos
tikrinimas)

– ? Ne Ne Ne Taip Taip

„Brute Force
Attack
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Stream

Techninė priežiūra

Protection“
(apsauga
nuo grubios
jėgos atakos)

– ? Ne Ne Ne Taip Taip

Nekonfigūruojama naudojant fotoaparato meniu (tik rodoma)*1

Elementas 
(2 lygis)

Fotoaparato
meniu

Žiniatinklio
meniu

„All
File“
(ALL

failas)

„Scene
File“

(siužeto
failai)

„All Reset
(except for

Network
Settings)“

(viską
nustatyti iš

naujo)
(išskyrus

tinklo
nustatymus)

„Network
Reset“
(tinklo

nustatymas
iš naujo)

„Factory
Default“

(gamyklinis
numatytasis
nustatymas)

Transliacijos
nustatymas

– ? Ne Ne Taip*1 Ne Taip*1

„Video
Stream“
(vaizdo įrašo
transliavimas)

– ? Taip Ne Taip Ne Taip

„Audio
Stream“
(garso
transliavimas)

– ? Taip Ne Taip Ne Taip

[NDI|HX] > [License] (NDI|HX > licencija) netaikoma*1

Elementas 
(2 lygis)

Fotoaparato
meniu

Žiniatinklio
meniu

„All
File“
(ALL

failas)

„Scene
File“

(siužeto
failai)

„All Reset
(except for

Network
Settings)“

(viską
nustatyti iš

naujo)
(išskyrus

tinklo
nustatymus)

„Network
Reset“
(tinklo

nustatymas
iš naujo)

„Factory
Default“

(gamyklinis
numatytasis
nustatymas)

Kalba ? ? Taip Ne Taip Ne Taip
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[276] Priedas

Išsaugoti išankstinių nustatymų padėčių elementai

„Taip“ rodo išsaugomą išankstinio nustatymo padėties nustatymą, o „Ne“ – neišsaugomą.

Pasukimo / pakreipimo elementai

„Accessibility“
(pritaikymas
neįgaliesiems)

– ? Taip Ne Ne Ne Taip

„Clock Set“
(laikrodžio
nustatymas)

? ? Taip*1 Ne Taip*2 Ne Taip

Reset – ? Ne Ne Ne Ne Ne

„Hours Meter“
(valandų
matuoklis)

? – Ne Ne Ne Ne Ne

Information – ? Ne Ne Ne Ne Ne

„System Log“
(sistemos
žurnalas)

– ? Ne Ne Ne Ne Taip

„HTTP
Access Log“
(HTTP
prieigos
žurnalas)

– ? Ne Ne Ne Ne Taip

„Service“
(Paslauga)

– ? Ne Ne Ne Ne Ne

EULA – ? Ne Ne Ne Ne Ne

Programinė
įranga

– ? Ne Ne Ne Ne Ne

Datos ir laiko informacija netaikoma*1
[Time Zone] (laiko juosta), datos ir laiko informacija netaikoma*2

Rodymo vieta Elementas Reikšmė
išsaugoma

Pasukimo / pakreipimo padėtis Taip
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Priartinimo elementai

Fokusavimo elementai

Tiesioginio valdymo ekrano
kadravimo valdymo skydelis [Pan-Tilt Speed] (pasukimo / pakreipimo

greitis) Ne1)

[Pan-Tilt] (pasukimas /
pakreipimas) žiniatinklio meniu

[P/T Speed] (pasukimo / pakreipimo
greitis)

Ne

[P/T Acceleration] (pasukimo /
pakreipimo spartinimas)

Ne

[P/T Range Limit] (pasukimo /
pakreipimo diapazono apribojimas)

Ne

[P/T Direction] (pasukimo / pakreipimo
kryptis)

Ne

[P/T Preset] (pasukimo / pakreipimo
išankstinis nustatymas)

Ne

Galima sukonfigūruoti atskirai kiekvienai išankstinio nustatymo padėčiai. Išsamesnė informacija pateikiama
žiniatinklio meniu [Pan-Tilt] > [Preset] (pasukimas / pakreipimas > išankstinis nustatymas).

1)

Rodymo vieta Elementas Reikšmė
išsaugoma

Tiesioginio valdymo ekrano kadravimo
valdymo skydelis

Priartinimo padėtis
(fokusavimo atstumas)

Taip

[Zoom Speed] (priartinimo
greitis) Ne1)

[Technical] > [Zoom] (techniniai >
priartinimas) fotoaparato meniu

[Zoom Type] (priartinimo
tipas)

Ne

Juda didžiausiu greičiu, kai atkuriama iš anksto nustatyta padėtis.1)

Rodymo vieta Elementas Reikšmė
išsaugoma

Tiesioginio valdymo ekrano
fotoaparato vaizdo skydelis

Sekimo realiuoju laiku AF nustatyto taikinio
sekimas

Ne

Nustatytos taškinio fokusavimo koordinatės Ne

Jungiklis [Touch Focus] (jutiklinis
fokusavimas)

Ne

Jungiklis [Auto Focus] (automatinis
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[277] Priedas

Struktūrinės schemos

„Audio Input“ (garso įvestis)

 (fokusavimo) skirtukas
tiesioginio valdymo ekrane

fokusavimas)
Taip

Mygtuko [Focus Hold] (fokusavimo
užlaikymas) būsena

Ne

Mygtuko [Push AF/MF] (AF/MF spaudžiant)
būsena

Ne

[Face/Eye Detection AF] (veido / akių
aptikimo AF)

Taip

[AF Subj. Shift Sens.] (AF objekto poslinkio
jautrumas)

Taip

[AF Transition Speed] (AF keitimo greitis) Taip

„Focus position“ (fokusavimo padėtis) Taip1)

[Shooting] > [Focus] (vaizdų
fiksavimas > fokusavimas)
žiniatinklio meniu

[Push AF Mode] (AF režimas spaudžiant)
(įskaitant nustatymus naudojant
priskiriamus mygtukus)

Ne

[Touch Function in MF] (lietimo funkcijos
veikiant rankiniam fokusavimui)

Ne

[AF Assist Control] (AF pagalbos valdymas) Ne

[Shooting] > [Focus] (vaizdų
fiksavimas > fokusavimas)
fotoaparato meniu

Fokusavimo dydis ir fokusavimo padėtis,
nustatyta naudojant [Focus Area]
(fokusavimo sritis)

Taip

Fokusavimo padėtis, nustatyta naudojant
[Focus Area (AF-S)] (fokusavimo sritis (AF-
S)

Taip

Neatkuriama, kai jungiklis [Auto Focus] (automatinis fokusavimas) nustatytas į įjungimo padėtį. Atkuriama, kai
nustatyta į išjungimo padėtį.

1)
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Garso išvestis

[278] Priedas

Objektyvo su E tipo tvirtinimu programinės įrangos
naujinimas

Objektyvo su E tipo tvirtinimu programinę įrangą galite atnaujinti naudodami įrenginį.
Kuriuos objektyvus galima atnaujinti, ir atitinkamą programinę įrangą rasite objektyvų
svetainėse.
Programinė įranga atnaujinama naudojant žiniatinklio meniu.

Uždėkite E tipo tvirtinimo objektyvą ant įrenginio.1

Žiniatinklio meniu patikrinkite [Maintenance] > [Information] > [Lens] > [Model
Name] (priežiūra > informacija > objektyvas > modelio pavadinimas) ir [Version
Number] (versijos numeris).

Objektyvo su E tipo tvirtinimu programinės įrangos versijos numeris bus rodomas šone.
Patikrinkite programinės įrangos versijos numerį ir prireikus programinę įrangą atnaujinkite.

2
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Pastaba

Toliau nurodytų veiksmų neatlikite, kol naujinimas nebus baigtas.
Atjungimas nuo tinklo
Objektyvo nuėmimas
Maitinimo išjungimas

Jei parodomas pranešimas, kad atnaujinti nepavyko, patikrinkite rodomą aprašymą ir bandykite
naujinti dar kartą.

[279] Priedas

Objektyvo atlaisvinimo mygtuko dangtelio uždėjimas

Kad objektyvas nebūtų nuimtas netyčia, galite uždėti objektyvo atlaisvinimo mygtuko dangtelį,
kuris pridedamas su CIB-PCM1 lubų laikikliu (papildoma).

Atsisiųskite „Windows“ skirtą objektyvo programinės įrangos naujinimo failą (.exe
plėtiniu) į įrenginį su žiniatinklio programa.

3

Eidami į [Maintenance] > [Information] > [Lens] > [Version Up] (priežiūra >
informacija > objektyvas > versijos naujinimas), spauskite mygtuką[Choose File]
(rinktis failą) ir pasirinkite atsisiųstą naujinimo failą.

4

Vykdykite ekrane pateiktas instrukcijas.5

Uždėkite objektyvą.

Išsamesnė informacija apie objektyvo uždėjimą pateikiama dalyje „Objektyvo uždėjimas“.

1

Paslinkite pasukimo / pakreipimo užrakto svirtelę į padėtį LOCK, kad užrakintumėte
fotoaparato galvutės pasukimo / pakreipimo funkciją.

2

Fotoaparato bloką perkelkite taip, kad būtų galima uždėti objektyvo išstūmimo
apsaugos dangtelį.

3

Objektyvo išstūmimo apsaugos dangtelį uždėkite taip, kad jis uždengtų objektyvo
atlaisvinimo mygtuką.

4

Objektyvo išstūmimo apsaugos dangtelį pritvirtinkite naudodami tam skirtą
tvirtinimo varžtą.

5
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Pastaba

Tai neapsaugo objektyvo nuo visiško nuėmimo.

[280] Priedas

Licencijos

MPEG-4 AVC patentų paketo licencija

ŠIAM GAMINIUI PAGAL „AVC“ PATENTŲ PAKETO NUOSTATAS SUTEIKTA LICENCIJA,
LEIDŽIANTI VARTOTOJUI ASMENINIAIS IR NEKOMERCINIAIS TIKSLAIS
(i) UŽKODUOTI VAIZDO ĮRAŠUS PAGAL „AVC“ STANDARTO REIKALAVIMUS („AVC
VIDEO“) IR (ARBA)
(ii) DEKODUOTI „AVC“ VAIZDO ĮRAŠUS, KURIUOS UŽKODAVO VARTOTOJAS
ASMENINIAIS TIKSLAIS IR (ARBA) KURIE BUVO ĮSIGYTI IŠ VAIZDO ĮRAŠŲ TEIKĖJO,
KURIAM SUTEIKTA LICENCIJA TEIKTI „AVC“ VAIZDO ĮRAŠUS.
LICENCIJA NESUTEIKTA IR NENUMATYTA NAUDOTI JOKIAIS KITAIS TIKSLAIS.
PAPILDOMOS INFORMACIJOS GALIMA GAUTI IŠ „MPEG LA, L.L.C.“. ŽR.
HTTP://WWW.MPEGLA.COM

Programinės įrangos įsigijimas pagal GPL/LGPL licenciją

Šiame gaminyje naudojama programinė įranga, kuriai taikoma GPL / LGPL. Tai reiškia, kad
turite teisę gauti, keisti ir platinti pirminį programinės įrangos programų tekstą, laikydamiesi GPL
arba LGPL licencijos sąlygų.
Programos pirminis tekstas pateikiamas internete. Naudokite šį URL ir vykdykite atsisiuntimo
instrukcijas.
https://oss.sony.net/Products/Linux/
Mes pageidaujame, kad nesikreiptumėte į mus dėl programos pirminio teksto turinio.

„?T-Kernel“ šaltinio kodas

https://oss.sony.net/Products/Linux/
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Šiame gaminyje naudojamas „?T-Kernel“ šaltinio kodas pagal „TRON Forum“ suteiktą T
licenciją 2.1 (www.tron.org).

[281] Priedas

Specifikacijos

Bendroji informacija

Svoris
Apie 4,6 kg (10 lb 2,3 oz) (tik aparatas)
Apie 6,0 kg (13 lb 3,6 oz) (su SELP28135G objektyvu)

Matmenys
Žr. „Išoriniai matmenys“.

Su maitinimu susiję reikalavimai
19,5 V nuolatinė srovė
PoE++ (IEEE802.3bt atitinka 4 tipo 8 klasės reikalavimus)

Energijos sąnaudos
19,5 V nuolatinė srovė: 80,0 W (maks.)
PoE++: 71,3 W (maks.)?

Eksploatacinė temperatūra
Nuo 0 iki 40 °C (nuo 32 iki 104 °F)

Laikymo temperatūra
Nuo –20 iki +60 °C (nuo –4 iki +140 °F)

Įrašymo formatas (vaizdo)
XAVC Intra
XAVC-I 4K/QFHD režimas: VBR, 600 Mb/s (maks.) sparta bitais, MPEG-4 AVC/H.264
XAVC-I HD režimas: CBG, 223 Mb/s (maks.), MPEG-4 AVC/H.264

XAVC Long
XAVC-L QFHD režimas: VBR, 150 Mb/s (maks.) sparta bitais, MPEG-4 H.264/AVC
XAVC-L HD 50 režimas: VBR, 50 Mb/s (maks.), MPEG-4 H.264/AVC
XAVC-L HD 35 režimas: VBR, 35 Mb/s (maks.), MPEG-4 H.264/AVC

Įrašymo formatas (garso)
LPCM 24 bitų, 48 kHz, 4 kanalų

Įrašymo kadrų sparta
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XAVC Intra
XAVC-I 4K režimas: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
XAVC-I QFHD režimas: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-I HD režimas: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
XAVC-L QFHD režimas: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-L HD 50 režimas: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-L HD 35 režimas: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Įrašymo ir atkūrimo laikas
XAVC Intra
XAVC-I QFHD režimas: 59.94P, apie 30 min. (naudojant CEA-G160T)
XAVC-I HD režimas: 59.94P, apie 78 min. (naudojant CEA-G160T)

XAVC Long
XAVC-L QFHD režimas: 59.94P, apie 115 min. (naudojant CEA-G160T)
XAVC-L HD 50 režimas: 59.94P, apie 155 min. (naudojant CEA-G80T)
XAVC-L HD 35 režimas: 59.94P, apie 210 min. (naudojant CEA-G80T)

Pastaba

Įrašymo / atkūrimo laikas gali kisti dėl naudojimo sąlygų ir atminties charakteristikų. Įrašymo ir
atkūrimo laikai nurodyti nuolatiniam vieno klipo filmavimui. Realus laikas gali būti trumpesnis,
atsižvelgiant į įrašytų klipų skaičių.

Pasukimo / pakreipimo valdymo skyrius

Min. pasukimo greitis: 0,02 laipsn./s
Min. pakreipimo greitis: 0,02 laipsn./s
Maks. pasukimo greitis: 60 laipsn./s
Maks. pakreipimo greitis: 60 laipsn./s
Pasukimo diapazonas: nuo ?170 laipsn. iki + 170 laipsn.
Pakreipimo diapazonas: nuo ?30 laipsn. iki +195 laipsn.
Triukšmo kriterijaus vertinimas: NC35 ar žemesnis
Išankstinių nustatymų skaičius: 100

Fotoaparato skyrius

Vaizdo įrenginys
35 mm viso kadro (35,6 x 23,8 mm), „Exmor R“ CMOS jutiklis

Pikselių skaičius
Apie 12,9 megapikselių (bendras pikselių skaičius)
Apie 10,3 megapikselių (efektyvieji pikseliai)

Automatinis fokusavimas
Aptikimo metodas: fazių aptikimas / kontrasto aptikimas
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Vidiniai ND filtrai
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Tiesiškai kintamas ND: nuo 1/4ND iki 1/128ND

ISO jautrumas
ISO 800/12800 („Cine EI“ režimas, D55 šviesos šaltinis)

Objektyvo tvirtinimas
E jungtis

Platumas
15+ sustojimų

Užrakto greitis.
nuo 64F iki 1/8000 sek. (23.98P)

Užrakto kampas
nuo 5,6° iki 360°, nuo 2 iki 64 kadrų

Sulėtintas ir pagreitintas filmavimas
XAVC QFHD: nuo 1 kadr./sek. iki 120 kadr./sek.
XAVC HD: nuo 1 kadr./sek. iki 240 kadr./sek.
XAVC 4K: nuo 1 kadr./sek. iki 60 kadr./sek.
XAVC HD (S35): nuo 1 kadr./sek. iki 120 kadr./sek.

baltos spalvos balansas
nuo 2000 K iki 15000 K

Stiprinimas
nuo –3 dB iki +30 dB (1 dB žingsniu)

Bazinis vaizdas
S-Cinetone, Standard, Still, ITU709, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Garso skyrius

Diskretizavimo dažnis
48 kHz

Kvantavimas
24 bitai
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Dažnių diapazonas
XLR įvesties MIC režimas: nuo 20 Hz iki 20 kHz (±3 dB ar mažiau)
XLR įvesties LINE režimas: nuo 20 Hz iki 20 kHz (±3 dB ar mažiau)

Dinaminis diapazonas
XLR įvesties MIC režimas: 80 dB (tipinis)
XLR įvesties LINE režimas: 90 dB (tipinis)

Iškraipymas
XLR įvesties MIC režimas: 0,08 % ar mažiau (?40 dBu įvesties lygis)
XLR įvesties LINE režimas: 0,08 % ar mažiau (+14 dBu įvesties lygis)

Įvesties / išvesties skyrius

Įvestis
DC IN

Atitinka EIAJ, 19,5 V nuolatinė srovė

AUDIO IN

XLR tipo, 5 kontaktų jungtis, lizdas
LINE / MIC / MIC+48V perjungiama
MIC: nuoroda nuo ?30 dBu iki ?80 dBu

GENLOCK IN

BNC jungtis, 1,0 Vp-p, 75 ?

TC IN

Jungtis BNC

Išvestys
SDI OUT

BNC jungtis, 12G-SDI, 6G-SDI, 3G-SDI (A/B lygis), HD-SDI

HDMI

A tipo jungtis

Išvesties jungtis OPTICAL

Atitinka SFP+
* Įrenginys nepalaiko optinio signalo įvesties.

Įvestis / išvestis
LAN jungtis
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RJ-45, 1000BASE-T

Jungtis OPTION

RJ-45 įspėjimo įvesties / išvesties jungtis

Laikmenos lizdo skyrius

„CFexpress“ A tipo / SD kortelės lizdas (2)

Komplekte esantys priedai

Kintamosios srovės adapteris (1)
Maitinimo laidas (1)
Infraraudonųjų spindulių nuotolinio valdymo pultas (1)
Korpuso dangtelis (1) (pritvirtintas prie įrenginio)
HDMI kabelio laikymo plokštė (1)
Prieš naudojant šį įrenginį (1)
Garantijos knygelė (1)

Išoriniai matmenys

Matmenys pateikiami kaip apytikslės reikšmės.
Vienetai: mm (in)
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Dizainas ir specifikacijos gali būti keičiami be išankstinio įspėjimo.

[282] Priedas

Prekių ženklai

 yra „Sony Group Corporation“ prekių ženklas.
XAVC ir  yra registruotieji „Sony Group Corporation“ prekių ženklai.
HDMI ir „HDMI High-Definition Multimedia Interface“ ir HDMI logotipas yra „HDMI Licensing
Administrator, Inc.“ prekių ženklai arba registruotieji prekių ženklai JAV ir (arba) kitose
šalyse.
„Microsoft“ ir „Windows “ yra „Microsoft Corporation“ prekių ženklai arba registruotieji prekių
ženklai JAV ir (arba) kitose šalyse.
„Mac“ ir „Mac OS“ yra „Apple Inc.“ įmonės prekių ženklai, registruoti JAV ir kitose šalyse.
„Catalyst Browse“ logotipas yra „Sony Group Corporation“ prekių ženklas arba registruotasis
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prekių ženklas.
IOS yra „Cisco“ prekių ženklas arba registruotasis prekių ženklas JAV ir kitose šalyse bei
yra naudojamas pagal licenciją.
„iPadOS“, „Safari“ ir „iPad“ yra „Apple Inc.“ prekių ženklai, registruoti JAV ir kitose šalyse bei
regionuose.
„Android“ ir „Google Chrome“ yra „Google LLC“ prekių ženklai arba registruotieji prekių
ženklai.
„Wi-Fi“ yra „Wi-Fi Alliance“ registruotasis prekių ženklas.
SDXC logotipas yra SD-3C, LLC. prekės ženklas.
„CFexpress“ ir „CFexpress Type A“ logotipas yra „CompactFlash Association“ prekių
ženklai.
„NewTek™“ ir NDI® yra „NewTek, Inc.“ prekių ženklai arba registruotieji prekių ženklai.
„JavaScript“ yra „Oracle“ ir (arba) jos filialų registruotasis prekių ženklas.
„Intel“, „Intel“ logotipas ir „Intel Core“ yra „Intel Corporation“ ir jos valdomų įmonių prekių
ženklai.
QR kodas yra „Denso Wave Inc.“ prekės ženklas.
Visų kitų įmonių pavadinimai ir gaminių pavadinimai yra jų atitinkamų savininkų registruotieji
prekių ženklai arba prekių ženklai. Šiame dokumente prekių ženklai nėra pažymėti
simboliais ™ arba ®.
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